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INTRODUCTION 

C 
hapter 1 is an introduction to the new line of Macintosh comput­
ers- the Power Macintoshes. Here you'll see why the timing is 
right for Apple to switch to a new microprocessor. 

Chapters 2 and 3 discuss the architecture of the new Power PC micro­
processor. First, the differences between the microprocessor design 
strategies of the 680x0 chips and the new PowerPC chips are described. 
Then, the architectural details that make the PowerPC such a powerful 
chip are discussed. 

Chapters 4 and 5 cover the new additions to the Macintosh system 
software. Chapter 4 covers the 68LC040 Emulator. This built-in software 
is what allows a Power Mac to run both old 680x0 applications and new 
PowerPC programs. This chapter also covers the new Mixed Mode 
Manager- the part of the Toolbox that coordinates the activity of the 
68LC040 Emulator. Chapter 5 covers the other manager new to the 
Power Macs- the Code Fragment Manager. Any executable code is now 
known as a fragment, and is handled by the Code Fragment Manager. 

Chapter 6 describes the new PowerPC compilers that are on the mar­
ket. Here you'll see a comparison of Symantec's Cross-Development Kit, 
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or CDK, and the new Metrowerks CodeWarrior compiler. This chapter 
steps through the creation of a project and executable program using 
both of these development environments. 

Chapter 7 discusses the single biggest programming change a Power 
Mac programmer faces-the use of universal procedure pointers. Use of 
the new U niversalProcPtr data type is one of the programming tech­
niques you'll need to master in order to generate an application that 
runs on both a 680x0-based Macintosh and a Power Mac. 

Chapter 8 discusses fat binary applications-programs that run on 
both old and new Macs. You'll see how this type of application actually 
consists of two complete versions of the same program-one compiled 
with a 680x0 compiler and the other compiled with a PowerPC compiler. 

Chapter 9 and 10 discuss differences in 680x0 code and PowerPC 
code. Chapter 9 focuses on numerics-the numerical data types that are 
used in Power Mac programming. Chapter 10 covers the steps needed to 
port existing 680x0 code to native PowerPC code. 

Chapters 11 and 12 discuss import libraries. An import library-also 
called a shared library or dynamically linked library-allows a portion of 
an application to be saved as a library that can be used by multiple appli­
cations. This makes modification of code easy-the effects of a single 
change to an import library carry over to all applications that use that 
library. Chapter 11 shows that import libraries also make the creation of 
"plug-in tools" an easy task. A plug-in tool is a feature that can be distrib­
uted-or withheld-from a program. An example would be an applica­
tion that, for an additional fee, comes with an import library that allows 
that application to play QuickTime movies. Chapter 12 discusses adding 
icons to import libraries, and introduces Apple events and their use in 
applications that work with import libraries. 

Chapter 13 ends the book with a discussion of a few techniques for 
optimizing your PowerPC code. While source code may work without fol­
lowing the tips discussed in this chapter, it may not execute as fast and as 
efficiently as code that does. 
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Introduction 

WHAT'S ON THE DISK 

T he disk that comes bundled with this book has a single folder on it. 
Within that folder are three more folders-Metrowerks Examples f, 

Symantec Examples f, and Utilities f. 

The Symantec Examples f holds the source code files and project 
files for the Symantec Cross-Development Kit (CDK) examples that are 
covered in this book. If you have the CDK, which is a Symantec product 
that can be used in conjunction with the Symantec 7.0 compiler, you'll 
find that everything is all set up for you. 

The Metrowerks Examples f contains the source code files and pro­
ject files for each of the Metrowerks examples discussed in this book. All 
of the Symantec examples are repeated here in CodeWarrior format­
you won't have to make any changes to the source code or project files. If 
you have the Metrowerks compiler, you'll find that you'll save a lot of typ­
ing by using these projects. 

The Utilities f folder contains a data fork erasing utility program 
named DFerase. You'll use this Macintosh utility in Chapter 8 when you 
turn a fat binary-a program that runs on both a 680x0-based Macintosh 
and a Power Macintosh-into a smaller program that runs only on Power 
Macs. 

WHAT You NEED 

T o understand the contents of this book you should be familiar with a 
higher-level language-preferably C or C++. All source code listings 

are given in C. You should also be familiar with basic Macintosh program­
ming concepts such as programming with the Toolbox. 

All you need to run the example programs included on the disks is a 
PowerPC compiler. Either the Metrowerks CodeWarrior PPC compiler or 
Symantec's Cross-Development Kit (CDK). If you have either of these com­
pilers you can compile all of the source code from either a 680x0-based 
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Macintosh or a Power Macintosh. The results of some of your compiles­
the executables-will only run on a Power Mac, however. This is especially 
true of programs that use import libraries. Import libraries, or shared 
libraries, require calls to the Code Fragment Manager-a manager avail­
able only on Power Macs. 

WHY THIS BOOK IS FOR You 

M ost programs that were written for a 680x0-based Macintosh will 
run, unchanged, on a Power Macintosh. So what's all the talk 

about PowerPC programming about? Here are a few reasons why any 
Macintosh programmer should be concerned about programming for 
the new PowerPC-based Macs: 

• Programs designed for a 680x0-based Mac may run on a Power 
Mac, but they won't take advantage· of the processing power of 
the PowerPC chip. The PowerPC executes native code-code that 
consists of PowerPC instructions-far more efficiently than it 
does 680x0 code. 

• Some 680x0 code-especially code that use procedure pointers, 
or ProcPtrs-must be changed in order to execute on a Power 
Macintosh. 

• Import libraries, or shared libraries, are dynamically linked 
libraries that are now fully supported on the Power Mac. They 
provide a powerful and easy way to make sections of your code 
modular and reusable. 

• Apple has added to new important managers to the operating sys­
tem-the Mixed Mode Manager and the Code Fragment 
Manager. 

If you'd like to know about any of these topics, this book is for you. More 
generally speaking, if you've programmed the Mac, but aren't sure how 
to go about writing programs that run-and run fast-on a Power Mac, 
this book is for you. 
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Introduction 

Programming the PowerPC covers all of the above-mentioned topics, 
and several others. You'll find this book contains a background on the 
PowerPC chip architecture, a complete guide to porting 680x.O code to 
PowerPC code, a chapter on numeric data types for the Power Mac, and 
tips on optimizing your PowerPC code. There's plenty of example C lan­
guage source code in the book-and on the included disk. And if you 
own either the Metrowerks CodeWarrior compiler or the Symantec 
Cross-Development Kit (CDK), you'll also find the disk contains project 
files all set up for your compiler. 
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CHAPTER 1 

THE POWERPC AND 
THE POWER MACS 

A pple's Power Macintosh computers- based on the new PowerPC 
microprocessor chip- were introduced with as much fanfare as 
the very first Macintosh computers back in 1984. Is all this pub­

licity just industry hype- a gimmick to try to spark interest in still one 
more of the many new processor chips that have been developed over 
the years? Intel, the manufacturer of the chip that is inside computers 
that compete with the Macintosh, doesn't think so. They ran a succession 
of ads downplaying the PowerPC. Intel knows the potential of the chip 
that is the driving force of the new PowerPC Macs. This new Macintosh 
isn't a gimmick at all. Apple is betting its future on it- they expect to 
ship one million of the new PowerPC Macs in the first year alone. 

In the last decade, improvements to the hardware and system soft­
ware of the Mac have caused the Macintosh to evolve into the industry 
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standard for what an easy-to-use, graphically-oriented computer should 
be. Why then was there a need for an entirely different microprocessor? 
And, perhaps more importantly, how will the new chip effect how people 
perceive the Mac? These questions are answered in this chapter. 

THE NEED FOR A NEW CHIP 

I n the ten years since its introduction, millions of Macintosh computers 
have been sold. In the past few years several very popular new model­

s<esuch as the Quadra and PowerBook-have been introduced. All of 
these Macs are based on the Motorola 680x0 series of microprocessor 
chips. So why, as the Macintosh enters its second decade, is Apple scrap­
ping the 680x0 chip for a new microprocessor? The answer is found in 
two acronyms, CISC and RISC, and the performance plateau one of 
them is reaching. 

680x0 is sometimes written as 68 K. In either case, it's 
normally pronounced 68-kay. The original Macs were 
equipped with the 68000 chip. Since then Apple has used 
68020, 68030, al)d 68040 chips as well. 

CISC and RISC 

Before the new PowerPC-based Macintoshes, all Macs used one of the 
Motorola 680x0 chips. The processor chips in this series use a CISC, or com­
pkx instruction-set computer, architecture. The first Macs, introduced a decade 
ago, contained the 68000 chip. Successive models contained the 68020, 
68030, and finally the 68040 chip. Each new chip, and each Mac that 
housed a new chip, was faster than its predecessors. But improvement 
boosts between chips has started to level off, and engineers feel they've 
reached a plateau. They've pushed the CISC architecture to its limits and 
maximized chip performance. The Macintosh has outgrown the CISC chip, 
and must move on to something more powerful-enter RISC technology. 
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CISC processors contain a wide variety of instructions meant to han­
dle many different tasks. The new RISC-or reduced instruction-set 
computer-processors hold a much smaller number of instructions. Only 
the most basic, commonly used instructions exist in the instruction set of 
a RISC processor. 

With far fewer instructions, how is a RISC processor capable of per­
forming the same tasks as a CISC processor? RISC processors build com­
plex instructions from combinations of their core of basic instructions. 
RISC processors are built in such a way that they execute basic instruc­
tions very fast-much faster than a more complex CISC instruction can 
execute. In RISC, when a more complicated task is required, a more 
complicated instruction is put together from the basic instructions. This 
offsets the performance gains that are made by running fast basic instruc­
tion-but only slightly. On a whole, the RISC chip runs faster than the 
CISC. Figure 1.1 illustrates the speed differences for CISC and RISC 
processors. 

CISC 

RISC instruction 2 

time 

llJ Task1 Task 2 

FIGURE 1.1 EXECUTION SPEED OF INSTRUCTIONS FOR CISC AND RISC PROCESSORS. 

In Figure 1.1, two tasks are being carried out by both a CISC and a RISC 
processor. The CISC processor uses one complex instruction for each task. 
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The RISC processor uses a single basic instruction to carry out the first 
task. For the second task, it must build a more complex instruction from 
two basic instructions. Even with the building of a complex instruction, the 
overall time to execute the two tasks is still less for the RISC processor. 

~ 
N 0 T ll 

If engineers knew the CISC design was complex years ago, 
why didn't they change it long before now? The acronym 
CISC didn't exist until the advent of RISC. Before reduced 
instruction set computing, what is now called CISC wasn't 
thought of as complex. 

The following two points summarize in a very general fashion the differ­
ences in architecture between CISC and RISC: 

• CISC: many instructions, each specialized 

• RISC: few instructions, each general 

RISC Leads to More Than Just Speed 

For computer users, speed is important. While a 30 or 60 second delay in 
a program might not seem extraordinarily long, if this delay occurs dur­
ing an operation that the user performs 50 or 100 times a day, significant 
time is wasted. Problems like this are very real to Mac developers who 
write programs for the Mac, and for Mac users who work with math-

. intensive programs such as graphics packages. Years ago a program's abil­
ity to rotate, scale, or filter a 24-bit color photo image would have been 
considered very high-tech. Now it's expected and demanded of photo­
enhancement software. It's also expected that this kind of action be done 
quickly. That's why the speed that accompanies the RISC architecture is 
so very important. Processor speed, however, isn't the only benefit that 
Apple hopes to gain by its switch to RISC. 

Creative computing ideas often don't become reality, not because of 
a lack of technical know-how, but because of a lack of processor speed. 
Many of the exciting things being done on computer workstations aren't 
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being done on home computers simply due to a shortage of computing 
horsepower. Apple hopes-and expects-that programmers will use the 
extra speed of the PowerPC chip to develop programs with features and 
capabilities that would have been too much for 680x0 Macs. QuickTime's 
display of real-time video is an example of at_~chnology that couldn't be 
supported by the original 68000 Macs, but was possible with the later and 
more powerful 68020 and higher chips. Apple hopes the muscle of the 
PowerPC will bring about similar advancementscein video, graphics, com­
munications, and areas not yet even imagined. 

THE POWER MACINTOSH LINE 

T he new family of Macintosh computers-each based on the 
PowerPC microprocessor chip-is called the Power Macintosh line. 

The introduction of the new Power Macs includes three models-all 
based on the PowerPC 601 chip. 

Features of the New Macs 

The first three Power Macintosh computers are the 6100/60, the 
7100/66, and the 8100/80. In recent years Apple has been criticized for 
its confusing array of model names and numbers-the Power Macintosh 
naming convention puts an end to that. The following pieces of informa­
tion can be extracted from the model number: 

• The higher the number, the more powerful the Mac 

• The second digit describes the PowerPC chip in the Mac 

• The number following the slash is the processor's clock speed 

From the first point you know that the 6100 is the least powerful, the 
8100 is the most powerful, and the 7100 lies in between the other two. 
From the second point you know that all three use the PowerPC 601 
chip-the "1" in 6100, 7100, and 8100 stands for the 601 chip. The third 
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point tells you that the three computers run at 60 MHz, 66 MHz, and 80 
MHz, respectively. , 

Table 1.1 gives an overview of the features of the first three Power 
Macintosh models that will be produced. 

TABLE 1.1 OVERVIEW OF THE MODELS IN THE POWER MACINTOSH LINE. 

I 
Model 6100/60 7100/66 8100/ 80 

Processor 
Chip PowerPC 601 PowerPC 601 PowerPC 601 
Speed 60MHz 66MHz BO MHz 

RAM 
Standard BMB BMB BMB 
Maximum 72MB 136MB 264MB 

Expansion Slots One 7" NuBus 3 full-size NuBus 3 full-size NuBus 

Video 
DRAM video Standard Standard Standard 
VRAMvideo 1 MB 2MB 
VRAM maximum 2MB 4MB 

Each of the three Power Macs is available in a multimedia version. The 
model numbers are the same, only each is appended with an "AV." The 
6100/60AV, 7100/66AV, and the 8100/80AV all include built-in video 
and frame capture and built-in sound and speech capabilities. 

The meaning of most of the numbers in Table 1.1 should be intu­
itive, with the exception of the figures pertaining to video. 604 KB of 
DRAM, or dynamic RAM, is standard on all three models. It allows 8-bit 
color on Apple 16" monitors and 16-bit color on Apple 14" displays. An 8-
bit color level means 256 colors can be displayed at any given time, while 
a 16-bit level means over 32,000 colors can be shown. 
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Both the 7100 and the 8100 models supplement the standard DRAM 
with VRAM, or video RAM. The standard 1 MB of VRAM in the 7100 
means that it can display 16-bit color on an Apple 16" monitor and 24-bit 
color on an Apple 14" screen. A 24-bit color level allows over 16 million 
colors to be displayed at any one time. The standard 2 MB of VRAM in 
the 8100 means it supports 24-bit color on both the 16" and 14" screens 
and 24-bit color on the Apple 19" and 21" monitors. Table 1.2 sums up 
the color capabilities of the Power Macs. 

TABLE 1.2 COLOR CAPABILITIES OF THE THREE POWER MACINTOSH MODELS. 

6100 / 60 7100 / 66 8100 / 80 

12" Color 

14" Color 

13" VGA 

15" Portrait 

16" Color 

19" Color 

21" Color 

O N/A 0 8-bit 16-bit - 24-bit 

In addition to the features already mentioned, each of the Power 
Macintosh models have 16-bit stereo input and output, on-board 
Ethernet, and the Apple Desktop Bus (ADB) for input devices. 

7 



Programming the PowerPC 

The Customer Base 

Apple envisions different sets of users for the different Power Mac mod­
els. The 6100/60 is the lowest priced of the three Power Macs, and is con­
sidered the entry level model. Its target customer base consists of the fol­
lowing groups: 

Ill Small businesses 

l!I Computer enthusiasts 

Ill DOS/Windows users switching to Macintosh 

The 7100/66 is the mid-range Power Macintosh model. Its faster speed 
and extra slots broaden its appeal to include the following groups: 

Ill All businesses 

Ill Education and administration 

Ill Entry level professionals 

Ill DOS/Windows users switching to Macintosh 

The most powerful and expensive of the three Power Macs is the 
8100/80. Its speed, multiple slots, and support of 24-bit color on a moni­
tor up to 21 inches in size makes it ideal for the following markets: 

Ill Professional publishing 

Ill Engineers 

Ill Multimedia authors 

Ill DOS/Windows users switching to Macintosh 

One group of users appears as part of the target audience for all three 
Power models-DOS and Windows users. All three of the Power Macs are 
capable of running Insignia Solutions' SoftWindows-emulation software 
that allows Macs to run DOS and Windows programs. That's appealing for 
users who are considering switching to Macintosh-it means they can get 
rid of their IBM-compatible hardware but retain their software investment. 
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Apple sees the 6100/60 appealing to DOS/Windows users because 
of its modest cost<esomething users of IBM clones are used to. The 
appeal of the 7100/66 is its three slots. Users of IBM clones are used to 
multiple slots and expect it in a computer. The 8100/80 will be the 
fastest of the Power Macs. That will appeal to the IBM compatible users 
who savor speed. 

Is IT STILL A MAc? 

Making a dramatic change to the hardware that makes up a comput­
er can provide that machine with a new appeal to many people. It 

can also scare off many potential computer buyers who fear struggling 
with issues such as learning a new system, loss of investment in 680x0 
software, incompatible hardware add-ons, and the learning curve associ­
ated with programming a new computer. Apple kept all of these issues in 
the forefront as it implemented the hardware architecture of the new 
Power Macintosh computers. 

The PowerPC System Software 

In moving from a CISC microprocessor to one that employs RISC tech­
nology, Apple invested a large amount of time and money in changing 
the internal workings of the Macintosh. This was done because of the 
belief that the CISC technology of the Motorola 680x0 series was reach­
ing its maximum potential. Apple did not, however, feel the graphical 
user interface that is the trademark of the Macintosh was also showing 
signs of aging. So the windows, menus, and icons that define the Mac 
have not changed. 

The Power Macs use a version of System 7-so they have the exact 
same user interface as the 680x0 Macs. The first version of System 7 that 
supports the Power computers is System 7.1.2. 
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Software Compatibility 

Owners of 680x0 Macs typically have hundreds or even thousands of dol­
lars worth of software. For users moving up to a Power Mac, this sizable 
investment is not lost. All software that was properly designed to run on a 
68020, 68030, or 68040 Macintosh will run on a Power Macintosh. 

Most major software vendors have modified their software programs 
that were originally designed to run on 680x0 Macs so that they will run 
much faster on Power Macs. Most older programs that were not modified 
will also run on the new Macs-they just won't take full advantage of the 
speed of the Power PC chip. 

Hardware Compatibility 

Users of the Power Macs may see their new computer as exciting, blazing­
ly fast, and fun to work with. Hardware components connected to a 
Power Mac will see the new computer as just another Mac<eand that's 
good news. It means that 680x0 printers and SCSI devices such as hard 
disks and scanners can be used with the new Macs. 

For businesses, hardware compatibility means Power Macs can be 
added to an existing network of 680x0 Macs without confusing the server. 
The Power Macs can run old and new programs and transfer files 
between other Power Macs and older 680x0 models. 

Developer Support 

Programmers who have grown accustomed to developing for the 
Macintosh have fears about programming the Power Macintoshes. For 
them, there is more good news. Writing software that will run on both 
the older 680x0 Macs and the new Power Macs can be done with a mini­
mum of effort. Programmers do not need to learn an entirely new pro­
gramming language or learn all the details of a new operating system. 
Greater effort is needed to take full advantage of the processing speed of 
the new Macs-but not an unreasonable amount. 
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This book deals with PowerPC issues that concern Mac programmers: 

• porting existing 680x0 source code to run on the PowerPC, 

• writing new code that maximizes the power of the PowerPC, 

• taking advantages of programming techniques unique to the 
PowerPC, and 

• 680x0/PowerPC compatibility issues. 

CHAPTER SUMMARY 

Before development of the Power PC chip, all Macs used a micro­
processor from the Motorola 680x0 family of chips. These 680x0 

chips used a CISC, or complex instruction-set computer, architecture. 
The new PowerPC chips that are the driving force of the Power Macs use 
a RISC, or reduced instruction-set computer, architecture. RISC technol­
ogy is superior because it uses a smaller set of instructions than CISC. 
From these fewer, simpler instructions, the RISC chip can carry out sim­
ple tasks quicker than a CISC chip. And for more complicated tasks, the 
RISC chip can string together a series of simple instructions that still run 
more quickly than the complex instructions of a CISC chip. 

There are three models in the first series of Macintosh computers 
that use the PowerPC chip. The 6100/60 is the low-end Power Mac 
aimed at small businesses and computer enthusiasts. The 7100/66 is the 
midrange model, and is aimed at businesses of all sizes, educational 
users, and entry-level professionals. The 8100/80 is the most powerful of 
the three models. It's appeal will be to professional publishers, engineers, 
and multimedia authors. Because the Power Macs can run DOS and 
Windows programs, all three models are ideal for users who are making a 
transition from the IBM-compatible world. 

The technology behind the change from a 680x0-based processor to 
a PowerPC-based processor will be transparent to end-users. The 
Macintosh system software used by the Power Macs appears identical to 
that used by 680x0 Macs. And, though older versions of existing pro-
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grams won't take full advantage of the speed of the PowerPC chip, they 
will nonetheless run on the new Macs. 

For programmers, getting old Macintosh code to compile and run on 
Power Macs will not be a daunting task. But there are several program­
ming issues programmers should be aware of. With the PowerPC there 
are also new features that developers will want to consider adding to new 
programscesuch as import libraries. The remainder of this book will dis­
cuss these points at length. 
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CHAPTER 2 

CISC AND RISC TECHNOLOGIES 

T hough the PowerPC is a new microprocessor, the RISC technolo­
gy that it is based on came into existence over fifteen years ago. 
As RISC evolved, it both borrowed from CISC and diverged from 

it into completely new directions. An understanding of the Motorola 
680x0 series, and the CISC technology upon which it is based, will help 
in understanding the newer RISC technology used in the PowerPC chip. 

While the Power Macintoshes are the computers everyone is talking 
about, Macs based on the 680x0 series will be around for years to come. 
Anyone designing software for the Power Macs will want to ensure that 
their programs also are compatible with the millions of 680x0 Macs cur­
rently on the market. This chapter discusses how both the 680x0 and the 
PowerPC work with instructions. This information will serve as a back­
ground for future chapters that discuss writing source code that is com­
patible on both old and new Macintoshes. 
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CISC AND THE 680x0 SERIES 

Before the advent of reduced instruction set computing, CISC-or 
complex instruction set computer-was the strategy used in the 

design of microprocessor chips such as the Motorola 680x0 series. 

Why CISC? 

The CISC design evolved from two sets of circumstances that prevailed in 
the world of computers years ago: 

II Computer programs were written primarily in assembly language 

Ill Computer memory was relatively slow and expensive 

The CISC design uses methodologies that aid assembly language pro­
grammers and reduce access to the slow, expensive, main memory chips. 
By making each instruction perform multiple tasks, assembly language 
programmers were spared the necessity of learning large sets of instruc­
tions. And by having the instructions perform much of the work within 
registers in the processor, long, slow trips to main memory were avoided. 

Instruction Execution on a 680x0 

The 680x0 processors have a number of general purpose registers for 
holding data and addresses, as well as a few special purpose registers. One 
of these special registers-the Status register-is used to hold information 
about the status of the Mac. The Status register is divided into two parts. 
One part-the CCR, or condition code register-is of more significance 
to programmers than the other part. The CCR holds information about 
the outcome of the most recently performed arithmetic or comparative 
operation. The CCR thus gives a programmer information such as 
whether or not an operation resulted in a negative value or a value of 
zero. Figure 2.1 shows many of the registers in a typical 680x0 chip. 
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Chapter 2 CISC and RISC Technologies 

Data registers Data registers I 
Address registers 

~Condition code register (CCR) 

FIGURE 2.1 SOME OF THE REGISTERS IN A 680x0 SERIES CHIP. 

Though this section discusses registers and shows a couple 
of assembly language instructions, a knowledge of assem­
bly language is not required for comprehension of the topics 
presented here. 

Like any microprocessor, the 680x0 carries out instructions by perform­
ing arithmetic operations on data. That data may be moved between 
main memory and registers within the processor, or from register to reg­
ister within the processor. The rich instruction set of a 680x0 micro­
processor holds instructions that accept 0, 1, or 2 operands. An operand 
holds data-or the memory address of data-that is to be acted on. 

An example of an assembly instruction that uses two operands is the 
add instruction. It adds two operands together and stores the results back 
in one of the two operands. Here's an example that adds the value 7 to 
the contents of register D 1 and stores the result back in D 1: 

ADD #7,Dl 
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The execution of a two-operand instruction-such as the add instruction 
mentioned above-requires that some parts of the processor be used 
multiple times. In the previous example, the contents of register 01 will 
be read from the register, the value 7 will be added to this read value, 
and the result will be written back into register 01. Figure 2.2 shows 
this-with emphasis on the 01 register. 

Dl Dl Dl 

FIGURE 2.2 INSTRUCTION EXECUTION CAN USE ONE REGISTER MORE THAN ONCE. 

After the completion of the add instruction the condition code regis­
ter-the CCR-will hold information about the addition operation that 
just took place. In fact, most assembly instructions affect the condition 
codes in this register. 

This discussion has shown that two-operand instructions use and 
reuse registers and that the condition code register is usually altered 
after the execution of an instruction. These two concepts are very impor­
tant limiting factors in the determination of the speed at which a 
680x0-or any other CISC microprocessor-can process instructions. 

Back in Figure 2.2, you saw that the example add instruction took 
more than one step to complete. Of the three steps shown, the first and 
last both involve the 01 register. That means that at any point in time 
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between these steps, the D 1 register cannot be used by another instruc­
tion. If another instruction were to start executing before the add was 
complete (and it too used the Dl register) it might interfere with results 
obtained during the add. For this reason, any 680x0 processor, and any 
other CISC processor, cannot start executing a new instruction until the 
currently executing instruction has completed. 

Once an instruction is complete, it sets various flags in the condition 
code register. The next instruction that executes may examine these flags 
and use information from one or more of them. This is a second reason 
that CISC processors can't run concurrent instruction-an instruction 
must complete before the condition code register flags get set. 

The lack of the ability to start executing an instruction until the cur­
rently running instruction completes is a key factor that restricts the 
speed that a CISC processor can obtain. RISC processors use a design 
implementation that overcomes this boundary-as you'll see later in this 
chapter. 

The Timing of Instructions on a 680x0 

While a 680x0 processor can't execute more than one instruction at a 
time, it can perform more than one task at a time. Typically, a single 
instruction is divided into multiple stages that run consecutively. The 
result of one stage can be used by another stage. 

Let's look at a hypothetical example that demonstrates the multiple 
stages of an instruction. Assume there exists an instruction that draws a 
square in a window. To take advantage of the Mac's graphics capabilities, 
the instruction tries to give the square a three-dimensional look by first 
drawing a black square, then a white square slightly offset from the black 
one. The result of one execution of this instruction might look some­
thing like that shown in the window in Figure 2.3. 

One execution of this square-drawing instruction takes one clock 
cycle. Now, to get a better feel for the timing involved as a CISC proces­
sor executes instructions, imagine that a program has been written that 
repeatedly uses this instruction. Not too sophisticated a program, but its 
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simplicity and repetitiveness will serve well to demonstrate the timing of 
instructions in a CISC processor. Figure 2.4 shows the timing and out­
come of the program after four clock cycles have completed. 

D 

FIGURE 2.3 RESULTS OF A HYPOTHETICAL SQUARE·DRAWING INSTRUCTION. 

-Iii' '::Iii' F.lli" =1ii1 

• D D D 

• D 
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Clock~les 1 2 3 4 5 6 7 8 

Black square 0 m 
White square m ~ 

FIGURE 2.4 INSTRUCTION TIMING IN A HYPOTHETICAL CISC PROGRAM. 
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The task of the first clock cycle is the drawing of the black square- the 
result is shown in part A of Figure 2.4. The second and final task of the 
instruction is to draw the white square over the black square, as shown in 
part B of the figure. The third clock cycle starts the second execution of 
the square-drawing instruction. By part D of the figure, the instruction­
and the fourth clock cycle- are complete. 

Figure 2.5 shows another way of looking at the instruction timing. 
This figure places the emphasis on the objects-the two squares. This 
figure shows that it takes two cycles to create a single object. After 
four cycles, two objects have been created. It also clearly illustrates 
that a second instruction will not begin until the first instruction has 
completed. 

• D 

A B 

Clock c cles 

Black square 

White square 

Q 1st object 111111 2nd object 

D 

• 
c 

D 
D 

D 

FIGURE 2.5 TIMING OF THE DRAWING OF AN OBJECT IN A HYPOTHETICAL CISC PROGRAM. 
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Important! If you take nothing more away from this section 
than the idea that the CISC chip is incapable of starting 
one instruction before completing the previous one, you've 
learned enough! 

CISC-Fast, But Not Fast Enough 

This section has emphasized the pitfall inherent in complex instruction 
set computing-the inability to run concurrent instructions. But that's 
not to say that CISC is slow. A CISC chip like the Motorola 68040 makes 
software on the Quadra Macintosh models run very quickly. CISC chips 
are still the dominant chip used in personal computers-even Intel's 
newest and fastest chip, the Pentium, is of a CISC design. But in the 
1990's, fast isn't good enough. Now, users are expecting and demanding 
very fast. And for that, a newer technology is needed. RISC, or reduced 
instruction set computing, is that new technology. 

RISC AND THE POWER MAC SERIES 

T he three models of Macintoshes that were the start of the Power 
Macintosh series introduced the personal computing world to the 

PowerPC chip and RISC technology. Most new Mac models that follow 
will also be based on PowerPC and RISC. 

Why RISC? 

The primary reasons the CISC design philosophy came about were that 
programmers used assembly language and memory was slow and expen­
sive. Today, assembly language is a dying art. Even programs that are 
dependent on great speed are usually written in a higher-level language, 
with a few assembly routines added to handle the most speed-intensive 
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operations. This, coupled with the fact that computer memory has 
become very fast and very inexpensive, has greatly reduced the benefits 
of a chip design based on the CISC philosophy. 

CISC chips are complex-that's a result of the complexity of the 
instructions that the chip can execute. For the benefit of assembly lan­
guage programmers, CISC chip instructions usually perform multiple 
tasks. The hardware necessary to make this come about is thus more 
complex. And complex means slow. A chip designed to carry out only 
simpler instructions will inherently run faster. 

CISC uses powerful instructions that perform numerous tasks to make 
life easier for assembly programmers. In recent years compilers have been 
optimized so that they can take code written in a high-level language such 
as C or C++ and generate machine language code that is as fast and effi­
cient as code written in assembly language. Because of this, the use of 
assembly language has been diminishing while the use of high-level lan­
guages has soared. Developers who write programs in an "English-like" 
higher-level language need not memorize obscure assembly mnemonics. 
For the architects of processor chips, that meant that they could look at 
new ways of implementing instructions within a chip. From this reexami­
nation of instruction execution, RISC technology was born. 

Instruction Execution on a Power Mac 

The PowerPC chip, like the 680x0 chip, has internal general purpose 
and special purpose registers. One of these is the CR, or condition regis­
ter-it's analogous to the 680x0 CCR, or condition code register. And, 
again like the 680x0 chips, some PowerPC instructions require the reuse 
of one or more of the internal registers. Yet the RISC technology in the 
PowerPC chip overcomes this obstacle so that the execution of one 
instruction can begin before the completion of another. 

In CISC, instructions vary in length and complexity. A single instruc­
tion may require more than one fetch-more than one access of main 
memory to obtain instruction information. In RISC, all instructions are 
of the same length. Each instruction can be fetched in a single opera-

21 



Programming the PowerPC 

tion. And almost all RISC instructions are so basic that they can be com­
pleted in a single cycle. 

While all RISC instructions are simple, all of the tasks expected of a 
microprocessor are not. How does the PowerPC handle an operation 
that is of greater complexity than any one RISC instruction is capable of 
performing? In such an instance the PowerPC will execute a series of 
simple instructions to handle this one more complex task. 

It might seem like the total amount of time to execute a series of sim­
ple instructions could be equal-or even greater-than the time to run 
one complex instruction. If the simple instructions were run one after 
the other, with no overlap in execution, this indeed would be the case. 
But in RISC, one instruction can begin before another ends. This tech­
nique of building a complex instruction from several basic instructions 
results in a net savings of time. 

In order to take advantage of the RISC chip's ability to overlap 
instruction execution, a stumbling block present in CISC technology had 
to be overcome-instruction dependencies. If a second instruction 
depends on the results produced by a first instruction, the execution of 
the second instruction can't begin until the completion of the first. To 
circumvent this problem the PowerPC actually rearranges the instruc­
tions found in a program to reduce or eliminate dependencies. This 
technique is called instruction scheduling. 

22 

The rearrangement of instructions is obviously not a hap­
hazard effort. A programmer has some control over this 
process, but compilers such as Metrowerks' CodeWarrior 
and Symantec's Cross Development Kit (CDK) do the major-
ity of the work in determining where dependencies lie, and 
where they can safely be removed. Additionally, the 
PowerPC chip itself uses sophisticated logic to determine 
the ordering of instruction execution. 

Note that as a programmer you need not be concerned 
about the instruction rearranging that your compiler and 
Power Mac institute. Only instruction switching and depen­
dency removals that don't harm the integrity of data will be 
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performed. If a rearrangement of instructions would lead to 
an incorrect instruction result, the switch will not be made. 

Let's take a look at an example that demonstrates how instruction sched­
uling might work. For the 680x0, the add instruction has two operands. 
The value in the first operand is added to the second, and the result is 
stored back in the location named as the first operand. For the PowerPC, 
the instruction to perform addition has three operands. The second and 
third operands specify the values to add, while the first operand specifies 
where the result should be stored. Here's an example that adds the num­
ber seven to the contents of register r2, then stores the result back in r2: 

add r2. r2. 117 

Now, here's the above instruction included in a very short snippet of 
code: 

add r2, r2, /17 
stw r2, total 
sub r3, r3, //5 

In the above example, the value seven is added to the contents of register 
r2 and the result is stored back in r2. Then, the stw instruction stores 
this sum into the word in memory addressed by tot a 1. Finally, a subtrac­
tion, or sub, instruction performs a subtraction using register r3. 

In previous sections you've seen that the add instruction reuses the 
register that serves as both the source of one of the values to add and the 
destination of the final result. In the above example, you see a similar sit­
uation-register r2 will be accessed twice. While the addition operation 
is taking place, no other instruction that uses the r2 register can run. 
Since the instruction that follows the add-the stw instruction-uses r2, 
it cannot begin running until the add has completed. The add must com­
plete so that r2 contains the final and correct value that the stw instruc­
tion is to write to memory. 

You know that a RISC system attempts to start one instruction while 
running another one. When the system has to wait for an instruction to 
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complete before beginning the next instruction, a stall results. 
Instruction scheduling eliminates stalls. In the next code snippet the 
order of the second and third instructions of the previous example have 
been switched: 

add r2, r2, 117 
sub r3, r3, 1f5 
stw r2, total 

This one simple change prevents a stall. While the add instruction is 
running, the sub can begin. Why? Because there is no instruction 
dependency-the sub instruction does not use r2. Because the sub 
instruction doesn't make use of r 2 or access the memory location 
addressed by tot a 1, whether the result of the add is stored in memory 
after the first instruction or after the second instruction is unimportant. 
Figure 2.6 illustrates. 

Before scheduling After scheduling .. add r2, r2, #7 .. add r2, r2, #7 

~ stw r2, total .. add r3, r3, #5 

add r3, r3, #5 stw r2, total 

.. executing ~ waiting 

FIGURE 2.6 A EXAMPLE OF INSTRUCTION SCHEDULING ELIMINATING A STALL. 

In a PowerPC, the switching of the order of instructions is commonplace. 
This is a feature of the PowerPC chip-as a programmer, you don't have 
to use special programming techniques to achieve instruction scheduling. 
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The Timing of Instructions on a Power Mac 

The goal of RISC is to speed up processing. To do that, the PowerPC 
employs a technique not possible in a CISC chip-pipelining. Pipelining is 
the processing of one instruction before a previous instruction has com­
pleted. Hardware design considerations in the PowerPC, along with the 
reduction of instruction dependencies through instruction scheduling 
make pipelining possible. 

You've seen that in a CISC system instructions are of varying 
lengths-depending on the complexity of the task the instruction is to 
perform. In RISC, each instruction is the same length. For complex 
operations, several instructions are joined to build one larger instruc­
tion. Thus in either CISC or RISC, the completion of a complex task can 
take more than one cycle. The RISC technique of pipelining doesn't 
decrease instruction latency-the number of cycles to complete a single 
instruction. It does, however, increase throughput-the number of 
instructions completed per cycle. That's because instructions are broken 
into many tasks-just as in CISC. But unlike CISC, the RISC processor 
doesn't wait for one instruction to end before starting another. Thus sev­
eral instructions can run concurrently and the flow of instructions 
speeds up. 

As an example of instruction timing in a RISC system, refer to Figure 
2.7. Here you see the execution of the same square-drawing instruction 
used in the CISC example earlier in this chapter. Once again I'll request 
that you cast aside your doubts as to the usefulness of a program that 
mindlessly draws square after square! 

The first clock cycle of the RISC system is identical to that of the 
CISC system-a black square gets drawn. But in the second cycle, things 
have changed. With pipelining, the RISC processor finishes the first 
square-drawing instruction by drawing the white square over the black 
one. But it also starts the second square-drawing instruction. So in the 
second cycle both a white square and a black square are drawn. The third 
cycle completes the second square and starts the third. The fourth cycle 
completes the third square and starts a fourth square. 
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FIGURE 2. 7 INSTRUCTION TIMING IN A HYPOTHETICAL RISC PROGRAM. 
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FIGURE 2.8 TIMING OF THE DRAWING OF AN OBJECT IN A HYPOTHETICAL RISC PROGRAM. 
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Figure 2.8 takes another look at the pipelining of instructions. Here, 
emphasis is on the objects. 

Note that while it takes two stages to create each individual object­
just as it did in the CISC system- after the first stage a new object is creat­
ed every stage. After four cycles, three objects have been created and a 
fourth has been started. Contrast this RISC result from that obtained 
with the CISC processor. In this chapter's CISC example only two objects 
were created in four cycles. Pipelining allows the RISC processor to start 
on a new object before the previous object is complete. Figure 2.9 con­
trasts the difference in instruction processing for CISC and RISC systems: 

Start of 
Start of 
2nd i nstructi 

CISC 
ls t i nstO .(} 

Clock cy cle 

Black squar1 

White squart 

Start of 
4thins t ructi 

Start of-·~•~r:n n 
1st instOl.Jl.)!J 

RISC 
Clock c cle 

Black squar1 

White s quari 

7 8 

7 8 

0 1st objec • 2nd objec • 3rd objec a 4th objec 

FIGURE 2.9 TIMING COMPARISON OF CISC AND RISC PROCESSORS. 

CHAPTER SUMMARY 

C ISC- or complex instruction set computer- is a design that uses 
methodologies that aid assembly language programmers and reduce 
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access to the slow main memory chips. The rich instruction set of a 680x0 
microprocessor holds instructions that accept 0, 1, or 2 operands. Two­
operand instructions use and reuse registers, and alter the value in the 
CPU's condition code register after the execution of an instruction. 
These two concepts are important factors that limit the speed at which a 
CISC microprocessor can process instructions. On a CISC processor, one 
instruction must complete before a second instruction can start. 

CISC held advantages over some technologies when assembly lan­
guage programming was prevalent and memory was slow. Today, high­
level languages are far more popular than assembly language. Also, main 
memory has become fast and inexpensive. These facts pave the way for 
RISC to become a mainstream technology. 

RISC relies on a small instruction set consisting of simple instruc­
tions. Each instruction can be carried out quickly. When a more complex 
instruction is needed, two or more of the simple instructions are strung 
together to form what is equivalent to the complex instruction. The 
other factor in making a RISC chip faster than a CISC chip is its ability to 
start a second instruction before completing a first. To accomplish this, 
instruction scheduling is used-instructions are rearranged to reduce or 
eliminate dependencies. 
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POWERPC ARCHITECTURE 

I 
n Chapter 2 you saw that pipelining-the ability to start executing 
an instruction before another has completed- is the key to the 
speed of the PowerPC microprocessor. In this chapter you'll see the 

chip architecture that makes pipelining possible . 
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BRANCH PROCESSING UNIT 

Branch instructions break up the uniform flow of a program. So it 
should come as no surprise that branches are one of the key limiting 

factors in the speed at which a processor can execute instructions. The 
PowerPC has a hardware solution to this potential dilemma-the Branch 
Processing Unit. 

Instruction Fetching 

The PowerPC, like any microprocessor, runs a program by fetching an 
instruction from RAM and then executing that instruction. Figure 3.1 
shows this unending cycle of fetching and executing instructions. How 
the PowerPC executes any one instruction depends on the type of 
instruction fetched-so for that reason the components that make up 
the PowerPC chip were intentionally left unlabeled in Figure 3.1. 

PowerPC RAM 

D 
D 

FIGURE 3.1 THE PROCESSOR CONTINUOUSLY FETCHES AND EXECUTES INSTRUCTIONS. 
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The PowerPC is fast- very fast. At times it may execute instructions faster 
than RAM can deliver new ones. To avoid a pause in instruction execu­
tion, the PowerPC employs instruction prefetching. Prefetching involves 
fetching several instructions at one time, and loading those instructions 
into a queue on board the PowerPC. During lulls in the delivery of 
instructions, the PowerPC can continue to dispense queued instructions 
to the appropriate components for processing. Figure 3.2 shows the 
instruction queue in place in the PowerPC. 

~ 
N 0 T E 

PowerPC 

Instruction 

• 
~ 

D 

RAM 

FIGURE 3.2 FETCHING INSTRUCTIONS TO THE INSTRUCTION QUEUE. 

Of interest to programmers who use assembly language is 
the new bit numbering convention of the PowerPC. When 
working with a 32-bit word, the 680x0 series calls the 
right-hand bit "bit O" and the left-hand bit "bit 31." On the 
PowerPC, bit numbering is reversed. This difference is 
shown in Figure 3.3. 
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PowerPC 680x0 

0 31 31 0 

MSB LSB MSB LSB 

FIGURE 3.3 BIT NUMBERING IN THE POWERPC AND THE 680x0. 

Instruction Fetching and the Branch Unit 

Prefetching keeps a RISC chip processing instructions at a constant 
rate-unless a branch is encountered. Statements in a program such as 
an if branch or function call result in the processor having to perform a 
branch. In instances such as these, the processor may need to access 
instructions that lie in a part of RAM that is not contiguous to where it is 
currently fetching instructions. That is, the sequential order of fetched 
instructions becomes broken. The processor can't use the pref etched 
instructions it has-it must fetch the instructions that make up the 
branch code or the subroutine code. While this occurs, components of 
the processor halt and a stall results. To avoid such stalls, the PowerPC 
has a special component called the Branch Processing Unit, or BPU. 

The purpose of the BPU is to detect branches and to respond by 
making adjustments to the instruction queue. Figure 3.4 shows that the 
BPU, along with the instruction queue, make up a component called the 
Instruction Unit. The PowerPC chip of course contains more units than 
the Instruction Unit-the unlabeled boxes in Figure 3.4 hint at that. 

The Branch Processing Unit constantly examines the last few instruc­
tions in the instruction queue. If a branch is included in the instructions, 
the BPU will fetch the appropriate instructions based on the branch. 
Figure 3.5 shows a few lines from a program written in C language. Each 
line is numbered, and the line numbers of a few of the lines are shown in 
the instruction. This is done for the sake of clarity-a real PowerPC 
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would be working with the machine language that resul ted from the 
source code, not the source code itself. Figure 3.5 shows how you might 
expect the instruction queue to look after the PowerPC encountered the 
first three lines of code. In fact, the instruction queue would look like 
that pictured in the following figure, Figure 3.6. 

Instruction 
Queue 

~ 
Branch 

Processing 
Unit 

(BPU) 

FIGURE 3.4 THE BRANCH PROCESSING UNIT COMPONENT OF THE POWERPC CHIP. 

Instruction 
Queue 

count++ ; 

Wri te_Note ( ) 

.index = 0 ; 

void Write_Note ( void ) 

MoveTo ( 10, 20 ) ; 

Drawstring ( ~ \pNonzero" ) 

FIGURE 3.5 PREFETCHING AND THE INSTRUCTION QUEUE-WITHOUT BRANCH PROCESSING. 
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Instruction 
Queue 

3 
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1 

• 
FIGURE 3.6 PREFETCHING AND THE INSTRUCTION QUEUE-WITH BRANCH PROCESSING. 

In Figure 3.6, the Branch Processing Unit noticed that there is a function 
call in the code-a function named Write_Note() is invoked. A func­
tion call is a branch. The BPU then replaces the function call with the 
instructions that make up the function itself. In this case the function 
consists of two Toolbox routines-MoveTo() and DrawStri ng( ). 

Function calls represent one form of PowerPC branch. The other 
kind is an actual branch statement-programming statements such as if, 
switch, and goto are examples. This type of branch has to be handled in a 
different manner than a function call branch. Why? Because while a 
function call such as that shown previously in Figure 3-6 will always be 
executed, a branch may or may not be. A branch statement relies on the 
test of a condition to determine if the code beneath the branch should 
be executed or skipped: 

if ( index > 0 
Drawstring( "\pNonzero" ); 

The course that will be taken by a branch such as this is determined by 
conditions at runtime. At the time that the Branch Processing Unit 
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examines this section of code, the value of index might not be known. 
So, as the BPU examines a branch statement for which it doesn't know 
the outcome, how does it determine which instructions to place in the 
instruction queue? It doesn't. But it still places the instructions that make 
up one body of the branch into the queue. 

The BPU uses branch prediction to make a decision regarding an unre­
solved branch. A guess is made as to which path will be taken, and the 
instructions that make up that path are prefetched and placed in the 
instruction queue. If the prediction is correct, instruction processing exe­
cutes without a stall-that is, without delay. The PowerPC hedges its bet 
by storing the address of the nonpredicted path. That way, if the predic­
tion proves to be incorrect, the instructions that make up the other path 
of the branch can be fetched. 

It's important that the BPU guess correctly much more often than 
not-an incorrect prediction obviously negates any time savings that 
would have resulted from a correct prediction. To aid in the determina­
tion of the correct branch instructions to pref etch, the BPU follows a set 
of fixed rules. One such rule is that the if path of a branch will always be 
selected over the else path. 

Examination of source code shows that programmers will usually 
(intentionally or not) place the code that is most likely to execute under 
the if rather than the else. Imagine a program that contains an integer 
variable named index. The program allows this variable to be assigned 
any value between 0 and 100. If the program is interested only in 
whether index is either zero or in the range of 1 to 99, a programmer 
will usually write the code as shown here: 

if ( index > 0 
Drawstring( "\pNonzero" ); 

else 
Drawstring( "\pZero" ); 

I* 99 of 100 end up here */ 

I* 1 of 100 end up here */ 

Again taking the liberty of using source code for clarity, Figure 3.7 shows 
an example of how the BPU would start to fill the instruction queue as it 
encounters a section of code that includes an if-else statement. 

35 



Programming the PowerPC 

Instruction 
Queue 

6 

3 

2 

1 

1 count++ 

2 if ( index O ) 

3 Drawstring { "\pNonzero' ) 

4 else 

5 Drawstring { 

6 index = 0 

FIGURE 3. 7 BRANCH PREDICTION IS USED TO RESOLVE BRANCHING. 

Branch prediction is another good reason to use a compiler 
designed to optimize code for the PowerPC-as the 
Metrowerks and Symantec CDK compilers do. These com­
pilers are set to correctly handle conditional branches. 

SUPERSCALING 

Simplifying each instruction in a chip's instruction set is one way to 
reduce the execution time of instructions. You've seen that the 

PowerPC does just that. A second means of speeding up instruction exe­
cution is to run instructions concurrently. The PowerPC employs a super­
scalar design to accomplish this feat. 
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The Superscalar Design 

Parallel processing is the use of multiple processors to speed up instruc­
tion execution. Another method used to achieve this effect is to design 
the parts of a single processor such that they run in parallel to one anoth­
er. This design strategy is called superscalar design, and is the one used by 
the PowerPC. 

The PowerPC relies on three functional units that work both inde­
pendently and in conjunction with one another to execute instructions. 
You are already familiar with one of the units- the Branch Processing 
Unit. The other two units are the Integer Unit, or IU, and the Floating­
Point Unit, or FPU. Figure 3.8 shows the three major components of the 
Power PC. 

PowerPC Instruction Unit 

Instruction 
Queue 

~ l 1 
T 

Branch 
Integer Processing Floating Point 

Unit Unit Unit 
( IU) ( BPU ) ( FPU ) 

FIGURE 3.8 MAJOR COMPONENTS OF THE POWERPC CHIP. 

Having three separate units means that at any one time the PowerPC can 
execute three separate instructions: an integer instruction, a floating­
point instruction, and a branch instruction. 
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Branch Processing Unit 

The Branch Processing Unit, or BPU, was covered earlier in this chapter. 
Its purpose is to locate branches before they occur. Then, using branch 
prediction, the BPU prefetches what it believes are the instructions that 
make up the branch. 

The BPU is located, along with the instruction queue, in the instruc­
tion unit. That's because all instructions pass through the BPU first. That 
enables the BPU to examine each instruction for a branch. Instructions 
that aren't branches are then handled by either the Integer Unit or the 
Floating-Point Unit. 

Integer Unit 

The Integer Unit, or IU, is responsible for the execution of all integer 
instructions. This includes integer arithmetic, shifts, comparisons, and 
logic operations. To accomplish this variety of chores the IU contains an 
arithmetic logic unit, or ALU, an integer exception register, or XER, and 
32 general-purpose registers, or GPRs. 

The ALU carries out the operations that make up an integer instruc­
tion. When the execution of an instruction is interrupted by an unexpect­
ed or illegal condition, an exception is said to have occurred. Examples of 
events that trigger an exception are illegal array bounds, division by zero, 
and an arithmetic overflow. The integer exception register, or XER, is a 
special-purpose register, or SPR, that holds exception information about 
the completed integer operation. Most notably, the XER notes when an 
integer operation results in an overflow. The general-purpose registers 
hold any non-floating-point values such as parameters and local variables. 

Floating-Point Unit 

The Floating-Point Unit, or FPU, is responsible for the handling of all 
instructions that involve floating-point values. This includes floating­
point arithmetic operations and compares. 
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The FPU contains parts that are roughly comparable to those in the 
Integer Unit. Because arithmetic operations for floating-point values use 
different logic than those performed on integers, these operations are 
performed by a multiply-add array rather than an ALU. 

The one special-purpose register, or SPR, in the FPU is the floating­
point status and control register-the FPSCR. The FPSCR holds exception 
information-such as overflow and zero divide status-about FPU opera­
tions, as well as the type of result produced by floating-point operations. 

In the FPU, general-purpose registers are called floating-point regis­
ters, or FPRs. The FPU contains thirty-two 64-bit FPRs. These registers 
are used for purposes such as the passing of floating-point parameters. 

CACHE 

C ache memory is memory that is accessed more quickly than standard 
RAM. Computers usually offer the option of an add-on cache board 

t~ speed up the system-and the Power Macs are no exception. But the 
PowerPC also contains an on-board cache built into the hardware of the 
microprocessor chip itself. This cache actually consists of two separate 
areas-a data cache and an instruction cache with a combined size of 
32K of fast memory. 

Data Cache 

The data cache holds the data of a program that is used the most often. 
Before accessing data from RAM, the PowerPC first checks to see if the 
referenced data is already present in the cache. If it is, the cache data is 
accessed rather than the external RAM data. 

For the data cache, the PowerPC maintains cache coherency. A coher­
ent cache means that the PowerPC will attempt to keep a synchroniza­
tion between cache data and RAM data-over the next few pages you'll 
see how this works. To aid in this task the PowerPC maintains something 
called snooping logfr that monitors bus addresses and makes comparisons 

39 



Programming the PowerPC 

between these addresses and those in the cache. Without coherency, the 
data in the cache could change while the copy in RAM would remain the 
same-making the RAM value invalid. 

In Figure 3.9, data from RAM is written to the PowerPC data cache. 
To remind you of the complexity of the PowerPC, a few of the several 
units are shown as gray boxes. 

Power PC RAM 

oOo 6 

Data Cache 

FIGURE 3.9 DATA FROM RAM GETS WRITIEN TO THE POWERPC DATA CACHE. 

When a running application attempts to make use of some data, the 
PowerPC will first check the Data Cache to see if that data resides there. 
If it does, the Data Cache value will be read and sent to the program. 
This saves a trip to the slower external RAM. Figure 3.10 shows cache 
memory being accessed. 

If the program that uses the data makes a change to it and then 
writes the new value to memory, that value will be first written back to the 
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fast Data Cache. Then, while the processor works on the next instruc­
tions, the newly-written value will be written back to RAM to keep the 
RAM value in sync with the cache value. This scenario is shown in Figure 
3.11 . 

PowerPC RAM 

oEJo 6 

.Application 

A. 
Data Cache 

]~ .,,..-
-

FIGURE 3.10 AN APPLICATION USES DATA FROM THE DATA CACHE. 

Instruction Cache 

The part of the PowerPC cache that holds instructions is not coherent. 
That means that the values in the cache will not always match the values 
in RAM. Coherency is not maintained for the Instruction Cache because 
the PowerPC makes the assumption that instructions are read-only and 
won't be modified. Once an instruction is read into the cache from RAM, 
it is thus assumed that this cache instruction will not change. 
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FIGURE 3.11 ALTERED DATA CACHE VALUES GET COPIED BACK TO RAM. 

A 32 K cache is of course not large enough to hold an 
entire program. The cache is meant to hold heavily used 
data and instructions. If the cache is full, and some of its 
contents have not been used recently, new data and 
instructions will be moved in from RAM. When it's said that 
an instruction in the cache will not change, it's meant that 
once an instruction is read into the cache from RAM, that 
version of that instruction in the cache will not be altered. 
If the instruction is not readily used again, the cache loca­
tion that holds it will eventually be overwritten by a new 
instruction from RAM. 

Figure 3.12 shows an instruction being read from RAM and stored in the 
cache. The figure then shows that instruction being used by the running 
program. The program accesses the cache rather than main memory. 
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FIGURE 3.12 AN INSTRUCTION FROM RAM 

GETS WRITIEN TO THE POWERPC INSTRUCTION CACHE. 

If a program does change an instruction and writes it back to RAM 
(something that is not recommended), the cache will be bypassed. The 
program will write directly to main memory while the cache maintains 
the original instruction. Figure 3.13 shows this unlikely scenario. 

CHAPTER SUMMARY 

P ipelining-the ability to start the execution of a second instruction 
before a first instruction has completed-is key to the speed of the 

PowerPC chip. The architecture of the PowerPC chip makes pipelining 
possible. 
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FIGURE 3.13 AN ALTERED INSTRUCTION BYPASSES THE 

INSTRUCTION CACHE AND IS INSTEAD WRITIEN TO RAM. 

Branch instructions break up the uniform flow of a program, and thus 
have the potential to slow down a program. To overcome this dilemma, 
the PowerPC has a hardware solution called the Branch Processing Unit, 
or BPU. The BPU detects branches before the executing program 
encounters them. It then makes adjustments to the instructions queue­
the holding place of prefetched instructions. 

To further increase instruction execution speed, the PowerPC uses a 
design strategy called superscaler design. The PowerPC uses three func­
tional units to execute instructions. The BPU, the Integer Unit (IU), and 
the Floating-Point Unit (FPU) work both independently and in conjunc­
tion with one another. 

The Powe rPC contains an on-board cache to speed up memory 
access. This 32K cache is composed of two separate areas- a data cache 
and an instruction cache. 
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POWERPC SYSTEM SOFTWARE: 
THE EMULATOR AND MIXED MODE 

T he blazing speed of the PowerPC microprocessor- and of the 
Power Macintoshes based on it- will be the impetus behind the 
development of many new, exciting Macintosh software pro­

grams. In the near future, Mac users will see the unveiling of programs 
that couldn't exist without the processing muscle of the PowerPC. The 
reality for most users of Power Macintosh computers, however, lies in the 
full disk case that sits near their new machine. It houses an investment of 
hundreds or thousands of dollars in Mac software- software designed to 
run on 680x0-based machines. These users will be grateful to hear that as 
Apple planned for the future, it did not forget the present. 

The new Power Macintosh computers are capable of running just 
about every existing Macintosh application- including those developed 
for the 680x0 Macs. Apple made this possible not through the PowerPC 
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chip, but instead through additions to the system software. This chapter 
covers the 68LC040 Emulator and Mixed Mode Manager-the new parts 
of the system software that allow the Power Macintoshes to run both old 
and new software. 

THE PowERPC SvsTEM SonwARE 

T he software investment of 680x0 users is one reason that Apple 
wants to make sure the new Macs run 680x0 software. Here's a few 

other reasons: 

Ill New Power Macs will be on networks along with older 680x0 
Macs. 

Ill Many people will be working with both old and new Macs and will 
need to run software that works on both. 

Ill Independent software developers with access to only one type of 
machine will be developing for both the 680x0 and the Power 
Mac. 

Ill New machines that don't have an abundance of software choices 
fair poorly. 

Ported System Software Routines 

Because of the design of the PowerPC chip, code runs quicker on a 
PowerPC-based Mac than it does on most 680x0-based machines. Further 
speed gains are noticed when code is recompiled using a compiler 
designed to optimize code for the PowerPC. This applies to all source 
code-yours and Apple's. Don't forget, your programs make extensive 
use of Toolbox and Operating System functions. Before ending up in 
ROM and in the System file, these routines started out as source code­
source code that was originally written for 680x0 machines. 

To get the most impressive speed increase from the PowerPC chip, all 
of the system software functions should be recompiled to make them 
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native PowerPC. Apple is in the process of doing that now. For the 6100, 
7100, and 8100 Power Macs, about 10 percent of the Toolbox has been 
rewritten in C and recompiled into native Power PC code. 

You'll see the word "native" throughout this book, and 
throughout any PowerPC literature you read. Native code is 
code written specifically for a PowerPC-based Macintosh. A 
native application is an application that has been compiled or 
recompiled for the PowerPC microprocessor. An existing 
680x0 application that runs on a Power Mac is not said to be 
native. Once appropriate changes are made to the applica­
tion's source code, and the source code has been recompiled 
using a PowerPC compiler, the resulting application is then 
said to be a native program. Native applications take advan­
tage of the speed increases offered by the PowerPC chip. 

Ten percent of the system software might not seem significant. But 
before you feel slighted by this seemingly low figure, you should consider 
what Apple calls the "90I10 rule." Apple engineers examined the code of 
numerous programs and found that 90 percent of the calls to Toolbox 
functions are made to just 10 percent of the Toolbox routines. That 
means that most programs repeatedly call a handful of Toolbox routines 
and seldom (or never) call the vast majority of the thousands of routines. 
Figure 4.1 gives emphasis to this fact. 

In particular, the DrawText( ), EraseRgn( ), Line(), and 
GetFontlnfo() routines represented about two-thirds of all system calls. 
Though a program might not call these routines directly, other system 
functions may. For the first Power Macintoshes, these routines, the entire 
Memory Manager, QuickDraw, and some other calls were ported to 
native Power PC code. The current Macintosh system software used by the 
Power Macs is thus a mixture of old 680x0 functions and new, native 
PowerPC functions. Over time Apple will port more and more of the sys­
tem routines to native PowerPC code. As new system software is released 
(in the form of new System files), more and more of it will be native 
PowerPC. Figure 4.2 shows that both old and new routines exist in the 
system software. 
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System software functions 

FIGURE 4.1 NINETY PERCENT OF SYSTEM CALLS ARE TO JUST 

TEN PERCENT OF THE SYSTEM FUNCTIONS. 

Mac System Software-Toolbox and OS 

Toolbox and OS 
functions that have 
not been changed-1 
original 680x0 code 

Toolbox and OS ] 
functions rewritten 
and recompiled into 
PowerPC code -

680x0 
system software 

Power PC 
system software 

FIGURE 4.2 SYSTEM SOFTWARE IS A MIX OF 680x0 AND POWERPC ROUTINES. 
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As Apple ports more Toolbox routines to native PowerPC 
code, new versions of the System file will be released. These 
new versions will hold the new, faster Toolbox functions. That 
way owners of what will become "older" Power Macintoshes 
will be able to take advantage of the faster Toolbox by simply 
getting a new version of the system software. 

The New System Software 

A mixture of 680x0 routines and native PowerPC routines in the same 
Toolbox could represent a programmer's nightmare-if it weren't for a 
lot of help from two new additions to the system software. To support 
software running in a mixed environment, the Power Macs contain new 
ROM chips and a new System file that together contain the Mixed Mode 
Manager and the 68LC040 Emulator. 

The first system software for PowerPC-based Macs is System 7.1.2. 
Apple wants the transition from 680x0 Macs to Power Macs to be smooth, 
with a minimum of new-technology shock for the user. For that reason, 
the screen of a Power Mac running System 7.1.2 will look like the screen 
of a 680x0 Mac running System 7.1. Inside the System, however, there are 
many new changes-the most notable of which is the Mixed Mode 
Manager. 

The Power Macs won't run using any version of System 6.x. 
The first Power Mac system software, 7 .1.2, is obviously a 
version of System 7. For this reason, any software you write 
that is to run on a Power Mac, or both a Power Mac and a 
680x0, must be compatible with System 7. That means 
your software should be 32-bit clean-as described in 
Inside Macintosh Volume VI and the latest versions of 
Inside Macintosh. Software should also be able to run in a 
multitasking environment and be compatible with the oper­
ations of the Virtual Memory Manager. 
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Like the other managers, such as the Memory Manager and the Window 
Manager, the Mixed Mode Manager is a set of functions that serves a 
common purpose. The purpose of the Mixed Mode Manager routines is 
to allow software to run in the mixed environment of 680x0 and 
PowerPC system software routines. The Mixed Mode Manager allows 
older programs designed for 680x0 Macs and new programs designed for 
the PowerPC to run side by side on a Power Macintosh. 

A program designed for a 680x0-but is now running on a Power 
Mac-will not always take advantage of the speed of the PowerPC chip. 
One reason for this is that the program would not have been compiled 
using a compiler that optimized the code for the PowerPC processor. 
Another reason is that many of the Toolbox calls made by the program 
will be to 680x0 Toolbox routines. The PowerPC microprocessor does 
not recognize the older instructions that make up these 680x0 Toolbox 
routines. Since the Toolbox of the Power Macs contain a mix of old and 
new routines, how does the PowerPC chip housed in a new Mac resolve 
this dilemma? Through software emulation. 

Any program that calls a 680x0 system software routine will find itself 
in the 68LC040 Emulator of the Power Mac. The Emulator is a software 
program that resides in the ROM chips of each Power Mac. Its sole pur­
pose is to convert 680x0 instructions to PowerPC instructions and then 
pass these converted commands to the PowerPC chip for execution. Not 
all calls to the Toolbox are routed to the 68LC040 Emulator--only calls 
to the older 680x0 functions. And the mechanism responsible for send­
ing a call to the Emulator? The Mixed Mode Manager. 

PowerPC Execution of System Software Routines 

The Mixed Mode Manager and the 68LC040 Emulator provide the 
Power Mac with the ability to run both 680x0 software and PowerPC soft­
ware. Figure 4.3 gives an overview of the system software of a Power Mac. 

Over the next several pages you'll see how a Power Macintosh han­
dles each of the four combinations of calls that applications running on a 
Power Mac can make. 
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Application Mixed Mode 
Manager 

680x0 
system 

software 

68LC040 
Emulator 

Nanokernel PowerPC 

----------·-·o 
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PowerPC I -------i 
PowerPC 
system 

software 

._) 

FIGURE 4.3 THE POWERPC SYSTEM SOFTWARE INCLUDES 

A MIXED MODE MANAGER AND A 68LC040 EMULATOR. 

processor 

Let's first examine the case of a 680x0 application running unmodified 
on a Power Mac. If this program makes a call to a 680x0 Toolbox or 
Operating System routine, the call will go to the system software and 
then will be processed by the 68LC040 Emulator. The Emulator converts 
the instructions that make up this function call to PowerPC instructions. 
The Emulator then passes the processed instructions on to a low-level 
piece of system software called the nanokernel. The nanokernel communi­
cates with the PowerPC chip and handles interrupts and memory man­
agement tasks. All calls, regardless of the path taken, pass through the 
nanokernel before reaching the PowerPC chip. Figure 4.4 shows the path 
taken by a 680x0 call made from a 680x0 application . 
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Application Mixed Mode 
Manager 

680x0 
system 

software 

PowerPC 
system 
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FIGURE 4.4 A 680x0 APPLICATION CALLING A 680x0 SYSTEM ROUTINE 

You might guess that applications written before the Power Macs came 
into existence don't call Power PC system routines- but in fact, they do. 
That comes about from the porting of some system routines- as was dis­
cussed in this chapter. Approximately 10 percent of the system calls were 
rewritten and made native Power PC routines. If a 680x0 application calls 
one of these routines, such as Dr a wT ext ( ) , then it is calling a Power PC 
Toolbox function. In an instance such as this a mode switch occurs. The 
Power Mac switches from handling a call via the 68LC040 Emulator to 
handling it directly by the PowerPC. Since the Toolbox routine has been 
ported to native PowerPC code, there is no reason to translate the rou­
tine's instructions to PowerPC code. As Figure 4.5 shows, the Mixed 
Mode Manager is responsible for routing this kind of call to the 
PowerPC-without going through the Emulator. 
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FIGURE 4.5 A 680X0 APPLICATION CALLING A NATIVE POWERPC SYSTEM ROUTINE. 
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It's important that you realize that a program doesn't neces­
sarily run in just one mode or the other. A typical program will 
be switching modes constantly throughout its execution. 

Just as a 680x0 application can call both old and new system software rou­
tines, so can a PowerPC application. If a PowerPC program makes a call 
to a PowerPC Toolbox routine, the call is handled by the PowerPC 
processor with no instruction conversion. Figure 4.6 shows this situation. 

As mentioned, the entire Toolbox has not been ported to native 
PowerPC code. That means that on occasion a new PowerPC program 
will have to make a call to an older 680x0 system routine. When that 
occurs, the Mixed Mode Manager becomes involved. It sends the call to 
the 68LC040 Emulator so that the instructions that make up the routine 
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can be converted to PowerPC code. Only then do the instructions reach 
the PowerPC chip. This situation is shown in Figure 4.7. 

Application Mixed Mode 
Manager 

680x0 
system 

software 

PowerPC 
system 

software 

68LC040 
Emulator 

Nanokernel PowerPC 
processor 

•• 

FIGURE 4.6 A POWERPC APPLICATION CALLING A NATIVE POWERPC SYSTEM ROUTINE. 

While the previous figures show what appears to be a complex handling 
of Toolbox calls, your role as a programmer is-fortunately-minimal. 
The system does most of the wo~k for you. This is evident in the running 
of an unmodified 680x0 application. Even without any porting or recod­
ing, most existing 680x0 programs run fine on a Power Macintosh. When 
the time comes for you to port existing 680x0 code to PowerPC code or 
to write a new native PowerPC program, your involvement increases. But 
only minimally. Mode switching situations that require your input will be 
discussed later. 
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FIGURE 4. 7 A POWERPC APPLICATION CALLING A 680x0 SYSTEM ROUTINE. 
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Today's quiz: If an existing 680x0 application seems to run 
fine on a Power Mac, why port it over to native PowerPC 
code? To make it run even better! A 680x0 application is not 
optimized for PowerPC performance, and is spending more 
time in the 68LC040 Emulator than a native PowerPC appli­
cation. Any time a program enters the Emulator, it is running 
slower than if it were running directly on the PowerPC chip. 

THE 68LC040 EMULATOR 

All late-model Macintosh computers- aside from the Power Macs­
contain either the 68020, 68030, or 68040 microprocessor. Figure 

4.8 shows the essential differences between these 680x0 series chips. 
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FIGURE 4.8 KEY DIFFERENCES BETWEEN THE MOTOROLA 680x0 MICROPROCESSORS 

The microprocessor that Apple chose to emulate in the Power 
Macintoshes is the Motorola 68LC040-a derivation of the 68040. The 
68LC040 microprocessor is a 68040 microprocessor without the floating­
point unit (FPU). The emulated version of the 68LC040 goes a step fur­
ther and removes support for the memory management unit (MMU). 
While foregoing emulation of the MMU and FPU may seem like a step 
backwards, Apple did so for good reason. 

Whether an instruction reaches the PowerPC chip via the emulator 
or directly from, say the Toolbox, all memory management is handled by 
the MMU built into the PowerPC. Thus, there is no need for the 
68LC040 Emulator to include MMU emulation. 

As in the case of the memory management unit, there is no need for 
the 68LC040 Emulator to emulate floating-point instructions-the 
PowerPC has its own floating-point unit. 
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with a floating-point unit, most 680x0 software packages 
don't make the assumption that one is present. 

When considering instruction sets, a 68040 without the floating-point 
unit or the memory management unit more closely resembles that of a 
68020. In fact, don't be surprised when a call to the Ges ta 1 t () function 
tells you just that. If an application passes Gest a 1 t ( ) a selector of 
gesta ltProcessorType while running in emulation mode on a Power 
Mac, Ges ta 1 t () will return a value of ges ta 1 t68020. Here's that call: 

OSErr err; 
long response; 

err= Gestalt( gestaltProcessorType, &response ); 

II response will equal gestalt68020 after the call 

The Macintosh Centris 610 is a 68LC040 processor-based 
Mac. So the hardware of the Centris 610 is what the 
68LC040 Emulator software is patterned after. If an appli­
cation executes properly on a Macintosh Centris 610 it 
should run properly on the 68LC040 Emulator of a Power 
Macintosh. 

THE MIXED MODE MANAGER 

Software, whether designed for a 680x0-based Mac or a PowerPC­
based model, run in a mixed environment of 680x0 system software 

and PowerPC system software on a Power Mac. The ROM-based emula­
tion software-the 68LC040 Emulator-and the functions that com­
prise the Mixed Mode Manager allow applications to run in this mixed 
environment. 
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Instruction Set Architecture 

Every type of microprocessor has an instruction set architectur~a group, 
or set, of instructions that it recognizes and works with. The 68LC040 
Emulator, which mimics a Motorola 68LC040 microprocessor, has its own 
instruction set architecture. The PowerPC microprocessor has its own 
instruction set architecture-one that differs from that of i:he 68LC040 
Emulator. 

When a single application running on a Power Macintosh makes calls 
to both 680x0 system software routines and PowerPC system software rou­
tines-that is, to both nonported and ported functions-mode switches 
occur. A mode switch means that the Power Mac goes from executing 
code in one instruction set to executing code in the other instruction set. 
When this happens, the Mixed Mode Manager is responsible for oversee­
ing this mode switch. 

Until the system software has been completely ported to native 
PowerPC code and all 680x0 applications are ported and recompiled to 
native PowerPC applications, a mechanism such as the Mixed Mode 
Manager is necessary. 

Cross-Mode Calls 

When a 680x0 application makes a call to a PowerPC routine, the call is 
said to be cross-mode. That is, the mode switches from that of the 
68LC040 Emulator to native PowerPC mode. The same applies when a 
PowerPC application calls a 680x0 routine. Figure 4.9 shows both types of 
cross-mode calls. 

Apple's intentions are for cross-mode calls to be handled transparent­
ly by the Mixed Mode Manager. No intervention is necessary on the part 
of an application's user, and little is necessary on the part of the pro­
grammer. 
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FIGURE 4.9 A 680x0 APPLICATION AND A POWERPC 

APPLICATION MAKING CROSS•MODE CALLS. 

680x0 to PowerPC Cross-Mode Calls 

When a 680x0 application calls a native PowerPC routine such as a Memory 
Manager or QuickDraw function , the emulator is called-but not directly. 
First, the Trap Manager checks the trap dispatch table. If the routine is a 
native PowerPC function, then the table holds a pointer to a routine descrip­
tor. A routine descriptor is a data structure that holds information about a 
routine, such as the parameters expected for a call to the function. 

The first field in a routine descriptor is an instruction that invokes 
the Mixed Mode Manager. Once invoked, the Mixed Mode Manager 
switches to native PowerPC mode, calls the native PowerPC code, and 
then returns to the 68LC040 Emulator. Figure 4.10 shows a 680x0 to 
PowerPC cross-mode call. 
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Routine descriptor 
data structure 

FIGURE 4.10 A 680x0 APPLICATION MAKING A CROSS-MODE CALL. 

All 680x0 to PowerPC cross-mode calls are handled implicitly by the 
Power Mac. The programmer need do nothing to ensure that the call is 
handled correctly. 

PowerPC to 680x0 Cross-Mode Calls 

On occasion, a PowerPC application will find it necessary to call a system 
routine that hasn't been ported to native code. When that happens, the 
operating system invokes some Toolbox interface glue code. This glue 
first checks the trap dispatch table to get a pointer to the code that 
makes up the 680x0 routine. The glue then passes this information on to 
the Mixed Mode Manager. The Mixed Mode Manager then switches to 
the 68LC040 Emulator mode and calls the 680x0 routine. When the 
680x0 routine has executed, the Mixed Mode Manager switches back to 
native PowerPC mode. Figure 4.11 shows a PowerPC to 680x0 cross-mode 
call. 
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Some apparent system software routines don't, in fact, 
exist in the System file or the ROM chips of your Mac. 
Instead, they are implemented by your development sys­
tem. Such a call is a glue routine. In response to a call to a 
glue routine, your development system executes some com­
bination of existing system software routines or some 
assembly language instructions to carry out the task or 
tasks of the glue routine. 

Toolbox interface 
glue code Trap dispatch table 

Check trap 
dispatch table ~o 

0 routine 
code /""-i pointer 

~f-----11 
Mixed Mode Manager 

Power PC ----------------------

Invoke Mixed 
Mode Manager 

Call 680x0 code 

Return to PowerPC mode 

FIGURE 4.11 A POWERPC APPLICATION MAKING A CROSS•MODE CALL. 

The Programmer's Role in Mode-Switching 

You've seen that 680x0 applications that call PowerPC code need no help 
from the programmer. The same is true with most PowerPC application 
cross-mode calls to 680x0 routines. There are, however, occasions when 
you, the PowerPC programmer, will be responsible for aiding the Mixed 
Mode Manager in its tasks. 
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Certain system software routines accept a pointer to another routine 
as one parameter. As the system routine executes, it makes use of the 
function whose address was passed to it. Because the function whose 
address was passed could be written in 680x0 code or native PowerPC 
code, a situation such as this requires special consideration on the part of 
the programmer. Figure 4.12 illustrates why. 

680x0 system 
software routine 

680x0 Macintosh I 
Address of 680x0 
application routine 

ModalDialog( MyFilterFunction, &theitem ); 

I Power Macintosh ~ 

680x0 or PowerPC Address of 680x0 or 
system software routine? PowerPC application routine? 

ModalDialog( MyFilterFunction, &theitem ); 

FIGURE 4.12 A PROCEDURE POINTER CAN BE THE ADDRESS 

OF EITHER A 680x0 ROUTINE OR A POWERPC ROUTINE 

On a Power Macintosh, you won't know exactly which system routines 
have been ported to native PowerPC code. Additionally, the system rou­
tine won't know if the code you wrote for the passed function was written 
in older 680x0 code or optimized, native PowerPC code. For a function 
that makes use of a ProcPtr-a procedure pointer-you'll have to use a 
routine descriptor. The routine descriptor tells the system routine the 
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instruction set architecture-680x0 or native PowerPC-of the code 
whose address is being passed to it. The descriptor also gives the system 
software information about the parameters that the ProcPtr routine uses. 

~ 
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A working example of the use of routine descriptors is pre­
sented in the sample program listing in Chapter 7. 

ProcPtr is the data type of a generic procedure pointer. There are also 
other procedure pointer types that are based on this type. Any system 
routine that requires any type of procedure pointer as a parameter will 
require a routine descriptor. When the routine descriptor is then used in 
place of the procedure pointer parameter, the called system routine will 
be able to properly invoke the Mixed Mode Manager. 

CHAPTER SUMMARY 

Code runs quicker on a Power PC-based Mac than it does on most 
680x0-based machines. And further speed gains come about when 

code is recompiled using a compiler designed to optimize code for the 
PowerPC. With the introduction of the first Power Macs came an updat­
ed Toolbox with about 10 percent of the Toolbox routines rewritten in C 
and recompiled into fast native PowerPC code. While 10 percent may 
seem like a low figure, Apple has determined that 90 percent of the calls 
to Toolbox functions are made to just 10 percent of the Toolbox rou­
tines-the 10 percent that have been ported. 

To avoid the problems of having a mix of 680x0 routines and native 
PowerPC routines in the Toolbox, Apple has made two important addi­
tions to the Macintosh system software-the 68LC040 Emulator and 
Mixed Mode Manager. The Power Macs contain new ROM chips and a 
new System file that together contain the these two additions that sup­
port software running in a mixed environment. 

Any program that makes a call to a 680x0 system software routine will 
temporarily jump into the 68LC040 Emulator of the Power Mac. The 
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Emulator is a software program that resides in the ROM chips of each 
Power Mac. Its purpose is to convert 680x0 instructions to PowerPC 
instructions, and then pass these converted commands to the PowerPC 
microprocessor for execution. 
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POWERPC SYSTEM SOFTWARE 
CODE FRAGMENTS 

T he Macintosh system software has undergone many changes in 
order to support the Power Macs and the PowerPC chip. Of 
these changes, the most notable is the support of fragments. 

While executable code such as applications, system extensions, and code 
resources still go by those same names to users of all Macintosh models, 
to developers of PowerPC software they are all called code fragments. That 
lends a commonality to all types of executable code- which is of benefit 
to both the developers that write code and the system software responsi­
ble for executing it. 

This chapter takes a thorough look at code fragments- including the 
import library. This type of fragment allows developers of multiple appli­
cations to eliminate redundant code from their programs. Also covered 
in this chapter is the new system software that supports fragments- the 
Code Fragment Manager. 
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THE POWERPC RUNTIME ENVIRONMENT 

C hapter 4 discussed the 68LC040 Emulator and the Mixed Mode 
Manager. This chapter talks about code fragments, and their han­

dling by the Code Fragment Manager. Together, these system software 
components make up a big part of something called the Macintosh run­
time environment. 

What the Runtime Environment Is 

The runtime environment, or runtime architecture, of a computer is the com­
bination of executable code and system software that runs it. You­
through your programming skills and your programming development 
system-are responsible for creating the executable code. The second 
part of the runtime environment-the Macintosh system software-is 
then responsible for managing the details of loading, managing, and exe­
cuting the applications you've developed. 

Each computer has its own runtime environment. While still a 
Macintosh, the PowerPC processor-based Macintoshes have a runtime 
environment that differs in many ways from that of the 680x0 processor­
based Macs. 

A New Runtime Environment­
And Why It Was Needed 

While the new Power Macs are capable of running both old and new 
applications, great speed increases are only noticed when a new Power PC 
program is executing. That's because only the native PowerPC applica­
tions will be able to take advantage of all of the extensive changes that 
are in the new PowerPC runtime architecture. 

Even without the arrival of the RISC processor, the Macintosh run­
time architecture was due for an overhaul. Over the years, Apple has 
improved the environment in bits and pieces. But it has always been 
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based on the same runtime environment that was designed for the origi­
nal Macs-and the limitations of those first computers. 

The first Macs had just 128 K of RAM-one-eighth of 1 Megabyte. 
The runtime environment was designed with that in mind. As such, limi­
tations were imposed upon the designers of the Mac environment. Now, 
with inexpensive and readily available RAM, those limitations no longer 
exist. Yet they still stifle the runtime environment of the entire line of 
680x0-based Macintosh computers. 

A second limiting factor in the advancement of the Mac runtime 
architecture also involves memory. The original Macs did not come with 
a hard disk or memory management unit. That, along with extremely 
limited RAM, made program segmentation a necessity. Because an entire 
application could not be placed into memory at one time, programs had 
to be divided into segments that would be loaded and unloaded during 
the course of program execution. Abundant RAM and virtual memory 
have now eliminated the need for segmentation-though the 680x0 fam­
ily of Macintoshes still require it. 

Apple had to redesign the Macintosh hardware architecture to 
accommodate the PowerPC chip. At the same time, they had to also 
make changes to the runtime architecture to support the new proces­
sor chip. With a large amount of time and money already invested, and 
many system software changes required, what better time to revamp 
the entire runtime architecture? That's how Apple felt, and that's what 
they did. 

IMPORT LIBRARIES 

An import library-also called a shared library or a dynamically linked 
library-is a collection of compiled functions that can be used by 

one or more applications. The code of an import library may be stored 
in ROM or in a resource, but more typically it is held in a library file. 
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Linked Libraries and Import Libraries 

The idea of a library of compiled code is not new to the Macintosh­
both the 680x0 Macs and the Power Macs make use of linked libraries. A 
linked library is a file of compiled code that gets added to an application 
when the application is built-that is, at link time. The MacTraps library 
that programmers add to a project file is an example of a linked library. 

MacTraps, and other libraries such as MacTraps2 and Graf3D, are 
supplied to you along with the rest of the development environment you 
purchase. But programmers can also make their own linked libraries. 
The first step to creating a linked library is to write the source code for 
one or more functions. How that source code becomes a library depends 
on the development environment used. If you were using a Symantec 
compiler, you'd then create a new project, add the file that contained the 
functions to the project, then select Build Library from the Project 
menu. The result would be a library that could be added to any other 
project. Once added to a new project, functions in the library could be 
called by source code in the new project. When it comes time to build an 
application, the linker combines object code, resources, and the code for 
any library functions that are called. 

Let's examine an example. Assume that source code in a file named 
Test.c calls one function in a library named MyLib. I'll call the compiled 
Test.c code Test.a. When it comes time to build an application, the linker 
will combine the Test.c object code with the resources and with the 
library code for the one called function. The result is shown in Figure 
5.1. Note that the final application contains code from the library. 

While the idea of a library of compiled code isn't new to the 
Macintosh, import libraries are. With import libraries and the PowerPC, 
the situation changes from that pictured in Figure 5.1. Like a 680x0 
linked library, an import library also can contain the object code of user­
written functions. But when it comes time to build an application, the 
library code does not end up in the final application. Instead, only a ref­
erence to the code in the library makes its way into the application. 
When a user launches the application, both the application and the 
import library code are loaded into memory. This means that in order 
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for the application to run, the import library must be present. If the 
application is distributed to others, the import library must be distrib­
uted as well. Figure 5.2 shows this. 
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Test.a 

5J 
Test.n.rsrc 

. ........ Linker Test application 

Mylib 

FIGURE 5.1 USING A LINKED LIBRARY AS PART OF AN APPLICATION. 

You may have noticed that I said that an application holds a 
reference to import library code, rather than a pointer to 
library code. The application doesn't actually hold a specific 
address-that's not known until the application is launched 
and the application and the import library are loaded into 
memory. Rather, the application keeps a placeholder, or 
marker, that will be filled with the library code address at 
application startup. More is said about this in the Code 
Fragment Manager section of this chapter. 

Advantages of Import Libraries 

At first glance, the fact that an import library must accompany an appli­
cation may seem like import libraries are actually a regression from the 

69 



Programming the PowerPC 

older linked library method. Closer examination, however, shows that 
import libraries have some important benefits over linked libraries. 

Test.a 

Test.7t.rsrc 
Linker Test application lmportlib 

lmportlib 

FIGURE 5.2 USING AN IMPORT LIBRARY AS PART OF AN APPLICATION. 

An application that uses an import library is smaller than one that 
doesn't. If only one application uses the import library, the advantage of 
this decreased size will be lost. That's because the combined size of the 
application and the import library will occupy as much or more disk 
space as an application created with linked libraries- as shown in Figure 
5.3. The PowerPC test application in this figure includes a reference to 
some of the code in an import library. 

The advantage of using import libraries comes when more than one 
application uses the same import library. Redundant code from the dif­
ferent applications can be placed in a common import library where 
both applications can make use of it. This is shown in Figure 5.4, where 
the two PowerPC applications both contain references to the same 
import library code. 
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PowerPC with import library 

SOOK 

Test application lmportLib 

100 K 500 K 

680x0 with linked library 

450 K 

Test application 

450 K 

FIGURE 5.3 THERE IS NO DISK SPACE SAVINGS 

WHEN ONE APPLICATION USES AN IMPORT LIBRARY. 

PowerPC with import library 

700 K 

Test app 1 lmportLib Test app 2 

100 K 500 K 100 K 

680x0 with linked library 

Test app 1 

450K 

900 K 

Test app 2 

450K 

FIGURE 5.4 THERE IS A DISK SPACE SAVINGS 

WHEN MULTIPLE APPLICATIONS USE AN IMPORT LIBRARY. 
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What is the likelihood of two applications sharing a large amount of com­
mon code? Actually, quite high-considering the amount of interface­
related code that is redundant from one Mac application to another. 

Centralizing the code that is common to multiple applications has 
advantages beyond the saving of disk space. When two applications that 
share a common import library are both loaded into RAM, only one copy 
of the import library is loaded. Both applications then make use of the 
same import library code, as shown on the left side of Figure 5.5. On a 
680x0 processor-based Mac, two applications will occupy more RAM than 
the two on the Power PC processor-based Mac-even if both 680x0 appli­
cations were linked with the same linked library. That's shown on the 
right side of Figure 5.5. 
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PowerPC with import library 680x0 with linked library 

~-+--~ Testapp 1 

l!ll!ll!lllilm!mllll!lll!!lllil Test app 
1 

lmportlib 

Testapp 2 

A[i~;~ 0 ~~~ 
Test app 1 lmportlib Test app 2 

Testapp 2 

Test app 1 Test app 2 

FIGURE 5.5 MULTIPLE APPLICATIONS USING AN 

IMPORT LIBRARY RESULT IN REDUCED RAM USAGE. 
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Memory considerations aren't the only reasons for opting to use import 
libraries. Obviously, eliminating the need to duplicate code means less 
code has to be written. It also allows for easier upgrading and bug fixes to 
applications. An enhancement that is added to a single import library 
will benefit all applications that make use of that library. 

Chapter 10 walks through the development of a small 
import library and two simple applications that make use 
of it. 

In the PowerPC runtime environment, executable code exists as a frag­
ment. An import library is a fragment that exports its functions and glob­
al variables for use by other fragments. When the Code Fragment 
Manager loads an application fragment, it also automatically loads the 
code of any import libraries that the application fragment uses-unless it 
was previously loaded and is still in memory. 

CODE FRAGMENTS 

0 n the Power Macintosh, any group of executable code-whether it 
be an application, extension, or code resource-is considered to be 

a code fragment. The remainder of this chapter looks at code fragments 
and how they are handled by the Code Fragment Manager. 

About Code Fragments 

The PowerPC runtime environment varies from that of the 680x0 Macs 
in the way it contains and handles executable code. On a Power Mac, any 
one group of executable code-and the data that accompanies it-is 
considered a code fragment. All units of executable code bear the same 
title-code fragment. Fragments can, however, be thought of in terms of 
their different purposes. 

An application code fragment is just that-an application. Like a 
680x0 application, a PowerPC application requires no other code, aside 
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from system software, to execute. Optionally it can, however, make use of 
the code in other fragments. 

An import library code fragment holds code and data accessed by one 
or more other fragments. Unlike an application fragment, an import 
library requires at least one other fragment to call the routines it holds. 

A code resource code fragment holds executable resource code. A 
menu definition, or MDEF, is one example. 

Extension code fragments add to the capabilities of other fragments. 
QuickTime is an example of an extension fragment. 

While there are different types of code fragments, all fragments use 
the same techniques to hold code and data, and to access the code and 
data of other fragments. This common structure makes it easy for the sys­
tem software to work with executable code. This new structuring of code 
also means that new system software was necessary. The new system soft­
ware routines that manage fragments is collectively called the Code 
Fragment Manager. 

The Code Fragment Manager 

While all code fragments exist as independent units of executable code, 
code fragments are not able to run on their own. For example, an appli­
cation fragment makes use of system software, which is itself a fragment. 
An import library fragment contains the executable code for functions, 
but doesn't have a main function-it runs in conjunction with the appli­
cation fragment that invokes it. The Code Fragment Manager, or CFM, is 
responsible for coordinating the interaction between the different frag­
ments that, together, make up a single application. 

When an application is built, the linker establishes which fragments 
hold the code that the application requires. When the final application is 
launched, the Code Fragment Manager loads the necessary fragments 
into memory and supplies each individual fragment with memory 
addresses of the other related fragments. As the application runs, each 
fragment can, under the control of the Code Fragment Manager, both 
export and import information to and from the other fragments. 
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When a program's user launches an application, the code fragment 
or fragments that the application consists of are loaded into memory by 
the Code Fragment Manager. The Code Fragment Manager relies on a 
system of symbols to prepare each segment that it loads. A fragment that 
makes use of code external to itself will have a series of symbols that 
denote which routines are called-but not contained in-the fragment. 
The import library that contains the code for the called routines will 
have symbols matching those in the calling fragment. From these sym­
bols the Code Fragment Manager creates the pointers necessary to relate 
fragments to one another. 

When the Code Fragment Manager has resolved all the fragment 
relationships, it loads the fragments into memory. If an application uses 
an import library fragment that in turn uses code from still another 
import library, the last import library will be loaded first. With memory 
addresses established for this third fragment, the Code Fragment 
Manager can then load the second fragment, and then finally the first 
fragment. Figure 5.6 illustrates this. 

~ 
N 0 T E 

When a fragment needs to be loaded, the operating system 
invokes the routines that make up the Code Fragment 
Manager. The operation of the Code Fragment Manager is 
transparent to the user, and to the programmer. 
Applications you write will rarely, if ever, have to explicitly 
make calls to the Code Fragment Manager. 

A code fragment contains both executable code-such as compiled func­
tions, and data-such as global variables. The Code Fragment Manager 
loads the code and the data of a fragment into separate sections, or 
regions, of memory. These two sections do not have to be in-and gener­
ally aren't in-contiguous areas of memory. 

Once the code and data sections of a fragment are loaded into mem­
ory, they will not be moved. Because a fragment contains numerous 
pointers to information located in other fragments, the moving of one 
fragment would involve significant updating of the pointers in one or 
more other fragments. The Code Fragment Manager resolves all the frag-
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ment pointer information one time-when it loads a fragment. By lock­
ing a fragment in memory, the Code Fragment Manager will not have to 
go through this effort again. 

~ 
N 0 T E 

76 

Test app lmportlib1 lmportlib2 

FIGURE 5.6 THE CODE FRAGMENT MANAGER LOADS CODE INTO MEMORY. 

Programmers of the 680x0 family are used to segmenting 
their programs. On a PowerPC, this is no longer necessary. 
The code section of a fragment is not segmented. The 
responsibility for juggling code in memory no longer belongs 
to the programmer or to the application. Old habits can be 
hard to break-so if a programmer inadvertently leaves any 
segmentation directives in a source code file, a compiler 
designed for the PowerPC will simply ignore them. And 
once a PowerPC application is running, the system soft-
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ware will ignore any Un l o ad Se g calls that may have been 
included by the programmer. 

In a 680x0 application, the maximum size of an applica­
tion's global variables is 32 K. That barrier is also removed 
in PowerPC applications-there is no segmentation, and no 
size limit imposed on a fragments data section. 

Application 
fragment 

Pointers to 
application 

: globals 

11 

Pointers to 
external globals 

Pointers to 
external functions 

Import library 
fragment 

FIGURE 5. 7 A FRAGMENT USES POINTERS TO KEEP TRACK 

OF GLOBAL VARIABLES AND EXTERNAL FUNCTIONS. 

If the code and the data of a fragment were loaded in contiguous memo­
ry, the fragment's code would always know the location of the fragment's 
data. The data, such as global variables, could always be at some prede-
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fined offset from the code-the compiled functions that use the data. 
Since the code section and the data section of a fragment are not 
required to be in contiguous memory, the code must be provided with 
the locations of data in the data section. In a similar fashion, a fragment 
that makes use of global variables and functions that are in a different 
fragment must also be provided with references to where this external 
code is located in memory. In all cases, pointers give a fragment the 
information it needs-as shown in Figure 5.7. 

To keep track of these pointers, the Code Fragment Manager relies 
on a fragment's Transition Vectors and its Table of Contents-topics that 
are about to be covered. 

The 680x0 runtime environment includes a manager called 
the Shared Library Manager. This is not the same as the 
Code Fragment Manager. The Shared Library Manager is 
used only on 680x0 Macs, while the Code Fragment 
Manager is used only on Power Macintoshes. In future 
releases of system software the two managers may be able 
to work on either processor. 

Transition Vectors 

Every function within a fragment has a single Transition Vector, or 
TVector, associated with it. The function code is located in the fragments 
code section, and the TVector is located in the fragment's data section. 
Each TVector serves as a pointer to the code of a single function. Figure 
5.8 shows a fragment with two functions. Note that the code section and 
data section of the fragment have been loaded in noncontiguous parts of 
memory-as is usually the case. 

TVectors exist not for the benefit of the fragment they appear in. 
Instead, they are used as an aid to other fragments. Using Figure 5.9 as a 
reference, let's examine an example. Imagine that code in one fragment 
calls a function whose code is in a different fragment. In Figure 5.9, the 
fragment on the left can call either FunctionA or FunctionB-both of 
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which are located in the fragment pictured to the right. In either case, the 
calling fragment first goes to the address of a TVector in the called frag­
ment. That TVector then leads to the code that makes up the function. 

FunctionA code 

FunctionB code 

TVector 

TVector 

FIGURE 5.8 A FRAGMENT'S TVECTORS POINT TO THE FRAGMENT'S EXECUTABLE CODE. 

In Figure 5.9, the pointers to the two external TVectors are shown grouped 
together. In fact, this is how they would appear in memory. Grouped along 
with the addresses of the TVectors would be other pointers that the frag­
ment would use to keep tabs on information it needs. Collectively, this 
group of pointers is called the fragment's Table of Contents. 

The Table of Contents 

When a PowerPC application is built, the linker creates a Table of 
Contents, or TOC, for each fragment that contains code used by the 
application. The linker places a symbol in the Table of Contents of a frag-
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ment for each external function that is used by the fragment. When the 
completed application is launched, the Code Fragment Manager 
replaces the symbols with the addresses of the TVectors that lead to the 
code of each function. Figure 5.10 updates Figure 5.9 by placing empha­
sis on the Table of Contents. In Figure 5.10 it is assumed that Funct i onC 
makes a call to Functi onA and Functi onB. If code in the called frag­
ment accesses code in a different fragment, it too will have a TOC. Note 
that in Figure 5.10 each of the fragments has a TOC, though I've only 
shown the TVectors in the fragment making the call. 

rl1 
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Called fragment 

Calling fragment FunctionA code -
FunclionC code 

TVectorC 
J 

Functions code 

J TVectorB 

TVectorA 
,_ 

.!!L" !Z_QID~t~ector ~ I• 
Pdinterto TVector A 

FIGURE 5.9 ONE FRAGMENT ACCESSES CODE IN ANOTHER VIA TVECTORS. 

The symbols can't be converted to pointers by the linker­
this step must take place at runtime. That's because during 
the building of the application, the linker doesn't know where 
in memory the program will be loaded when it is launched. 
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Called fragment 

Calling fragment FunctionA code 

Functions code 

FunctionC code 

TVectorC 

;p!fil 

Pointer to 1Vector a 
Pointer tO TVlctor A 

FIGURE 5.10 A FRAGMENT'S TOC HOLDS POINTERS 

TO THE TVECTORS IN OTHER FRAGMENTS. 

A Table of Contents contains more than just pointers to TVectors. It also 
contains pointers to global variables and static variables. Recall that a stat­
ic variable is a variable that is local to a function , yet retains its value 
between function calls. Each global variable used by the fragment­
whether the variable appears in the fragment or in another fragment­
gets its own Table of Contents entry. Additionally, each group of static 
variables that appear within the code section of the TOC's fragment get a 
single entry in the Table of Contents. These pointers allow the code in 
the code section of a fragment to find and use variables that are scattered 
about in memory. Figure 5.11 shows how a fragment's data section is 
structured. 
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Table 
of 
Contents 

~ector Ill .. 
7'ecto'r "' 

Static variable ................................................................. 
Static variable ............................................. .................... 
Static variable 

Global variable 

Global variable 

Pointer 

~o1nter 
Jointer 

Pointer 

,,Pointer 

To function code 

~agment) 

..._ 
~ 

~ 
~ 

Data 
section 

l To a global variable 
(different fragment) 

To a TVector 
(different fragment) 

FIGURE 5.11 THE STRUCTURE OF A CODE FRAGMENT'S DATA SECTION. 

PowerPC applications don't have an · AS world, as 680x0 
applications do. Instead, a fragment uses the TOC for the 
purpose of keeping track of its own data. There is an advan­
tage to the TOC's way of doing things-any fragment can 
have global data. The AS world used in 680x0 development 
allows for global data only in applications. 
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The following code snippet is for a fragment that declares two global 
variables, GrandTota 1 and Fina 1Sa1 es. The fragment contains two 
functions-Functi onA and Functi onB. Functi onB contains three static 
variables-count, index, and tot a 1. This fragment makes use of one 
function, Functi onC, that is found in a different fragment. It also uses 
one global variable found in the second fragment-Monthl yTota 1. 

void FunctionC( void ); 

extern int MonthlyTotal; 

int GrandTotal; 
int FinalSales; 

void FunctionA( void ) 
{ 

II function code here 
} 

void FunctionB( void 
{ 

} 

static int count; 
static int index: 
static int total: 

II function code here 

Figure 5.12 illustrates how memory would look for the first fragment. 
Notice that the fragment's Table of Contents contains one entry for each 
global variable-whether the variable is found in the fragment or in a dif­
ferent fragment. It also contains one entry for each group of static vari­
ables found in the fragment. A group consists of the static variables 
found in one function. Finally, the Table of Contents contains an entry 
for each external function that is used by the fragment. 

One final note on TVectors. A function's transition vector actually 
contains two pointers. The first is the pointer to the code that makes up 
the function. The second is a pointer to the fragment's table of contents. 
Thus the second of the two pointers of each transition vectors in a frag­
ment will point to the same address-the address of that fragment's 
TOC. Why does a function in a fragment need to know where that same 
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fragment's TOC lies? So that one function can successfully call a function 
that resides in a different fragment. Figure 5.13 illustrates this idea. 

Table 
of 
Contents 

FunctionA code 

~ 
FunctionB code 

FullCtiOtlB TVector 

FunctionA TVector 
1111 

] 

Code 
section 

., 
... _ ... ........• £0.-"'~!· ·· ··········-····· 
................... !m!.~~-- -·· ········ ··· · ·-

total 

GrandTotal 

FinalSales 

Pointer 
--;;: 

Pointer 

Pointer 

Pointer 

::ifointer 

~ 
Data 
section 

=il To global variable MonthlyTotal 
To TVector for FunctionC (in a different fragment) 
(in a different fragment) 

FIGURE 5.12 REPRESENTATION OF A CODE FRAGMENT IN MEMORY. 

Figure 5.13 shows that the TVector for function A has a pointer that 
points to the functions code , and a pointer that points to the fragment's 
TOC. Should function A make a call to function B, the TVector for func­
tion A will be used to determine where the function B code resides. 

CHAPTER SUMMARY 

T he runtime environment of the Mac is the combination of executable 
code and system software that runs it. A programmer, along with his 

or her programming development system, is responsible for creating the 
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executable code. The other part of the runtime environment- the 
Macintosh system software- is responsible for coordinating the details of · 
loading, managing, and running the executable code that the program­
mer has developed. 

Table 
of 
Contents 

FunctionA code 

FIGURE 5.13 A TVECTOR CONTAINS TWO POINTERS-

ONE TO A FUNCTION'S CODE, THE OTHER TO THE FRAGMENT'S TOC. 

For users of the Power Macs, executable code- such as applications, sys­
tem extensions, and code resources- still go by these same names. For 
developers of Power PC software, they are now all called code fragments. 

An application code fragment is a standalone application . Like a 680x0 
application, A PowerPC application, like a 680x0 application, requires no 
other code (aside from system software) to execute . Optionally, however, 
a PowerPC application can make use of the code in other fragments. An 
import library code fragment holds code and data that is accessed by other 
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fragments. An import library requires at least one other fragment to call 
the routines it holds. A code resource code fragment holds executable 
resource code. A control definition, or CDEF, is one example. Extension 

code fragments add to the capabilities of other fragments. QuickTime 
and Macintosh Drag and Drop are examples of extension fragments. The 
Code Fragment Manager, or CFM, is responsible for coordinating the 
interaction between the different code fragments. 

Every function within a fragment has a single Transition Vector, or 
TVector, associated with it. The code for the function is located in the 
fragment's code section, while the TVector is located in the fragment's 
data section. A TVector serves as a pointer to the code of a single func­
tion. The code in one fragment uses a TVector in a second fragment in 
order to locate a particular function in that second fragment. 
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POWERPC COMPILERS 

T o create a standalone, native Power PC program for a . Power 
Macintosh you'll need a compiler that was designed to do just 
that. Older, existing compilers will generate executables that will 

run on both 680x0-based Macs and PowerPC-based Macs, but the pro­
grams won't take advantage of the speed of the PowerPC chip- they 
won't be native applications. 

For years Symantec Corporation has dominated the Macintosh com­
piler market with their Symantec C++ and THINK C compilers. Version 
7.0 was released close to the time that the Power Macintosh computer hit 
the market. But while the Symantec C++ 7.0 compiler creates programs 
that can run on the Power Mac, these applications aren't native PowerPC 
programs. For that you need to get the Symantec Cross Development 
Toolkit (CDK). This addition to Symantec C++ 7.0 allows you to create 
native PowerPC applications using either a 680x0-based Mac or a Power 
Mac as your development system. 
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In 1994 Metrowerks released their entry into the Macintosh PowerPC 
compiler market-a pair of C/C++ compilers that allow the developer to 
generate 680x0 executables and PowerPC executables. Like the 
Symantec CDK, the Metrowerks compilers are capable of generating 
native PowerPC applications using either a 680x0-based Macintosh or a 
Power Mac as the development system. Appearing from out of nowhere, 
the Metrowerks compilers are giving Symantec a run for the money. 
Which compiler will become the most popular remains to be seen. But 
one thing is for certain-Symantec is no longer uncontested in the 
Macintosh compiler marketplace. 

This chapter covers both the Symantec CDK and the Metrowerks 
C/C++ compilers in detail-including walkthroughs of the steps it 
takes to create a standalone PowerPC program using either develop­
ment system. 

THE METROWERKS CODEWARRIOR COMPILERS 

For the last several years, programmers who wanted to write C or C++ 
applications for the Macintosh had very little choice in which compil­

er they would use. There was Apple's own Macintosh Programmer's 
Workshop (MPW) or Symantec's C++/THINK C compiler package. Nine 
out of ten developers selected the Symantec compiler. But now there is a 
new kid on the block-Metrowerks. Sneak previews of the Metrowerks 
CodeWarrior C/C++ compilers were available in 1993, and the final ver­
sions arrived in 1994. In a very short time, CodeWarrior has become very, 
very popular. 

What Metrowerks Consists Of 

Speaking about the Metrowerks CodeWarrior compiler isn't entirely 
accurate. That's because there are actually several CodeWarrior compil­
ers. The first is a Pascal compiler that generates executables that run only 
on 680x0-based Macs. Obviously enough, this compiler won't be of as 
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much interest to PowerPC programmers as compilers that create 
PowerPC code. Thus, the Pascal compiler won't be covered in this book. 
The other Metrowerks compilers are variations of their combined C/C++ 
compiler. Here's how Metrowerks distributes them: 

Bronze Version 

A C/C++ compiler that runs only on a 680x0-based Mac and generates 
executables that will run on 680x0-based Macs. Applications will also run 
on Power Macs, but they will not be native PowerPC. That is, they won't 
take advantage of the speed of the PowerPC chip. 

Silver Version 

A C/C++ compiler that runs on either a 680x0-based Mac or a Power 
Mac. The applications this compiler generates will be native PowerPC 
executables that will only run on a PowerPC. 

Gold Version 

Two separate C/C++ compilers. Both run on either a 680x0-based Mac or 
a Power Mac. The first compiler, named MW C/C++ 68K, generates exe­
cutables for 680x0-based Macs. The second compiler, named MW C/C++ 
PPC, generates native PowerPC applications for PowerPC-based Macs. 
Using each compiler to generate a separate version of the same program 
allows the developer to then combine the separate versions into a single 
fat binary application that will run on a 680x0-based Mac or run native 
on a Power Mac. 

For serious developers, the Gold version is the route to take. If you 
want to support the millions of Mac owners who have older machines, 
you'll want your applications to run on 680x0-based Macs. If you also 
want to support the increasing number of Power Mac owners, you'll want 
your programs to run on Power Macs. And you'll want your applications 
to run fast on the Power Macs-that means using native PowerPC instruc­
tions. The Gold version of Metrowerks Code Warrior allows you to create 
such applications. 
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Creating a CodeWarrior Project 

After following the installation instructions supplied by Metrowerks, dou­
ble-click on the MW C/C++ PPC icon to launch the PowerPC version of 
the CodeWarrior C/C++ compiler. This compiler generates PowerPC­
only code, but the compiler itself runs on either a 680x0-based Mac or a 
PowerPC-based Mac. Select New Project from the File menu. That menu 
is shown in Figure 6.1. 

New OON 
New Project ... 
Open... 8€0 
Open Selection 8€0 
Close 8€W 

Saue OOS 
Saue As ... 
Saue A Copy As ... 
Reuert 

Page Setup ... 
Print... OOP 

Quit 8€0 

FIGURE 6.1 THE METROWERKS FILE MENU. 

A dialog box that allows you to name the new project will open. To keep 
things organized you'll want to keep the new project in its own folder. 
First use the pop-up menu in the dialog box to move up a folder-keep­
ing project folders in the main CodeWarrior folder helps the compiler 
search for files that will be included in your projects. Next, click on the 
New Folder button and type in an appropriate name for the folder. I'll 
be naming this first Metrowerks program MWdemoPPC, so I've named 
the folder (6) MW Demo PPC f-as shown in Figure 6.2. The "(6)" 
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refers to the fact that this is a Chapter 6 example. You'll find a copy of 
this folder on the disk that was included with the book. If you have 
Metrowerks, you can use the project in the (6) MW Demo PPC f folder. 
I'd suggest you try creating your own version first, however, so that you 
become familiar with the process. 

~ 
N 0 T E 

The fancy letter "f" stands for "folder", and is created by 
pressing the letter "f" key while holding down the Option 
key. 

I a CodeWarrior™ Gold f ..... , 

o CodeWarrior Profiler f 
O CodeWarrior Tools f 
O Metrowerks C/C++ f 
o Metrowerks Documentati 
D MWC & CodeResource 
D PowerPlant Construct 

Name of new Project: 

c:::::J Hard Disk 

Name of new folder: 

I (6) MW Demo PPC f 

( Cancel ) 

FIGURE 6.2 CREATING A NEW FOLDER TO HOLD THE METROWERKS PROJECT. 

Click the Create button to create the folder. The New Folder dialog box 
will close and you'll find yourself inside the new folder. Type in a name 
for the project-I chose MWdemoPPC.µ-and click the Save button. 
Refer to Figure 6.3. 

~ 
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By convention, CodeWarrior project names end with the 
extension "p". To type this character, press the letter "m" 
while holding down the Option key. 
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I a (6) MW Demo PPC f ~ I (;=>Hard Disk 

.Q Eject 

.· Desktop 

1 New LI ) 
-0 

Name of new Project: ( Cancel ) 

._I M_W_d_e_m_oP_P_C._JI ____ ___.I [ saue D 

FIGURE 6.3 NAMING THE NEW METROWERKS PROJECT. 

After clicking the Save button, a new, empty project window will open­
as shown in Figure 6.4. 

=Iii MWdemoPPC • .Jl 
File Code Data 11• 

~ 

tzy 
0 file(s) OK OK \II 

FIGURE 6.4 A NEW, EMPTY METROWERKS PROJECT. 

Adding to the Project 

To create a new source code file, select New from the File menu. Select 
Save As from the same menu to give the file a name. I chose the name 
MWdemoPPC.c. 
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Before typing in the source code for the program you'll want to add 
all the files you'll need for the project. Aside from your source code file 
there's three Metrowerks libraries you'll want to include in each 
CodeWarrior project you create: MWCRuntime.Lib, MathLib, and 
InterfaceLib. These libraries include code necessary for just about every 
project, so you'll want to play it safe and always add them to a new pro­
ject. Each of these libraries can be found in folders in the Metrowerks 
CIC++ f folder. The specific pathnames to each library are listed below. 
Figure 6.5 graphically illustrates the folder hierarchy. 

Metrowerks CIC++ f 
Metrowerks CIC++ f 
Metrowerks CIC++ f 

Runtime f PPC f : MWCRuntime.Lib 
Libraries f MacOS PPC f MathLib 
Libraries f : MacOS PPC f : InterfaceLib 

r:lJ 
N 0 T E 

Metrowerks [/[++ f 
13 items 202.7 MB in disk 122.5 MB 

Ill • Runtime f Libraries f 
Runtime f libraries f 

3 items 202. 7 MB in disk 122 t- 4items 202. 7 MB in disk 122.5 MB 

• • • • PPC I C++ 68K f MacOS PPC f MacOS 68K f 
pp[ f Mac:OS PPC f 

3 items 202.7 MB in 3 items 202. 7 MB in disk 

D D D 
MWCRuntime.Lib Math Lib I nterfaceli b 

FIGURE 6.5 THE FOLDERS THAT LEAD TO THE THREE LIBRARIES 

INCLUDED IN ALL METROWERKS POWERPC PROJECTS. 

12 

The paths listed are for the Metrowerks CodeWarrior 
release (1.0) as of this books printing. If a subsequent ver­
sion of CodeWarrior moves these files, search the folders 
within the Metrowerks C/C++ f folder for them. 
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To add the new source code file and the three libraries, select Add Files 
from the Project menu. This menu is shown in Figure 6.6. To add a 
library, use the pop-up menu at the top of the dialog box to traverse 
through the folders. Double-click on a file name to move it to the bottom 
list in the dialog box. After all four files (MWdemoPPC.c, 
MWCRuntime.Lib, MathLib, and InterfaceLib) have been added, click 
the Done button. Figure 6. 7 shows the Add Files dialog box. The 
InterfaceLib library has been added-its name is in the bottom list. The 
MathLib library is about to be added. 

Add Window 
Add File ... 
Remoue 
Reset File Paths 

Check SyntaH oo· ' 
Precompile ... 
Compile 8€K 
Disassemble 

Remoue Binaries 8€-
Bring Up To Date 8€U 
Make 8€M 

Run 8€R 

FIGURE 6.6 THE METROWERKS PROJECT MENU. 

After clicking the Done button in the Add Files dialog, you'll see that the 
four files have been added to the project window. Figure 6.8 shows what 
your project window should look like at this point. 
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I a MacOS PPC f ... 1 
c:J Hard Disk 

D Toolslib.o 
( Eject l 
( Desktop l 

n Add l) 
{} 

( Add all l 
Select files to add ... Remoue 
I nterfacelib {} 

( Remoue all ) 

( Done l 
{} [ Cancel l 

FIGURE 6. 7 ADDING FILES TO A METROWERKS PROJECT. 

MWdemoPPC.JJ. 
File Code Data Iii • 

=-~-t 
[II 0 

lnterfacel ib 0 l 0 l [II 
Mathlib . 0 l 0 l [II 

.......... ~~.~~-~-~-~~~.!. ~.~.~-~ ...... .. l... ........... gl... ...... .. ... gl... ............. JEL 

4 file(s) 4K OK 

FIGURE 6.8 A METROWERKS PROJECT WITH 

THE THREE REQUIRED LIBRARIES AND A SOURCE CODE FILE 
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Chapter 5 discussed program segmentation. Mac applica­
tions that run on a 680x0-based Mac are divided into seg­
ments-no one segment exceeding 32K in size. For 
PowerPC application, this barrier is gone-there are no seg­
ments. You no longer have to be concerned with shuffling 
files about in a project in order to meet segment size limits. 

The Prefix File 

A prefix file is one that is available for use by all source code files of a pro­
ject. When compiling with the CodeWarrior C/C++ PPC compiler, the 
MacHeadersPPC file should be the prefix file-it's a precompiled header 
file that contains information essential for your Mac programs to compile. 

To verify that the PPC compiler is using the proper prefix file, select 
Preferences from the Edit menu. That option is shown in Figure 6.9. 

Undo Paste 3€2 

Cut 3€H 
Copy 3€C 
Paste 3€U 
Clear 
Select Rll 3€R 

Balance 3€0 
Shift Left 00[ 
Shift Right 3€] 

Insert TR Template 3€Y 

Preferences ... 

FIGURE 6.9 THE PREFERENCES MENU ITEM IN THE METROWERKS EDIT MENU. 
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Selecting the Preferences menu item will open the dialog box pictured 
in Figure 6.10. The left side of the dialog box holds a scrollable list of 
icons. Clicking an icon changes the information displayed to the right of 
the icon list. Metrowerks calls the different sets of information in this dia­
log panels. To see the panel that allows you to set the project prefix file , 
click on the Language icon in the icon list. The panel that opens will 
have an edit box that holds the name of the prefix file for the current 
project. If the MacHeadersPPC file is not named in this edit box, type it 
in- as shown in Figure 6.10. 

To see this 
panel, click 
here 

D 
Font 

D 
Editor 

• [S 
v/arnings ~ 

Language Info: ---------~ 
D Rctiuate C++ Compiler 

D RRM conformance 

0 RNSI CIC++ Key Words Only 
D Require Function Prototypes 

D EHpand Trigraph Sequences 

D Enums Rlways Int 

D Enable MPW Pointer Type Rules 

(Factory Settings ) ( cancel ) (( OK l) 

Make sure the MacHeadersPPC file is listed 
here when running the PowerPC version of CodeWarrior 

FIGURE 6.10 USING THE PREFERENCES DIALOG BOX 

TO VERIFY THAT THE PROPER PREFIX FILE IS BEING USED. 

Before building a program, you'll want to enter the name the standalone 
application will be given. If you've dismissed the Preferences dialog box, 
again select Preferences from the Edit menu. Click on the Project icon­
as shoWI1 in Figure 6.11. Verify that the type of the project is set to appli­
cation . CodeWarrior will give the program the same name as the pro-
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ject-without the ".µ" extension. If you want to use a different name, 
type it in. 

To see this 
panel, click 
here 

Enter an application 
name here 

Rpply to open 

D 
Linker 

D 
PEF 

Project type is an application 

Rpplication 

Creator ???? 

I 
'SIZE' Flags~ 

Type RPPL 

II 
Access Paths ~ 

(Factory Settings J 

Preferred Heap Size (k) 384 

Minimum Heap Size (k) 384 

( Reuert Panel J ( Cancel J ( OK D 

FIGURE 6.11 SUPPLYING A NAME FOR THE FINAL STANDALONE APPLICATION. 

Creating the Resource File 

The MWdemoPPC program requires a couple of resources. Leave the 
Metrowerks environment for a moment and launch your resource editor. 
Create and name a new resource file. Make sure that you're in the folder 
that holds the Metrowerks project file-the folder I named (6) MW 
Demo PPC f. If you give the resource file the same name as your project, 
with the ".rsrc" extension appended to the end, CodeWarrior will auto­
matically include the resource file as part of your project. With that in 
mind I chose the name MWdemoPPC.µ.rsrc. 
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All PowerPC programs also require a 'SIZE' resource and a 
'cfrg' resource. The Metrowerks PowerPC compilers are 
kind enough to add these resources to your application 
when you build it. If you'd like more information on these 
two resource types they're covered in detail in Chapter 8. 

The purpose of this chapter is to cover the basic steps necessary to create 
a PowerPC application using your compiler-not to create a highly 
sophisticated program. The MWdemoPPC program fits that description 
quite nicely. When executed, the MWdemoPPC program does nothing 
more than display a dialog box with a button in it. Clicking the button 
closes the dialog box and ends the application. Figure 6.12 shows what 
the user sees when MWdemoPPC is running. 

OK 

FIGURE 6.12 THE RESULT OF RUNNING THE MWDEMOPPC PROGRAM. 

A dialog box requires two resources-a 'DITL' and a 'DLOG.' Figure 
6.13 is a view of the 'DITL' resource as it looks in the resource editor 
ResEdit. Figure 6.14 shows the 'DLOG' resource. After creating these 
resources, select Save from the File menu, then quit your resource 
editor. 
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~Iii~ D Ill ID = 128 from MWdemoPPC.rsrc 

OK Llj 

FIGURE 6.13 THE 'DITL' RESOURCE IN THE MWDEMOPPC RESOURCE FILE. 

§Iii DLOG ID = 128 from MWdemoPPC.rsrc 

.ii: fll11 ldll a.tcul't:lll Wlndaw 

Top: '---14_0 __ 

Left: ~14_0 _ 

] 

Height: I 1 00 

Width: 1300 

[][] 
Color: @ Default 

0 Custom 

DITL ID: i 120 ---
D Initially uisible 

D Close boH 

FIGURE 6.14 THE 'DLOG' RESOURCE IN THE MWDEMOPPC RESOURCE FILE. 

The MWdemoPPC Source Code 

The last step before creating the application is to enter the source code. 
Double-click on the MWdemoPPC.c file to open it. Then type in the fol­
lowing code: 

100 



Chapter 6 PowerPC Compilers 

//+++++++I I I I I I I I function prototypes ++++++I I I I I I I I 
void Initialize_Toolbox( void ); 
void Open_Modal_Dialog( void ); 

//++++++++++++++++ define directives +++++++++++++++ 
#define DIALOG_ID 128 
#define OK_BUTTON_ITEM 1 

//++++++++I I I I I I I I I I I I++ main +++++++++++++++!I I I I I I 
void main( void ) 
{ 

Initialize_Toolbox(); 

Open_Modal_Dialog(); 
} 

//+++++++++++++ initialize the Toolbox +++++I 1111111 
void Initialize_Toolbox( void ) 

{ 

} 

InitGraf( &qd.thePort ); 
InitFonts(); 
InitWi ndows (); 
InitMenus(); 
TEinit(); 
InitDialogs( OL ); 
FlushEvents( everyEvent, 0 ); 
InitCursor(): 

//+++I I I I I 1+++++ open a modal dialog I I I I I I+++++++++ 
void Open_Modal_Dialog( void ) 
{ 

DialogPtr 
short 
Boolean 

the_dialog; 
the_ item; 
all_done =false; 

the_dialog GetNewDialog( DIALOG_ID, nil, CWindowPtr)-lL ); 
ShowWindow( the_dialog ); 

while ( all_done ~ false 
{ 

Modal Dialog( nil. &the item ); 

switch ( the_item 
{ 

case OK_BUTTON ITEM: 
all_done =true; 
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break: 
} 

} 
DisposDialog( the_dialog ); 

} 

PowerPC compilers require that a function prototype be present for each 
function you write-the ma i n ( ) function being the only exception. After 
main ( ) , the MWdemoPPC source code includes two functions. Here are 
the prototypes for each: 

void Initialize_Toolbox( void ); 
void Open_Modal_Dialog( void ); 

After the function prototypes comes the #define directives. The two 
resource IDs are the only #defines needed by the program: 

//define 
//define 

DIALOG_ID 
OK_BUTTON ITEM 

128 
1 

Following the #define directives comes Initialize_Toolbox(). This 
function is like any other Toolbox initialization routine you've seen in 
the past: 

void lnitialize_ToolboxC void 
{ 

} 

InitGraf( &qd.thePort ); 
InitFontsC): 
InitWindowsC): 
InitMenus(): 
TEini tC); 
InitDialogs( OL ); 
FlushEvents( everyEvent, 0 ); 
InitCursor(); 

The Open_Moda l _Di a 1 og () function opens the the program's dialog 
box. This same routine-with a few modifications-appears in the follow­
ing chapter. In the version in Chapter 7 the call to Modal Di al og() will 
invoke a filter function. 
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void Open_Modal_Dialog( void ) 
{ 

DialogPtr 
short 
Boolean 

the_dialog; 
the_ item; 
all_done =false: 

the_dialog = GetNewDialog( DIALOG_ID, nil, CWindowPtr)-lL ); 
ShowWindow( the_dialog ); 

} 

while ( all_done ==false 
{ 

} 

ModalDialog( nil, &the_item ); 

switch ( the_item 
{ 

} 

case OK_BUTTON ITEM: 
all_done =true: 
break; 

DisposDialog( the_dialog ); 

Creating the PowerPC Application 

To build an application select Make from the Project menu. If you're 
doing your development on a Power Mac, you can alternately select Run 
from the Project menu. That builds an application and runs it from 
within the Code Warrior environment. If you're developing on a 680x0-
based Mac, selecting Run will cause the compiler to build the applica­
tion and then attempt to run it-but it won't run it. Instead, you'll see 
the alert pictured in Figure 6.15. The program won't run because the 
application will be a PowerPC-only program. While this won't damage 
the application or the compiler, there's no point in attempting to run 
the program. 

If you're using a Power Mac you can run your new application from 
the desktop-just double-click on its icon. If you don't own a Power Mac, 
you won't be able to run the program. If you try to run it from the 
Finder, you'll see the alert pictured in Figure 6.16. 
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• Unable to launch application 
Resource not found. 

( OK D 

FIGURE 6.15 AN ERROR WILL RESULT WHEN TRYING TO RUN 

A POWERPC APPLICATION WHILE DEVELOPING ON A 680x0 MAC. 

The application program" MWdemoPPC" 
could not be opened, because an error of 
type -192 occurred. 

FIGURE 6.16 AN ERROR WILL RESULT WHEN TRYING TO LAUNCH 

A POWERPC APPLICATION FROM THE DESKTOP OF A 680x0 MAC. 

The Metrowerks MW C/C++ PPC compiler runs on either a 680x0-based 
Mac or a PowerPC-based Mac. The code it generates, however, can only 
be run on a Power Mac. Don't blame Metrowerks though-this isn't a 
flaw in the compiler. A native PowerPC application can only run on a 
PowerPC-based computer-regardless of the compiler used to generate 
it. A PowerPC program can be made to run on either platform though. 
That's done by combining the Power PC version of the application with a 
680x0 version of the same program to form one larger program. This 
kind of program is called a fat binary application and is the topic of 
Chapters. 
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SYMANTEC'S CROSS-DEVELOPMENT KIT {CDK) 

I f you own Symantec C++ 7.0 and want to write programs that run 
native on Power Macs, you'll also need Symantec's Cross-Development 

Kit, or CDK The CDK allows you to use either a 680x0-based Mac or a 
PowerPC-based Mac to develop programs that will run on-and take 
advantage of-Power Macintoshes. 

What the CDK Consists Of 

The Symantec CDK uses AppleScripts and ToolServer scripts to automate 
the process of building a Power Macintosh application. These prewritten 
scripts allow developers to easily turn their Symantec projects into Power 
Mac programs. 

AppleScript is an integrated scripting system that lets developers 
write scripts that allow users to perform complex operations with a single 
click of the mouse button. If you don't have AppleScript, don't worry­
the CDK comes with the AppleScript system software extension as well as 
the Script Editor. And if you don't know how to write scripts, again, don't 
worry-the CDK comes with prewritten scripts so that you don't have to 
learn scripting. 

ToolServer is a Macintosh Programmer's Workshop (MPW) Shell that 
allows the use of third-party environments (like the Symantec THINK 
environment) to execute MPW tools and scripts-even when the MPW 
compiler isn't present. The MPW tools and scripts necessary to build 
Power Mac applications are included as a part of the CDK 

When the AppleScript system extension is installed in your System 
Folder, the menu bar of the THINK Project Manager will have one extra 
menu appended to it-the AppleScript menu. After creating a project 
file and writing your source code, you'll make a single menu item selec­
tion from the AppleScript menu to build a Power Mac application. This 
menu item will run the necessary scripts and use the appropriate MPW 
tools to build the application-without further effort on your part. 
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Installing the CDK is simple. First run the Installer program that is on 
Disk #1 of the multiple disk package. In the dialog box that opens, click 
the Switch Disk button to select the hard disk on which you want installa­
tion to take place. Then click the Install button. The Installer will 
prompt you to switch disks when necessary. 

The CDK discussed here is a developmental release-it's 
an interim product to allow programmers to create native 
PowerPC programs while Symantec works on developing a 
CDK that is more fully integrated into the THINK Project 
Manager environment. Look for the new version sometime 
in early 1995. 

Installing AppleScript 

While AppleScript comes on one of the disks that make up the CDK 
package, the Installer program doesn't install AppleScript automatically. 
That's because many people already have AppleScript as part of their 
installed system software. If you don't already have AppleScript installed 
on your Mac, you'll want to install it now. 

One of the disks that comes with the Symantec CDK is titled 
AppleScript Setup. Insert this disk in your floppy drive and click on the 
Installer icon. You'll see a dialog box like the one pictured in Figure 
6.17. Click the Install button. After a few minutes installation will be 
complete. 

The installer adds the AppleScript extension and a few related files to 
your System Folder. It also creates a folder called AppleScript Utilities 
and places the Script Editor and Scriptable Text Editor in it. If you aren't 
familiar with AppleScript, don't be alarmed. As mentioned, the 
AppleScript-related items will be used when you create a Power Mac 
application-but not directly by you. Instead, they'll be used by the 
Symantec environment as you build an application. You won't have to 
run the AppleScript editor or write any scripts. 
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Easy Install 

3.4 

Click Install button to install 

• RppleScript™ I. I 
• RppleScript™ English Dialect I. I 

on the hard disk named 

= Hard Disk 

Help 

([ Install J) 

( Eject Disk 

[ Switch Disk J 

( Customize J 

Quit 

FIGURE 6.17 THE DIALOG BOX FROM SYMANTEC'& APPLESCRIPT INSTALLER. 

Using AppleScript to Update ANSI Libraries 

When you installed the CDK, the installation made some changes to an 
ANSI library file. That means the ANSI libraries have to recompile so 
that they are kept up-to-date. Now that AppleScript is installed, this 
update is an easy process. Open the CDK Release Notes folder that was 
created during the install of the CDK. It contains a script, shown in 
Figure 6.18, that will update the ANSI libraries for you. Double-click on 
the file named Rebuild ANSI Libraries. 

Double-clicking on the Rebuild ANSI Libraries script will launch 
both the Script Editor and the THINK Project Manager. After a minute 
or two, you'll see the Script Editor window with a script in it-that's 
shown in Figure 6.19. 

Click on the Run button in the Script Editor window to run the 
script. When you do, a dialog box like the one shown in Figure 6.20 will 
open. Use the pop-up menu in the dialog to work your way into Standard 
Libraries folder that's in the Symantec C++ for Macintosh folder. Then 
click the Choose "Standard Libraries" button. 
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;;irn COK Release Notes IB.~ 
6 items 216 MB in di sk 1 09 .2 MB available 

~ 

EJ t I -

Getti ng 5ta rted 1,o1it h the CD K Rebuild ANSI Libraries 
~ fO. 

¢} 1¢ Iii 

FIGURE 6.18 THE APPLESCRIPT THAT UPDATES THE SYMANTEC ANSI LIBRARIES. 
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Rebuild ANS I libraries 
V Description : 

Simple script to automagicallybuild the standard libraries 
modified for the Syma.ntec C++ CDK. 
By Tom Emerson, Syman tee DTG 

on DoBuildli b(src) 
trg 

tell application "THINK Project Manager" 
activate 

App le Script 

di sa 11 o\o/ user i nte racti on 
open file src 
delete object code 1 of first project document 
Ylth timeout of 1 800 seconds 

compile first project document 
end timeout 

FIGURE 6.19 THE WINDOW THAT RESULTS FROM RUNNING 

THE REBUILD ANSI LIBRARIES SCRIPT. 
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Select your Standard Libraries folder: 

I OJ Standard Libraries ~ I 

O C sources 
O C++ headers 
0 C++ sources 

Choose "Standard Libraries" 

~Hard Disk 

Desktop 

( Choose ) 

( Cancel ) 

( Open J 

FIGURE 6.20 MOVING TO THE STANDARD LIBRARIES 

FOLDER WHILE RUNNING THE APPLESCRIPT. 

When you click on the Choose "Standard Libraries" button, a THINK 
project will open. The files in the project window will recompile- be pre­
pared for a wait of possibly several minutes. The AppleScript automates 
this process, so you won't have to intervene. When the compile is com­
plete, select Quit from the File menu. The Script Editor will quit, and 
you' ll find yourself in the THINK Project Manager. Again select Quit 
from the File menu-this time to exit the Project Manager. 

At this point the installation of AppleScript, the installation of the 
CDK, and the updating of Symantec files is complete. All the steps you've 
taken up to this point were "one-time-only" tasks. Now, it's time to see 
how to use the Symantec CDK to build an application that runs native on 
a Power Mac. 

Creating a Folder to Hold Your Power Mac Project . 

A Symantec CDK project requires several files not found in a "normal" 
Symantec project. Rather than memorizing the names of these files and 
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then adding each to every new project you make, you should just copy an 
existing CDK project. Then it merely becomes a matter of substituting a 
new source code file and resource file to the copied project. 

Installation of the CDK adds a folder titled PPC Demos to your 
Development folder. Since each demo folder within in this folder con­
tains the files and project file for a Power Mac project, you can save your­
self time and effort by copying one of these folders and using it as the 
basis of your own Power Mac project. I'll do just that by making a copy of 
the Sillyballs f folder found in the PPC Demos folder. Figure 6.21 shows 
you the contents of this folder. 

PPC Demos 

2 items 217.2 MB in disk 1 08 MB available 

JL 5 items 217.2 MB in disk 

IJ - . 

Sill yballs.c 

~ 
SIZE.r 

Sill yballs.n" 
~ 

PPCBuild.ts 

~ 
~ 
cfrg.r 

FIGURE 6.21 THE CONTENTS OF THE FOLDER THAT HOUSES 

SYMANTEC'& POWERPC DEMO PROGRAM SILLYBALLS. 

To copy the entire Sillyballs f folder, click once on it to highlighten it, 
then choose Duplicate from the File menu. The folder will be duplicat­
ed, and your PPC Demos window should look like the one shown in 
Figure 6.22. 
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PPC Demos Im 
3 items 21 7 .3 MB in disk 107.9 MB available 

FIGURE 6.22 DUPLICATING THE SILLYBALLS f FOLDER. 

Rename the duplicate folder. In this chapter I'll walk though the cre­
ation of a program I'll call CDKdemoPPC-so I've given the folder a 
name similar to that. Figure 6.23 shows the new name I've typed in 
for the folder. The " ( 6)" refers to the fact that this is a Chapter 6 
example. If you want to see what this folder looks like, you'll find it 
on the disk that was included with the book. If you have the Symantec 
CDK you can use the project in the (6) CDK Demo PPC !-though 
I'd suggest you try creating your own version so that you become 
familiar with the process. 

PPC Demos 

3 items 217.3 MB in disk 1 07 .9 MB available 

FIGURE 6.23 RENAMING THE DUPLICATED SILLYBALLS f FOLDER. 
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After renaming the duplicate folder, double-click on it to open it. You'll 
see several files in the folder. Each CDK project you create will hold at 
least two resource files- SIZE.r and cfrg.r. Each project will also make 
use of the ToolServer script PPCBuild.ts. These files are present in the 
duplicated folder- leave them there, unchanged. 

The duplicated folder also contains a source code file and a project 
file . Rename each to reflect the code you'll be working on. You can give 
the source code file any name you'd like, as long as it ends with one of 
three extensions: ".c", ".cp'', or ".cpp". Likewise, the project file can be 
given any name-as long as it ends with the extension ".n". Press the "p" 
key while holding the Option key down to create the pi symbol. Figure 
6.24 shows what the contents of the duplicated folder now look like. 

PPC Demos 
3 items 2 17.4 MB in disk 107.8 MB avail abl e 

m - ICDlld.ililill 
' 

Lyapunov I 
. 

Sill yball s I 

;;;[ii (6) CDK Demo PPC f Im§ 
5 items 2 17.4 MB in disk 1 07.8 MB available 

~ [i] ~ 
~ 

CDKdemoPPC.c CDKdemo PPC.11 PPCBuild.ts 

I ~ 
SIZE.r cfrg.r 

-01 
<::iI 19 \iii 

FIGURE 6.24 RENAMING SOME OF THE FILES IN THE DUPLICATED FOLDER. 

Creating the Resource File 

There's one last step you'll want to take before running the project­
you'll want to create a resource file to hold the resources your program 
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will use. Run your resource editor and create a new resource file. If you 
give the resource file the same name as your project, with the ".rsrc" 
extension appended to the end, the THINK Project Manager will auto­
matically include the resource file as part of your project. While you may 
have been used to doing that in the past, don't do it here-you'll see why 
in a moment. Instead, give it any name but the project name followed by 
".rsrc". My project is named CDKdemoPPC.1t, so I chose a resource name 
of CDKdemoPPC.rsrc. Note that I omitted the ".1t". If you want your files 
to match those pictured in the figures of this chapter, give your resource 
file the same name. 

Later, you'll be explicitly telling the THINK Project Manager which 
resource files to use with your project. In the past you've probably had 
just a single resource file for one project. For CDK projects, you'll have 
more than one. Each project will always include the SIZE.r and cfrg.r 
resource files that already appear in the file you duplicated. Additionally, 
your project will include the resource file you make-the one specific to 
your program. The Project Manager will create a single resource file 
from these individual files. And the name it gives this final file will be the 
project name followed by the ".rsrc" extension-that's why you don't 
want to use this name now. 

For learning how to use a new environment, simple is better. The 
CDKdemoPPC program abides by that policy. When executed, the 
CDKdemoPPC program will display a dialog box with a single item in it­
a button. Clicking on the button will close the dialog box and end the 
running of the program. Figure 6.25 shows what the user will see when 
he runs CDKdemoPPC. 

To support the dialog box that the program displays, the 
CDKdemoPPC program requires two resources-a 'DITL' and a 'DLOG'. 
Figure 6.26 shows what the 'DITL' resource looks like in ResEdit. Figure 
6.27 shows what the 'DLOG' looks like. After creating these two 
resources, select Save from the File menu, then quit your resource editor. 
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OK 

FIGURE 6.25 THE RESULTS OF RUNNING THE CDKDEMOPPC PROGRAM. 

~Iii~ Dill ID= 128 from COKdemoPPC.rsrc 

OK lJj 

FIGURE 6.26 THE 'DITL' RESOURCE FROM THE CDKDEMOPPC RESOURCE FILE. 

~Iii DLOG ID = 128 from COKdemoPPC.rsrc 

llll fll11 11111 -.:.oun:. Wlnll11w 

Top:~ Height: ~ 

Left:~ Width: ~ 

[][] 
Color: @ Default 

O Custom 

DITL ID: i 120 
~-~ 

D Initially uisible 

D Close boH 

FIGURE 6.27 THE 'DLOG' RESOURCE FROM THE CDKDEMOPPC RESOURCE FILE. 
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After quitting your resource editor, your project folder will have one new 
file in it. The folder should now look like the one pictured in Figure 
6.28. 

• (6) CDK Oitmo PPC f . 
6 items 21 7.4 MB in disk 1 07 .8 MB available 

. IJ 
CDKdemoPPC.c CDKdemoPPC:n' 

SIZE.r CDKdemoPPC.rsrc 

~ 
~ 

PPCBuild.ts 

IJ - ·. 

cfrg.r 

FIGURE 6.28 THE PROJECT FOLDER FOR THE CDKDEMOPPC PROJECT. 

Opening the CDK Project 

Double-click on the CDKdemoPPC.1t project file to start the THINK 
Project Manager and open the project file. When the project window 
opens, you'll see ten file names listed in it. The same nine resource, 
library, and script files that you see should appear in every CDK project 
you create. Only the one source code file will change. Figure 6.29 
emphasizes this. 

Figure 6.29 shows the significance of copying an existing CDK project 
and using it for a new CDK project-you don't have to memorize a lot of 
file names, or spend time adding files to the project. 

The project window doesn't contain the name of the source code file 
that you'll be using for this project. Select Add Files from the Source win­
dow to bring up the dialog box that gives you the opportunity to add it. 
The Source menu is pictured in Figure 6.30. 
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All of these 
files will appear 
in each of your 
CDK projects 

~ CDKdemoPPC.11 
ltiName 

vsource 

........ ~ ... ~.il.~~-~-~).l~.:~ ......................................... . 
v Resources 

cfrg.r 

SIZE.r 

v Libraries 
lntorfacoL ib .xcoff 

Mathlib .xcoff 

PPC CPlusL ib .o 

PPCCRuntimo .o 

StdCLib .xcoff 

StdCRuntimo .o .................................................................................. 
VScripts 

PPCBuild.ts 

Totals 

FIGURE 6.29 ALL SYMANTEC CDK PROJECTS CONTAIN THE SAME NINE FILES. 

Add Window 
Add Files ••. 
Remoue 
Get Info 
Debug ~I 

SourceSeruer ~ 

Check SyntaH ~y 
Preproc:ess 
Disassemble 

Precompile ... 
Compile ~K 

Make ..• ~\ 

Browser ~J 

FIGURE 6.30 THE SYMANTEC SOURCE MENU. 
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Selecting Add Files brings up the dialog box pictured in Figure 6.31. If 
the pop-up menu at the top of the dialog box doesn't show that you're in 
the (6) CDK Demo PPC f, use the menu to move to that folder. Then 
double-click on the CDKdemoPPC.c file name to add the source code 
file to the project. Next, double-click on the name of your resource file 
to add it to the project. Then click the Done button. 

!: je( t ) 

Desktop ) 

( OnnP l 
{} ( Cancel 

........................................ ...................................... 

l) 

~ 
([ Rdd 

[ Rdd Rll 

[ Hf'HHWf' 

FIGURE 6.31 ADDING FILES TO THE SYMANTEC CDK PROJECT. 

After clicking the Done button you're project window should look like 
the one pictured in Figure 6.32. 

Note that the project file shows the name of the source code file (or 
files) that appeared in the original project. In this example you'll see that 
the Sillyballs.c file is in the project. Remove this file from the project by 
clicking once on the Sillyballs .c file name in the project window, and 
then selecting Remove from the Source menu. 

To keep your project window well organized, click once on the 
CDKdemoPPC.rsrc file name and, with the mouse button still down, drag 
the file into the segment named Resources. When you've done that your 
project window will look like the one shown in Figure 6.33. 
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CDKdemoPPC. TJ 

~Name 
v Source 

+ CDKdemoPPC .c 

FIGURE 6.32 THE CDl<DEMOPPC PROJECT AFTER ADDING TWO FILES TO IT. 

CDKdemoPPC.11 
~Name 

V Source 
+ CDKdemoPPC .c 

v Resources 

cfrg.r 
SIZE.r 

V Libraries 
lnterf acel ib .xcoff 
Mathl ib .xcoff 
PPC CPlusL ib .o 
PPCCRuntime .o 
StdCL ib .xcoff 
StdCRuntime .o 

v Scripts 
PPCBuild. ts 

Totals 

FIGURE 6.33 THE CDKDEMOPPC PROJECT AFTER DELETING 

THE ORIGINAL SOURCE CODE FILE AND MOVING THE RESOURCE FILE. 
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Required Resources 

You'll notice that the project window holds two resource files-other 
than the one you just added. These two files were duplicated when you 
copied the Sillyballs folder. Every PowerPC application requires that a 
'SIZE' and 'cfrg' be present. Symantec has chosen to create these 
resources using text descriptions rather than through graphical resource 
descriptions like those created using ResEdit. 

Figure 6.34 shows what the 'SIZE' resource looks like. Double-click 
on the SIZE.r file in the project window to view its contents. This file can 
usually be used "as is" from project to project. The only changes you 
might want to make are to the very last couple of items in the 'SIZE' data 
structure. These two fields establish the memory partition your applica­
tion will have-that is, the amount of memory the operating system will 
allot for your program when the user launches it. There are two numbers 
related to the partition size. The first is the preferred memory size-the 
amount of memory the operating system will attempt to secure for the 
application. The second number is the minimum memory partition. If 
there is not enough free memory to obtain the preferred size, the operat­
ing will go as low as this second number in its bid to get memory. Figure 
6.34 shows that the default value for both of these sizes is 384K bytes. If 
you feel your program requires more or less memory, change these num­
bers from "384" to more appropriate values. 

If you've used Symantec C++ or THINK C to develop programs for 
680x0-based Macs, you're probably familiar with the Set Project Type 
menu item. It presents you with a dialog box like the one shown in 
Figure 6.35. For 680x0 applications, this is where you establish the pro­
gram's partition size. While this dialog box can be used when creating a 
PowerPC application, the value entered in the Partition (K) edit box will 
not be used. This value will be overwritten by the values used in the 
'SIZE' resource. Make sure to make memory partition sizes in the SIZE.r 
file rather than in this dialog box. 
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Preferred 

Minimu 
memory size 

SIZE.r 

#include <Types.r> 

resource 'SIZE' ( -1 ) 
reserved, 
occeptSuspendResumeEvents, 
reserved, 
cannot8ackground , 
multiFinderRwore, 
bockgroundRndForeground, 
dontGetFrontClicks , 
ignoreChi ldOiedEvents , 
is32BitCompotible , 
isHighlevelEventAwore , 
onlylocolHLEvents, 
notStotioneryAwore, 
dontUseTextEditServices, 
reserved, 
reserved, 
reserved, 
(384 * 1024 ) ' 
(384 * 1024 ) 

FIGURE 6.34 THE 'SIZE' RESOURCE, VIEWED FROM THE SIZE.R FILE. 

Set the application's partition size here 

@ Application 

0 Desk Acces 

O Deuice Driu 

0 Code Resou 

Partition (K) 384 

File Type 

Creator 

~---~ 

D Far CODE 

D Far DATA 
SIZE Flags ~I 0000 I D Separate STRS 

Cancel OK D 

FIGURE 6.35 SETIING AN APPLICATION'S PARTITION SIZE USING SYMANTEC C++ 7 .0. 
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The 'cfrg' resource is unique to PowerPC applications. When a program 
is launched, the operating system checks the resource fork of the pro­
gram to see if this resource is present. If it is, the Mac knows it is about to 
work with a PowerPC program. I'll go into more detail about the 'cfrg' 
resource in Chapter 8. For now, you'll only have to be aware of one item 
in the 'cfrg' data structure. The last field of the 'cfrg' holds the name of 
the application. Double-click on the cfrg.r file and look at this field. 
Since the file was copied from the Sillyballs folder, it will show the pro­
gram name as "Sillyballs." Type in the name "CDKdemoPPC"-as I've 
done in Figure 6.36. For each project you create you'll want to change 
this one line in the cfrg.r file. 

cfr .r· · 
#include "CodeFragmentTypes.r" 

kPowerPC, 
kFul I Lib, 
kNoVersionNum, 
kNoVersionNum, 
kDefaultStackSize, 
kNoAppSubFolder, 
klsApp, 
kOnD i skF I at, 
kZeroOffset, 
kWholeFork, 
"CDKdemoPPC" 

II archType 
II updateLevel 
II currentVersion 
II oldDefVersion 
II appStackSize 
II appSubFolderlD 
II usage 
II where 
II offset ~ 
II length ~ 
11 <== Change this to be the !-II; 

~·~':; 

Change this to the name of your application 

FIGURE 6.36 SETIING THE NAME FOR THE STANDALONE 

PROGRAM FROM WITHIN THE CFRG.R FILE. 

The CDKdemoPPC Source Code 

Next, you'll want to edit the source code file. Double-click on the 
CDKdemoPPC.c file to open it. When you duplicated the entire Sillyballs 

121 



Programming the PowerPC 

f, a copy of Sillyballs.c was made. At that time you renamed the file 
CDKdemoPPC.c. Since this file was the Sillyballs.c file, it holds the code 
for the Sillyballs program. Choose Select All from the Edit menu and 
then press the Delete key to delete all the code. Now, type in the follow­
ing code or, better yet, copy it from the disk that came with this book. 

//+++++++++++++++ function prototypes ++++++++++++++ 
void Initialize_Toolbox( void ); 
void Open_Modal_Dialog( void ); 

//I I I I I I I I I I I+++++ define directives I I I I I I I I I I I I I++ 

/fdefi ne 
/fdefi ne 

DIALOG_ID 
OK_BUTTON ITEM 

128 
1 

//11111111111++++++ global variables 111111111111+++ 

QDGlobals qd; 

//++++++++++++++++++++++ main ++++++I I I I I I I+++++++++ 

void main( void ) 
{ 

Initialize_Toolbox(); 

Open_Modal_Dialog(); 
} 

//+++++++++++++ initialize the Toolbox +++++++++++++ 

void Initialize_Toolbox( void 
{ 

} 
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//I I I I I I I I I I I I I I open a modal dialog +++++++++++++++ 

void Open_Modal_Dialog( void ) 
{ 

} 

DialogPtr 
short 
Boolean 

the_dialog; 
the_ item; 
all_done =false; 

the_dialog GetNewDialog( DIALOG_ID, nil, 
CWindowPtr)-lL ); 

ShowWindowC the_dialog ); 

while ( all_done == false 
{ 

} 

ModalDialog( nil, &the item ) ; 

switch ( the_item 
{ 

} 

case OK_BUTTON ITEM: 
all_done =true; 
break; 

DisposDialog( the_dialog ); 

Before creating the PowerPC application, let's take a brief look at the 
source code for CDKdemoPPC. It's a very simple program, but there are 
a couple of points worthy of note. 

PowerPC compilers are insistent on the inclusion of function proto­
types. If you've been lax about their use in the past, now is the time to get 
consistent. The CDKdemoPPC source code includes two functions (other 
than ma i n ( ) ) . Here are their prototypes: 

void Initialize_ToolboxC void ); 
void Open_Modal_Dialog( void ); 

The only purpose of the program is to display a dialog box. The resource 
ID of the dialog's 'DLOG' resource is 128. The item number of the only 
item in the dialog box-the OK button-is 1. These two values appear in 
the source code as #define directives: 
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1/define 
1/defi ne 

DIALOG_ID 
OK_BUTTON ITEM 

128 
1 

CDKdemoPPC uses one global variable-the QDGl oba 1 s variable qd. If 
you've used Symantec compilers, but haven't compiled for the PowerPC, 
this declaration may not look familiar to you. Several global variables that 
most Mac programs make use of are QuickDraw global variables. Two 
examples are the Port and screenBi ts. The five standard patterns, 
white, 1 tGray, gray, dkGray, and black, are also QuickDraw global vari­
ables. While in the past it was acceptable to reference these variables 
directly, you must now preface their names with the name of the data struc­
ture which encapsulates them-qd. For example, if you used Symantec 
C++ 6.0 or THINKC 6.0, you may have called Ini tGraf() like this: 

InitGraf( &thePort ); 

Using Symantec C++ 7.0 and compiling for 680x0-based Macs, you must 
now call Ini tGraf() like this: 

InitGraf( &qd.thePort ); 

Note that when compiling with either the Symantec 6.0 or 7.0 compilers, 
and when compiling for a 680x0 Mac, you need not declare the qd data 
structure. Now, when using Symantec C++ 7.0 and the CDK and compil­
ing for PowerPC-based Macs, you must declare qd yourself. So while 
you'll use QuickDraw globals as you did when compiling 680x0 applica­
tions using Symantec C++ 7.0, you'll need to first declare qd: 

QDGlobals qd; 
InitGraf( &qd.thePort ); 

The main () function's tasks include calling a function to initialize the 
Toolbox and calling a function to open the modal dialog box. Here's 
main (): 

void main( void ) 
{ 

Initialize_Toolbox(); 
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Open_Modal_Dialog(); 
} 

The I n i ti a 1 i z e_ Too 1 box ( ) routine is standard stuff. The only thing 
worth noting is the call to In it Graf ( ) , which is made in the manner just 
discussed. 

void Initialize_Toolbox( void 
{ 

} 

InitGraf( &qd.thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus (); 
TEinit(); 
InitDialogs( OL ); 
FlushEvents( everyEvent, 0 ); 
InitCursor(); 

The Open_Moda l _Di a 1 og () function opens the dialog box described by 
the 'DLOG' and 'DITL' resources. You'll see this same routine again, 
with a couple of modifications, in the next chapter. There the call to 
Mod a 1Dia1 og ( ) will be changed so that it invokes a filter function. 

void Open_Modal_Dialog( void ) 
{ 

DialogPtr 
short 
Boolean 

the_dialog; 
the_ item; 
all_done =false; 

the_dialog = GetNewDialog( DIALOG_ID, nil, (WindowPtr)-lL ); 
ShowWindow( the_dialog ); 

while ( all_done ~false 
{ 

ModalDialog( nil, &the_item ); 

switch ( the_item 
{ 

} 

case OK_BUTTON_ITEM: 
all_done =true; 
break; 
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} 
DisposDialog( the_dialog ); 

} 

Creating the PowerPC Application 

The project contains all of the necessary files, and the source code is writ­
ten. Normally, the next step would be to bring the project up to date by 
compiling the new code and loading any libraries that haven't been pre­
viously loaded. Since you created this project by copying an existing one, 
however, there is one step you should take before bringing the project up 
to date. Select Remove Objects from the Project menu. Removing all 
objects will force the compiler to start from scratch-it will reload all 
libraries and recompile all of the source code. Figure 6.37 shows the 
Project menu and the two menu items you should use . 
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Close Project 
First remove Close & Compact 
existing objects Switch To Project ~ 

Set Project Type •.• 
Remoue Objects 

Bring Up To Date 3CU 
Check Link 3CL 

Then compile Build Library •.. 
and load all 
project files to Build Rpplication •.• 
bring the project 
up to date Use Debugger 

Run 3CR 

FIGURE 6.37 REMOVE THE OBJECTS BEFORE BRINGING 

A SYMANTEC CDK PROJECT UP TO DATE. 
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Selecting Remove Objects from the Project menu will result in the dis­
play of the alert shown in Figure 6.38. Recompiling and reloading of the 
files is exactly what you want, so click the OK button. 

This will require all project files to be 
recompiled or reloaded. Continue? 

can c e I ) fi~( iiiiiiiio iiiiK ~l 

FIGURE 6.38 SYMANTEC ALERTS YOU THAT REMOVING 

OBJECTS WILL CAUSE FILES TO BE RECOMPILED. 

Select Bring Up To Date from the Project menu. The THINK Project 
Manager will load the libraries and compile the source code and 
resource files. When finished, the folder will contain a new file named 
CDKdemoPPC.n.rsrc and a new folder called (CDKdemoPPC.n OBJs). 
Figure 6.39 shows what your project folder should now look like. 

.. (6) CDK Demo PPC f -~ 8 items 21 8 .4 MB i n disk 1 06.8 MB available 

~ [i ~ ~ 
~ 

CDKdemoPPC .c CDKdemoPPC.11 PPCBuild .ts CDKdemoPPC.11.rsrc 

~ ~ ~ ®'~~{' 
·"'2i.-~ 

SIZE.r CD Kde mo P PC. rs re cfrg .r (CDKdemoPPC.11 OBJs) -0' 
¢J 1¢ Iii 

FIGURE 6.39 THE CDK PROJECT FOLDER AFTER THE PROJECT IS BROUGHT UP TO DATE. 
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The new folder, named (CDKdemoPPC.1t OBJs), contains the object files 
that result from compiling the files in the project. These files are used by 
the linker to create the standalone application. 

Besides the new object files folder, you'll notice one new file in the 
project folder. The newly created file is a resource file. It holds the 
resources that were defined in the Symantec files SIZE.r and cfrg.r, and 
the resources you created and kept in the CDKdemoPPC.rsrc file. Note 
the name of the resource file created by the Project Manager: 
CDKdemoPPC.7t.rsrc. The name is the project name with ".rsrc" append­
ed to it. Earlier I warned you not to give your own resource file this 
name-now you see why. If you had, the THINK Project Manager would 
have overwritten your resource file with this new one. 

Now it's finally time to create the standalone PowerPC application. 
To do this, you need only run one AppleScript. Fortunately, this script 
has already been written by Symantec. And, better yet, this one script 
works for all projects. Click on the AppleScript menu that appears to the 
right of the Windows menu and select Build PowerPC App. This menu is 
shown in Figure 6.40. 

Project Info 
Re moue Files In Segment 
Saue project as teHt 

FIGURE 6.40 SELECTING THE BUILD POWERPC 

APP SCRIPT FROM THE APPLESCRIPT MENU. 

The script that runs when you select Build PowerPC App will open a Tool 
Status window. This window will display a changing message to let you 
know at what step in the build the script is at. Figure 6.41 shows the Tool 
Status window beside the project window. 
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COKdemo~PC.tt 
)it; Name 

v Sour-ce 
+ CDKdemoPPC .c 

v Resour-ces 
CDKdemoPPC .rsrc 
cfrg.r 
SIZE.r .................................................................................. .., 

v Libr-ar-ies 
lnterfacelib .xcoff 
Mathl ib .xcoff 
PPC CPlusl ib .o 
PPCCRuntime .o 
StdCL ib .xcoff 

Totals 

FIGURE 6.41 THE TOOL STATUS WINDOW DISPLAYS EACH STEP 

THAT TAKES PLACE AS A PROGRAM IS BUILT. 

If you forgot to select Remove Objects before bringing the project up to 
date, the AppleScript will fail to complete. You'll see the alert pictured in 
Figure 6.42. 

An error occured. Do you want to open 
the ToolSeruer output? 

( cancel ) [ Open D 

FIGURE 6.42 FORGEnlNG TO REMOVE THE OBJECTS 

BEFORE RUNNING THE APPLESCRIPT RESULTS IN AN ERROR. 
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If you click on the Open button, you'll see the error message window 
shown in Figure 6.43. If you're at this point, select Remove Objects from 
the Project menu, then select Bring Up To Date from the same menu. 
Then again select Build PowerPC App from the AppleScript menu. 

~Iii~ Hard Disk: ... :(C:DKdemoPPC: .11 OBJs):PPC:Build.out ~ii 
# Error: Fi I e "CDKdemoPPC. c. o" 'ill' 
# Reference to unresolved symbol "lni tGrcif" 
• Error: Fi le "CDKdemoPPC.c.o" 
# Reference to unresolved symbol "lni tFonts" 
• Error: Fi I e "CDKdemoPPC. c. o" 
# Reference to unresolved symbol "lnitWindows" 
• Error: Fi I e "CDKdemoPPC. c. o" 
• Reference to unresolved symbol "lnitMenus" 
# Error: Fi I e "CDKdemoPPC. c. o" 
• Reference to unreso I ved symbo I "TE I n i t" 
• Error: Fi le "CDKdemoPPC.c.o" 
# Reference to unresolved symbol "lnitDicilogs" 
#Error: Fi le "CDKdemoPPC.c.o" 
# Reference to unresolved symbol "FlushEvents" 
• Error: Fi le "CDKdemoPPC.c.o" 

FIGURE 6.43 THE ERROR WINDOW THAT RESULTS FROM THE 

FAIWRE TO REMOVE OBJECTS BEFORE RUNNING THE APPLESCRIPT. 

If the build was successful you'll have two new icons in the project folder. 
One is for the PowerPC application icon. The other is a .SYM files. The 
.SYM file is used for debugging purposes. Figure 6.44 is a final look at 
how the project window looks. 

If you own a Power Mac you can test the application by double-click­
ing on its icon to run it. If you don't own a Power Mac, you're out of 
luck-you'll see the alert pictured in Figure 6.45. 

While the Symantec CDK runs on either a 680x0-based Mac or a 
PowerPC-based Mac, a standalone application that it generates can only 
be run on a Power Mac. That's not a shortcoming of the Symantec prod­
uct, however. Any native PowerPC application can only be run on a 
PowerPC-based computer. It is possible, however, to combine a PowerPC 
version of an application with a 680x0 version to form one larger pro­
gram that will run on either platform. This type of program is called a fat 
binary, or fat application, and is the topic of Chapter 8. 
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~ (6) CDK Demo PPC f iml 
1 O items 21 B.3 MB in disk 106.9 MB available 

~ iJ ~ .r~ 
i1! 

CJ .,...., . 
00 - OlO 

CDKdemoPPC.c CDKdemoPPC.'11 CDKdemoPPC.rsrc (CDKdemoPPC.'11 OBJs) CDKdemoPPC.SVM 

~ -
SIZE.r 

121 

~ ~ - ~ 
cfrg.r PPCBuild.ts CDKdemoPPC.'11.rsrc 

FIGURE 6.44 THE CDK PROJECT FOLDER AFTER 

THE STANDALONE POWERPC APPLICATION IS BUILT. 

~ 
CDKdemoPPC 

The application program "CDKdemoPPC" 
could not be opened, because an error of 
type -192 occurred. 

t OK , 

FIGURE 6.45 ATTEMPTING TO LAUNCH A POWERPC APPLICATION 

FROM THE DESKTOP OF A 680X0-SASED MAC RESULTS IN AN ERROR. 

CHAPTER SUMMARY 

-0 
T¢ liiil 

T o create a standalone, native PowerPC application for a Power Mac, 
you'll need a PowerPC compiler. While other compilers will gener­

ate executables that run on both 680x0-based Macs and Power Macs, 
these programs won't run native on Power Macs. That means that while 
the program will work on the new family of Macintosh computers, it 
won't take advantage of the speed of the PowerPC chip. 
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Symantec Corporation has long been the supplier of Macintosh com­
pilers. Version 7.0 of the Symantec C++ compiler was released close to 
the time that the Power Mac came to market. While this compiler does 
create programs that run on the Power Mac, these applications aren't 
native PowerPC. To cre;;i.te native applications you'll need to get the 
Symantec Cross Development Toolkit (CDK). This addition to Symantec 
C++ 7.0 allows you to create native PowerPC applications using either a 
680x0-based Mac or a PowerPC-based Mac as your development system. 

In 1994 Metrowerks unleashed their entries onto the Macintosh 
PowerPC compiler market. The Silver edition of their C/C++ compiler 
generates native PowerPC applications using either a 680x0-based Mac or 
a Power Mac as the development system. The Gold edition includes two 
separate compilers. Both use either a 680x0-based Mac or a Power Mac as 
the development system. The first of the two compilers generates 680x0-
only applications, while the second generates PowerPC-only programs. 
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UNIVERSAL PROCEDURE POINTERS 

T he Mixed Mode Manager makes it possible for an application to 
contain a mix of 680x0 code and native PowerPC code. 
Functions that you write may make calls to Toolbox routines that 

have or haven't been ported- with no extra work on your part. The 
Mixed Mode Manager does an incredible job of keeping track of what 
mode the Mac should be in at all times- PowerPC or 68LC040 emulator. 
Still, there will be a few occasions when you will have to give this manager 
an assist. You'll do that by including a special pointer type in your source 
code- the universal procedure pointer, or Universal ProcPtr . This 
pointer type, which is new to Mac programming, enables you to pass the 
address of one of your own functions to a Toolbox routine. In the past, 
this was done through the use of a procedure pointer, or ProcPtr . 

Several Toolbox routines- Modal Di a l og () and SetDi t em() being 
the most notable- make use of Pr ocPt rs on the 680x0-based Macs. On 
the PowerPC-based Macintosh these routines use Univers al ProcPtrs 
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instead. This chapter will provide all the details on what this pointer type 
is, and how to use pointers of this type in Toolbox calls. 

UNIVERSAL PROCEDURE POINTER THEORY 

I n Chapter 4 you saw that the Macintosh system software is a mixture of 
old 680x0 functions and new, native PowerPC functions. While Apple 

has ported the most frequently called Toolbox routines to native code, the 
majority of the Toolbox routines have not been ported. The Mixed Mode 
Manager is aware of which routines are 680x0 code and which are 
PowerPC code. That frees you, the programmer, from worrying about any 
mixed mode details when you add a call to a Toolbox routine to your code. 

The Mixed Mode Manager is fully capable of properly routing calls to 
both ported and nonported Toolbox routines. It cannot, however, han­
dle calls to functions which it knows nothing about. Not, anyway, without 
a little help from the programmer. 

Procedure Pointers and the 680x0 Processor 

Programmers of all pre-PowerPC Macintosh computers who use modal 
(nonmovable) dialog boxes will be familiar with a line of code such as 
the following: 

ModalDialog( nil, &the_item ); 

If the user of a program clicks the mouse button while over an enabled 
item in a modal, or nonmovable, dialog box, the Toolbox function 
Mod a 1Dia1 og () will report this fact to the program. Mod a 1Dia1 og () 
will then take control. For example, if the user clicked on a dialog but­
ton, Mod a 1Dia1 og () is responsible for changing the highlighting of the 
button. 

While the first parameter to Mod a 1Dia1 og () is most often n i 1, it 
doesn't have to be. If the programmer wants to perform some special 
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action when a dialog box item is clicked-on, this first parameter should 
be the name of a special filter function. If a function name does appear 
as the first parameter, that function will be invoked before 
Modal Di al og() has the opportunity to take action. If I wrote a filter 
function named My _Filter (), then a call to Modal Di al og ( ) would look 
like the one shown here: 

ModalDialog( My_Filter, &the_item ); 

Each time Modal Di al og ()) was called, the filter function would first exe­
cute-as shown in Figure 7.1. 

My_Filter() 
{ 

ModalDialog(My_Filter, the_item); 

ModalDialog() 
{ 

If a function is listed 
as the first parameter 
to ModalDialog ( ) , 
then that function gets 
executed before 
ModalDialog () 

Depending on the results of 
the filter function , the Toolbox 
code that makes up the 
ModalDialog ( ) function 
may or may not execute 

FIGURE 7.1 A FILTER FUNCTION ALLOWS THE PROGRAMMER 

TO ADD TO THE FUNCTIONALITY OF M 0 d a l D i a l 0 g ( ) • 

Filter functions are handy for-naturally enough-filtering. In the case 
of Modal Di al og (), a filter function is often used to determine if the 
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user pressed a Command key combination. If the user did, the filter 
function handles it in it's own way-and the Toolbox code that makes 
up Mod a 1Dia1 og () is skipped. If the user wasn't pressing the Command 
key when an item was clicked on in the dialog box, the filter function 
doesn't handle the action, and the Mod a 1Dia1 og () code does. 

The first parameter to Mod a 1 Di a 1 o g ( )-whether n i 1 or a function 
name-is actually a pointer. In the case of n i 1 , it is of course a n i 1 point­
er. In the case of a function name, it is a pointer to the code that makes 
up that function. On the Macintosh, this type of pointer is called a 
ProcPtr-a pointer to a function. 

While Mod a 1Dia1 og () may be the most notable example of a Toolbox 
function that allows the use of a ProcPtr, it isn't the only one. 
TrackContro 1 (), Standa rdGetFi 1 e (), and A 1 ert ()-and its three varia­
tions, StopA 1 ert (), NoteA 1 e rt ( ) , and Caution A 1 ert ( )-all accept a 
ProcPtr as one of their parameters. Each of about a dozen of the Apple 
Events Toolbox routines also requires a P roe Pt r as a parameter. 

Universal Procedure Pointers and the PowerPC 

The previous section dealt with the ProcPtr type-a pointer to a func­
tion. Since that section didn't mention the PowerPC, you may have cor­
rectly guessed that its purpose was to serve as a lead-in for a more 
PowerPC-specific topic. On a Power Mac, a ProcPtr doesn't point direct­
ly to the code of a function. Instead, it points to the function's TVector­
its transition vector. Recall from Chapter 5 that each function has a tran­
sition vector that consists of two pointers. One pointer holds the address 
of the function's code, while the other holds the address of the table of 
contents for the fragment in which the function resides. Together these 
two pointers keep track of the function and any other routines that the 
function may call. Chapter 5 closed with a figure that summarized 
TVectors-it's reprinted here as Figure 7.2. 

Figure 7.3 compares a ProcPtr used on a 680x0-based system with a 
ProcPtr used on a PowerPC-based system. 
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TVecto rA 

[ 
Table 
of 
Conten ts 

FunctionA code -
pointer I -

pointer 

[ Pointer to TVector B _] 

TVector B 
r-

[ 

t---F-u-nc-tio_n_B_co_d_e_ .. J 
pointer 

pointer 

FIGURE 7 .2 A TVECTOR CONTAINS TWO POINTERS-

ONE TO A FUNCTION'S CODE, THE OTHER TO THE FRAGMENT'S TOC. 

There is still another difference between ProcPtrs used on different 
processor-based systems-how they are used by the programmer. You've 
seen that on a 680x0-based Mac, a ProcPtr can be used directly. 
Modal Di al og (), for instance, allows a function's name to be used as the 
first parameter and to serve as a ProcPtr: 

ModalDialog( My_Filter, &the item); II My_Filter is a 
ProcPtr 

On a PowerPC-based Mac, things are more complicated. Because instruc­
tions from two different instruction sets (680x0 and PowerPC instruc­
tions) are used within a single program, the Mixed Mode Manager needs 
help in handling calls that involve ProcPtrs. A ProcPtr is an address 
(680x0-based systems) or a pointer to an address (PowerPC-based sys-
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terns). In either case, an address alone is not enough to tell the Mixed 
Mode Manager what type of code is to be accessed. That information is 
held in a data structure not found on the 680x0-the universal proce­
dure pointer, or Universal ProcPtr. 

~ 
N 0 T E 
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680x0 system PowerPC system 

Function code ~ 

PiOcPtr I-' 

FIGURE 7 .3 COMPARISON OF pr 0 c pt rs ON A 680x0-BASED 

SYSTEM AND A POWERPC·BASED SYSTEM. 

Un i versa l P r o c Pt rs play a big part in porting 680x0 code 
to the Power Mac. In fact, the conversion of function point­
ers of type ProcPtr to type Universal ProcPtr will proba­
bly represent your largest porting task-that's why I've 
dedicated an entire chapter to the subject. This chapter­
as well as code in subsequent chapters-will provide plenty 
of examples. 
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On a PowerPC-based Mac, a Universal ProcPtr (or UPP) is used much as a 
680x0-based Mac uses a ProcPtr. The Universal ProcPtr just yields more 
information than a ProcPtr. The Universal ProcPtr is a pointer to still 
another data structure-a routine descriptor, or Routi neDescri ptor. The 
Rout i neDescri pt or holds information about the function, or routine, that 
is to be invoked. One of the pieces of information in the 
Rout i neDescri pt or is a flag that specifies the instruction set architecture of 
the routine. That is, whether the routine can be handled directly by the 
PowerPC chip or whether the Mixed Mode Manager must pass instructions 
to the 68LC040 emulator for preliminary processing. Another field in the 
Routi neDescri ptor is a ProcPtr. This ProcPtr leads, via the 1Vector, to 
the functions code. Figure 7.4 illustrates this. 

Function code 

TVector 

Routine 
descriptor 

FIGURE 7 .4 A u n i v e r s a l p r 0 c pt r INDIRECTL y 

LEADS TO THE CODE THAT MAKES UP A FUNCTION. 
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Don't despair if Figure 7.4 gives you the feeling that things appear to be 
getting very complicated-I won't be adding to the number of data struc­
tures and pointers in that figure. 

And, of more significance yet, you won't be responsible for 
organizing TVectors, Routi neDescri ptors, or any other 
pointer or data structure regarding function calls via 
ProcPtrs. Rather, you'll simply create a 
Universal ProcPtr and let the compiler organize things. 

USING UNIVERSALPROCPTRS 

I fyou're compiling code that will run on a Power Mac, you need to use 
Universal ProcPtrs rather than standard ProcPtrs. Anytime you 

invoke a function in a manner that used to require a ProcPtr, you must 
now first create a Uni versa 1 ProcPt r. 

Using a UniversalProcPtr in a Call to ModalDialog() 

To make the process of creating and using UPPs easier for the PowerPC 
programmer, Apple has modified its set of header files to include a set of 
macros that aid in this task. Since this chapter began with a discussion of 
Mod a 1Dia1 og ( ) , I'll continue to use this Toolbox routine in examples. 
The first parameter to Modal Di al og() is a ProcPtr that points to a filter 
function. Assuming I've written one, and it's named My_Fi 1 ter( ), a call 
to Mod a 1Dia1 og () on a 680x0 Mac would look like this: 

ModalDialog( My_Filter, &the_item ); 

As you can see from the above line, on a 680x0 Mac the filter function 
name serves as the ProcPtr. On a Power Mac, things are quite different. 

To work with a filter function on a Power Mac I need to first declare a 
UniversalProcPtr variable and then create a routine descriptor for the fil­
ter function. Here's how that's done: 
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ModalFilterUPP my_filter_UPP; 
my_filter_UPP = NewModalFilterProc( My_Filter ); 

Then, rather than use the name of the filter function-as done on a 
680x0-based Mac, I pass the Uni versa 1 ProcPt r to Mod a 1Dia1 og ( ) : 

ModalDialog( my_filter_UPP. &the_item ); 

The above example is worthy of closer examination. First, we'll look at 
the declaration of the variable my_fi 1 ter _UPP. With the advent of the 
universal headers, Apple has defined a whole new set of data types that 
are to specifically be used when working with universal procedure point­
ers. Mod a 1Fi1 terUPP is one such data type. In the universal header file 
Dialogs.h, you'll find this definition: 

typedef UniversalProcPtr ModalFilterUPP; 

So it turns out the Modal Fi 1 terUPP is nothing more than a 
UniversalProcPtr. 

Declaring a Universal ProcPtr variable doesn't create a routine 
descriptor for a function-as shown in Figure 7.5. For that, you need to 
call one of the many macros that creates a routine descriptor, examines a 
function, and fills in the fields of the routine descriptor accordingly. 
These macros are defined in the universal header files. To set up the 
Universal ProcPtr for my filter function that is to be used by 
Mod a lDi a 1 og (), I'd call the NewModa 1 Fi lte rP roe ( ) macro: 

my_filter_UPP = NewModalFilterProc( My_Filter ); 

The call to NewModal Fi 1 terProc() creates a routine descriptor with 
information specific to the function whose name appears as the single 
function parameter. When the call to NewModal Fi 1 terProc() is com­
plete, a Uni versa 1 ProcPtr will be returned. Variable my_fi 1 ter _UPP is 
then associated with the My_Fi 1 ter() function. That's shown in Figure 
7.6. Now, in place of the function name (as is done in 680x0 develop­
ment), use the Universal ProcPtr variable: 

ModalDialog( my_filter_UPP, &the_item ); 
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ModalFilterUPP my_filter_UPP; 

The declaration of 
my_filter_UPP 
does not create a 
routine descriptor for 
My_Filter() 

Nor does the 
declaration create an 
association between 
my_ filter_UPP 
and the function 
My_Filter() 

my_filter_UPP 

My _Filter() 
function code 

potnte_i::~ 
J 

~9 

Unlveraa!P~ ' 

] TV•cim 

FIGURE 7.5 THE DECLARATION OF A Uni versa l p roe Pt r 
DOES NOT ASSOCIATE THAT POINTER WITH A FUNCTION. 

To summarize, the 680x0 method of passing a pointer to a function is to 
simply use the function's name in place of the parameter that is of type 
ProcPtr: · 

ModalDialog( My_Filter, &the_item ); 

The PowerPC method of passing a pointer to a function is to first declare a 
Universal ProcPtr (of the type specific to the Toolbox routine in which it 
will be used). Next, create a routine descriptor and set up the UPP via one 
of the Apple-implemented macros designed to do just that. Finally, use the 
UPP as the parameter that is to serve as the pointer to the function: 
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ModalFilterUPP my_filter_UPP; 
my_filter_UPP = NewModalFilterProc( My_Filter ); 

II open dialog here 

ModalDialog( my_filter_UPP, &the_item ); 

When you're through with the UPP, dispose of it just before you leave the 
function in which it was allocated: 

DisposeRoutineDescriptor( my_filter_UPP) ; 

my_ filter_ UPP = NewModalFilterProc(My_Filter); 

The call to 
NewModalFilterProc() 
creates a routine descriptor 
that hold information about 
theMy_ Filter () function 

my_filter_UPP 

My_Filter() 
function .code 

FIGURE 7.6 AN APPLE·DEFINED MACRO SUCH AS NewModa l Fil terProc () 
CREATES A ROUTINE DESCRIPTOR AND RETURNS A uni v er s a l pr 0 c pt r. 

Later in this chapter you'll see some of the other Apple macros that cre­
ate routine descriptors. 

143 



Programming the PowerPC 

How the Compiler Chooses 
Between ProcPtr and UniversalProcPtr 

Almost all applications that were written before the arrival of the Power 
Macs-those programs designed for 680x0-based Macs-will run without 
modification on a Power Mac. This type of program won't, however, take 
advantage of the speed of the PowerPC chip. That's because the applica­
tion will spend most of it's time in emulation mode, with instructions 
being handled by the 68LC040 Emulator. Modifying programs of this 
type to run in native mode is the primary reason you'll port existing 
680x0 applications. 

If you're going to port 680x0 code to run native on a Power Mac, 
you'll be making use of Universal ProcPtrs-a compiler designed to 
generate native PowerPC code won't recognize ProcPtrs. Consider the 
following line of code: 

ModalDialog( My_Filter. &the_item ); 

When I used the Metrowerks PowerPC compiler in an attempt to com­
pile source code that included a line like the above, I got the error mes­
sage shown in Figure 7. 7.When I ported my source code to include a 
Universal ProcPtr rather than a ProcPtr, the source code successfully 
compiled to native code. Now, with a new version of my source code, is 
there no turning back? With a Universal ProcPtr declared in my source 
code, could I compile the code using a compiler a compiler designed to 
generate executables for 680x0-based Macs? The answer-perhaps sur­
prisingly-is "yes." Let's see why. 

Source code for a small application that uses a 
Universal ProcPtr appears later in this chapter. 

If you program in C or C++, you may be familiar with the Code Warrior 
compilers by Metrowerks-they were covered in detail in the previous 
chapter. There are two versions of the CodeWarrior C/C++ compiler. 
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One is named MW C/C++ 68K, and the other is named MW C/C++ PPC. 
The first generates executables that run on 680x0-based Macs, the sec­
ond creates executables for PowerPC-based Macintoshes. 

Messa e Window 
•• Errors : 1 ¢¢ Warnings : 0 

•• Error : type mismatch ..(r 
UPPbadDemo.c I ine 68 ModalDialog ( My_Fi lter , &the_item ); 

r:l1 
N 0 T E 

FIGURE 7. 7 POWERPC COMPILERS ALERT YOU WHEN YOU 

ATTEMPT TO USE A ProcPtr IN PLACE OF A UPP. 

When used in conjunction, the two separate compilers gen­
erate code that can be combined to create a fat binary-a 
program that can be run on either a 680x0 or Power Mac. 
Chapter 8 provides the details on that. 

If I write C or C++ code that makes use of a Universal ProcPt r , it will of 
course compile on the MW C/C++ PPC compiler. But it will also compile 
on the MW C/ C++ 68K compiler. That's because the Metrowerks compil­
ers, like version 7.0 of the Symantec compiler, makes use of the universal 
header files. By using conditional preprocessor directives, the new header files 
can be used by 680x0 compilers or PowerPC compilers. 

You're certainly familiar with preprocessor directives like #include 
and #define. Conditional compilation directives are another type of pre­
processor directive. They allow a file to be compiled in more than one 
way. By using preprocessor directives like #if and #else, the compiler 
can be forced to compile or ignore blocks of code according to the con­
ditions at the time the compile takes place. In the universal version of the 
Dialogs.h header file you' ll find conditional compilation directives that 
cause Modal Fil terUPP to be defined in two different ways. Here's an 
edited version of a part of Dialogs.h: 
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#if USESROUTINEDESCRIPTORS 

typedef UniversalProcPtr ModalFilterUPP; 

1te 1 se 

typedef ModalFilterProcPtr ModalFilterUPP; 

/fend if 

You can see from the above that if the flag USESROUTI NEDESCRI PTO RS is 
present, Modal Fil terUPP will be defined as a Universal ProcPtr. If it 
isn't, then Modal Fi lterUPP will be defined as a Modal Fil terProcPtr. A 
Modal Fi lterProcPtr is a type of ProcPtr, and can be used by 680x0-
based compilers. Dialogs.h also uses conditional compilation directives to 
define what NewModa l Fil terProc () looks like. If compiling takes place 
using a compiler that is to generate PowerPC code, 
NewModal Fil terProc() is defined such that it will create the necessary 
routine descriptor. If the compiling takes place using a compiler that gen­
erated 680x0 code, then NewModal FilterProc() won't create a routine 
descriptor. How the two different Metrowerks compilers handle procedure 
pointers is shown in Figure 7.8 and Figure 7.9. 

Using UniversalProcptrs In other Toolbox Calls 

In this chapter you've seen that the universal header files define the 
ModalFilterUPP to be of type UniversalProcPtr: 

typedef UniversalProcPtr ModalFilterUPP; 

This is done for the purpose of adding clarity to your source code. Declaring 
a variable to be a Modal Fil terUPP rather than a Universal P rocPtr makes 
it very evident as to the variables purpose. 
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--~" #if USESROUTINEDESCRIPTORS 
typedef UniversalProcPtr ModalFilterUPP; 

MW C/C++ PPC 

#else 
Using a PowerPC typedef ModalFil terProcPtr ModalFilterUPP; 
compiler results in 
ModalFilterUPP 
being defined as a #endif 
UniversalProcPtr 

ModalDialog () 
receives a 
ModalFil terUPP, 
which in this case is a 
UniversalProcPtr 

rny_filter_UPPisa 
UniversalProcPtr 

A routine descriptor 
is created here 

ModalFilterUPP rny_filter_UPP; 

rny_filter_UPP = NewModalFilterProc(My_Filter); 

II open dialog here 

ModalDialog( rny_filter_UPP, &the_itern ); 

FIGURE 7 .8 A COMPILER THAT GENERATES POWERPC CODE 

DEFINES A Modal Fi lte rU pp AS A Uni versa l p roe Pt r. 

Once a Modal Fi l t er UPP variable is declared, you use the 
NewModal Fil terProe() routine to create a routine descriptor for the 
filter function: 

ModalFilterUPP my_fi lter_UPP; 

my_filter_UPP NewModalFilterProc( My_Filter ); 

Modal Di al og () isn't the only Toolbox routine that requires a 
Uni versa l P roe Pt r. Every Toolbox function that requires that one of its 
parameters be the address of a function requires a Uni versa l Pro e Pt r. 
So the universal header files contain several typedefs that define 
Universal ProcPtr types that are descriptive of the purpose for which 
they'll be used. 
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- #if USESROUTINEDESCRIPTORS 
typedef UniversalProcPtr ModalFilterUPP; 

MW C/C++ 68K 

#else 
typedef ModalFilterProcPtr ModalFilterUPP; 

Using a 680x0 compiler #endif 

results in the type ~--------------------• 
ModalFilterUPP 
being defined as a 
ModalFilterProcPt~ 
which is a ProcPtr rny_filter_UPP 

A routine descriptor 
is not created here 

ModalDialog () 
receives a 
ModalFilterUPP, 
which in this case is a 
ProcPtr 

is a ProcPtr 

ModalFilterUPP rny_filter_UPP; 

my_filter_UPP = NewModalFilterProc(My_Filter); 

II open dialog here 

ModalDialog( rny_filter_ UPP, &the_itern ); 

FIGURE 7 .9 A COMPILER THAT GENERATES 680x0 CODE 

DEFINES A M 0 d a l Fi l t e r u p p AS A TYPE OF p r 0 c pt r. 

Consider TrackControl () as an example. This Toolbox routine 
accepts the address of an action procedure as its third parameter. The 
action procedure-which the programmer is responsible for writing-is 
called repeatedly while the user holds the mouse button down in a con­
trol. In the Controls.h universal header file you'll find this type definition: 

typedef UniversalProcPtr ControlActionUPP; 

Just as there is a function defined in the universal header files to create a 
filter function routine descriptor, so also is there a function defined to cre­
ate an action procedure routine descriptor-NewCont ro l Action P roe ( ) . 
Assuming you named your action routine My _ Action (), you're code 
would look similar to the following: 
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ControlActionUPP my_action_UPP; 

my_action_UPP = NewControlActionProc( My_Action ); 

Passing the address of a function to Toolbox routines such 
as Mod a lDi al og () and Trac kCont ro l C) is an option. If you 
pass nil in place of a function address-as is often the 
case-you don't need to declare a Universal ProcPtr or 
create a routine descriptor. 

I've covered two of the most common Universal ProcPtrs, but there 
are a lot more. Here, from the universal header files, are several more: 

typedef UniversalProcPtr ModalFilterUPP; 
typedef UniversalProcPtr ControlActionUPP; 
typedef UniversalProcPtr UserltemUPP; 
typedef UniversalProcPtr IOCompletionUPP; 
typedef UniversalProcPtr GrowZoneUPP; 
typedef UniversalProcPtr MenuDefUPP; 
typedef UniversalProcPtr MenuBarDefUPP; 
typedef UniversalProcPtr MCActionFilterUPP; 
typedef UniversalProcPtr DlgHookUPP; 
typedef UniversalProcPtr FileFilterUPP; 
typedef UniversalProcPtr DragGrayRgnUPP; 
typedef UniversalProcPtr WindowDefUPP; 

Remember, you don't have to create a routine descriptor for 
every function in your program. You are only required to cre­
ate a routine descriptor for routines that are called via a 
ProcPtr. That is, if the address of one of your functions is 
passed to a Toolbox routine, you must explicitly create a rou­
tine descriptor. If a routine in your program is directly called 
by another routine, it is not your responsibility to supply a 
routine descriptor or Uni versa l ProcPtr for that routine. 

How will you know, or remember, just when to use one of the many 
Uni versa 1 ProcPt rs? Keep in mind that they are only used for those few 
instances when you write a special routine whose address is passed to a 
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Toolbox function. You should quickly recognize those functions in your 
own code. And what of the times when you have to convert someone 
else's source code to PowerPC code? If you overlook something, don't 
worry-the compiler won't. When a PowerPC compiler looks for a 
Universal ProcPtr and doesn't find one, it will let you know. Figure 
7.10 shows the error message you'll receive what compiling with the 
Metrowerks MW C/C++ PPC compiler. Figure 7.11 shows the error gen­
erated by the Symantec CDK compiler. 

Messa e Window Iii 
•• Errors : 1 ¢¢ Warnings : 0 
•• Error : type mismatch {} 

UPPbadDemo .c line 58 ModalDialog < My...Fi lter , &the_item >; 

FIGURE 7 .10 THE METROWERKS ERROR MESSAGE WHEN 

A PROCPTR IS USED IN PLACE OF A UPP. 

Compile Errors 

F i le «LJPPbadDemo.c»; Line 66 
Error : cannot imp I icitly convert 
from : unsigned char <*__pascal Pascal func >< GrafPort*,EventRecord*,short *> 
to : RoutineDescriptor* 

FIGURE 7 .11 THE SYMANTEC ERROR MESSAGE WHEN 

A PROCPTR IS USED IN PLACE OF A UPP. 

There is one instance, though, where a Universal ProcPtr is necessary, 
yet the compiler won't notice or report it if you forget to include one. 
The UPP type is a UserltemUPP, and the Toolbox call that uses the UPP 
is SetDitem( ). SetDitem() can be used to change one of the properties 
of a dialog box item. When used for this purpose, the fourth argument to 
SetDitem() is a handle to the item. SetDitem() can also be used to 
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associate a drawing function with a user item. When used in this manner, 
the fourth argument is a handle to the drawing routine. In either case, 
this fourth argument to SetDitem() is a handle-so the compiler can't 
insist that it be a Universal P roe Pt r. 

Later in this chapter you'll find the source code for a short 
program that includes a user item. Look for the program 
named UPPdemo2. 

It will be your job to search your source code for any calls to 
SetDitem( ). You'll also want to search for SetDi al ogltem( ). The new 
universal header files now define both Set DI tern ( ) and the more 
descriptive SetDi al ogltem() to be one in the same routine-you can 
use either. If you come across a call to either routine, and it is used to 
associate a drawing routine with a user item, you'll need to modify the 
code to make use ofa Universal ProcPtr. Assuming I wrote a user item 
drawing routine called My _User ( ) , here's the 680x0 way of using 
SetDitem( ): 

II Open dialog, get item information 

SetDitem( the_dialog, MAN_USER_ITEM, the_type, 
(Handle)My_User, &the_rect ); 

Compare that with the PowerPC way of doing things-declare a UPP, cre­
ate a routine descriptor for the drawing routine, then typecast the UPP 
to a handle in the call to SetDitem( ): 

UseritemUPP my_user_UPP; 

my_user_UPP = NewUseritemProc( My_User ); 

II Open dialog, get item information 

SetDitem( the_dialog, MAN_USER_ITEM, the_type, 
(Handle)my_user_UPP, &the_rect ); 
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As I mentioned, the PowerPC compiler will not notice if you 
forget to convert your SetDitem() calls to PowerPC code. 
Your code will successfully be turned into a standalone 
application. When you attempt to launch the program, how-
ever, it will crash. 

UNIVERSALPROCPTR EXAMPLE PROGRAMS 

T he disk that accompanied this book has project files and source code 
files for a couple of programs that include UniversalProcPtrs. If 

you have CodeWarrior, look in the CodeWarrior Code f folder. If you own 
the Symantec Cross Development Kit (CDK), look inside the Symantec 
CDK Code f folder. 

ModalDialog() and UPPs 

Much of this chapter has used the Mod a 1Dia1 og ( ) Toolbox function as 
an example of when to use a Uni versa 1 ProcPt r. So it makes sense that 
the first complete UPP example involves the Mod a 1Dia1 og () function. 
This program, called UPPdemol, should look familiar to you. It's the 
same as the example program listed in Chapter 6-with one addition. 
Here, Modal Di al og() makes use of a filter function. And that means a 
UPP will have to be involved. Here's the source code listing in its entirety. 
An explanation follows. 

//+++++++++++++++ function prototypes +++++111111111 

void 
void 
pascal 

Initialize_Toolbox( void ); 
Open_Modal_Dialog( void ); 
Boolean My_Filter( DialogPtr 

Event Record 
short 

dlog, 
*event, 
*i tern ) ; 

//++++++++++++++++ define directives +++++++++++++++ 
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#define 
#define 

DIALOG_ID 
OK_BUTTON ITEM 

128 
1 

II+++++++++++++++++ global variables +++++++++++++++ 

II If you're using the Symantec CDK, uncomment the 
II following declaration. CodeWarrior users, leave as is 

II QDGlobals qd; 

II++++++++++++++++++++++ main ++++++++++++++++++++++ 

void main( void ) 
{ 

Initialize_Toolbox(); 

Open_Modal_Dialog(); 
} 

II+++++++++++++ initialize the Toolbox +++++++++++++ 

void Initialize_Toolbox( void 
{ 

} 

InitGraf( &qd.thePort ); 
InitFonts C); 
InitWindowsC); 
InitMenus(); 
TEini t(); 
InitDialogs( OL ); 
FlushEvents( everyEvent, 0 ); 
InitCursor(); 

II++++++++++++++ open a modal dialog +++++++++++++++ 

void Open_Modal_Dialog( void ) 
{ 

DialogPtr 
short 
Boolean 

the_dialog; 
the_ item; 
all_done =false; 

ModalFilterUPP my_filter_UPP; 
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} 

my_filter_UPP = NewModalFilterProc( My_Filter ); 

the_dialog = GetNewDialog( DIALOG_ID, nil, 
(WindowPtr)-lL ); 

ShowWindow( the_dialog ); 

while ( all_done ==false 
{ 

} 

ModalDialog( my_filter_UPP, &the_item ); 

switch ( the_item ) 
{ 

} 

case OK_BUTTON_ITEM: 
a 11 _done = true: 
break: 

DisposeRoutineDescriptor( my_filter_UPP); 
DisposDialog( the_dialog ); 

//+++++++++++I I I I I I filter function I I I I I I I I I I I I I I I I 

pascal Boolean My_Filter( DialogPtr dlog, 

{ 
long the_long; 
char chr: 

EventRecord *event, short *item ) 

if ( event->what != keyDown ) 
return ( false ); 

chr = event->message & charCodeMask: 

if ( chr == 'x' ) 
{ 

} 

*item= 1: 
return ( true ): 

return ( false ); 

The purpose of the Modal Di al og() Toolbox function is to handle user 
actions in a dialog box. A filter function has that same purpose. It, how-
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ever, handles events differently than Modal Di al og() would. What events 
it handles, and how it handles them, is up to you. In the UPPdemoI pro­
gram, the purpose of the filter function is to treat a press of the 'x' key 
the same as Modal Di al og ( ) would treat a mouse click on the OK but­
ton-the dialog box closes. 

A filter function has three arguments. The first is a pointer to the dia­
log for which the filter will be used. The second is a pointer to the event 
record that holds the event which the filter will work with. The last argu­
ment is a pointer to a short. Here's the prototype for the filter function: 

pascal Boolean My_Filter( DialogPtr dlog, 
EventRecord *event, 
short *item ); 

The function can assign this last argument the item number of an item 
in the dialog box. When the function completes, it will return a value of 
true if it handled the event and the Modal Di al og() need do nothing 
more with the event. Returning a value offal se tells Modal Di al og () 
that while the filter may or may not have used or altered the event 
record, Modal Di al og ( ) should still process the event in its normal man­
ner. 

The filter function examines the event record to see if a key was 
pressed. If it wasn't, then event- >what won't have a value of key Down. In 
that case the filter function ends. A value of fa l s e is returned to let 
Modal Di al og () know that the event wasn't processed-it should go 
ahead and do its thing. 

if ( event->what != keyDown 
return ( false ); 

If a key was pressed, the filter function carries on. It next determines 
which character was typed. If it was the letter 'x', the filter sets variable 
i tern to a value of I-the item number of the OK button. It then returns 
a value of true to let Modal Di al og() know that though the filter has 
altered things, further processing is needed by Modal Di al og (). 
Modal Di al og () will treat the event as it would if there was a mouse click 
in item number I-it closes the dialog box. 
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chr = event->message & charCodeMask: 

if ( chr = 'x' ) 
{ 

} 

*item= 1: 
return C true ); 

If the program makes it to the end of the filter function, a value of fa 1 s e 
is returned. That tells Mod a 1Dia1 og () tO go ahead and process the event 
as if nothing has happened. 

UPPdemol is a PowerPC program. So the call to Modal Di al og() 
needs to include a Universal ProcPtr. The Open_Modal_Di al og() rou­
tine first declares a Modal Fi 1 terUPP variable. It then calls 
NewModal Fi 1 terProc() to fill a routine descriptor with information 
about the My_Filter() filter function. NewModalFilterProc() also 
sets the my_fi 1 ter _UPP to point to this new routine descriptor. When it 
comes time to call ModalDi al og(), the Universal ProcPtr variable is 
passed. 

ModalFilterUPP my_filter_UPP: 

my_filter_UPP = NewModalFilterProc( My_Filter ); 

II open dialog, then loop until done 

ModalDialog( my_filter_UPP, &the_item ); 

Use your compiler to compile the UPPdemol code and to build a stand­
alone application. If you have forgotten how to do that, refer back to 
Chapter 6. When you run UPPdemol, note that you can click the mouse 
on the OK button or press the 'x' key to end the program. 

~ 
N 0 T E 
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Just a reminder that this is PowerPC code-so don't expect 
it to run on a 680x0-based Macintosh. In Chapter 8, you'll 
see how to get around this dilemma and produce applica­
tions that run on both the old and the new Macs. 
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Another Example of User Items and UPPs 

If you want a picture to appear in a dialog box, you can include a picture 
item in the dialog's 'DITL' resource. As your standalone program runs, 
you can be assured that the picture will be properly updated as windows 
or alerts overlap it. That's because the Dialog Manager knows how to 
update 'DITL' items. 

What about an instance where your program is to display a picture, but 
whi c h picture is to be displayed isn't established until runtime? Perhaps 
the user gets to make a selection that determines which one of two pictures 
will show up in a dialog box. In a case such as· this, you can't place a picture 
item in the 'DITL' of the resource file-you won't be able to fill in the 
resource ID of the 'PICT' that is associated with the picture item. True, you 
could simply draw the picture in the dialog box in response to the user's 
selection, but then it will be up to you to make sure the picture is properly 
updated every time the dialog becomes obscured and then comes back 
into view. A better solution is to make use of a user item. 

The UPPdemo2 program opens a dialog box that displays a picture 
and two buttons. Clicking the mouse on the Post Alert button will cause 
an alert to open. The alert serves only as a test to see if the picture, which 
is partially obscured by the alert, gets properly redrawn when the alert is 
closed. Figure 7.12 shows what you'll see when you run UPPdemo2. 

My only purpose is to 
obscure the user item. 

Post Alert 

Done 

FIGURE 7 .12 A LOOK AT THE UPPDEM02 PROGRAM. 
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When the alert is closed, the picture gets redrawn. The interesting part 
of the program isn't that the picture gets redrawn-you'd expect that in 
any Mac program. Rather, the point to note is that there is no update 
routine in the program. The picture gets redrawn without any effort on 
the part of the programmer. 

The resource file for UPPdemo2 contains an 'ALRT' and a 'DITL' 
that holds the items in the alert. It also contains a 'PICT' to hold the pic­
ture that will go in the dialog box. Figure 7.13 shows that picture. 

~-~ PICTs from UPPdemo2.µ.rsrc ~Iii 
1 .. ... .. ......................................... ... .. ................. 1 {r 

;, ............................................................ ....... ... : 

128 

FIGURE 7 .13 THE SINGLE 'PICT' RESOURCE 

IN THE RESOURCE FILE OF THE UPPDEM02 PROGRAM. 

Finally, the resource file holds the two resources that define the pro­
gram's dialog box-a 'DLOG' and a 'DITL'. Figure 7.14 shows what the 
'DITL' looks like. The gray rectangle is a user item. Though there's no 
connection between the user item and the 'PICT' resource in the 
resource file, there will be once the program runs. 

The source code for UPPdemo2 appears below. You'll find an expla­
nation immediately following it. 

//+++++++++++++++ function prototypes ++++++++++++++ 

void Initialize_Toolbox( void ); 
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8 Button ............................................ 
18] Check Box 

® Radio Button 

111 Control 

T: Static Text ( Post Rlert ) 

( Done ) 

············································ IOI Edit Text 

& Icon ............................................ 
t, Picture 

Efil User Item 

FIGURE 7 .14 THE SINGLE 'DITL' RESOURCE 

IN THE RESOURCE FILE OF THE UPPDEM02 PROGRAM. 

Open_Dialog( void ); void 
pascal void My_User( DialogPtr, short ); 

II+++++++++++++ define global constants +++I 11111111 

#define 
/fdefi ne 
//define 
/fdefi ne 
/fdefi ne 
/fdefi ne 

ALERT_ID 
DIALOG_ID 
DONE_BUTTON 
ALERT_BUTTON 
MAN_USER_ITEM 
THE_MAN_PICT_ID 

129 
128 

1 
2 
3 

128 

111 I I I I I I I I I I I I define global variables ++++++++++++ 

II If you're using the Symantec CDK, uncomment the 
II following declaration. CodeWarrior users, leave as is 

II QDGlobals qd; 

Boolean All_Done =false; 
EventRecord The_Event: 
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short The_Pi cture_ID: 

//1111111111111111111 main listing 11111111111111111 

void main( void ) 
{ 

Initialize_Toolbox(); 

The_Picture_ID = THE_MAN_PICT_ID; 

Open_Dialog(); 

while All_Done ==false ) 

} 

//1 I I I I I I I I I I I I initialize the Toolbox I I I I I I I I I I I I I 

void Initialize_Toolbox( void 
{ 

} 

InitGraf( &qd.thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEinit(): 
InitDialogs( OL ); 
FlushEvents( everyEvent, 0 ); 
InitCursor(); 

//111111111111111 open a modal dialog 11111111111111 

void Open_Dialog( void 
{ 
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short 
Handle 
Re ct 
DialogPtr 
short 
Boolean 

the_type; 
the_handle; 
the_rect: 
the_dialog; 
the_ item: 
dialog_done = false; 

UserltemUPP my_user_UPP; 

my_user_UPP = NewUserltemProc( My_User ); 
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the_dialog = GetNewDialog( DIALOG_ID, nil, CWindowPtr)-lL ); 

} 

GetDitem( the_dialog, MAN_USER_ITEM, &the_type, 
&the_handle, &the_rect ); 

SetDitem( the_dialog, MAN_USER_ITEM, the_type, 
CHandle)my_user_UPP, &the_rect ); 

ShowWindowC the_dialog ); 

while C dialog_done == FALSE 
{ 

} 

ModalDialog( nil, &the_item ); 

switch ( the_item 
{ 

} 

case ALERT_BUTTON: 
Alert( ALERT_ID, nil ); 
break; 

case DONE BUTTON: -
dialog_done = true; 
All_Done =true; 
break; 

DisposeRountineDescriptorC my_user_UPP); 
DisposDialog( the_dialog ); 

//++++++++++++ user item drawing routine +++++++++++ 

pascal void 
{ 

My_User( DialogPtr the_dialog, short the_item 

short 
Handle 
Re ct 
Graf Ptr 
PicHandle 

the_type; 
the_handle; 
user_rect; 
old_port; 
pict_handle; 

GetPort( &old_port ); 
SetPort( the_dialog ); 

GetDitem( the_dialog, the_item, &the_type, 
&the_handle, &user_rect ); 

pict_handle = GetPicture( The_Picture_ID ); 
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DrawPicture( pict_handle, &user_rect ); 

SetPort( old_port ); 
} 

UPPdemo2 begins with the usual function prototypes and 1/defi ne direc­
tives. All of the 1/defi nes are IDs of resources and 'DITL' items. The pro­
gram contains three global variables: Al l_Done signals the end of the pro­
gram, The_Event holds information about the most recent event, and 
The_Pi cture_ID contains the resource ID of the 'PICT' to display. 

The program begins by initialing the Toolbox. Then, 
The_Pi cture_ID is set to the value of the 'PICT' resource. This assign­
ment is made to demonstrate that the picture that is to be displayed in 
the dialog box could be determined at runtime. In a more involved pro­
gram The_Pi ctu re_ ID could be assigned its value in a statement such as 
the following: 

switch C users_picture_choice 
{ 

} 

case MAN_PICT: 
The_Picture_ID = THE_MAN_PICT_ID: 
break: 

case BOY_PICT: 
The_Picture_ID = THE_BOY_PICT_ID: 
break: 

default: 
The_Picture_ID = THE_DOG_COW_PICT_ID: 
break: 

After assigning The_Pi cture_ID its value, the program opens a modal 
dialog in which to display the picture. Here's another look at main ( ) : 

void main( void ) 
{ 

Initialize_Toolbox(); 

The_Picture_ID = THE_MAN_PICT_ID: 

Open_Dialog(); 
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while A 11 Done false ) 

} 

Open_Di al og () is the routine that holds the PowerPC code. This func­
tion declares a UserltemUPP variable named my_user _UPP. It then uses 
the NewUserltemProc() Toolbox function to create a routine descriptor 
for the My_User() drawing routine. The UPP variable my_user _UPP is 
assigned the address of this routine descriptor: 

UseritemUPP my_user_UPP; 

my_user_UPP = NewUseritemProc( My_User ); 

Next, a call to GetNewDialog() opens the dialog box. GetDltem() is 
first called to get the dialog item information of interest-which dialog, 
which item, etc. Then SetDitem() is called. The information that was 
received from GetDitem() is passed to SetDitem( ), along with the 
Universal ProcPtr. The fourth parameter passed to SetDitem() must 
always be a handle, so the UPP is typecast to one in the call. 

the_dialog = GetNewDialog( DIALOG_ID, nil, (WindowPtr)-lL ); 

GetDitemC the_dialog, MAN_USER_ITEM. &the_type, 
&the_handle, &the_rect ); 

SetDitem( the_dialog, MAN_USER_ITEM, the_type, 
(Handle)my_user_UPP, &the_rect ); 

After the call to SetDitem( ), the My_User() routine is bonded to the 
MAN USER_ITEM. That means that whenever the MAN USER_ITEM needs 
updating, the My _User ( ) routine will be called. The system will take care 
of this call-it need not be explicitly made by your program. The remain­
der of the Open_Di al og () code is straighforward stuff. It displays the 
dialog box with a call to Show_Wi ndow( ), repeatedly calls 
Modal Di al og () to process user mouse clicks on dialog items, and closes 
the dialog box with a call to Di sposeDi al og( ). 

The user item drawing routine accepts a pointer to the dialog box to 
draw to and the item number of the user item to draw into. The routine 
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saves the old port, then sets the port to that of the dialog. GetDitem() is 
called to get the size of the user item. GetPi cture() is called to get a 
handle to the 'PICT' resource defined by The_Pi cture_ID. Then, 
DrawPi cture() is called to draw the picture into the rectangle that was 
returned by Get DI tern ( ) . The routine ends by setting the port back to 
the original port. 

pascal void 
{ 

My_User( DialogPtr the_dialog, short the_item 

} 

short 
Handle 
Re ct 
Graf Ptr 
PicHandle 

the_type; 
the_handle; 
user_rect; 
old_port; 
pict_handle; 

GetPort( &old_port ); 
SetPort( the_dialog ); 

GetDitem( the_dialog, the_item, &the_type, 
&the_handle, &user_rect ); 

pict_handle = GetPicture( The_Picture_ID ); 
DrawPicture( pict_handle, &user_rect ); 

SetPort( old_port ); 

CHAPTER SUMMARY 

The Mixed Mode Manager allows a program to contain both 680x0 code 
and PowerPC code. The Mixed Mode Manager is responsible for keeping 
track of what mode the Mac should be in at all times-PowerPC or 
68LC040 emulator. There are occasions, however, where the Mixed 
Mode Manager can't make this determination without an assist from the 
programmer. You'll do that by including a universal procedure pointer, 
or UniversalProcPtr in your code. This new pointer type enables you to 
pass the address of one of your functions to a Toolbox routine. In 680x0 
development, this task was accomplished through the use of a ProcPtr. 

A Universal ProcPtr is a pointer to a routine descriptor, or 
Routi neDescri ptor. The Routi neDescri ptor data structure holds 
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information about a function, or routine, that is to be invoked. Among the 
many pieces of information in the Routi neDescri pt or is a flag that speci­
fies the instruction set architecture of the routine (680x0 or PowerPC), 
and a ProcPtr that, via the TVector, leads to the function's code. 

On a Power Mac, to pass a pointer to a function you first declare a 
Universal ProcPtr. Next, you'll create a routine descriptor and set up 
the UPP using one of the Apple-implemented macros that were designed 
just for this reason. Lastly, you'll use the UPP as the parameter that is to 
serve as the pointer to the function. 
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T o give your program the broadest appeal, you'll want to ensure 
that it runs in fast, native mode on a Power Mac, yet is still com­
patible with the huge number of 680x0-based Macintoshes still 

on the market. To do that you'll turn your program into a fat binary appli­
cation. Having a single program that runs on both 680x0-base Macs and 
PowerPC-based Macs means you won't have to supply the user with two 
separate versions of your program. 

There m ay be occasions when you know a program will be run only 
on a Power Macintosh. Perhaps the program was designed to take advan­
tage of the speed of the PowerPC, and won't run as smoothly on a 680x0-
based Mac. Or, you may have custom written the application for someone 
who has a Power Mac- or a network of Power Macs. For applications like 
this, you'll want to keep your program as a PowerPC-only application. 
You will, however, want to let users know why their attempts to run the 
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program on a 680x0-based Mac won't work. To do this, you won't create a 
fat binary-but you will use the principles of creating a fat application. 

Finally, you might want to take a fat binary designed by someone else 
and turn it into a PowerPC-only application. A fat binary is large in size­
it takes up much more disk space than its PowerPC-only version. If you 
have a fat application, and you know you'll only be running it on a 
PowerPC, you can reduce the amount of disk space it occupies by con­
verting it to a PowerPC application. 

FAT APPLICATION THEORY 

T urning your program into a fat binary application makes it backward 
compatible. That is, it will be compatible with pre-Power Macintosh 

era machines. In this section I'll cover the generalities of fat binaries. 
Much of the rest of the chapter will be devoted to specific instances of 
creating fat binaries. 

Applications and 680x0 /PowerPC Compatibility 

A Mac application created using a compiler designed to generate code 
for a 680x0 Mac will be able to run on any Macintosh-including Power 
Macs. However, when run on a Power Macintosh the application will be 
running in emulation mode. So while a 680x0, or 68K, program will run 
on a Power Mac, it won't be taking advantage of the speed gains of the 
PowerPC processor. Figure 8.1 uses the Metrowerks 68K compiler icon in 
an illustration of this idea. 

The apparent solution is to use a PowerPC cross-compiler to generate 
code that runs in the native mode on a Power Mac. This is only a partial 
solution, though. An application built to run on a Power Mac does so 
exclusively-it won't run on a 680x0 Mac. This is because PowerPC 
instructions will not be recognized by the 680x0 processor. In Figure 8.2 
the icon for Metrowerks other C/C++ compiler-a PowerPC version-is 
used to illustrate this. 
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68K compiler 

- ~~ 
MW CIC++ 68K 1 .0 68K App 

68K application 
runs on a 680x0 
Mac 

68K application 
runs in emulation 
on a Power Mac 

FIGURE 8.1 A 68K COMPILER GENERATES EXECUTABLES 

THAT RUN ON BOTH 68K AND POWERPC SYSTEMS. 

I PowerPC com_e!ler ) 

~ PowerPC app 
won't run on a 

- ~~ [ 
680x0 Mac 

or 

~ 
MW CIC++ PPC 1.0 PPC App PowerPC app 

runs in native 
on a Power Mac 

FIGURE 8.2 A POWERPC COMPILER GENERATES EXECUTABLES 

THAT RUN ON ONLY POWERPC SYSTEMS. 

If you create a Power PC version of a program and attempt to run it from 
the desktop of a 680x0 Macintosh, you'll encounter the system alert 
shown in Figure 8.3. An error ID of -192 represents a "resource not 
found" error. This error comes about when the Process Manager 
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attempts to load the program's code in memory, but can't find it. Code 
for a 680x0 application is kept in resources-in a PowerPC application it 
isn't. This will be fully explained later in this chapter. 

The application program "MyPowerPCProgram" 
could not be opened, because an error of type 
-192 occurred. 

FIGURE 8.3 A POWERPC APPLICATION WILL NOT RUN ON A 68K MAC. 

The complete solution is to build a fat application-also referred to as a fat 
app or fat mnary. A fat application contains all of the compiled code for two 
separate versions of a single application. This is achieved by building one 
version of the application using a 68K compiler and a second version of 
the application using a PowerPC. Then, a resource editor such as ResEdit 
or Resourcerer is used to combine the code from both versions into a sin­
gle program. This final program will run on a 680x0 Mac, and will run in 
native Power PC mode on a Power Mac. Figure 8.4 illustrates this. 
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Resource editor 

Res Edit 

Fat application 
runs on a 680x0 
Mac 

Fat application 
runs in native 
on a Power Mac 

FIGURE 8.4 A FAT BINARY IS CREATED BY COMBINING 

THE RESOURCES OF TWO VERSIONS OF THE SAME PROGRAM. 
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Two separate version of a program are created. then, from these two ver­
sions, a single fat application is formed. Figure 8.5 summarizes the 
process of making a fat application. 

68K compiler 

• r::> ~ 
MW CIC++ 68K 1.0 68K App 

Runs on 
a680x0 

Runs emulation 
on a Power Mac 

PowerPC compiler 

•u>~ MW CI C++ PPC 1.0 PPC App 

Won't run 
on a 680x0 

Runs native on 
a Power Mac 

Resource editor 

~'~~ ResEdit Fat App 

Runs on Runs native on 
a 680x0 a Power Mac 

FIGURE 8.5 DIFFERENT VERSIONS OF THE SAME PROGRAM RUN ON DIFFERENT SYSTEMS. 

Structure of a 680x0 Application 

All Macintosh files-including applications-can contain two forks: a 
resource fork and a data fork. A fork can be empty, or even nonexistent 
for any one file. For a 680x0 application file, both the code that makes 
up the application and the resources that the application uses are stored 
in the resource fork. The data fork will usually be empty. Figure 8 .6 
shows the structure of a 680x0 application. 
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N 0 T E 

The structure of a document file created by an application 
is generally the opposite of that of an application. In a doc­
ument, the resource fork is rarely used. The bulk of the 
file-such as graphics or text-resides in the data fork. 

Data fork Resource fork 

FIGURE 8.6 THE DATA FORK OF A 680x0 APPLICATION IS USUALLY EMPTY. 

Figure 8.6 shows that the executable code that makes up a 680x0 applica­
tion is stored in one or more 'CODE' resources. Since no one 'CODE' 
resource is allowed to exceed 32K in size, most programs contain more 
than one 'CODE' resource-the figure arbitrarily shows four 'CODE' 
resources. When a user double-clicks on a 680x0 application icon, the 
Segment Manager looks to the application's resource fork. It loads the 
application's code from the 'CODE' resources that are found there. 
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Figlire 8.6 also shows that the resources that are typically found in all 
Mac programs, such as 'DLOG' and 'DITL' resources, reside in the 
resource fork. With the arrival of System 7 Apple requested that develop­
ers include a 'SIZE' resource with an ID of -1 in each application. The 
'SIZE' resource contains information that the Process Manager needs in 
order to launch and allocate memory for an application. Figure 8.6 
includes a 'SIZE' resource in the resource fork. 

Structure of a PowerPC Application 

The general structure of a PowerPC application is the same as that of a 
680x0 application-it has both a data fork and resource fork. The con­
tents of the two, however, bear important differences. 

In Chapter 5 you saw that all PowerPC executable code-whether for 
an application, code resource, or shared library-is considered a code frag­
ment. To let the Process Manager know that it is dealing with a PowerPC 
code fragment rather than a 680x0 application, the resource fork of a 
PowerPC application contains a type of resource not found in 680x0 appli­
cations-the 'cfrg' resource. Besides telling the Process Manager that the 
application is a PowerPC application, the 'cfrg' resource-which has an ID 
of 0-indicates where the executable code is located. Unlike a 680x0 appli­
cation, the executable code of the PowerPC application is usually found in 
the application's data fork. Figure 8.7 illustrates this. 

Structure of a Fat Application 

When an application launches on a 680x0-based Mac, the Process 
Manager looks for a 'CODE' resource with ID 0 in the applications 
resource fork. Ifit finds one, it loads that 'CODE' resource and any other 
'CODE' resources that are marked for preloading. If executable code 
exists in the application's data fork, it will be ignored. Likewise, if a 'cfrg' 
resource exists it too will be ignored-the 'cfrg' resource type didn't exist 
prior to the PowerPC-based Macs. 
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Data fork Resource fork 

FIGURE 8. 7 THE DATA FORK OF A POWERPC APPLICATION 

HOLDS THE APPLICATION'S EXECUTABLE CODE. 

When an application launches on a PowerPC-based Mac, the Process 
Manager first looks for and examines the 'cfrg' resource with ID 0. This 
resource indicates where the executable code for the application is locat­
ed-usually in the application's data fork. If 'CODE' resources are pre­
sent in the resource fork, the Process Manager will simply ignore them. 

From the above two paragraphs it should be evident that if a single 
application contains executable code in two separate but complete for­
mats-one version in the data fork and one version as 'CODE' resources 
in the resource fork-than that application will be able to run on either 
a 680x0-based Macintosh or a PowerPC-based Mac. That is, in fact, just 
how a fat binary application is set up. Figure 8.8 illustrates the structure 
of a fat app. 
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Data fork Resource fork 

FIGURE 8.8 A FAT BINARY HOLDS TWO VERSIONS OF AN APPLICATION'S EXECUTABLE CODE. 

Not only will the fat application run on either type of Macintosh, but it 
will run native on the PowerPC. Without the executable code in the data 
fork and without the 'cfrg' resource, the application would still run on a 
PowerPC-but it would be the old, nonported 680x0 code that would 
run-not the faster, PowerPC code. 

Creating a fat application requires that you compile the same code 
twice-once using a 680x0 compiler and once using a PowerPC compiler. 
Then, using a resource editor the resulting applications are merged 
together to form a single fat application. Exactly how that is done is the 
topic of the next two sections. If your development system is Symantec's 
CDK, you might want to skip the next section and move right on to the 
Using Symantec's CDK to Create Fat Apps section. Or, if you haven't yet 
decided on a development system you might want to read both of the 
next two sections to see which system looks more appealing. 
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USING CODEWARRIOR TO CREATE FAT APPS 

T o create a fat application you'll make two versions of the same pro­
gram- a 68K version and a PowerPC version . Rather than go over 

the source code for a new program, I'll use the UPPdemol source code 
from Chapter 7 as my starting point. I created two new folders-one 
named UPP Demo 1 (PPC) f and the other named UPP Demo 1 (68K) 
f. I then copied the source code file and resource file from the (7) UPP 
Demo 1 f to each. Next, I renamed the files in the new folders. Since I'll 
be creating two similar programs, I included "(PPC)" and "(68K)" in the 
names of the project and source code files so that I won't mix things up. 
Figure 8.9 shows the results of my effort. 

-[ii (8) UPP Demo 1 PPC f ~1 
2 items 233 MB in di sk 92.2 MB availabl 

(7) UPP Demo 1 f 
ifr 5 item~ 233 MB in disk n ~ . 

~ n UP Pde mo 1 ( PPC) .c UP Pde mo 1 ( PPC) .µ .r src 
tzy . 

UP Pde mo 1.J.J UP Pde mo 1.c ¢1 1¢ Iii 

• ~ 
(8) UPP Demo 1 68K t 

2 ite ms 233 MB in di sk 92 .2 MB avail abl 
UP Pde mo 1 .xSYM UP Pde mo 1 .µ .rs r c n . ~ 

UP Pde mo 1 ( 68K) .c UP Pde mo 1 ( 68K) .).l.rs r c 

FIGURE 8.9 CREATE TWO FOLDERS, ONE TO HOLD A 

68K PROJECT AND ONE TO HOLD A POWERPC PROJECT. 

Creating the PowerPC Version 

To create the fat application you'll use both of CodeWarrior's two 
C/ C++ compilers. Begin by running the MW C/ C++ PPC compiler. 
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Create a new project named UPPdemo 1 (PPC). µ, making sure to save it 
in the UPP Demo 1 (PPC) f folder. Then add the source code file and 
the three libraries that are common to all PowerPC projects. Figure 8.10 
shows the project window for my project. The source code file is a copy 
of the first Universal ProcPtr example found in Chapter 7. If you'd 
like to see the source code, refer back to the UPPdemol example in 
Chapter 7. 

~- ~· U:PPdemol (PPC).JJ. 
File Code Data II • 

1 UPPdemo1 (PPC).c 0 i 0 i I!) 1} 
lnter-facelib 01 0 l I!) A 
Mathlib 0 i 0 i I!) 

.......... ~~-~~-~-~-~~~.!.+.~.~ ........ l... ........... .9.l... ........... .9.l... ............. .JEI .. 

4 file(s) OK OK 

FIGURE 8.10 THE PROJECT WINDOW FOR THE POWERPC PROJECT. 

To verify that the correct prefix file is being used, select Preferences 
from the Edit menu. When you do you'll see the Preferences dialog box. 
Click the Language icon to view the message area that includes the Prefix 
File edit box. For compiling with the PPC compiler, the prefix file must 
be the MacHeadersPPC file-as shown in Figure 8.11. 

While you're at the Preferences dialog box, click on the Project icon. 
That displays a new pane of information in the dialog box. Type in a file­
name-as shown in Figure 8.12. Then click the OK button. 

After dismissing the Preference dialog box, select Make from the 
Project menu. That creates a PowerPC version of the program. Select 
Quit from the Edit menu to return to the desktop. 
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To see this 
panel, click 
here 

Rpply to open project. 

~ 
El 

Font 

D 
Editor 

• ~ 
'Warnings 

Source Model: I Custom "" I 
Language Info:---------~ 

D Rctiuate C++ Compiler 

D RRM confor mance 

0 RNSI C/ C++ Key Words Only 

D Require Function Prototypes 

D EHpand Trigraph Sequences 

D Enums Rlways Int 

D Enable MPW Pointer Type Rules 

(Factory Settings J [ Cancel J (( OK B 

Make sure the MacHeadersPPC file is listed 
here when runn ing the PowerPC version of CodeWarrior 

Click 
here 

FIGURE 8.11 ALL CODEWARRIOR POWERPC PROJECTS 

USE THE MACHEADERSPPC PREFIX FILE. 

Enter the application 
name here 

Rpply to open 

n 
Linker 

n 
PEF 

Project type is an application 

nfo: ---------~ 

UPPdemo I (PPC) 

Creator J ???? 
'SIZE' Flags~ 

Type J RPPL 

Preferred Heap Size (k) J 384 

Minimum Heap Size (k) J 384 

[Factory Settings J [ Reuert Panel) [ Cancel J n OK ' 

FIGURE 8.12 SET THE POWERPC PROGRAM'S NAME BEFORE BUILDING THE APPLICATION. 
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Creating the 680x0 Version 

Now it's time to create a second version of the UPPdemol application. 
This time launch the 68K version of CodeWarrior-the MW C/C++ 68K 
compiler. Select New from the File menu to create a new project. Save it 
in the UPP Demo 1 ( 68K) f folder as UPP demo 1 ( 68K). µ. Add the source 
code file and the one library that's required for all 68K projects­
MacOS.lib. Figure 8.13 shows what my project window looks like. 

§Ii UPPdefllol (68K).JJ. 
File Code Data 151 .. 

1 UPPdemo1 (68K).c ! 0 ! 0 ! · [I {t 
.......... ~~~~.~.:~~~ ................... l... ........... .9.l... ........... .9.l... ................ rfl .. 

2 file(s) OK OK 

FIGURE 8.13 THE PROJECT WINDOW FOR THE 68K PROJECT. 

Recall that I copied the original UPPdemol.c file from my Chapter 7 
example-an example written to compile using a PowerPC compiler. 
With that in mind, do I now have to change any of the source code in 
order to compile it using the 68K compiler? No. The same source code 
can be used for both the 68K and PPC compilers. That's because 
CodeWarrior makes use of Apple's universal header files. Once I have my 
source code able to compile using a compiler that generates PowerPC 
executables, I can also use the same source code with a compiler that 
generates 68K executables. 

In Chapter 7 you read that the two Metrowerks C/C++ compilers 
require different MacHeaders prefix files. When compiling with the 
CodeWarrior PPC compiler, the MacHeadersPPC file must be the prefix 
file. For the CodeWarrior 68K compiler, the prefix file is 
MacHeaders68K. To verify that the 68K compiler is using the proper pre­
fix file, select Preferences from the Edit menu. Click the Language icon 
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in the Preferences dialog box to have the dialog display the proper 
panel. Make sure that the MacHeaders68K file is named in this edit box. 
If it's not, type it in-as shown in Figure 8.14. 

Click 
here 

Hpply to open project. 

n 
Font 

• Editor 

a 
. -

'w'arnings 

Source Model: I Custom ... I 
Language Info:-~~~~~~~~-. 

D Hctiuate C++ Compiler 

D BRM conformance 
0 HNSI C/C++ Key Words Only 

D Require Function Prototypes 
D EHpand Trigraph Sequences 

D Enums Hlways Int 
D Enable MPW Pointer Type Rules 

(Factory Settings) ( Cancel ) ( OK J 

Make sure the MacHeaders68K file is listed 
here when running the 68K version of CodeWarrior 

FIGURE 8.14 ALL CODEWARRIOR 68K PROJECTS 

USE THE MACHEADERS68K PREFIX FILE. 

Before dismissing the Preferences dialog box, click the Project icon. 
Type in a program name that will distinguish this version of UPPdemol 
from the PowerPC version-as I've done in Figure 8.15. 

Click the OK button to dismiss the Preferences dialog box. Then 
select Make from the Project menu. In a matter of seconds you'll have a 
68K version of the UPPdemol program. Select Quit from the File menu 
to exit the Code Warrior compiler. When you do, you'll find that you have 
a second version of the UPPdemol program. 
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Enter an application name that 
includes a reference to the CPU 
it's compiled for-the 680x0 

Project type is an application 

Click 
here 

Rpply to open 

Ji, i 
· ~ Ii 

Access P a\hs iQ-

Rpplication ...,. l 
nfo:--------

UPPdemo 1 (68K) 

Creator I???? 
'SIZE' Flags~ 

Type I RPPL 

Preferred Heap Size (k) 1384 

Minimum Heap Size (k) 1384 

[Factory Settings J [ Reuert Panel J [ Cancel J ([ OK )J 

FIGURE 8.15 SET THE 68K PROGRAM'S NAME BEFORE BUILDING THE APPLICATION. 

Creating the Fat Binary 

To create a fat binary version of the UPPdemol program you'll need to 
use a resource editor. Launch the editor and work your way into the UPP 
Demo 1 (68K) J folder as I'm doing in Figure 8 .16. Open the 
UPP demo I ( 68K) program (not the resource file). 

~ 
N 0 T E 

You'll be turning the PowerPC version of the program into a 
fat application. If for some reason you would like to retain a 
"PowerPC-only" application, make a copy of the UPPdemo1 
(PPC) program before altering it with the resource editor. 

Next, open the PowerPC version of the program. Figure 8.17 shows the 
resource files for both applications . Note that there is no 'CODE' 
resources in the PowerPC version, and no 'cfrg' resource in the 68K ver­
sion-just as expected. 
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I a (8) UPP Demo 1 (68K) f .... 1 i=l Hard Disk 

D UPPdemol (68K).c {} Eject 
D UPPdemo 1 (68K).SYM 
D UPPdemo 1 (68K).µ Desktop 
D UPPdemo 1 (68K).JJ..rsrc 

Cancel 

New 

n Open 

D Use Alias instead of original 

D 

FIGURE 8.16 OPENING THE 68K APPLICATION FROM THE RESOURCE EDITOR. 

~HOV l,.Al 
.JSR <AO) 
CHP Dl,::Z 
~Mr:~ 

RT< 

CODE 

0'10 1 I I OI 
00 10 I OO I 
0 11 0 10 10 
000 1 111 0 
(I I 00 0000 

XREF 

0 101 I IOI 
0010 1001 
0 11 0 1010 
0 001 111 0 
0100 0000 .. . 

DATA DITL 

(110 1 I IOI 
001 0 100 1 
01 10 10 10 
000 1 111 0 
O I 00 0000 

cfrg 

I - . e 
DLOG SIZE 

UPPdemo 1 (PPC) 

DITL DLOG 

«Th 
'8 
SIZE 

FIGURE 8.17 THE RESOURCE FILES FOR BOTH VERSIONS OF THE UPPDEMOl PROGRAM. 
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Now click on the CODE icon in the 68K resource file to select the 
'CODE' resources. Select Copy from the Edit menu. Then click on the 
PowerPC resource file and select Paste from the Edit menu. Do the same 
with each of the resources that appear in the 68K version but not in the 
PowerPC version. That includes the 'CODE, ' 'DATA, ' and 'XREF' 
resources. When you're done, your resource files should look like the 
ones pictured in Figure 8.18. 

ilHOIJ l ,.Al 
.J5R <AO) 
CHP Dl,2 
SMI!: ii ... 
CODE 

010 1 I I OI 
00 10 100 1 
0 11(11 0 10 
0001 111 0 
0 1(100000 

XREF 

UPPdemo 1 (68K) 

0 10 1 11 0 1 
00 10 100 1 

~ ~ 0 11 0 10 10 
0001 111 0 
010 0 (11)(10 

. 

DATA DITL DLOG SIZE 

§Im UPPdemol (PPC) 

0101 I I O I 
ilHOIJ l,.Al 

(HO I I IO I 
0010 1001 00101001 
01 10 1010 J5R<M> 01 JO 10 10 
000 1 111 0 CHP Dl,.2 0001 1 11 0 
0 1000000 £:;ME ii 01000000 

RT< ... 

cfrg CODE DATA DITL 

0101 I I O I 

~ ~ 
OO H) 100 1 
(1 11 0 10 10 
0001 111 0 . 
0 I 00 0000 

DLOG SIZE XREF 

FIGURE 8.18 THE RESOURCE FILES AFTER THE 68K RESOURCES 

HAVE BEEN COPIED TO THE POWERPC RESOURCE FILE. 

You've just created a fat binary application. The PowerPC version now 
contains all its original resources as well as the resources that were 
unique to the 68K version of the program. Save the resource files and 
exit the resource editor. 

To make it obvious that the Power PC version of the program is now a 
fat binary, rename it to something like UPPdemol (fat app) - as I'm 
doing in Figure 8.19. 
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(8) UPPdemo1(68K) 
5 items 162.6 MB in disk 37.4 MB available 

~ n . ~ 
UP Pde mo 1 ( 68K) .u UP Pde mo 1 ( 68K) .c UP Pde mo 1 ( 68K) 

r-- Iii (8) UPPdemol(PPC) liij ,__ 
5 items 162.6 MB in di sk 37.4 MB available 

~ n ~ 
~ 

. 

UP Pde mo 1 ( PPC) .u UP Pde mo 1 ( PPC) .c [UP Pde mo 1 (fat ap~)] 

~ • UP Pde mo 1 ( PPC) .u.rsrc UPPdemol ( PPC ).xSYM ro 
¢J 1¢ Iii 

FIGURE 8.19 GIVE THE NEW FAT BINARY AN APPROPRIATE NAME. 

To test your fat application try running it on both a 680x0-based Mac and 
a Power Mac. Unlike the PowerPC version, which won't run on a 680x0-
based Mac, this application will run on both systems. 

USING SYMANTEC'S CDK TO CREATE FAT APPS 

A fat application starts out as two versions of the same program-a 68K 
version and a PowerPC version . To save a little typing, I'll use the 

UPPdemol source code from Chapter 7 and turn it into a fat binary. I 
begin by making two new folders-one named UPP Demo 1 (PPC) f and 
the other named UPP Demo 1 (68K) f. Next, I copy the six files that I 
need for any Symantec CDK project to the PowerPC folder. Then I copy 
the source code file and resource file from the (7) UPP Demo 1 f to the 
68K folder-Symantec projects that result in 680x0 applications don't 
need the extra PowerPC files. Finally, I rename the copied files, making 
sure to include "(PPC)" and "(68K)" in the names so that I can keep track 
of things. Figure 8.20 shows the original folder and the two new ones. 
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10 items 

~ -
PPCBuild.ts 

~ 
cfrg.r 
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(8)UPP Demo I PPCf 1¥J~ 
6 items 233.6 MB in disk 91.6 MB available 

~ ~ iJ 
0 P-

- -
PPCBuild.ts UP Pde mo 1 ( PPC) .c UP Pde mo 1 ( PPC) .11 

17) UPP Demo 1 f 

~ ~ ~ 233.6 MB in disk 91.6 ~ -
cfrg.r UPPdemol (PPC).rsrc SIZE.r '{} 

~ iJ ¢1 1¢ Vi -
UPPdemol .c UPPdemo 1 .11 11 
~ ~ 

(B) UPP Demo 1 6BK f 
2 items 233.6 MB in disk 91.6 MB available -

UP Pde mo 1.rsrc SIZE.r 

~ ~ 
UPPdemol (68K).c UP Pde mo 1 ( 68K) .11.rsrc 

FIGURE 8.20 CREATE TWO FOLDERS, ONE TO HOLD A 

68K PROJECT AND ONE TO HOLD A PowERPC PROJECT. 

Creating the PowerPC Version 

Begin by double-clicking on the PowerPC project to launch the THINK 
Project Manager. The project window that opens will hold just about all 
the files you need for the project. Add the UPP demo 1 (PPC) .c file and 
the UPP demo (PPC) .rsrc file using the Add Files menu item. Then 
remove the UPPdemol.c and UPPdemol.rsrc files-they're remnants of 
the original UPPdemol project from Chapter 7. Figure 8.21 shows what 
your project window should look like. 

Double-click on the cfrg.r file to open it. This file contains the name 
that the standalone application will be given. Type in a new name, such 
as UPPdemol (PPC). That's what I've done in Figure 8.22. 

Now you're all set to create the PowerPC version of the program. 
Select Remove Objects from the Project menu, then choose Bring Up To 
Date from the same menu. Next, select Build PowerPC App from the 
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AppleScript menu. After a few moments the build will be complete and 
you 'll have one of the two applications you need. 

186 

~ UPPdemol (PPC).Tf .. ~ 
~Name 

v Source 
+ UPPdemo1 (PPC).c 

V Resources 
cfrg .r 

SIZE.r 

UPPdemo1 (PPC) .rsrc ........ .... .. ........... .. .... .. .... .. 
v Libraries 

lnterfacelib .xcoff 

Mathl ib .xcoff 

PPC CPlusL ib .o 

PPCCRuntime .o 

StdCLib .xcoff 

StdCRuntime .o 

v Scripts 
PPCBuild .ts 

l Totals 

........................................ 

FIGURE 8.21 THE PROJECT WINDOW FOR THE POWERPC PROJECT. 

18 Cfl]l.r 18J 
'*include "CodeFragmentTypes .r" 

II this 'cfrg' is created with version 5 of the 
resource ' cfrg' (0 ) { 

if> 

CodeFragmentTyl, 

mm 

} ; 

• 

{ 
kPowerPC, 
kFul llib , 
kNo\JersionNum, 
kNoUersionNum , 
kDefaultStackSize, 
kNoAppSubFolder, 
klsApp, 
kOnD i skF I at , 
kZeroO ff set, 
kWholeFork, 
"UPPdemo 1 (PPC )" 

II archType 
II updatelevel 
II current\Jersion 
II oldDefVersion 
II appStackS ize 
II appSubFo lder lD 
II usage 
II where 
Ii offset 
II length 
II <== Change this to be 

FIGURE 8.22 EDIT THE CFRG.R FILE TO SET THE APPLICATION'S NAME. 
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Creating the 680x0 Version 

Now you need to make a second version of the UPPdemol application. If 
you 've left the THINK environment, restart it now. If you're still in the 
THINK environment, close the PowerPC project now. The New Project 
dialog box will open. Click once on the words Empty Project in the list, 
and click once in the Create folder checkbox to uncheck it. The New 
Project dialog box is shown in Figure 8.23. 

New Pro·ect 

Select the type of project to create: 

Uisual Architect Project 
ANS I Project 
C++ I OStreams Project 
C++ Project 

D Create folder 

( Cancel J n Create J) 

FIGURE 8.23 SELECT THE EMPTY PROJECT OPTION AND 

UNCHECK THE CREATE FOLDER BOX WHEN CREATING A NEW PROJECT. 

I a (8) UPP Demo 1 68K f ..... 1. =Hard Disk 

D UPPdemol (68K:1.c 
D UPPdemo 1 (68K) . Tl.rsrc 

Name new project: 

I UPPdemo 1 (68K). n 

Eject 

Oesktop 

New tJ J 

[ Cancel J 

n Saue J] 

FIGURE 8.24 NAMING AND SAVING THE NEW 68K PROJECT. 
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Click the Create button. The dialog box will close and another one will 
open-it's shown in Figure 8.24. After working your way into the UPP 
Demo I 68K f folder, enter the name UPP demo I ( 68K) .1t for the project. 
Then click the Save button. 

An empty project window will open. Add the source code file and the 
MacTraps library to the project. Your project window should then look 
like the one pictured in Figure 8.25. 

UP Pde mo 1 (68K).1f 
Name Code 

V Segment 2 4 ~ Mac Traps 0 
UPPdemo1 (68K).c 0 
Totals 582 

-0 
1ii 

FIGURE 8.25 THE PROJECT WINDOW FOR THE 68K PROJECT. 

The UPPdemo I ( 68K) .c source code file is a copy of the UPP demo l .c file 
from Chapter 7. This source code was written to compile using a 
PowerPC compiler and run on a Power Mac. The question now arises as 
to whether or not you have to change any of the source code in order to 
get it to compile for a 68K Mac. You will, but only a single line. Look for 
the global declaration of the QDG 1oba1 s variable qd and either delete it 
or comment it out: 

II QDGlobals qd; <-only used for building PowerPC apps 

After writing source code for a PowerPC application, you can use that 
very same source code to compile a 68K version of the program-with 
the exception of the QDGl obal s variable. Apple's universal header files 
make this possible. 

To create the 68K version of the program, select Build Application 
from the Project menu. That menu is shown in Figure 8.26. Note that 
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you don't use a menu option from the AppleScript menu. The 
AppleScript menu is only used by the Cross Development Kit to build 
PowerPC applications. 

Close Project 
Close & Compact 
Switch To Project ~ 

Set Project Type ... 
Remoue Objects 

Bring Up To Date 8€U 
Check Link 8€L 
Build Library ... 

Use Debugger 
Run 8€R 

FIGURE 8.26 THE SYMANTEC PROJECT MENU. 

When the dialog box pictured in Figure 8.27 prompts you for an applica­
tion name, enter UPPdemol (68K). That will distinguish this application 
from your PowerPC version. 

Click the Save button. The Symantec compiler will compile and link 
the code to build an application. If you forgot to comment out the vari­
able qd, you'll see the error message displayed in Figure 8.28. Open the 
source code file and comment out the single line of code that declares 
the qd variable. Then select Build Application again. 

After successfully building the application, select Quit from the File 
menu to exit the THINK Project Manager. You'll now have two versions 
of the UPP demo 1 program. 
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loi (8) UPP Demo 1 68K f """I 
D !.WPth~mo ! ({)HKL< 
D !.WPih~mo ! {6HKL n 

~ G:=i Hard Disk 

D UPPd~~mol{M!K),n,r~1l: 

Saue application as: 

I UPP demo 1 (68K) 

[8] Smart Link 

( [j~~ct 

(Desktop ) 

H Saue Il 
( Cancel ) 

FIGURE S.27 NAMING THE &SK APPLICATION. 

··Unk Errors 
multiply defined: qd 

FIGURE S.2S FORGETTING TO COMMENT OUT THE QD VARIABLE 

DECLARATION IN THE 6SK VERSION RESULTS IN A LINK ERROR. 

Creating the Fat Binary 

Creating a fat binary version of the UPPdemol program entails the use 
of a resource editor. I'll be using ResEdit for the following example. Run 
the editor and work your way into the UPP Demo I ( 68K) f folder, as 
shown in Figure 8.29. 

190 

You'll be copying resources from the 68K version and past­
ing them into the PowerPC version-turning the PowerPC 
version into a fat application. If for some reason you want 
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to retain a "PowerPC-only" application, make a copy of the 
UPPdemo1 {PPC) program before editing it. 

Ja (8) UPP Demo 1 6BK f,.. I =Hard Disk 

Cl UPPdemol (68K).c 
Cl UPPdemo 1(68K).11 
Cl UPPdemo 1(68K).11 .rsrc 

D Use Alias instead of original 

Eject 

Desktop 

[ Cancel ) 

n Open D 

FIGURE 8.29 OPENING THE 68K APPLICATION FROM THE RESOURCE EDITOR. 

Now open the PowerPC version of the program. Figure 8.30 shows the 
resource files for both versions of the program. Note that the PowerPC 
version contains no 'CODE' resources, and the 68K version doesn't have 
a 'cfrg' resource-as expected. 

ollHOU l , Al 
.JSR <AO> 
CHP Dl , :Z 
HE:oll .,, 
CODE 

e . 

SIZE 

UPPdemo 1 (68K) 

0 10 1 I I O I 
00 10 100 1 
0 11 0 10 10 
0 00 1 111 0 
0 1000000 

DATA DITL DLOG 

0 101 I IOI 

0 10 1 I IOI 
00 10 100 1 
0 11 0 10 10 
000 1 111 0 
0 1000000 

DREL 

0 01 0 10 01 
0 11 0 101 0 §Iii~ UPPdemo 1 (PPC) ~Iii 
000 1 111 0 
0 1000000 

ZERO 
01 0 1 I IOI 
0010 1001 
0110 1010 
000 1 1 110 
0100000(> 

cfrg 

e -" = 
DITL DLOG 

tITJ'i 
'\;;!;} 
SIZE 

0 

FIGURE 8.30 THE RESOURCE FILES FOR BOTH VERSIONS OF THE UPPDEM01 PROGRAM. 
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Click on the CODE icon in the 68K resource file to select the 'CODE' 

resources. Select Copy from the Edit menu . Click on the PowerPC 

resource file and select Paste from the Edit menu. Do this for each of the 

resources that appear in the 68K version but not in the PowerPC version. 

That includes the 'CODE,' 'DATA,' 'DREL,' and ' ZERO' resources. 
When you're done, your resource files should look like the ones shown 

in Figure 8.31. 

.llHOU l ,A1 
.JSiiR CAO) 
CHP Dl , 2 
r;:M[ .ll 
RT< 

CODE 

~ . 

SIZE 

UPPdemo 1 (68K) 

0 1(1 1 1101 
(10 101(11)1 
M 10 10 10 
(1001 1110 
01000000 

DATA DITL DLOG 

0 101 I I OI §Im 00 10 1001 
01 10 1010 
00(1 1 1110 
01 (11)0000 0 10 1 11 0 1 

00 10 1001 

ZERO 0 110 1010 
000 1 111 0 
01000000 

cfrg 

0 10 1 1101 
1)010 1001 
01 10 1010 
000 1 111 0 
0100(h)00 

OREL 

010 1 1 10 1 
0 0101001 
0 11 0 1010 
0001 1 1 10 
01000000 

OREL 

.llHOIJ l,A l 
0 10 1 I I O I 
0010 100 1 

.JSiiR (AQ) 0 1 10 1010 
CHP Dl ,. 2 0001 111 0 
SM[ .ll O I 00 0000 
RT < 

CODE DATA 

(1 101 I I OI 

~ 
0010 1001 
0 11 0 10 10 
0001 111 (1 . 
O IO OO(u)O 

SIZE ZERO 

[2f3 
DITL DLOG 

FIGURE 8.31 THE RESOURCE FILES AFTER THE 68K RESOURCES 

HAVE BEEN COPIED TO THE POWERPC RESOURCE FILE. 

{7 

Iii 

You now have a fat binary application. The PowerPC version contains all 
its original resources, as well as the resources that were unique to the 68K 

version of the program. Any resources that appeared in both versions, 
such as the 'DITL' and 'DLOG', were identical to one another and didn 't 
need to be copied. Save the resource files and exit the resource editor. 

The fat application will still have the name UPPdemo 1 (PPC). 
Rename it so that it is obvious that it is now a fat binary. In Figure 8.32, 

I'm renaming the application to UPPdemol (fat app). 
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(81 UPP Demo 1 68K f 
4 i te ms 232.5 MB i n di sk 92.7 MB avai l able 

UP Pde mo 1 ( 68K) .c UP Pde mo 1 ( 68K) .11. r src UP Pde mo 1 ( 68K) .11 UP Pde mo 1 ( 68K) 

(8) UPP Demo 1 PPC f 
1 0 i te ms 232.5 MB in disk 

PPC Buil d.ts UP Pde mo 1 ( PPC) .c UP Pde mo 1 ( PPC) .11 

FIGURE 8.32 GIVE THE NEW FAT BINARY AN APPROPRIATE NAME. 

You can test the fat application by trying to run it on both a 680x0-based 
Mac and a PowerPC-based Mac. Unlike the PowerPC version-which won't 
run on a 680x0-based Mac-this application will run on both systems. 

GRACEFULLY EXITING A POWERPC·ONLY APP 

B uilding an application using a Power PC compiler such as the 
Metrowerks MW C/C++ PPC compiler or the Symantec CDK results 

in an application that only runs on a Power PC-based Mac. If the program 
is to run on both 680x0-based Macs and PowerPC-based Macs, you'll want 
to turn it into a fat binary. If you know that all of the users of a program 
you created use Power Macs, however, you'll want to leave your applica­
tion PowerPC-only. Depending on the size of the application, that strate­
gy can save a considerable amount of disk space. 
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PowerPC-only Applications and User-Friendliness 

If you do decide to keep a program PowerPC-only, you'll want to alert 
680x0 users who attempt to use the program. There's nothing more dis­
concerting then having a program fail when it is launched-with little or 
no explanation as to why. When the user of a PowerPC-only application 
attempts to launch the program on a 680x0-based Mac, the user will see 
the alert pictured in Figure 8.33. 

The application program "MWdemoPPC" 
could not be opened, because an error of 
type -192 occurred. 

FIGURE 8.33 A POWERPC APPLICATION LAUNCHED ON A 

680X0 MAC GIVES THE USER A NONDESCRIPTIVE ERROR MESSAGE. 

An error ofID -192 is a "resource not found" error. You and I know that 
this means that the 680x0 Mac looked for a CODE resource when it 
attempted to launch the application. Since it's a PowerPC application, 
the code is in the data fork, not in 'CODE' resources. It's very likely that 
the user of the program won't have any idea what error -192 means. You 
can help the 680x0 user out by having your PowerPC-only application 
display an alert like the one shown in Figure 8.34. It informs the user that 
the program can't be run on a 680x0-based Mac. Then the program can 
exit. That's called a graceful exit, and it's a feature that's quite easy to add 
to your PowerPC-only applications. 

Creating a fat application involves building two separate programs 
and then combining them into one. This is the same technique you'll use 
to create a PowerPC-only that displays a user-friendly alert when 
launched on a 680x0-based Mac. As an example, I'll start with the exist­
ing PowerPC-only version of UPPdemol. I'll create a small 680x0 pro­
gram that displays an alert, then merge the two applications. 
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Sorry, this program only runs 
on a Power Mac computer. 

K OK ~ 

FIGURE 8.34 THE RESULTS OF REPLACING THE SYSTEM 

ERROR MESSAGE WITH A MORE INFORMATIVE MESSAGE. 

The 680x0 Resource File 

The 68K program that is to merge with the PowerPC application has but 
a single purpose-to display an alert. In Figure 8.35 I've created a 
resource file that has an 'ALRT' resource and a 'DITL' resource in it. I've 
given both an ID of 129. 

AlertDemo(68K).,1.1.rsrc 

ALRT DITL 

~Iii~ OHL 1 D =•f29 from Alertoemo(61JK) 

Sorry, this program only runs 
on a Power Mac computer. 

OK 

FIGURE 8.35 THE RESOURCE FILE FOR THE 68K PROGRAM 

THAT WILL BE ADDED TO THE POWERPC PROGRAM. 
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When ResEdit creates a new resource it usually gives the resource an ID 
of 128. I changed the IDs of the two resources to 129 because the 
resource file for the UPPdemol program contains a 'DITL' with an ID of 
128-as shown in Figure 8.36. After both programs are built you'll copy 
the resources from the 680x0 application into the PowerPC application. 
You'll want to plan ahead so that you'll avoid a resource ID conflict. 

UPPdemo 1 (PPO.µ.rsrc 

DITL DLOG 

~-~Dill ID= 128 from UPPUemoHPPC 

OK 

FIGURE 8.36 THE RESOURCE FILE FOR THE POWERPC PROGRAM. 

CodeWarrior uses resource files with the "11" character in 
the file name-as shown in the previous two figures. If 
you're using Symantec's CDK, use the "1t" character that is 
part of that environment's naming convention. 

The 680x0 Source Code 

The source code file for the 680x0 application need do nothing but post 
the alert that's defined in the resource file. Using CodeWarrior, I created 
a project named AlertDemo. µ and a source code file AlertDemo.c. If 
you're using Symantec's CDK, name the project AlertDemo.7t. Here, in 
its entirety, is the source code for the 68K application. 
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//11111111+++++++ function prototypes ++++++++++++++ 

void Initialize_Toolbox( void ); 

//++++++++++++++++ define directives +++++++++++++++ 

ffdefi ne ALERT_ID 129 

//++++++++++++++++++++++ main ++++++++++++++++++++++ 

void main( void ) 
{ 

Initialize_Toolbox(); 

StopAlert( ALERT_ID, nil ); 
} 

//+++++++++++++ initialize the Toolbox +++++++++++++ 

void Initialize_Toolbox( void 
{ 

InitGraf( &qd.thePort ); 
InitFonts(); 
InitWindows(); 
InitMenus(); 
TEI nit(); 
InitDialogs( OL ); 
FlushEvents( everyEvent. 0 ); 
InitCursor(); 

Use your compiler to build the 68K application. Then quit to return to 
the desktop. 

Copying the Resources to the PowerPC-only App 

You add the 68K program to the PowerPC program in the same way you 
created a fat binary-you copy all the resources that are present in the 
68K program but are not found in the PowerPC application. Use your 
resource editor to open both applications-as I've done in Figure 8.37. 
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ALRT 

<HOI I IOI 
00 10 100 1 
Oc l 10 101 0 
0001 111 0 
0 1000000 ... 

XREF 

Alertoemo(68K) 

O I 01 11 0 I 
olH OU 1,Al O(ll 0 100 1 e .J~R <AO > 0 110 1010 

CHP Dl,2 000 1 1110 
~Mt,;, 0 I 00 0 000 

. 
•Tt ... 

CODE DATA DITL SIZE 

~Iii UPP demo 1 (PPC) 

01(1 1 11 0 I 
0010 100 1 e 0 11 0 I 010 
00-t.J I 111 0 
0 I0011)000 

. 
... 

cfrg DITL DLOG SIZE 

FIGURE 8.37 THE RESOURCE FILES FOR BOTH THE 

68K PROGRAM AND THE POWERPC PROGRAM. 

Iii 
0 

Copy the 'ALRT,' 'CODE,' 'DATA,' 'DITL,' and 'XREF' resource from 
the AlertDemo(68K) program and paste them into the UPPdemol (PPC) 
program. Figure 8.38 shows the results of this editing. Don't forget about 
the 'DITL' resource. When creating a fat binary, you won 't need to copy 
resources such as 'DITL,' 'DLOG,' and 'MENU'. That's because you're 
working with two versions of the same program. Here, you're combining 
two very different programs. The UPPdemol (PPC) application has a 
'DITL' with an ID of 128, while the AlertDemo(68K) program has a 
'DITL' with an ID of 129. 

Save the files and quit the resource editor. You can test the PowerPC­
only application by running it on both a 680x0 machine and a Power 
Mac. When you run it on the 680x0-based Mac you'll see the alert pic­
tured in Figure 8.39. When you click on the OK button, the application 
will exit and return to the desktop. 
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ALRT 

0101 11(11 
0010 1001 
0116 1010 
(1001 1111) 
0100 l)t(u) 

XREF 

Alertoemo(6BK) 

iilHOU l,A1 
.JSR <1110) 
CHP 11,:Z 
SME .a ... 
CODE 

ALRT 

DLOG 

0101 I IOI 
001011)01 
0110 1011) 
0001 111(11 
OIOO(u)On) ... 
DATA DITL 

m 
8 
SIZE 

· UPPdemol(PPC) 

0101 I IOI 
.aHOU 1,11111 

(1101111)1 
00101001 (1010 101)1 
0110 101(1 .JSR (AO) 011(11010 
0001 111(1 CHP £111,.:Z (1(11)1 111(1 
0 I OOO(u)(I IME iii 0 I 00 (U)l)I) ... ... 

cfrg CODE DATA 

1)101 1101 

@ 
(u)((l 1001 
011(11010 
00(11 1110 . 
0 I (U) (u)(U) ... 

SIZE XREF 

FIGURE 8.38 THE RESOURCE FILES AnER THE 68K 

RESOURCES HAVE BEEN ADDED TO THE POWERPC RESOURCE FILE. 

Sorry, this program only runs 
on a Power Mac computer. 

OK D 

FIGURE 8.39 THE MESSAGE THE USER SEES WHEN 

ATTEMPTING TO RUN THE POWERPC PROGRAM ON A 68K MAC. 
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STRIPPING FAT APPLICATIONS 

A fat application contains the code for two separate versions of a pro­
gram. A fat app can therefore occupy a lot of disk space-thus the 

word "fat" in the name. This almost doubling of an application's size may 
be worth the increased disk space-then again, it may not be. For some 
programs, turning the application into a fat binary may be crucial to its 
success-you may need to maintain the backwards compatibility that a fat 
app provides. There are situations, however, when you'll know that acer­
tain program will only be run on Power Macs, or only run on 680x0-based 
Macs. In a case such as this, there is no need to have an application that is 
almost double the size it needs to be. If you've created the program your­
self, the solution is simple-compile and build it using the appropriate 
compiler, and don't turn it into a fat binary. If you've obtained the pro­
gram from an outside source, however, you'll have to convert it yourself. 

As always, before altering a standalone application make 
sure to save a copy of the original program onto a floppy 
disk. 

Converting a Fat Binary to a PowerPC Application 

A fat application that will only be run on Power Macs can be converted to 
a PowerPC-only application to save disk space. This involves editing the 
applications resource fork to remove the 'CODE' resources. Power Mac 
programs don't make use of 'CODE' resources, so you know you'll be 
safe in doing this. 

To test this conversion process, I've made a copy of the fat applica-
1 tion version of UPPdemol that I created earlier. I'll work with the copy 

and retain the original, just in case something goes wrong. You'll find a 
folder named Strip to PPC f on the disk that came with this book. It 
holds a copy of both the unaltered UPPdemol (fat app) program and a 
version that I've stripped down to a PowerPC application. 

200 



Chapter 8 Fat Binary Applications 

To begin, start your resource editor. Then open the UPPdemol (fat 
app) program. You'll see a resource file like the one pictured in Figure 
8.40. Click the mouse on the 'CODE' resource icon and then select Cut 
from the Edit menu. The 'CODE' resources hold the bulk of the 68K ver­
sion of the program. There may be other resources associated with the 
68K version that aren't used by the PowerPC version- but unless you 
know for sure which resources these are, don't remove anything else. 
Since I created the original UPP demo 1 (fat app), I know that the 'DATA' 
resources and the 'XREF' resources were copied from the 68K version of 
UPPdemol. Since they only occupy a total of about 100 bytes, however, 
I'll leave them in. I don't want to get in the habit of deleting resources 
other than 'CODE' resources. 

If you know what other resources 
Delete the 'CODE' resources are 68K-specific, you can delete them 

UPPdemol (fat 
.. -------------

0 10 1 I I OI 
.;i HOIJ 1.-Al 

01(11 11 0 1 
00 10 I OOI 00 10 100 1 
01 10 101 0 J S:!!! (AO) 01 10 10 10 
000 1 11 10 CHP Dl.-2 Q(u)I 1 1 10 
(1 100000(1 ~Mt ii O l(l(l(U)(H) ... ••• 

cfrg CODE DATA DITL 

O l f.l l 1101 

e OOMIOOI 
0 1 M IO I O 
0001 1110 . 
0 100(1000 ... 

DLOG SIZE XREF 
{7 --------------
Iii 

FIGURE 8.40 THE RESOURCES THAT CAN BE DELETED 

FROM A FAT BINARY TO MAKE IT POWERPC-ONL Y. 

Save the resource file and quit the editor. You now have a PowerPC-only 
version of the program. Give the application a more appropriate name, 
such as UPPdemol (now PPC). If you now run the program on a Power 
Mac, it will run in fast native PowerPC mode-just as it did before. If, 
however, you attempt to run it on a 680x0-based Mac, you' ll get the sys­
tem alert that displays the -192 error. 
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Converting a Fat Binary to a 680x0 Application 

If you've obtained a fat application that you know will only be running 
on 680x0-based Macs, you can remove, or "zap," the data fork. The data 
fork holds the PowerPC version of the program, so deleting it will greatly 
reduce the size of the application. 

In this section I'll use the fat application version of UPPdemol that I 
created earlier in this chapter. Before I begin I'll of course make a copy 
of the UPP demo 1 (fat app) program and work on that copy. If something 
goes wrong, I'll still have the original, unaltered program. You'll find a 
folder named Strip to 68K f on the included disk. It contains a copy of 
the unaltered UPPdemol (fat app) program and a version of it that's 
been stripped to a 68K application. 

Before deleting the data fork there's one check you'll want to make. 
This check involves the 'cfrg' resource, so you should run your resource 
editor and open the UPPdemol(fat app) program. Double-click on the 
'cfrg' icon to see the contents of the 'cfrg' 0 resource. I've shown this in 
Figure 8.41. 

The primary purpose of the 'cfrg' resource is to provide the Process 
Manager with information about the application fragment. The 'cfrg' 
tells the Process Manager that the application's data fork contains an 
executable code fragment, and tells it where in the data fork the code is. 
While in almost all PowerPC applications the entire data fork is devoted 
to the fragment's code, there is the possibility that an application could 
use a part of the data fork for other purposes. If this is the case, the code 
fragment won't begin at the start of the data fork-it will be offset a num­
ber of bytes. 

Before deleting the data fork you'll want to verify that the code frag­
ment is in fact the first thing in the data fork. There are four bytes in the 
'cfrg' resource that give this information. The 'cfrg' has a strictly defined 
format, so these bytes always appear in the same place within the 
resource. In Figure 8.41 I've outlined the four bytes. 

The four bytes starting at 000038 in the 'cfrg' resource indicate the 
data fork offset at which the code fragment begins. If the four bytes pie-
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tured in Figure 8.41 all consist of zeros, the application code fragment is 
the first and only information in the data fork. An offset of zero means 
it's all right to zap the data fork. Any other numbers indicate that some 
information aside from the code fragment appears in the data fork. 
Since you don't know what this information is-and because the applica­
tion may rely on the information in order to run properly-you'll want to 
leave the application as a fat binary. 

~ 
N 0 T E 

000000 
000008 
000010 
000018 
000020 
000028 
000030 
000038 
00004 
000 
0 

ID= o from UPPdem1>Hfat app) 
0000 0000 0000 0000 DDDDDDDD 
0000 0001 0000 0000 DDDDDDDD 
0000 0000 0000 0000 DDDDDDDD 
0000 0000 0000 0001 DDDDDDDD 
7077 7063 0000 0000 pwpcDDDD 
0000 0000 0000 0000 DDDDDDDD 
0001 0000 0000 0101 DDDDDDDD 

r·ifo·a·a···aa·ac)"ioooo 0000 DDDDDDDD 
···a·oo·o ... ti'a·a·cr·oooo 0000 aaaoaaaa 
0038 0055 5050 6465 D8DUPPde 
606F 3128 5050 4329 mo1<PPC) 

These bytes tell where the code 
fragment starts in the data fork 

FIGURE 8.41 THE BYTES OF A 'CFRG' RESOURCE 

THAT INDICATE THE RESOURCE FORK OFFSET. 

A complete description of the information in each byte of 
the 'cfrg' resource can be found in Inside Macintosh: 
PowerPC System Software. 

After confirming that the code fragment data fork offset is 0, select Get 

Info from the File menu. If you're using ResEdit, the File menu looks 
like the one pictured in Figure 8.42. 

203 



Programming the PowerPC 

New ••• 
Open .•. 
Open Special 
Close 
Saue 
Reuert File 

Uerify ... 

Page Setup •.. 
Print ••• 

Preferences ••• 

Quit 

38N 
380 .. 
38W 
~s 

38P 

38Q 

FIGURE 8.42 THE GET INFO MENU ITEM IN RESEDIT'S FILE MENU, 

In ResEdit, selecting Get Info will bring up a dialog box like the one 
shown in Figure 8.43. Here you can see the size of the two forks that 
make up the application-the resource fork and the data fork. 

After deleting the data fork, I'll return to ResEdit and the Get Info 
dialog box to take a look at the size of each fork. If all goes well, the data 
fork size should be 0. 

To zap the data fork you'll want to use a utility designed for just that 
purpose. The disk that was included with this book contains just such a 
program. It's called DFerase, and appears in the Utility f folder. Quit 
your resource editor and go to that folder. Figure 8.44 shows the icon for 
the DFerase utility. 

Double-click the DFerase icon to launch the program. You'll see an 
introductory dialog box with the program's name in it. Click the Start 
button to dismiss it. At this point the screen will be empty. Select Open 
from the File menu. You'll see a dialog box like the one shown in 
Figure 8.45. 
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Info for UPPdemol (fat app) 

File: I UPPdemol (fat app) O Locked 

Type: I RPPL I Creator: I???? 
O File Locked O Resources Locked File In Use: Yes 
O Printer Driuer MultiFinder Compatible File Protected: No 

I Time: 16:27:37 PM created: I Tue, Jun 28, 1994 

Modified: I Tue, Jun 28, 1994 I Time: I 10:10:04 PM 

Size: 1709 bytes in resource fork 
1768 bytes in data fork 

.A 

Finder Fla-;j \7.H O 6.0.H 

O Has BNlf* O No IN ITs Label: I None ..-1 
O Shared [8J lnited 0 lnuisible 

O Statiom •i: O Rlias O Use Custom I con 

... 
The PowerPC version of this 
fat binary occupies 1768 bytes 

FIGURE 8.43 CHECKING THE SIZE OF THE FAT 

APPLICATION'S RESOURCE FORK AND DATA FORK. 

Iii Utility f Iii] 
2 items 233.8 MB in disk 91.4 MB availab 

~ 

~ EJ -
DFerase About DFerase 

to 
¢1 1¢ Iii 

FIGURE 8.44 THE ICON FOR THE DFERASE DATA FORK ZAPPER. 
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~Hard Disk 

EJect 

Desktop 

( Cancel ) 

-0 n Open l 
FIGURE 8.45 SELECTING THE FILE WHOSE DATA FORK IS TO BE REMOVED. 

Use the dialog's pop-up menu to move into the folder that contains the 
program whose data fork you wish to delete- as I've done in Figure 8.45. 
Then click the Open button. In just a moment you'll see the alert pic­
tured in Figure 8.46. Click the OK button to dismiss the alert, then select 
Quit from the File menu to exit DFerase. 

Data Fork Has Been 
Erased Successfully 

n OK D 

FIGURE 8.46 DFERASE GIVES CONFIRMATION THAT THE DATA FORK HAS BEEN DELETED. 

The last step in turning the fat binary into a 68K application is to remove 
the 'cfrg' resource. Again run your resource editor. Open the 
UPPdemol (fat app) program. Before deleting the 'cfrg', select Get Info 
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from the File menu. You'll see that the resource fork hasn't changed in 
size, but the data fork size is now 0-just as you want. This is shown in 
Figure 8.47. After confirming this, close the Get Info window. 

Info for UPPdemo1 (fat app) 

File: I UPPdemo1 (fat app) D Locked 

Type: I APPL I Creator: I???? 
D File Locked D Resources Locked File 1.n Use: Yes 
D Printer Driuer MultiFinder Compatible File Protected: No 

Created: I Tue, Jun 28, 1994 

Modified: I Tue, Jun 28, 1994 

I Time: 16:27:37 PM 

I Time: I 10:10:04 PM 

Size: 1709 bytes in resource fork 
O bytes in data fork 

.A 

Finder Fla~ "\1.H O 6.0.H 

D Has BNQ " D No IN ITs Label: I None ..,. I 
D Shared c;s [2J lnited D lnuisible 

D Station~ D Alias D Use Custom Icon 

ff --After zapping the data fork, 
the data fork size is zero 

FIGURE 8.47 USING RESEDIT'S GET INFO DIALOG 

TO VERIFY THAT THE DATA FORK HAS BEEN REMOVED. 

Now you'll delete the 'cfrg' resource. When running any application on a 
680x0-based Mac, the 'cfrg' resource-if present-is ignored. But if you 
attempt to run this modified application on a Power Mac, the system will 
examine the 'cfrg' resource and assume it is working with a PowerPC 
application. Since you've deleted the data fork, this is a situation you 
want to avoid. Click once on the 'cfrg' resource icon, then select Cut 
from the Edit menu. 

Select Save from the File menu and quit the resource editor. You now 
have a 68K application from what was a fat binary. Give the program an 
appropriate name, such as UPPdemol (now 68K). 
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r2i 
N 0 T E 

You can still run the new 68K version on a Power Mac-just 
as you can run any 68K application on a Power Mac. It just 
won't be running native PowerPC code anymore. Instead, It 
will be running the slower 680x0 code. Of course, for a triv­
ial program such as UPPdemo1 there won't be any notice­
able difference in speed. But for large, real-world applica­
tions there may very well be a difference. 

CHAPTER SUMMARY 

To keep the applications you develop in line with user demands, you'll 
want to ensure that they run in native mode on Power Macs. You'll also 
want to keep a broad market base by keeping your programs compatible 
with the millions of 680x0-based Macs that are currently in use. To do 
that, you'll modify your programs so that they become fat binary applica­
tions. A fat binary application, or fat app, or fat mnary, is a single program 
that runs on a 680x0-base Mac and runs native on a Power Mac. Creating 
a single fat binary means you won't have to supply the user with two sepa­
rate versions of your program. 

For those occasions when you know a program will be run only on a 
Power Macintosh, you'll want to make sure that users of 680x0-base Macs 
understand why their attempts to run your program fail. Using the prin­
ciples involved in creating a fat application, you can create a program 
that runs as planned on a Power Mac, but displays an informative alert 
when an attempt is made to run it on a 680x0-based Mac. 

A fat binary is large in size-it takes up much more disk space than its 
PowerPC-only version. If own a fat application developed by someone else, 
you can reduce the amount of disk space it occupies. Simply convert it to a 
PowerPC-only application by stripping the application of its data fork. 
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THE POWERPC 
NUMERICS ENVIRONMENT 

W 
henever you write code that performs a mathematical opera­
tion, you're using a numeric environment. Typically, this envi­
ronment consists of a set of routines that are a part of the pro­

gramming language you use . If your 680x0 code contains floating-point 
operations, your application is making use of routines found in the 
Standard Apple Numerics Environment- better known as SANE. 

The PowerPC-based Macintoshes don't use SANE. Instead, Power 
Macs use PowerPC Numerics. PowerPC Numerics is an environment used 
to allow quick and accurate computation of floating-point expressions on 
Power Macintosh computers. If your PowerPC code performs floating­
point operations, then you're using the PowerPC Numerics environment. 

In this chapter you'll see how PowerPC Numerics differs from SANE. 
Because those differences will need to be addressed when you port 680x0 
code to native PowerPC code, numerics porting considerations are also 
covered here. 
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SWITCHING FROM SANE TO POWERPC NUMERICS 

M acintosh applications running on a 680x0-based Macintosh make 
use of SANE-never PowerPC Numerics. PowerPC Numerics is 

only available on a Power Mac. When you run a 680x0 application that 
hasn't been ported on a Power Mac, it too will use SANE. Since older 
680x0 applications aren't familiar with PowerPC Numerics, SANE com­
patibility is a necessity. So when is PowerPC Numerics used? When you 
run a native PowerPC application on a Power Macintosh. Figure 9.1 
shows these three scenarios. 

210 

~ 
68K App 

~ 
68K App 

~ 
PPC App 

SANE 

SANE 

PowerPC 
Numerics 

68K applications use 
SANE on a 680x0 Mac 

68K applications use 
SANE in emulation on 
a Power Macintosh 

PowerPC applications 
use PowerPC Numerics 
in native mode on a 
Power Macintosh 

FIGURE 9.1 SCENARIOS FOR USING SANE AND POWERPC NUMERICS. 
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From Figure 9.1 you can see that porting code that uses SANE to 
PowerPC Numerics code is optional-680x0 applications that use SANE 
will run on a PowerPC. So why expend effort on porting properly func­
tioning SANE code to PowerPC Numerics code? Once again, the word 
"native" appears in the answer. These 680x0 applications will use SANE 
on a PowerPC, but they will use it in emulation mode. Porting this code 
will allow it to run in the much faster, native PowerPC Numerics environ­
ment. So for PowerPC development, you won't use SANE. As Metrowerks 
very bluntly states in its documentation, "SANE is dead." 

Why the need for an entirely new numerics system? Because the 
PowerPC microprocessor differs so greatly from the Motorola 680x0 
processors. SANE is based on an extended 80-bit data format. The 
PowerPC microprocessor relies on a 64-bit data format called double. 
While possible, attempting to force the double-based PowerPC to manip­
ulate data that is in an 80-bit format would be very inefficient. 

Coming from the 80-bit data format that's available on the 680x0 
processors to the 64-bit data format on the PowerPC seems like a step 
down. In most instances however, 64-bits is sufficient. And when it isn't, 
Power Numerics supports a 128-bit data format called double-double. 

POWERPC NUMERICS DATA FORMATS 

P owerPC Numerics makes use of three floating-point data formats: the 
single format, the double format, and the double-double format. Just 

as the 680x0 floating-point format is represented by the Pascal real data 
type and the C float data type, each of the PowerPC Numerics formats has 
a data type representation. The single format is represented by the float 
data type, the double format is represented by the double data type, and 
the double-double format is represented by the long double data type. 
Here are the declarations of a variable of each of these types: 

fl oat 
double 
long double 

the_single; 
the_double; 
the_double_double; 
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The Single Format 

The single format is represented by the float data type. A PowerPC 
Numerics float occupies four bytes. These 32 bits provide a range of 
-3.4E+38 to +3.4E+38 with seven to eight digits of precision. 

The Double Format 

The PowerPC Numerics double format is represented by the doubl,e data 
type. The doubl,e occupies eight bytes. The 64 bits of the double format give 
a range of -l .8E+308 to + l .8E+308 with fifteen to sixteen digits of precision. 

The Double-Double Format 

The double-double format is represented by the long doubl,e data type. A 
PowerPC Numerics long double occupies 16 bytes. These 128 bits provide 
the same range as the double format: from a minimum negative value of 
-l.8E+308 to a maximum positive value of+ l.8E+308. The difference 
between a double format and a double-double format is not in the size of 
the number that the types hold, but rather in the precision that the two 
types provide. While the double format yields numbers with fifteen to six­
teen digits of precision, the double-double format will provide no less 
than thirty-two decimal digits of accuracy. 

Since the double-double format offers no greater range of 
values, in most instances you'll be using the double format. 
Computations are performed much more quickly using the 
eight byte double than the sixteen byte double-double. 

Numeric Data Format Summary 

Table 9.1 is a summary of the attributes of the three PowerPC Numerics 
floating-point data types. Of the three types, you'll find that the double 
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data type provides the best compromise in terms of precision, range, and 
speed. 

TABLE 9.1 POWERPC NUMERICS DATA FORMAT SUMMARY. 

float double long double 

Size ( in bits ) 32 64 128 

Precision ( in digits ) 7-8 15-16 >=32 

Maximum positive value +3.4E+38 +1.8E+308 +1.8E+308 

Minimum negative value -3.4E+38 -1.8E+308 -1.8E+308 

NUMERICS LIBRARIES AND THE POWERPC 

I f you've ever used SANE for 680x0 development, you've included the 
SANE.h header file in your source code: 

#include <SANE.h> 

In your PowerPC source code, you'll want to substitute the fp.h header 
file for the SANE.h header file: 

#include <fp.h> 

If you used SANE functions, then besides the inclusion of the SANE.h 
header file, you also added the SANE library to your 680x0 project. 
Figure 9.2 shows a Symantec project window that includes the SANE 
library. Figure 9.3 shows a CodeWarrior 68K project window with the 
Metrowerks version of the SANE library, SANE.lib, included. 
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Name 

v Segment 2 

Mac Traps 

v Segment 3 
ANSI++ 

CPlusLib 

v Segment 4 

Test.cp 
Totals 

Test.ff 

4 
0 
0 
4 
0 

590 

FIGURE 9.2 INCLUDING THE SANE LIBRARY IN A SYMANTEC PROJECT. 

Iii Test.µ 
File Code Data ~ ,. 

1 Test .c J OJ OJ · [il {} 
~ ~;;;- ~i:~ ~[il 

.......... ~~~~-~-'.~~~ .............................. L ........... g.L. ........... g.L. ................. !D. 

3 file(s) OK OK 

FIGURE 9.3 INCLUDING THE SANE LIBRARY IN A METROWERKS PROJECT. 

Now, for PowerPC development, you'll use the MathLib library rather 
than a SANE library. If you use the Symantec CDK, and you use the 
method of copying an existing project folder to use as the basis of a new 
project, then your project will already have the MathLib in it. Figure 9 .4 
shows a typical Symantec PowerPC project with the MathLib. 
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Test. TJ 
Name Code 

VSource 4 '\) 

.......... !.~.S. ~:.C.P. ......... .. .. .. ................................................ g .. 1-=-
v Resources 4 

c~gr 0 
SIZE.I'" 0 
test.l'"sr-c 0 ........................................ ....................................................... 

V Libraries 4 
lnter-facel ib .xcoff 0 

± ~::::n~ o 
PPC CPlusl ib .o 0 
PPCCRuntime .o 0 
Std CL ib .xcoff 0 
StdCRuntime .o 0 ......................................................................................... ..... 

v Scripts 4 
PPCBuild .ts 0 

Tota ls 594 1-=-

;Q 
Iii 

FIGURE 9.4 INCLUDING THE MATHLIB LIBRARY IN A SYMANTEC PROJECT. 

Chapter 6 made the recommendation that CodeWarrior users always add 
the same three libraries to their Power PC projects. One of those libraries 
was MathLib. Figure 9.5 shows the project window of an MW C/ C++ PPC 
project with the MathLib included. 

Test.µ 
File Code Data ~ ' 
Test.c 0 [J {r 
lnterfacelib 0 ! [J 

~.I!!l!!!:!! ....... .-.....---..i:..;.;.;.Ll~.:J!li--.......l!!:i,.:..;.....;--l l!I 
.......... t:'.'~.c.'.~.~.~.~~~.!. :.~.~.h. ............. .L.. ........... .9-L ........... .9.L .......... ...... lll. 

4 file(s) OK OK 

FIGURE 9.5 INCLUDING THE SANE LIBRARY IN A METROWERKS PROJECT. 
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NUMERICS PORTING CONSIDERATIONS 

U nfortunately, porting floating-point numerics is not quite as easy as 
just including MathLib rather than Sane in your PowerPC projects, 

and substituting fp.h for SANE.h in your source code. While fp.h has just 
about every function found in SANE.h, there are differences between the 
function headers listed in the two files. Firstly, the data type of some para­
meters varies for some functions. Secondly, and to a lesser degree, the 
number and order of parameters varies for some functions. 

The extended and double_t Data Types 

PowerPC Numerics does not support the SANE extended floating-point 
format. Instead of the 80-bit extended format, PowerPC Numerics sup­
ports the 64-bit doubl e_t format. You'll find the doubl e_t format 
defined in the Types.h universal headers file such that it will be interpret­
ed as 64 bits by both PowerPC compilers and 680x0 compilers. Here's a 
part of that definition: 

1/ifdef appl ec 
typedef long double double_t; II 68K long double is 64 

bits 

/lelif powerc 
typedef double double_t; II PPC double is 64 bits 

/lendif 

If you compile with a PowerPC compiler, double_t is defined to be of 
type doub 1 e. A PowerPC doub 1 e is 64 bits. If you compile with a 680x0 
compiler and the compiler encounters a variable that is declared as a 
doub 1 e_t, the compiler will consider it a 1 ong doub 1 e. A doub 1 e on the 
680x0 is 32 bits, while a 680x0 1 ong double is 64 bits in size. 

Since PowerPC Numerics doesn't use the extended format, and 
SANE relies heavily upon it, the conversion from extended to do u b 1 e_ t 
may be your biggest numerics porting concern. You'll want to search 
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your source code for the word "extended" and replace all occurrences of 
it with "double_t." As you do so, though, you'll also want to have both the 
SANE.hand fp.h header files open. When you encounter a SANE func­
tion that has a parameter or return type of extended, you'll want to com­
pare the SANE.h version of the function header with the fp.h version. 
For some functions, the number or order of the arguments may differ. 

As an example, consider the SANE function seal b (). This function 
multiplies x times 2An, where x and n are values passed in as parameters. 
In SANE.h, s cal b ( ) is defined as: 

extended scalb( short, extended ); 

Here's a 680x0 code snippet that makes a call to seal b (): 

short n = 2; II first parameter to scalb() 
extended x = 3; II second parameter to scalb() 
extended result; II hold result returned by scalb() 

result = scalb( n. x ) ; II X * 2An = 3 * 2A2 = 3 * 4 = 12 

Power PC Numerics also supports the s cal b ( ) function, but the argu­
ments and return type are different than those found in the SANE imple­
mentation of seal b(). Additionally, the ordering of the two arguments 
is reversed. In fp.h, s cal b ( ) is defined as: 

double_t scalb ( double_t x, long int n ); 

In PowerPC Numerics, x is listed first and n is listed second. That's the 
opposite of the SANE definition of the same function. Here's a PowerPC 
snippet of code that makes a call to s cal b ( ) : 

double_t 
long int 
double_t 

x = 3; 
n = 2; 
result; 

II first parameter to scalb() 
II second parameter to scalb() 
II hold result returned by scalb() 

result= scalb( x, n ); 
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Eliminate the comp Data Type 

When a very high degree of precision is necessary, some SANE routines 
make uses of the comp data type. The comp data type offers 64 bits of pre­
cision. Since PowerPC Numerics offers no comp type, you'll have to 
replace any usage of this type with a PowerPC Numerics type. The 
PowerPC Numerics doub 1 e offers 53 bits of precision-that translates to 
15 to 16 decimal digits of accuracy. You should search your source code 
listings for each occurrence of comp and, where acceptable, replace these 
references with doub 1 e. If still more accuracy is needed you can use the 
PowerPC Numerics 1 ong double type. 

Be Aware of How Expressions Are Evaluated 

In SANE, all floating-point operations are performed using extended 
precision. PowerPC Numerics has no extended equivalent. Operations 
involving large values that compiled properly on a 680x0 compiler may 
not yield the correct results on a PowerPC compiler. In particular, you'll 
have to be watchful for midexpression overflow. Consider this snippet: 

double d_l = 1.6E+308; 
double d 2 = 1.4E+308; 
double answer; 

II max double is 1.8E+308 
II max double is 1.8E+308 

answer = ( d_l + d_2 ) I 2; II (3.0E+308)12 = 1.5E+308 

Because midexpression ( d_l + d_2) has a value larger than the maxi­
mum value a double can hold (l.8E+308), a 680x0-base Macintosh will 
use the SANE extended data type to hold the result of the midexpres­
sion. After the midexpression value of 3.0E+308 is divided by 2, the result 
will be stored in the do u bl e variable answer. 

On a PowerPC, the above snippet will generate a midexpression over­
flow, and the final result will be unusable. PowerPC Numerics has no 
extended data type, so the midexpression value of 3.0E+308 cannot be 
properly stored. On a PowerPC, you'll want to evaluate numeric opera-
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tions and, where necessary, separate one involved operation into two or 
more simpler operations. For the above snippet, you could rewrite the 
one numeric operation into three separate ones: 

double d_l = 1.6E+308; 
double d_2 = 1.4E+308; 
double temp_l; II divide each value separately, 
double temp_2; II holding the results in temp 

II vars 
double answer; 

temp_l d_l I 2; II (1.6E+308)12 = 0.8E+308 
temp_2 d_2 I 2; II (1.4E+308)12 = 0.7E+308 
answer = temp_l + temp_2; II (0.8E+308 + 0.7E+308) = 

II 1. 5E+308 

PowerPC compilers define a minimum evaluation format that is used in all 
expression evaluations performed by that compiler. The minimum evalu­
ation format specifies the least precision that will be used in all expres­
sion evaluations. The compiler designers will implement this minimum 
evaluation format as any one of the three PowerPC Numerics data format 
types: single, double, or double-double. 

If a compiler has a minimum evaluation format of double, then all 
operands of less precision than a double will be promoted to a double 
during evaluation of that expression. Consider the expression in this 
snippet: 

float 
fl oat 
double 

s_l = 1. 5E+20; 
s_2 = 1. OE+20; 
answer; 

answer = s_l * s_2; 

If the minimum evaluation format is double, then each of the two sin­
gle format variables (C fl oat types) will be temporarily promoted to 
do u b 1 e during expression evaluation, and the result of their multiplica­
tion together will also be temporarily held in a double. This is shown 
in Figure 9.6. 
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Minimum evaluation format = double 

float s_1 

float s_2 

11. 5E+20 ~ 

11. OE+20 I 

answer = ( s_1 * s_2 

1. 5E+20 1.0E+20 

1.5E+40 

] 

Variables 
of type float 
are stored 
in single 
format 

During 
expression 
evaluation, 
floats get 
temporarily 
promoted to 
double format 

FIGURE 9.8 WHEN THE MINIMUM EVALUATION FORMAT IS DOUBLE, 
SINGLE YAWES ARE PROMOTED TO DOUBLE. 

If the minimum evaluation format is single rather than double, then 
each of the two single format variables in the previous snippet will 
remain in single format during expression evaluation. Because interme­
diate operations aren't temporarily held in a larger data format, the 
potential for overflow increases. In Figure 9.7, the same values that were 
used in the example for a minimum evaluation format of double are 
used. Yet here, the result of the multiplication operation will be garbage. 
That's because while each of the two fl oat variables is in range, the 
result of their multiplication together (l.5E+40) exceeds the maximum 
value that the single format can hold (l.8E+38). 
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Minimum evaluation format = single 

float 

float 

s_1 

s_2 

11. 5E+20 I 
11. OE+20 I 

answer = ( s_1 * s_2 

???? I 

] Variables 
of type float 
are stored 
in single 
format 

During 
expression 
evaluation 
there is the 
potential for 
overflow­
that's because 
floats remain 
as singles 

FIGURE 9.7 WHEN THE MINIMUM EVALUATION FORMAT IS SINGLE, 

THE POTENTIAL FOR OVERFLOW INCREASES. 

From the preceding discussion and figures, it seems that the higher, or 
"wider'', the minimum evaluation format, the better. After all, overflow 
resulting from expression evaluation is obviously reduced when the for­
mat is double as opposed to a format of single. There are advantages, 
however, to using the single format. 

~ 
N 0 T E 

Though the double-double format exists for high-precision 
numerics, the PowerPC Numerics are based on the single 
and double formats. Thus Power Macintosh compilers 
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implement either the single or double format for the mini­
mum evaluation format. 

If an expression contains variables of both single and a double format, 
then the evaluation of that expression will take place in a double format. 
This is true regardless of the minimum evaluation format. Consider the 
expression listed here: 

float s_l = 1.5E+20; 
double d_l = 1.0E+50; 
double answer; 

answer= s_l * d_l; 

Here, the intermediate result of ( s_l * d_l ) is held as a doubl,e. That's 
because a double, d_l, is involved in the expression. So while the result 
of the above multiplication (l.5E+70) would overflow a single, the opera­
tion will still be successful because a double is used to hold the interme­
diate result. In instances such as this, the minimum evaluation format 
isn't a consideration. 

The single minimum evaluation format yields the fastest results in the 
evaluation of single-precision expressions. And, expressions that involve 
a mix of single and double types can be evaluated accurately due to the 
compiler's ability to store intermediate results in the more precise dou­
ble format. 

The double minimum evaluation format has the advantage of pre­
venting midexpression evaluation overflow. However, expressions involv­
ing only single format variables will be evaluated less efficiently than they 
would be with a single minimum evaluation format compiler. That's 
because the single types will be promoted to double types before the eval­
uation-even if the single-precision variables are small and the potential 
for overflow doesn't exist. 

r2J 
N 0 T E 
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evaluation format of single, while the Symantec CDK uses a 
minimum evaluation format of double. 

As you write PowerPC code, you should keep in mind the different way 
PowerPC Numerics handles numeric operations. You'll also want to 
closely examine numerical operations in your 680x0 code that is being 
ported to PowerPC code. Keep a watchful eye open for overflow condi­
tions in both the final value of an expression and in intermediate results. 

CHAPTER SUMMARY 

A numerics environment defines the way a computer performs 
numeric operations. On a 680x0-based Macintosh, SANE is that 

environment. On a PowerPC-based Macintosh, the environment is 
PowerPC Numerics. The evaluation of any floating-point expression on 
the Power Macintosh involves the PowerPC Numerics environment. 

PowerPC Numerics makes use of three floating-point data formats­
each represented by a C data type. The single format, the double format, 
and the double-double format are represented by the fl oat, the double, 
and the 1 ong double, respectively. The fl oat is a 4-byte data type, while 
the double and 1 ong double each occupy 8 bytes. Though the range of 
the double and the 1 ong double is the same, the 1 ong double has 
greater precision. The trade-off is that the PowerPC cannot manipulate 
1 ong double variables as quickly as it can double variables. Since the 
great precision of the 1 ong double is seldom needed, the double data 
type is the most commonly used PowerPC Numerics data type. 

If you used SANE routines on a 680x0-based Macintosh, you included 
the SANE.h header file in your source code and the SANE library in your 
project. For the Power Mac, you'll instead include the fp.h header file 
and the MathLib library. While most of the routines in fp.h match those 
found in SANE.h, they are not all identical. You'll keep this in mind as 
you port 680x0 source code to native PowerPC code. Another porting 
consideration is that Power Numerics doesn't define the 80-bit extended 
data type found in SANE. 
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Compilers define a minimum evaluation format to determine how 
midexpression evaluation is stored in memory. A format of type double 
means that operands of type single will be promoted to double before a 
numerical operation is performed. This decreases the likelihood of over­
flow. A minimum evaluation format of single means operands of type sin­
gle won't be promoted. Though the chances of midexpression overflow 
increase with this format, the speed at which numeric operations can be 
performed also increases. 
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PORTING CODE TO 
NATIVE POWERPC 

Almost any program written for a 680x0-based Mac will run on a 
PowerPC. Apple put a great effort into keeping existing code 
compatible by creating the 68LC040 Emulator that's built into 

every Power Mac. So why bother expending the effort to port 680x0 code 
to PowerPC code? To avoid the 68LC040 Emulator. While 680x0 applica­
tions will run on a Power Mac, they do so at the cost of constantly using 
the software emulator- slowing things down considerably. To take advan­
tage of the greater speed of the PowerPC chip, you'll want to port your 
code and then recompile it so that your program's instructions become 
native to the PowerPC chip. 

Much of the work involved in turning 680x0 code into PowerPC code 
is handled by the compiler and linker that make up your development sys-
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tern, and by the Code Fragment Manager and Mixed Mode Manager. But 
while many of the intricacies of making old code run on new machines 

- has been taken care of for you, there are still plenty of subtle-and a few 
not-so-subtle-changes you'll be responsible for. This chapter covers those 
changes you'll be responsible for. 

PORTING PREPARATION 

Before beginning the port of your 680x0 source code to PowerPC 
code, you'll want to take care of a couple of preliminary matters. The 

first task is easy-make sure your development environment is making 
use of Apple's universal header files. The second may or may not be 
easy-it depends on whether you have assembly language included in 
your 680x0 source code. 

Use the Universal Header Files 

First and foremost, make sure you're using the universal headers-some­
times referred to as the universal interface files. The header files are nec­
essary if you're going to port to PowerPC. They hold information about 
universal procedure pointers and other PowerPC-specific data types. 
Figure 10.1 shows a few of the hundred-plus header files. Many of the file 
names, such as Dialogs.h and Events.h, should look familiar to you. 
Other files, such as FragLoad.h and fp.h (discussed in Chapter 9), are 
new to the PowerPC. 

If you're using the Symantec CDK, you don't have to do anything spe­
cial to make use of these header files. Symantec gives you both the older 
Apple #includes and the universal header files in separate folders. The 
compiler will use the headers that appear in whichever folder doesn't have 
its name nested in parentheses-as shown in Figure 10.2. 
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§Iii~ Uniuersal Headers ~~ 
1 08 items 256. 5 MB in di sk 6 7. 7 MB avi ........................................................... ............................ 

Name Size Ki 

D Dialogs. h 1 7K ~ 
D Dictionary .h 6K !l!!l! 
D Disk I nit.h 6K 

mm D Disks.h 6K 

D Displays. h 1 1 K I D Editions .h 1 7K 

D ENET .h 6K 

D EPPC.h 6K mm 
D Errors.h 39K 

Ill D Events. h 1 1 K 

D Files. h 77K 

D FileTransfers. h 17K ~m~l 
D File T ra nsfe rToo l s. h 6K 

·::j:: 

mm 
D Finder.h 6K 

mm D FixMath.h 6K 

D Folders .h 6K 1111!1 

D Fonts.h 1 1 K mm 
D fp .h 28K :::.:; 

~ D Fragload .h 1 1 K '-0-

• ~ Vi 

FIGURE 10.1 SOME OF THE HEADER FILES FROM THE UNIVERSAL HEADERS. 

15 

Deuelopment 

Symantec C++ for Macinto sh 
14items 

Mac #j nc l udes ~ 

Mac #includes 
256.4 MB in disk 

~ 
Uni versa l Heade rs ( Apple #includes) 

Nesting this folder's name between parentheses forces 
the Symantec compiler to use the universal header files 

FIGURE 10.2 SYMANTEC SUPPLIES BOTH THE OLDER 

INTERFACE FILES AND THE NEW UNIVERSAL HEADERS. 
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The Metrowerks compilers also come with a folder that houses the uni­
versal header files. The older Apple #include header files aren't sup­
plied. Even if you intend to continue to write code that you feel will 
never run on a PowerPC, you can and should still use the new universal 
headers. Figure 10.3 shows the Metrowerks folder hierarchy of the uni­
versal headers. 

Codelllarrior UU4 Gold 
20 items Metrowerks C/C++ t 

13 items Headers f 
Metrowerks CIC++ f 3 items 268. 7 MB in disk 

Headers f 
Universal Headers f 

¢ 

FIGURE 10.3 METROWERKS SUPPLIES THE UNIVERSAL HEADERS WITH ITS COMPILERS. 

One particular header file requires a special note. The header file 
Values.h, which was present in the pre-universal headers and also appears 
among the universal headers, will be phased out of the group of univer­
sal header files. You may have included Values.h in your projects in order 
to access its macros that represent the ranges of different data types. 
Apple recommends that you now use the ANSI C header files float.h and 
limits.h: 

II #include <Values.h> 

#include <float.h> 
#include <limits.h> 

no longer used - remove or 
II comment out 
II these two ANSI header files 
II now replace Values.h 

While the float.h and limits.h files hold macros that define type ranges, 
the macro names differ slightly. So besides changing your #include direc­
tives, you'll have to be aware that you may encounter "XXXX undefined" 
errors. For example, if in the past you used MAX I NT, now you'll use 
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I NT _MAX. For a complete listing of both the old and new macro names, 
open and examine the universal header version of the Values.h header 
file. While the file doesn't contain the macros themselves, it does have a 
commented section that lists the old Values.h names and their new ANSI 
C equivalents. 

Change Assembly Code to C Code 

Assembly language fanatics will not be pleased with Apple's very strong 
recommendation that all assembly language code be rewritten as C 
source code. But this step is a necessary one. The PowerPC compilers do 
not use the asm directive that is found in THINK C. The asm directive 
allows assembly language to appear along with C language code in the 
same source code file. 

Assembly routines are usually added to a C program when the pro­
grammer feels that speed is of the utmost importance. Assembly lan­
guage code compiles into executable code that is faster than the exe­
cutable code that results from compilation of high-level language code. 
While execution speed increases due to the use of assembly language 
may have been significant on CISC processors, that speed improvement 
has diminished to almost zero on the PowerPC microprocessor. 
Optimizing compilers-like the Metrowerks MW C/C++ PPC compiler­
generate executable code that is fast. 

Assembly language programmers would have to expend a great deal 
of effort hand-optimizing their assembly code for it to be able to match 
or beat the speed of code generated by an optimizing PowerPC compiler. 

For you assembly die-hards, Apple does have a PowerPC 
Assembler available. It comes as part of the Apple RISC 
Software Developer Kit (SOK). This development environ­
ment also includes an ANSI-compliant C/C++ compiler, a 
two-machine debugger, and various other tools and docu­
mentation. 
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ANSI c AND THE POWERPC 

W hile the Power PC chip is new, the RISC technology on which it is 
based is not. Before the PowerPC microprocessor there were other 

RISC microprocessors, and, of course, other RISC C language compilers. 
The current PowerPC compilers are derived from these non-Macintosh 
compilers. So, like those compilers, the PowerPC compilers are based on 
the ANSI C standards. As such, these Macintosh PowerPC compilers do 
not allow for some of the features that traditional Macintosh C compilers 
have. Before recompiling your 680x0 source code to PowerPC code, 
you'll want to remove certain non-ANSI code that was accepted by 680x0 
compilers, but won't be accepted by PowerPC compilers. 

Change i n t Variables to other Integral Types 

A development environment has the ability to change the amount of 
memory that an integer will occupy. Compilers such as THINK C have a 
preference setting that allow the programmer to indicate whether each 
integer should occupy 2 bytes or 4 bytes. Figure 10.4 shows the THINK C 
dialog box that's used for this purpose. 

While Symantec lets the programmer make the decision as to the size 
of an integer, other development environments-like Apple's Macintosh 
Programmer's Workshop (MPW) and the PowerPC compilers-fix the 
size of an integer at 4 bytes. This variance in the treatment of the integer 
data type make it a poor candidate for portability. 

While source code that contains variables of type int will of course 
compile on a Power PC compiler, you run the risk of introducing bugs in 
your PowerPC version of the application you're porting. Introduce a 
bug? How so? Consider this simplistic example: 

int score; 

if ( score > MAXINT ) 
Display_Number_Too_Big_Message(); 
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®This Project »Copy» O New Projects 

[;] I Compiler Settings I 

D Generate 68020 instructions 

D Generate 68881 instructions 

181 Classes are indirect by default 

181 Methods are uirtual by default 

181 Generate class names 

1814-byte ints 

D 8-byte doubles 

181 "\p" is unsigned char II 
D Natiue floating-point format 

181 Hlign arrays of char 

.................................................................................................................................................................................................................................. ~ 

( Factory Settings } ( C++ Compatible} Cancel ([ 

FIGURE 10.4 You CAN CHANGE THE SIZE OF THE INT 

DATA TYPE IN THE THINK C ENVIRONMENT. 

OK 

If this snippet was written in a 2-byte int environment, then the pro­
grammer's intentions were for the error message to be displayed if score 
exceeded 32, 767-the value that MAX I NT has in a 2-byte int environ­
ment. The programmer, in preparation for the port to PowerPC, faithful­
ly changes from the Values.h header file to the limits.h header file. He 
then looks at the table in the new version ofValues.h to see that the MAX­
I NT macro he used with his 680x0 compiler is now named I NT _MAX m 
the limits.h header. So he changes his if statement to read as follows: 

int score; 

if ( score > INT_MAX ) 
Display_Number_Too_Big_Message(); 

The result? Now the conditional test of the if statement will not pass 
until score has a value of 2,147,483,647-the maximum value of the 4-
byte integer that variable score has become in the PowerPC program. 
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So, what is the solution for the troubled programmer? He should 
change the int variable score, and all other int variables, to an integral 
data type other than i n t. In this case, score could be changed to a 
short and the conditional test should be altered to include the macro in 
limits.h that defines the maximum value a short can have: 

short score; 

if ( score > SHRT_MAX) 
Display_Number_Too_Big_Message(); 

Since the short data type is always a 2-byte type-regardless of the devel­
opment environment-the code will compile the same regardless of 
whether it is compiled with a 680x0 compiler or a PowerPC compiler. 
Backwards-compatibility is maintained. 

In summary, search for all occurrences of the i n t data type in all of 
the source code files of the project that is being ported. Then examine 
the context in which each int variable is used. Change each int variable 
to a different integral data type-such as the short type or the long data 
type. In any environment, these data types are 2-byte and 4-byte types, 
respectively. 
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The exception to the rule of changing a variable's type from 
i n t to a different integral type is when the variable will be 
used as an index. Indices are worked with (incremented, 
decremented, etc.) in registers. The CPU will work more 
efficiently with integers than it will with other data types. A 
loop index is one instance. Another is an array index. The 
address of an array member is calculated using the array 
index as an offset, so registers are involved. 
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Use ANSI Function Declarations 

A C compiler always expects a function to return something. If no value 
is returned, then that function returns void: 

void Post_Error_Alert( Str255 err_str 
{ 

II function body 
} 

Since some C compilers will compile a function that doesn't explicitly 
state a return type, it may be tempting to declare the above function as 
follows: 

Post Error_Alert( Str255 err_str 
{ 

II function body 
} 

Because the above declaration of Post_Error _Alert() lists no return 
type, it may appear that the function returns void. In fact, a function that 
is declared with no return type by default returns an int. Failing to 
include a return type makes the processor work a little harder than nec­
essary. When the function has completed its execution, the processor 
goes to the effort of returning to the calling function whatever value 
results from the last statement in the called function. If you aren't con­
cerned about the extra work the processor performs, you should be con­
cerned that this type of function declaration can potentially introduce a 
bug into your program. Consider this trivial example: 

My_Function( long num ) 
{ 

num = 10; 
} 

void main( void 
{ 

long test_num; 
long result; 
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test_num 5; 
result 2; 

result My_Function( test num ); 

In this example, the declaration for My_Function() lists no return type. 
After My_Functi on() has executed, what should the value of the result 
variable be? Even though result is given a value of 2 just before the call to 
My _Fun ct i on ( ) , after the function completes res u l t will have a value of 
10. Since My_Functi on() declares no return type, an int will be returned. 
And because the value of the last (and only) statement in My_Functi on() 
is 10, 10 is the value of the returned int. Figures 10.5 and 10.6 show the 
program output in the Metrowerks debugger. 

Just before My_Function () 
is called, result has a value of 2 

Iii Test Iii~ 
[_startup_ 0 result !2 i:fr 

tesLnum is 

r -0 ~ 

MyJ'unction < long num ) ~ 
{ 

num = 10; 

void main ( void ) ., { 
long test...num; 
long resu It; 

test...num = 5; 
result = 2; 

-:+ result = MyJ'unction< test...num ) ; 

IQ) Line: 15 

FIGURE 10.5 MONITORING THE RESULT VARIABLE BEFORE THE CALL TO MY _ FUNCTION ( ) • 
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After My _Function ( ) executes, 
result has a value of 10 

Jest 
result i 1 O 
tesLnum js 

My-.Function< long num ) 
{ 

num = 10; 

void main< void ) 
{ 

I ong tes Lnum; 
long result; 

- test...J"lum = 5; 
result = 2; 

result= My-.Function< test...J"lum >; 

-i• } 
!ill Line: 15 (ti 

FIGURE 10.6 MONITORING THE RESULT VARIABLE AnER THE CALL TO Mv_FUNCTION( ). 

The good habit of including function return types should carry over to 
function argument types as well. For functions that have no arguments, 
include v o i d in the function declaration: 

void Write_Warning( void ); 

If you're still using the pre-ANSI style of writing function declarations, 
you' ll want to switch to the ANSI style. Before ANSI, function argument 
names were written in the function declaration, while the argument types 
were listed after the declaration: 

int X_To_The_N( x. n ) 
int x, n; 
{ 
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II function body 
} 

To be ANSI-compliant you should instead include the argument type in 
the function's declaration line: 

int X_To_The_N( int x, int n ) 
{ 

II function body 
} 

Use Function Prototypes 

If you've used function prototypes in the past, this step will already be 
taken care of. Function prototypes are the same whether you compile 
with a PowerPC compiler or a 680x0 compiler. For every application­
defined function, include a function prototype at the top of your source 
code (or in a header file). Every time you make a call to an application­
defined function in your code, the compiler will compare the data type 
of each passed parameter in the function call with the data type listed in 
the function's prototype. So while function prototypes are extremely easy 
to implement, they are also one of the most powerful tools you can use 
to quickly catch potential bugs. 

When creating a function prototype you have the option of either 
including or omitting the names of the function's parameters. Consider 
this application-defined function: 

long X_To_The_N( long x, short n ) 
{ 

int i : 
long result 1: 

for ( i = 0: < n: i++ ) 
result *= x: 

return ( result ); 
} 
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The X_To_The_N() function can have a function prototype that looks 
like this: 

long X_To_The_N( long x, short n ); 

At your discretion, the X_ To_ The_N () function could instead have a 
function prototype such as the following: 

long X_To_The_N( long, short ); 

r2J 
N 0 T E 

The choice of prototype styles is that of the programmer. 
The compiler has no preference. In this book you'll see 
function prototypes without the variable names. 

USING A SINGLE SOURCE FILE FOR 

BOTH 68K AND POWERPC DEVELOPMENT 

In Chapter 8 you saw that to develop a fat binary you must create two sep­
arate projects. One project is for 680x0 compilation, the other is for 
PowerPC compilation. The resulting executables can then be merged 
into one fat application. This process is the same whether you're working 
in the Symantec environment or the Metrowerks environment. 

The fat application example in Chapter 8 had its own project and 
one source code file for compilation using a PowerPC compiler. A sepa­
rate project and a copy of the source code file were then used for compi­
lation with a 680x0 compiler. Two copies of the source code file were 
made because there are sometimes changes that have to be made in 
order for the source to compile on both a 680x0 compiler and a 
PowerPC compiler. In this section you'll see how you can use a single 
source code file-without modifications-with both compilers. 

Allowing your code to be compilable with both 680x0 compilers and 
PowerPC compilers isn't just an aid to help you develop fat binaries from 
your new projects. It will also help you when you port existing 680x0 
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code to PowerPC code. Rather than just haphazardly make changes to 
existing code, you'll want to make sure your ported code still compiles 
with 680x0 compilers as well as with PowerPC compilers. That will allow 
you to keep your applications backwards compatible. You'll find it easy to 
create a 680x0 application, PowerPC-only application, and a fat binary­
all from the same source code file. 

Using Conditional Compilation Directives 

Apple's universal header files exist to assist developers in their develop­
ment of Macintosh applications-regardless of the compiler platform or 
platforms they use. As you saw in the discussions of universal procedure 
pointers in Chapter 7, conditional compilation directives play a big role 
in making the header files universal. 

Since you're familiar with universal procedure pointers, I'll continue 
to use them in an example. Consider that the universal headers have an 
1ii f and 1ie 1 s e preprocessor directive to force a compiler to use the 
proper definition of a Mod a 1Fi1 terUPP. A 680x0 compiler will define 
ModalFilterUPP to be a ModalFilterProcPtr-a ProcPtr. 
A PowerPC compiler, on the other hand, will define a macro called 
USESROUTINEDESCRIPTORS, which will cause Modal FilterUPP to take 
on a different definition. On a PowerPC compiler a Mod a 1 Fil terUPP is 
defined to be a UPP: 

#if USESROUTINEDESCRIPTORS 

typedef UniversalProcPtr ModalFilterUPP; 

/lel se 

typedef ModalFilterProcPtr ModalFilterUPP: 

/lend if 

By using the 1ii fdef conditional directive, the universal headers can 
force different definitions upon the same type. The above example shows 
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that the programmer need not be concerned with the actual type defini­
tion of Modal Fi 1 terUPP. Using the universal headers, the programmer's 
development environment will choose the proper definition for 
Modal Fil terUPP-without assistance from the programmer. 

The universal header files use conditional directives in hundreds of 
instances to greatly minimize the headaches of writing compiler-specific 
code They don't, however, completely eliminate the need for you to 
include a few conditional directives in your own code. 

QuickDraw Globals and Conditional 
Compilation Directives 

Several global variables that most Mac programs make use of are 
QuickDraw global variables. A few examples are thePort, screenBi ts, 
and randSeed. The five standard patterns, white, ltGray, gray, 
dkGray, and black, are also QuickDraw global variables. While in the 
past it was acceptable to reference these variables directly, you must now 
preface their names with the name of the data structure which encapsu­
lates them-qd. For example, if you called I ni tGraf () like this: 

InitGraf( &thePort ); 

you must now call it like this: 

InitGraf( &qd.thePort ); 

The reason for this is a change in the way the QuickDraw globals have 
been defined in the QuickDraw.h header file. In the older Apple 
#includes, the QuickDraw globals where defined to be in a struct 
named qd: 

extern struct 
{ 

char 
long 
BitMap 
Cursor 

privates[76]; 
randSeed; 
screenBits; 
arrow; 
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Pattern 
Pattern 
Pattern 
Pattern 
Pattern 
GrafPtr 

dkGray; 
ltGray; 
gray; 
black; 
white; 
thePort; 

} qd; 

From the universal headers version of QuickDraw.h comes this new defi­
nition: 

struct QDGlobals 
{ 

} ; 

char 
long 
BitMap 
Cursor 
Pattern 
Pattern 
Pattern 
Pattern 
Pattern 
GrafPtr 

privates[76J; 
randSeed; 
screenBits; 
arrow; 
dkGray; 
ltGray; 
gray; 
black; 
white; 
thePort; 

You can see that in above struct definition varies from the older defini­
tion. Most significantly, no global qd variable is declared. If you're devel­
opment environment doesn't declare such a variable for you, you'll have 
to do it yourself: 

QDGlobals qd; 

Does your development environment declare qd? Later in 
this chapter you'll see how to write condltlonal code that 
only makes the above declaration if the development envi­
ronment doesn't already do so. 

Regardless of where the qd variable is declared, you'll want to change all ref­
erences to its members to include the qd preface. So a call such as this one: 

InitGraf( &thePort ); 
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should be changed to this: 

InitGraf( &qd.thePort ); 

Though Apple's universal header files eliminate most of the 
680x0/PowerPC compilation discrepancies, they don't handle all situa­
tions. One such case is the QDGl obal s variable that I've been discussing. 
Though the following example doesn't apply directly to Metrowerks 
users, the general problem (and eventual solution) applies to users of 
any PowerPC compiler. 

To successfully compile a PowerPC project using the Symantec cross 
development kit, you need to define a QDGl obal s variable in your source 
code: 

QDGlobals qd: 

Before the PowerPC-based Macintosh, a global definition of qd was sup­
plied by Apple in its runtime library-you did not have to declare this 
variable yourself. This situation is in fact the sole reason that the 
Symantec version of the Chapter 8 fat binary example used separate 
source code files for the two projects. The 680x0 file did not need to 
define the qd variable, while the PowerPC file did. 

The solution to the problem of whether to declare or not declare qd 
involves another conditional compilation directive and another macro: 

#ifdef __ POWERPC 
QDGlobals qd: 

#endif 

~ 
There are two underscores at the start of the __ POWERPC 
macro. 

N 0 T E 

In general, the #i fdef directive is written as: 

1fi fdef macro 
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II do something 
/lend if 

Or, if more than one option is available: 

iii fdef macro 
II do option 1 

1fe 1 s e 
II do option 2 

1/endif 

In this specific case the macro is __ POWERPC. If you're compiling with a 
PowerPC compiler, __ POWERPC is defined. That means the statement 
under the 1/i fdef will be compiled-and qd will be defined. If you're 
compiling with a 680x0 compiler, it turns out that the __ POW ERPC macro 
is not defined, and the declaration statement is thus skipped. This means 
that you can use the same source code file regardless of the compiler you 
use. Figure 10.7 illustrates how a PowerPC compiler will recognize the 
powerc macro and compile the qd declaration, while a 680x0 compiler 
working with the same source file will ignore the declaration. 

r:l1 
N 0 T E 

Of course, you may still find it convenient to have two ver­
sions of the source code file. For the sake of being tidy, you 
might want to keep all the files for each version ( 680x0 
and PowerPC) in their own respective folders. Then you'll 
have a version of the source code file in each folder. But, if 
you use the 1/i fdef and the __ POWERPC macro, the two 
files will always be identical. And that's the real issue. Now 
it won't matter if you accidentally delete one file-the con­
tents of the other is the same. 

How the Compiler Knows If powerc Is Defined 

Beside the __ POWERPC macro, there are two other macros that can be 
used to determine if code is being compiled with a PowerPC compiler. 
The macros powerc and __ powerc both have the same effect as 
__ POWERPC. The powerc and __ powerc macros are both used in many 
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of the universal header files , and, like __ POWERPC, they can be used in 
your own source code file. None of these macros are se t in the universal 
header files, though. They each get defined by the compiler environ­
ment you use. This is best be illustrated by looking at how the Symantec 
compilers work. Whether you ' re developing a 680x0 application or a 
PowerPC application, Symantec users begin by launching the THINK 
Project Manager. Once in the Project Manager, a developer can create a 
680x0 project that includes a snippet like this one: 

#ifdef POWERPC 
QDGlobals qd; 

#endif 

[I! 
THINK Projellll1ager 

Power PC C+ + 

~ 
THINK Projellll1ager 

Symantec C+ + 

II MySource File.cp 

_POWER PC 

QDGlobals qd; 

#endif 

II MySourceFile . cp 

#ifdef _POWERPC 

QDGlobal s qd; 

#endif 

FIGURE 10. 7 A POWERPC COMPILER WILL EXECUTE CODE 

UNDER AN #IFDEF _POWERPC; A 680x0 COMPILER WON'T. 
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The 680x0 project can be compiled, and, since it is a 680x0 project, 
POWE RPC will not be defined and the QDG 1 oba 1 s declaration will be 

skipped. Then, the project can be closed and a PowerPC project can be cre­
ated. Using the same source code file, with the same snippet, the project 
can be compiled as PowerPC code. This time __ POWERPCc will be defined 
and the QDGl oba 1 s declaration will take place-as desired. This seemingly 
contradictory behavior can take place without ever leaving the THINK 
Project Manager, and without ever explicitly setting the __ POWERPC macro. 

To see how the Symantec environment handles the above situation, 
I'll open a 680x0 project, such as the UPPDemol (68K) project I created 
in Chapter 8. This project window is shown in Figure 10.8. 

Jl ~J~;dtmRl(jJlKJ: 11. 
Name 

VSegment 2 
Mac Traps 
UPPdemo1 (68K).c 
Totals 

FIGURE 10.8 THE SYMANTEC PROJECT WINDOW FOR THE UPPDEM01(68K) PROJECT. 

If I added an /Ii fdef __ POWERPC directive to the code of 
UPPdemo1(68K) and compiled it, the declaration of the QDGl obal s vari­
able would be skipped. That's because __ POWERPC would not be defined 
for a 680x0 project. 

To investigate the reason for this, I'll select the Options menu item 
from the Edit menu. As shown in Figure 10.9, I'll drag the mouse over to 
the right and select THINK Project Manager from the hierarchical menu. 

In the dialog box that opens I'll choose to look at the Extensions options. 
Figure 10.10 shows the pop-up menu that will display that information. 

In Figure 10.11 you can see that my C source code file will be com­
piled by the THINK Project Manager using the THINK C translator. The 
translators can be thought of as separate compilers that are run from 
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within the THINK Project Manager. If my source code file was for a C++ 
program, it would have a .cpp extension and would be using the 
Symantec C++ translator. 

Undo ggz 

Cut OOH 
Copy :~:c 

Paste oou 
Clear 
Select All ggn 

Set Tabs & Font ... 
Shift left 00[ 
Shift Right 00) 
Balance ggo 

PowerPC C++ •.. 
Symantec C++ ... 
THINK C ••• 
THINK Rez ••• 

FIGURE 10.9 SELECTING THE OPTIONS DIALOG BOX FOR THE THINK PROJECT MANAGER. 

@This Project »Copy» O New Projects 

tlDlllmill!Dl••ldates D Always check file dates 
L!:r....,""'"".....,....,.,.. ...... ,.r,ojects D Don't ask for project on open 
D Generate link map D Always resegment on ouerflow 
~ Optimize monomorphic methods 

This is the THINK Project Manager options dialog. Cliok on any button to find out more about that option 
Use the pop-up menu to go to a specific page, or use the arrow button to move to the next or previous 
pages. 

Cancel 

FIGURE 10.10 USING THE OPTION'S POP.UP MENU TO 

MOVE TO THE FILE EXTENSION INFORMATION SCREEN. 

OK 
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@This Project » Copy » O New Projects 

~ I EHtensions 
File Extension Translator 
.asm THINK C 

File EKtension 
.cp Symantec C++ 
.cpp Symantec C++ 
.note «none» 
.0 .o Converter 
.r THINK Rez 
.rsrc Resource Copier 

This is the list of all recognized file extensions. Flles ending with one o 
the project and compiled by the corresponding translator . 

{f 

Replace 

Q Delete 

............................................................................................................................................... 

Cancel ([ DK 

FIGURE 10.11 THINK C FILE EXTENSION INFORMATION 

IN SYMANTEC'S OPTIONS DIALOG BOX. 

After dismissing the options dialog box, and without leaving the THINK 
Project Manager, I'll close the 680x0 project and open a PowerPC pro­
ject-such as UPPdemol (PPC). The project window for this Chapter 8 
project is shown in Figure 10.12. If I added an #if def __ POWERPC condi­
tional compilation directive to the source code file of this project and then 
compiled it, __ POWERPC would be defined, and the line under it-the dec­
laration of the QDGl obal s variable qd-would be included in the compile. 

With that project open, I'll again use the Options menu item as I did 
for the 680x0 project. The result is shown in Figure 10.13. Notice that for 
this PowerPC project, the THINK Project Manager is using a different 
translator-the PowerPC C++ translator. 

The Symantec translators act as separate compilers-though they all 
run in the same THINK Project Manager environment. The code that 
defines __ POWERPC is in the PowerPC ++ translator. If your project uses 
this translator-as Power PC projects do-__ POWERPC will be defined. If 
your projects use a different translator-such as the THINK C or 
Symantec C++ translator-__ POW ERPC will not be defined. 
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~ UPP demo 1 (PPC). Tl' ~ 
Name Code 

VSourc" 4 0 
...... .. ~ ... U..P..P..ci.:.l'l"l.°..1.(~~t::~ ·.C. .. ...................... 9 t-=-1 
v R"sourc"s 4 

c&gr 0 
Sl2E.r 0 

..... .. .. .... ..U..P..P..d.:.l'l"l.°..1 .~~~t::~ ·r.:.r.~ ... 0 
v Ubrari"s 4 

lnterfacel ib .xcoff 0 

Mathl ib .xcoff 0 

PPC CPlusL ib .o 0 

PPCCRuntime.o 0 

Std CL ib .xcoff 0 

StdCRuntime .o 

v Scripts 
PPCBuild .ts 

Totals 

....................... 0 
4 

0 

594~ 
'li 

FIGURE 10.12 THE SYMANTEC PROJECT WINDOW FOR THE UPPDEM01(PPC) PROJECT. 

@This Project »Copy» 0 New Projects 

~ I E1-1tensions 

File E1-1tension 

Translator 

PowerPC C++ 

File Extension Translator 

.cp 

.cpp 

.note 

.0 

. r 

.rs re 

.ts 

.xcoff 

PoverPC C++ 
PoverPC C++ 
«none» 

XCOFF converter 
THINK Rez: 
Resource Copier 
«none» 

XCOFF converter 

Replace 

Delete 

This is the list of all recognized file extensions. Files ending with one of these extensions can be added to 
the project and compiled by the corresponding translator. 

Factory Settings Cancel ([ 

FIGURE 10.13 POWERPC FILE EXTENSION INFORMATION 

IN 5YMANTEC'S OPTIONS DIALOG BOX. 

OK J) 
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For the powerc and __ powerc macros, Symantec does things just a little 
different. These two macros are defined in the PPC MacHeaders++ pre­
compiled header file that gets included in each of your PowerPC pro­
jects. The net effect is the same-using __ POWERPC, powerc, or 
__ powerc in an //i fdef conditional directive will allow you to selectively 
choose which parts of your code get compiled-or don't get compiled. 
As you look at PowerPC code that was written by other programmers, 
you'll encounter one or more of these macros. 

For the Code Warrior compilers, things are just a little different. The 
Metrowerks PowerPC and 68K compilers are two separate applications. 
But the definition-or lack of definition-of POWERPC works the same 
way. Launching the MW C/C++ PPC compiler sets the __ POWERPC macro 
to be defined. Launching the MW C/C++ 68K compiler doesn't define it. 
Additionally, the powerc and __ powerc macros are also defined by the 
compiler itself-not in the MacHeadersPPC precompiled header file. 
This differs from the Symantec compiler, which defines these last two 
macros in its PPC MacHeaders++ precompiled header. 

POWERPC COMPATIBILITY 

System 7 brought some changes to the way Macintosh programmers 
developed programs. In general, Apple strongly encouraged develop­

ers to alter their programming style to meet the new demands of System 
7. Now, with PowerPC, developers who didn't heed Apple warnings will 
find that they have a little extra work in store. The two biggest concerns 
for Mac programmers will be 32-bit clean code and code that properly 
accesses low-memory global variables. 

Keep Code 32-bit Clean 

With the introduction of System 7 came the warning to developers that they 
should keep their code 32-bit clean. Without modification, most existing 
applications were already 32-bit clean. Applications that weren't 32-bit clean 
generally did some fancy things with the upper 8 bits of 32-bit addresses. 
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Before System 7, the Mac used only the lower 24 bits of a 4 byte pointer. So 
some programmers used the upper 8 bits for application-specific purposes. 
When these applications were run on a Macintosh that considered all 32-
bits of a pointer to be dedicated to an address, problems resulted. 

Macs that are 680x0-based can, via the Memory control panel, switch 
addressing from 32-bits to 24-bits-even when running System 7. For the 
Power Macs, the 24-bit compatibility option that was provided for on 
680x0 machines has been removed. Your PowerPC applications must be 
32-bit clean. 

How can you be sure your application is 32-bit clean? You can follow the 
guidelines as specified in the new Inside Madntosh books. Short of that, old­
fashioned beta testing is still one of the best ways to make sure your applica­
tion is 32-bit clean. Run your application on a Mac that has System 7 installed. 
If you're using a 680x0-based Macintosh, check the Memory control panel 

·and verify that 32-bit addressing is turned on. Ifit isn't, tum it on and reboot 
your Mac. The Memory control panel is shown in Figure 10.14. If you're test­
ing your application on a Power Mac, the Memory control panel-shown in 
Figure 10.15-won't have an option to toggle the number of bits in an 
address. The PowerPC will always use 32-bit addresses, so you're all set. 

Use Access Functions for Low-Memory Globals 

When an application is launched it receive its own section of RAM-its 
own application partition. The system also gets its own memory partition­
the system partition. When a Mac boots up, system information is loaded 
into the system partition. While an application partition can start any­
where in a wide range of addressing space, the system partition always 
starts at the bottom of memory, at address 0. 

The system partition consists of the system heap and, at the very bot­
tom of the partition, a group of system global variables. Because of their 
physical position in memory, these system global variables are also 
referred to as low-memory system global variables, or low-memory globals. 
Figure 10.16 shows an overview of how the system global variables fit into 
the Mac memory scheme. 
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250 

~ 
'SI 

v7.1 

Memor 

Disk Cache Cache Size l384K I rgi 
Always On l2:J 

Virtua 1 Memory 

@on 
Qoff 

32-Bit Addressing 

Select Hard Disk : 

I= Hard Disk 340 ..-1 
Available on disk : 9 1 M 

Available built-in memory: 9M 

[ill[] [ID 

@on 
Qoff 

,. .. ____ --.... 
Turn 32-bit addressing '-91------ on before testing 

( Use Defaults J 

FIGURE 10.14 THE MEMORY CONTROL PANEL ON A 680x0.BASE MACINTOSH. 

filfil 
~ 

v7 .3 

Disk Cache 
Always On 

Memory 

Cache Size 

Modern Memory Manager 

®on 
Qoff 

Virtua 1 Memory 

Qon 
@off 

RAM Disk 

Oon 
@off 

Select Hard Disk : 

! r;:::::; Mncin1 o~h HD 
Available on disk: 77M 

Available built-in memory: SM 

Percent of available memory 
to use for a RAM disk : 

(1.D:::::::::::::::;:::::::::;;::::::::::::::::::::::: ::::::::~= 
0% 50% 100% 

RAM Disk Size ~ 

( Use Defaults ) 

FIGURE 10.15 THE MEMORY CONTROL PANEL ON A POWER MACINTOSH. 
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High memory 

Low memory 

System 
global 
variables 

Application 
partition 

Application 
partition 

System 
partition 

FIGURE 10.16 THE LOW·MEMORY SYSTEM GLOBALS 
RESIDE AT THE BOTTOM OF THE SYSTEM PARTITION. 

The low-memory globals are used by the system to keep track of the oper­
ating system environment. One of the most commonly used low-memory 
globals is GrayRgn. If a programmer sets a window's dragging boundary 
to this region, that window will be able to be dragged about the entire 
desktop area of a user's machine- regardless of the size of the user's 
monitor or monitors. 

In the past, Apple has stated that the best approach to using low­
memory global variables involved not using them directly. While for now 
low-memory globals will always load to the same address each time your 
Mac boots up, Apple can 't guarantee that the release of a new system ver­
sion won't change the loading address of one or more low-memory glob­
als. If that happens, code that relies directly on a low-memory global vari­
able may have unpredictable results . 

Apple's past recommendation has now become an unswerving rule­
don 't use a low-memory system global in your Power PC code. Instead of 
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directly including a system global variable such as GrayRgn in your code, 
use one of the low-memory global accessor functions that are provided in 
the LowMem.h universal header. As an example consider how you may 
have used GrayRgn in the past: 

Rect Drag_Rect; 

Drag_Rect = ( **( GrayRgn ) ).rgnBBox; 

In the above snippet low-memory global GrayRgn is dereferenced twice 
to get at rgnBBox, which holds the area of the user's desktop. For the 
PowerPC, you should rewrite the above code as follows: 

Re ct 
RgnHandle 

Drag_Rect; 
the_gray_rgn; 

the_gray_rgn = LMGetGrayRgn(); 
Drag_Rect = ( **( the_gray_rgn ) ).rgnBBox; 

The low-memory global GrayRgn doesn't appear in the above code. 
Instead, the code relies on the Apple accessor function LMGetGrayRgn () 
to access GrayRgn and to return a handle to your program. 

What happens if in the future Apple moves GrayRgn to a different 
address? Apple will modify LMGetGrayRgn () appropriately and provide a 
patch for the routine in the new system. You won't have to be aware of 
the change, and existing applications you've developed won't have to be 
recompiled. Instead, an existing application that calls LMGetGrayRgn () 
will execute the patched version of this routine. The patched version of 
this routine will know how to find GrayRgn. An application that relied on 
the global GrayRgn and didn't use the accessor function will not be able 
to locate GrayRgn and may fail. 

The older Apple #include files consisted of an interface file named 
SysEqu.h. This file, which is not part of the new universal headers set of 
files, defined the memory addresses of the low-memory system global 
variables. Here is just a small part of the SysEqu.h file: 

MainDevice = Ox8A4; 
DeskPattern = OxA3C; 
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MBarHeight = OxBAA; 
GrayRgn = Ox9EE; 

I* height of the menu bar 
I* Handle to desktop region 

*I 
*I 

You won't find the SysEqu.h header file anymore. If developers follow 
Apple's recommendation, there should never be a need for an applica­
tion to know the address of a low-memory system global. Instead, rely on 
the accessor routines. To get the current value of any of the above four 
low-memory globals, you should use one of these accessor functions: 

extern GDHandle LMGetMainDevice( void ); 

extern void LMGetDeskPattern( Pattern *DeskPatternValue ); 

extern short LMGetMBarHeight( void ); 

extern RgnHandle LMGetGrayRgn( void ); 

The LowMem.h header file also provides routines that allow you to 
change the value of any of the low-memory global variables. To set any of 
the same four globals listed above, you'd use these four accessor func­
tions: 

extern void LMSetMainDevice( GDHandle MainDeviceValue ); 

extern void LMSetDeskPatternC Pattern *DeskPatternValue ); 

extern void LMSetMBarHeight( short MBarHeightValue ); 

extern void LMSetGrayRgn( RgnHandle GrayRgnValue ); 

If your 680x0 project relies on any low-memory globals, search for an 
accessor function in the LowMem.h file found in the universal headers 
and instead use that accessor function. 

~ 
N 0 T E 

If you've used the THINK C header file LoMem.h in the past, 
you'll want to now substitute the universal header file 
LowMem.h for it. That simply means changing the #include 
directive that appears at the top of your source code file or 
in your project's header file. 
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Use Universal Procedure 
Pointers in Place of ProcPtrs 

Chapter 7 discussed universal procedure pointers at great length. Many 
of the porting suggestions provided in this chapter have been just that­
suggestions. The use of UPPs, however, is mandatory. The failure to use 
Universal ProcPtrs when required will cause your PowerPC compiler 
to stop dead in its tracks. 

Chapter 7 covered the theory and the use of UPPs. Here I provide a 
slightly different strategy for using them. Consider the following function 
from Chapter 7. It creates a routine descriptor for an application-defined 
routine called My_Fil ter( ), opens a dialog box, and then disposes of 
the routine descriptor when the user is finished with the dialog box: 

void Open_Modal_Dialog( void ) 
{ 

} 

II variable declarations 
ModalFilterUPP my_filter_UPP; 

my_filter_UPP = NewModalFilterProc( My_Filter ); 

II open dialog box 

ModalDialog( my_filter_UPP, &the_item ); 

DisposeRoutineDescriptor( my_filter_UPP ); 

II dispose of dialog box 

The above example creates a local UPP, uses it, then disposes of it. A dif­
ferent strategy would be to create a global UPP variable rather than a 
local one. Then the routine descriptor is created once at program start­
up, and remains in memory until the application quits. Using this 
scheme, there is no need to dispose of the routine descriptor-the sys­
tem will perform that task when the program exits. Universal procedure 
pointers are nonrelocatable objects. If you want to declare one globally 
and have it remain in memory for the life of your program, you should 
allocate memory for it at the start of your program. That prevents it from 
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occupying memory in the middle of your application's partition. Here's 
an example of how the filter procedure UPP could be used globally: 

ModalFilterUPP My_Filter_UPP: 

void main( void ) 
{ 

II declare globally 

II create routine descriptor at application startup 

My_Filter_UPP= NewModalFilterProc( My_Filter >: 

II do stuff 

Open_Modal_Dialog(); 
} 

With memory already allocated for the My_Fil ter() routine descriptor, 
Open_Modal_Di al og() doesn't have to create a local UPP variable or 
call NewModal Fi 1 terProc( ). And when Open_Modal_Di al og() ends, 
the UPP shouldn't be disposed of-it will be used the next time 
Open_Modal_Dialog() is called. Here's a look at how 
Open_Moda l _Di a 1 og ()would now look: 

void Open_Modal_Dialog( void 
{ 

II variable declarations 

II open dialog box 

ModalDialog( My_Filter_UPP. &the_item >: 

II DON'T dispose of the routine descriptor here 

II dispose of dialog box 
} 

DATA ALIGNMENT 

C ompilers are designed such that they follow the data alignment con­
vention of the processor they are compiling for. When a compiler 

places a data structure in memory, the compiler arranges the individual 
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elements that make up the data structure in a way that allows the target 
processor. When porting 680x0 code to native PowerPC code-and when 
writing PowerPC code that may run on a 680x0-based machine-you'll 
wa1t to keep these differences in data alignment in mind. 

oi<, 

T• 680x0 Alignment Convention 
., 

Wlien a data structure is placed in memory, its individual data members 
m~y not occupy contiguous bytes of memory. When compiling source 
code, a compiler may set up a data structure such that there is padding, 
or empty bytes, between some data members of a data structure. This is 
done to aid the proq;ssor in accessing individual data members. When 
pad,ding is applied, and how much padding is applied, is subject to the 
processor the compiler is running on. 

A 680x0 processor can access-that is, read or write-a word or a 
long word value at any even address. A single byte can be accessed at any 
address-even or odd. On a 680x0 processor a word is 2 bytes. That 
means the C data types short (2 bytes, or a word) and 1 ong (4 bytes, or 
a long word) can be aligned to any even address. The C data types char, 
which is a single byte, ;eeds no alignment-it can appear at any address. 

What happens when a data structure contains a number of different 
sized members, and by the nature of their ordering the start of some 
word and long word members don't fall on even addresses? The compil­
er supplies padding-empty bytes-to ensure that these members will in 
fact align to even adjresses. Consider the definition of the following 
struct: 

struct My Data 
{ 

char field 1· II 1 byte 

\'}; 
long field=:2£ II 4 bytes 

When compiled on a 680x0 processor, a variable of the above struct type 
will occupy 6 bytes of :rp.emory-not the 5 bytes that the two data members 
require. Because the fi~st member is only a single byte in size, a single byte 
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of padding will be added to ensure that the second member-a long 
word-will begin on an even address. Figure 10.17 illustrates this. 

r:l1 
N 0 T E 

Note that Figure 10.17 uses the Macintosh conventiorf. of 
showing a data object with its starting address as the larg­
er address, and the object data members appearing below 
the starting address-down towards smaller addresses. 

iat:i;uct MyData 

;},}}:~ti~' fi~~~l; I/ ;~:byte 
long fiela;.:.2; /14 bytes 

} ; 

Ox01446A06 

Ox01446A05 

Ox01446A04 

Ox01446A03 

Ox01446A02 

Ox01446A01 

• data GJ padding 

FIGURE 10.17 DATA ALIGNMENT OF A STRUCT ON A 680X0-BASE MACINTOSH. 

After supplying padding to coerce individual struct members to fall on 
the appropriate boundaries, the 680x0 compiler Will check to see what 
the overall size of the struct is. If it occupies an odd number of bytes, 
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the compiler will add a single byte of padding at the end of the structure 
to force it to occupy an even number of bytes. 

The PowerPC Alignment Convention 

Like a 680x0 compiler, a PowerPC compiler may add padding to a data 
structure. The alignment convention for the PowerPC processor, howev­
er, differs from that of the 680x0 processor. 

A PowerPC can access data in exactly the same manner as a 680x0 
processor-but it won't unless specifically requested to do so. Instead, 
accesses data that is aligned on a boundary that matches the size of the 
data. Data occupying 1 byte will be accessed at any address divisible by 1. 
Two byte data will be accessed at any address divisible by 2. Four byte 
data will be accessed at any address divisible by 4. The same pattern 
applies to data larger than 4 bytes. 

Like the 680x0 compiler, the PowerPC compiler will insert padding 
into a data structure to force its individual members to fall on the above 
mentioned boundaries. Because the data alignment scheme is different 
for a PowerPC than it is for a 680x0, the resulting size the data structure 
occupies in memory may differ on a PowerPC-Mac than it will on a 
680x0-base Mac. Consider the data structure used in the previous sec­
tion's example: 

struct My Data 
{ 

char field_l; II 1 byte 
long field_2; II 4 bytes 

} ; 

When compiled on a 680x0 processor, a variable of the above struct 
type will occupy 6 bytes of memory. The 680x0 compiler inserts one byte 
of padding after the char field to force the long field to start on an even 
address. When compiled on a PowerPC processor, a variable of the above 
struct type will occupy 8 bytes of memory. The PowerPC alignment con­
vention states that a long should start at an address divisible by 4, so the 
compiler inserts three bytes of padding after the first member. This is 
shown in Figure 10.18. 
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struct MyData 
{ 

char field_l; 
long field_2; 

}; 

Ox00224EC8 

Ox00224EC7 

Ox00224EC6 

Ox00224EC5 

Ox00224EC4 

Ox00224EC3 

Ox00224EC2 

Ox00224EC1 

0 data 

II 1 byte 
II 4 bytes 

f!J padding 

FIGURE 10.18 DATA ALIGNMENT OF A STRUCT ON A POWER MACINTOSH. 

When the padding to the structure members is complete, the PowerPC 
compiler will add padding to the end of the structure in certain circum­
stances. If the entire structure is one or two bytes in size, no padding will 
be added. If the entire structure is greater than 2 bytes in size, and the 
structure doesn't end on a word boundary, padding will be added to the 
end of the structure to force the structure to end on a word boundary. 
For example, a 3 byte structure will receive 1 final byte of padding (to 
make a 4 byte structure), a 5 byte structure will receive 3 bytes of padding 
(to make an 8 byte structure), and a 9 byte structure will receive 3 bytes 
of padding (to make a 12 byte structure). 
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Keeping in mind, of course, that a PowerPC word is 4 bytes 
(while a 680x0 word is only 2 bytes). 

While the PowerPC processor has its own data alignment scheme for 
accessing data in memory, it also has the ability to access data that doesn't 
conform to this convention-including data in a 680x0 format. Since the 
PowerPC alignment will cause some data structures to occupy more mem­
ory than their 680x0 counterparts, you may wonder why the PowerPC 
wouldn't use the 680x0 alignment plan. The answer has to do with speed. 
The PowerPC can access data that is aligned on the described boundaries 
much more quickly than it can access data that is not so aligned. 

Potential Data Alignment Problems 

Under most conditions, the differences in how the two types of proc.es­
sors align data won't be of significance to a programmer. Though a 
Macintosh programmer constantly works with addresses, these addresses 
are in the form of pointers and handles. As long as a programmer can 
access a data structure through one of these address-holding variables, 
the programmer need not be concerned with the exact address at which 
a data structure resides. There are some circumstances, however, when 
data alignment becomes a very important issue. 

You need to be concerned about data alignment when there is the 
potential that your application will transfer data between a PowerPC and 
environment and a 680x0 environment. This can happen if your pro­
gram is running on a PowerPC and the program creates a file that holds 
an application-defined data structure. If that file is transferred to a 
680x0-based Mac, and that file is opened and read by a program running 
on a 680x0-based Macintosh, the file contents will not be properly loaded 
into memory. 

The transfer of a data structure from one environment to another 
doesn't have to take place in the form of a physical medium for there to 
be potential alignment problems. If a network consists of both Power 

260 



Chapter 10 Porting Code to Native Pow,PC 

Macs and 680x0-based Macintosh computers, data transfer across the net­
work can cause problems. 

Rather than saying that data transfer from onJMacintosh to anotper 
Macintosh causes problems, I chose to use the phrase "from one enviton­

ment to another environment." That's because the transfer does not neces­
sarily have to be between physical machines. If your PowerPC program 
passes a data structure to code that happens to 'e running under the 
68LC040, that data structure will pass from the PowerPC environment to 
the 680x0 environment. Here the data transfer from one environment to 
another occurs within the confines of a single machine. 

The Data Alignment Solution 

Data alignment can be a problem. So, of course, compilers offer a solu­
tion. The solution comes in the form of the #pragma options directiye. 
The /lpragma directive is a C statement that is used to include compiler­
specific information within a source code file. One of the many //pragma 
directives is the //pragma options directive. 

The //pragma options directive is followed by,,an option name. The 
option name specifies which compiler setting you'd like changed.iFor , 
data alignment, you'll use the a 1 i gn option name. ' 

You'll find other //pragma directives in the documentation 
for the specific C or C++ compiler you use. While different 
compilers have different /Ip r a gma directives, both the 
Symantec and Metrowerks compilers support the //pragma 
options directives discussed here. 

If you'd like to guarantee that a struct will be aligned such that both a 
Power Mac and a 680x0-based Macintosh can recognize it, use the 
a 1 i gn=mac68k option before the start of the structure definition. Then, 
immediately after the definition, use the al i gn=reset option: 

#pragma options align=mac68k 
struct MyData 
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} ; 

char 
long 

field_l; 
field_2; 

II 1 byte 
II 4 bytes 

#pragma options align=reset 

Since the PowerPC alignment convention allows for quicker data access, 
you won't want to use the al i gn=mac68k option throughout your entire 
source code file. Instead, you'll only want to mark particulars t ruct defi­
nitions to be aligned in such a way. That's why you follow the st r u ct def­
inition with the al i gn=reset option . This restores the alignment 
scheme to the PowerPC alignment convention. 

The various #pr a gma directives will alter certain compiler settings. 
There's another way of changing compiler settings- through your com­
piler's preferences menu item. For instance, if you use the Metrowerks 
C/C++ PowerPC compiler you can globally set the alignment convention 
for a project from the Processor panel in the Preferences dialog box, as 
shown in Figure 10.19. 
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Apply to Metrowerks defaults. 

[EJ 
Warnings 

• D 
Linker 

D 
PEF 

Optimizations: ---------~ 

D Instruction Scheduling 

D Global Optimization 

[81 Peephole Optimization 

Optimize for: Speed ~I 

(Factory Settings) ( Reuert Panel ) ( Cancel ) ([ OK )J 

FIGURE 10.19 SETTING DATA ALIGNMENT IN THE METROWERKS COMPILER. 
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As mentioned, the preferences dialog box lets you choose struct align­
ment for the entire project. If you want to change the alignment for indi­
vidual data structures, you'll use ffpragma options directives in your 
source code. 

You'll want to set the preference settings to PowerPC 
struct alignment for the entire project, then use ffpragma 
options directives to mark individual data structures for 
680x0 alignment. Whenever you use #pragma options 
al i gn=reset, the compiler will return alignment to the type 
of alignment set in the preferences dialog box. 

Testing Data Alignment 

Since this entire discussion of alignment schemes sounds pretty theoreti­
cal, a few simple tests might be in order to verify it really is possible to 
switch back and forth between the different alignment schemes. First, 
consider this short C program: 

struct MyData 
{ 

} 

char field_l; 
long field_2; 

void main( void ) 
{ 

struct MyData the_data; 

the_data.field_l = O; 

printf( "Size of the_data = %d bytes", sizeof( the_data ) ); 
} 

The above program defines a single structure and one variable of that 
struct type. It then uses a pri ntf() call to write out the size of the 
struct variable. 
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~ 
The assignment statement that follows the variable declara­
tion has no bearing on the size of the struct or on the out­
come of the test. It is included for the sole purpose of pre­
venting the compiler from optimizing the variable out of 
existence. If you declare a variable, but never use it, the 
compiler will remove it. This is an important fact to consid­
er when setting up quick tests. If you ever can't "find" a 
variable in a debug window, it's because that variable was 
never used in any assignment statement. 

N 0 T E 

What should the outcome of the pri ntf() call be? If my compiler pref­
erence settings were set such that the project compiles code using the 
PowerPC alignment, the size of the_data should be 8 bytes. This is the 
same st r u ct that was discussed several pages back, and pictured in 
Figure 10.18. Compiling the above code with the Metrowerks PowerPC 
compiler resulted in the output shown in Figure 10.20. As anticipated, 
the struct has a size of 8 bytes. 

s true t MyDa ta 
{ 

} ; 

char f i e I d_ 1 ; 
long field...2; 

vo id main (voi d ) 
{ 

struct MyData the__data; 

the__data . field_l = O; 

AlignTest 

print f( "Size of the__data = ~d bytes", s i zeof( the__data ) ) ; 

FIGURE 10.20 RESULTS OF TESTING DATA ALIGNMENT ON A POWER MACINTOSH. 
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~ 
N 0 T E 

Once a structure is marked to be aligned by 680x0 data 
alignment conventions, any variable that is later declared 
to be of that struct type will appear in memory using the 
680x0 alignment. You won't have to use the /Jpragma 
options directives on each individual variable. 

To see if the /Ip r a gma opt i on s directive has the expected effect of alter­
ing the struct size in memory, I'll nest the struct definition between 
/lpragma statements. The new version of the source code, and the out­
put, are shown in Figure 10.21. Again, the results are as expected. The 
same structure now has a size of 6 bytes. You can refer back to Figure 
10.17 to see how a 680x0-processor would align this structure in memory. 

1-----------R_l_,ig._n_T_es_t_-i size of the....data = 6 bytes 

•pragma options align=mac68k 

struct MyData 
{ 

}; 

char field-1; 
long field...2; 

•pragma options align=reset 

void main<void) 
{ 

struct MyData the....data; 

the....data.field_1 = O; 

printf< "Size of the....data = lSd bytes", sizeof< the....data ) >; 

FIGURE 10.21 RESULTS OF USING #pRAGMA TO FORCE 

680x0 DATA ALIGNMENT ON A POWER MACINTOSH. 

{} 

• 

Before quitting the Metrowerks compiler, I'll run one final test. If this 
source code file might be used for compilation with both a 680x0 compil­
er and a PowerPC compiler, I should add a conditional test to see if the 
/lpragma statement should be used. If I compile the source code with a 
680x0 compiler, the data will be aligned using the 680x0 alignment con-
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vention. There'll be no need to use a #pragma options statement. The 
way to perform this test is to use an #i fdef statement with the powerc 
macro that was described earlier in this chapter. Figure 10.22 shows the 
latest version of the struct code, along with the output. Because I com­
piled it using a PowerPC compiler, the #pragma options directive was 
compiled and the alignment of the struct was set to 680x0 alignment. 

~ 
N 0 T E 
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Here's today's quiz. If I used a PowerPC compiler (such as 
Metrowerks MW C/C++ PPC compiler), but ran it from a 
680x0-based Macintosh, would the #i fdef powerc pass or 
fail? It would pass. The #ifdef isn't seeking to determine 
which Mac you are compiling on, but rather which Mac 
you're compiling for. A PowerPC compiler, regardless of the 
machine it is run on, generates an executable designed to 
run on a PowerPC. So, the #i fdef powerc is checking to 
see what type of compiler is being used, not what type of 
machine you happen to be running that compiler on. 

RlignTest.out 
Align Test S ize of the....doto = 6 bytes ~ 

#j fdef powerc 
•pragma opt i ons a I i gn=moc68k 
•endi f 

s t rue t MyOa ta 
{ 

char f ield-1 ; 
l ong f ield...2 ; 

}; 

# i f def powerc 
•pragma opt i ans a I i gn=rese t 
•end if 

v oid main (vo id ) 
{ 

struct MyDoto the....dato ; 

the....doto . field_! = O; 

printf( "Size of the....do to = lid bytes" , s izeof< the....doto ) ); 
} 

FIGURE 10.22 VERIFYING THAT THE POWERPC 

COMPILER RECOGNIZES THE POWERC MACRO. 

izy 
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Avoiding an Alignment Switch 

A PowerPC processor cannot access data that is in the 680x0 data align­
ment format as quickly as it can access that same data if it is in the 
PowerPC data alignment format. So if it is at all possible, you'll want to 
manually rearrange your data structures so that they will appear in mem­
ory in both the PowerPC format and the 680x0 format. This statement 
might appear to be contradictory to previous discussions, so a short 
example is in order. Consider the following small struct: 

struct More Data 
{ 

short field_l; II 2 bytes 
long field_2; II 4 bytes 
short field_3; II 2 bytes 

} ; 

Though the above struct is 8 bytes in size, Figure 10.23 shows that a 
PowerPC compiler would align the MoreData struct such that it occu­
pies 12 bytes. The last two bytes of padding are to force the structure to 
end on a word boundary, in compliance with the PowerPC data align­
ment guidelines. 

A 680x0 will place the MoreData struct in only 8 bytes of memory. 
Because each member starts at an even address without the need for 
padding, none will be added between members. And because the overall 
size of the structure is an even number of bytes, no padding need be 
added to the end of the structure. This is shown in Figure 10.24. 

By rearranging the members of the MoreData structure, it is possible 
to have the data structure align in the same way in both the PowerPC and 
the 680x0 environments. Here's how I've currently defined the 
MoreData structure: 

struct MoreData 
{ 

} ; 

short 
long 
short 

field_l; 
field_2; 
field_3; 

II 2 bytes 
II 4 bytes 
II 2 bytes 
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struct MoreData 

{ short field_l 
long field_2 
s hort field_3 

}; 

Ox00286278 

Ox00286279 

Ox0028627A 

Ox0028627B 

Ox0028627C 

Ox0028627D 

Ox0028627E 

Ox0028627F 

Ox00286280 

Ox00286281 

Ox00286282 

Ox00286283 

II 2 bytes 
II 4 bytes 
I I 2 bytes 

] field_l 

] field_2 

l fie ld_3 

FIGURE 10.23 DATA ALIGNMENT ON A POWER MACINTOSH. 

Since the order in which the data members appear in the structure is 
unimportant, rearranging them won't have an impact on there use later 
in the source code. Here I've simply switched the order of the fie l d_ 2 
and field 3 members: 

struct MoreData 
{ 

} ; 
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short 
short 
long 

field_l; 
field_3; 
field_2 ; 

II 2 bytes 
II 2 bytes 
II 4 bytes 
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struct MoreData 

{ short field_l 
long f ield_2 
short field_3 

}; 

Ox01446A08 

Ox01446A07 

Ox01446A06 

Ox01446A05 

Ox01446A04 

Ox01446A03 

Ox01446A02 

Ox01446A01 

II 2 bytes 
II 4 bytes 
II 2 bytes 

l field_ l 

] field_ 2 

l field_3 

FIGURE 10.24 DATA ALIGNMENT ON A 680x0·BASED MACINTOSH. 

Figure 10.25 shows how the MoreData structure will now be aligned in 
memory if the code was compiled with a PowerPC compiler. Notice that 
there is now no padding, and that the structure occupies the same 
amount of memory (8 bytes) as it would if it had been compiled using a 
680x0 compiler. 

For a st r u ct that holds standard data types, an examination and 
manual rearrangement of its members can be done with relatively little 
effort. If the struct members are rearranged properly, no #pragma 
options align statement will be necessary. When an application is built 
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and executed, a Power PC processor will be able to access the st r u ct 
members quickly- they're aligned in the PowerPC format. And, if the 
data structure is to ever be used by a 680x0-based Mac, its members will be 
readable by that machine-they're also aligned in the 680x0 format. 

struct MoreData 
{ 

short field_l II 2 bytes 
short field_3 II 2 bytes 
long field_2 II 4 bytes 

}; 

If th is is an even~ 
address, n. . . '>..J ~------, 

j; ~~h!~e~is o :~~~~~~~~~~: ~ 
address, n+2 . . . .!I 
... andthis n ] 
is an even ~ 
address, n + 4 _;:_ 

As required by the i---~ . .._------'.I 

field_l 

field_3 

field_2 

PowerPC alignment 
format, each short 
data member starts at 
an address divisible 
by 2. The long data 
member starts at an 
address divisible by 4. 

FIGURE 10.25 MANUALLY REARRANGING STRUCT MEMBERS TO FORCE DATA ALIGNMENT TO 

BE THE SAME ON BOTH A 680x0·BASE MACINTOSH AND A POWER MACINTOSH. 

For larger structures, this manual rearrangement will not be worth the 
work. This is especially true of large structures that contain members 
whose size isn't readily apparent. For example, if you define a struct 
that has a Wi ndowRecord as one of its members you might not want to 
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expend the effort necessary to determine where the Wi ndowRecord and 
the other struct members should be positioned. For cases such as this 
you'll want to stick with the method of using the 1/pragma options 
align directive. 

CHAPTER SUMMARY 

W hile just about every program that runs on a 680x0 Mac with 
System 7 will also run on a Power Mac, these programs won't take 

advantage of the increased speed of the PowerPC microprocessor. Unless 
they are first ported to native PowerPC code. 

The primary step in turning 680x0 code into native PowerPC code is 
to recompile the old code using one of the new PowerPC compilers. This 
book has covered two such compilers-the Symantec CDK and the 
Metrowerks CodeWarrior compilers. 

Before recompiling 680x0 code, you'll want to take a few measures to 
ensure that the compilation goes smoothly. First and foremost, you'll 
want to make sure that you're using Apple's universal header files. You'll 
also want to remove assembly code and replace it with C or C++ code. In 
almost all cases, the execution time of your code will not suffer-the 
speed of the PowerPC processor and the optimization algorithms of the 
PowerPC compilers will see to that. Some other porting recommenda­
tions from Apple are: 

• Change int variables to variables of type short or 1 ong. 

• Always list a function return type in a function declaration. 

• Always use function prototypes. 

• Keep your code 32-bit clean. 

• Use access functions to examine or set low-memory system global 
variables. 

• Use Uni versa 1 ProcPtrs in place of ProcPtrs. 
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If you want to use a source code file as part of both a 680x0 project and a 
PowerPC project, you'll want to make use of conditional directives such 
as #i fdef. The powerc macro can be used to force the compiler to 
include or omit certain lines of code from compilation. 

Compilers align data structures in memory. That is, they add padding 
between some data members of a structure in order to coerce those data 
members to start on certain address boundaries. The data alignment 
scheme used by the Power Macintosh is different than that used by the 
680x0-based Macintosh. If your PowerPC program will write data struc­
tures to files that may be read by a 680x0 machine, or vice versa, you'll 
want to force the PowerPC compiler to use the 680x0 data alignment 
convention. You can do that by using the ffpragma options 
al i gn=mac68k directive. 
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IMPORT 
LIBRARIES 

I 
mport libraries, or shared libraries, are a very powerful, yet easy, 
means of packaging code such that it can be shared by several appli­
cations. Import libraries are also a convenient way for you to imple­

ment "plug-in tools" capabilities to any of your Power PC applications. In 
this chapter you'll see how the code in an application loads the code in 
an import library, and then executes it. You'll see how the Metrowerks 
PowerPC compiler makes it easy to turn a project into a shared library 
rather than an application. 

Import libraries are powerful in their own right. When combined 
with an application that uses Apple Events, they become even more 
potent. This chapter sets the foundation for creating import libraries, 
and applications that load them. The next chapter shows how Apple 
Events can easily be added to an application to further enhance the use­
fulness of import libraries. 
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CODE FRAGMENT BASICS 

O n a Power Macintosh, an import library, like an application, is a 
code fragment. When you double-click on an application, the oper­

ating system will invoke the Code Fragment Manager routines that are 
necessary to load the application code fragment. For an import library 
code fragment, however, you'll have to intervene and make the Code 
Fragment Manager calls yourself. So, before delving into import library 
code, a little background information on code fragments is in order. 

All Code is a Fragment 

On the PowerPC, a code fragment is any block of executable code. 
Whatever code you write must eventually be turned into a fragment. 
Whether your fragment is standalone code, or code that relies on that 
found in another fragment, your PowerPC compiler will take care of the 
details of marking code as a fragment. 

r2I 
N 0 T E 

Of course, it's the linker that is the part of your develop­
ment environment that actually creates a fragment. An 
environment's editor, compiler, and linker have become so 
Integrated, though, that people generally refer to individual 
actions such as editing, compiling, or building, as being per­
formed by "the compiler." 

On the 680x0-based Macintosh, code fell into clearly defined categories. 
On the Power Mac, the boundaries between types of code have become 
blurred. Though a fragment can be considered to fall into one of a few 
categories, the distinction between fragment types is trivial. From 
Chapter 5 you may recall that a code fragment is usually thought of as 
being in one of the following categories: 

• An application code fragment. Like a 680x0 application, a 
PowerPC application is standalone code that needs no other code 
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(aside from system software) to execute. It can optionally, howev­
er, make use of the code in other fragments. 

• An import library code fragment. This fragment type, which is also 
called a shared library or dynamically linked library, holds code 
and data that are to be accessed by one or more other fragments. 
Unlike an application fragment, an import library requires at 
least one other fragment to call the routines it holds. Often this 
other fragment is an application fragment. 

• A code resource code fragment. A code resource holds executable 
resource code. A control definition, or CDEF, is an example. 

• An extension code fragment. This fragment type adds to the capa­
bilities of other fragments. QuickTime is the most notable exam­
ple of an extension fragment. 

Fragment Code and Containers 

In keeping with the Power Mac generalization that any executable code 
is a fragment, all PowerPC code fragments are thought to be kept in con­
tainers. The container is the physical holding area of executable code. 
Just what a particular container is can vary widely from fragment to frag­
ment. In general, if the Mac operating system can access it, it might be a 
container. 

Because PowerPC system software now exists as an import library, it 
resides in a container. So one type of container is the ROM of a Power 
Macintosh. The import libraries that you'll create in this chapter will be 
stored in files. One such import library file type is the 'shlb' file-so this 
file can be thought of as a container holding executable import library 
code. An application fragment's data fork is still another type of contain­
er. For a PowerPC application, the data fork holds the application's exe­
cutable code-Figure 11.1 is a modification of a Chapter 8 figure, and 
serves as a reminder of how a Power PC application looks. 
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Data fork Resource fork 

Container 

FIGURE 11.1 THE DATA FORK OF A POWERPC APPLICATION HOLDS THE 

APPLICATION'S EXECUTABLE CODE, AND IS CONSIDERED A CONTAINER. 

Up to this point, all of the example code in this book has 
been for source code that gets turned into applications­
files of type 'APPL.' So, perhaps without being aware of it, 
you've already worked extensively with fragments and con­
tainers. Each fragment, however, has had the same general 
purpose--to serve as a standalone application. In this chap­
ter you'll be exposed to fragments with other purposes. 

Before a fragment's executable code can be used, it needs to be loaded 
into memory. For an application fragment, this act is performed by the 
Code Fragment Manager when the user double-clicks on the applica-
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tion's icon. For a different type of fragment, you, the developer, will have 
to include a call to a Code Fragment Manager routine. 

The different kinds of fragments fall into one of two different for­
mats that the Code Fragment Manager is capable of recognizing-the 
Extended Common Object File Format (XCOFF) and the Preferred 
Executable Format (PEF). 

XCOFF is a format derived from the Common Object File Format 
(COFF). XCOFF is an IBM format used primarily on UNIX-based com­
puters. The format that Apple has defined and uses, and more fully sup­
ports on the Power Mac, is PEF. Apple has improved upon XCOFF by 
creating a container format that occupies much less space. Besides the 
obvious advantage of saving on hard disk real estate, the smaller size 
makes it easier and faster for the Code Fragment Manager to load a PEF 
container than an XCOFF container. 

~ 
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So why does Apple bother to support XCOFF, even to a lim­
ited extent? IBM, Motorola, and Apple all participated in 
the development of the PowerPC chip. The original develop­
ment tools generated code in the IBM XCOFF format. As 
time goes on, Apple support of XCOFF will diminish. 

IMPORT LIBRARY BASICS 

O n a Power Macintosh, both an application and an import library are 
code fragments. The executable code of an application is stored in 

the data fork of a file. While the executable code of an import library 
may be stored in ROM or in a resource, you'll typically use a file as its 
container. The primary distinction between an application and an import 
library is that an application is double-clickable code, while an import 
library cannot execute without the support of another fragment-often 
the application fragment. 
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Imported and Exported Symbols 

All fragments contain symbols. A symbol is used as a reference point that 
allows code-either code in the fragment or in a different fragment-to 
access a routine or variable. A symbol that is referenced by code in a dif­
ferent fragment is called an exported symbol, or export. 

An import library fragment contains exported symbols-symbols that 
will be referenced by the fragment or fragments that use the library 
code. These other fragments contain imported symbols, or imports, that will 
eventually correspond to the exported symbols. 

When a fragment is built by your development environment, an 
imported symbol is created for each reference to external code. Since 
the memory location of code isn't known until runtime, when it is 
loaded, the symbols must suffice during the build process. Then, each 
time a fragment is loaded into memory (such as when an application is 
launched), the Code Fragment Manager replaces all imported symbols 
with memory addresses. These addresses are the addresses of referenced 
routines in external code. 

Even upon the launching of an application, the Code Fragment 
Manager may not be able to resolve all symbols in that application frag­
ment. This can occur when an import library used by the application 
isn't already loaded in memory. If the library is not marked by the appli­
cation to be loaded at application launch, the Code Fragment Manager 
will wait until the import library is eventually loaded before resolving 
these symbols. 

When an application launches, why wouldn't it load any 
import libraries it uses? Because a library may contain sel­
dom used code that gets executed only when a particular 
menu item Is selected. You'll see a specific example of this 
later In this chapter. 

When the Code Fragment Manager finally does resolve the import sym­
bols in a fragment, it creates a connection to the fragment that holds the 
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referenced code. When using import libraries, you'll use the connection 
ID that the Code Fragment Manager returns to your application. This 
connection ID can be used by your application to sever the connection 
and unload the fragment code when your application is through with it. 

Import Library Special Routines 

A shared library fragment creates a list of symbols that it exports to frag­
ments that will be importing the shared library's code. This list of export 
symbols is mandatory and necessary-without it, a fragment wouldn't 
have access to the variables and functions in the shared library it was try­
ing to load and execute. Besides this mandatory list of symbols, a shared 
library can optionally define three special symbols. Each symbol repre­
sents a function in the shared library, and allows other fragments access 
to these three functions. For that reason the three special routines are 
also called entry points. Two of these symbols allow two of the three func­
tions to be invoked implicitly by other fragments. That is, the code within 
another fragment will be able to trigger the execution of one of these 
functions without the programmer ever including a call to it. 

While a very interesting concept, this implicit function call­
ing shouldn't be new to you. Dialog box user items are 
updated through this implicit type of function call too. 
Chapter 7 covers this concept in some depth. 

The three special routines consist of an initialization routine, a main rou­
tine, and a termination routine. As mentioned, each of these special rou­
tines are optional. 

If a fragment has an initialization routine, it will be executed by the 
application upon loading the import library. The application source 
code need make no explicit call to the initialization routine-it will be 
called just as soon as the import fragment is loaded. Regardless of how 
long the imported fragment remains in memory, this is the only time that 
the initialization routine will be executed. 
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When the initialization routine is called, it receives a pointer to a 
data structure that holds information about the import fragment's con­
tainer. Since the application is loading the fragment, it should be obvi­
ous that the application has information about the fragment container. 
The initialization routine of the import library can use this information 
about its own container to do things such as access its own resource 
fork. In Figure 11.2, an application is loading an import library. 
Because the import library has defined an initialization routine, the 
application invokes it-passing it information about the import library 
container. In this example the initialization routine uses this informa­
tion to find its own resource fork to access an 'ALRT' resource and 
then display an alert. 
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Later in this chapter you'll see complete source code list­
ings for examples that do just what's shown in Figure 11.2. 

When an application is finished with an import library it may keep the 
import library in memory for later use or unload it to free up memory. If 
the import library has a termination routine defined, that routine will auto­
matically be invoked if the import library fragment gets unloaded. If a 
fragment defines a termination routine, its purpose is often to free mem­
ory that was allocated in the fragment's initialization routine. 

The third optional special routine is a fragment's main routine. This 
routine has no one set purpose-though it often holds code that updates 
drawing that was performed by the fragment. This routine is also the 
only one of the three special routines that is not called automatically. 

Consider the following hypothetical example. An import fragment 
displays the standard get file dialog box to allow the user to select a 
'PICT' file, and then opens and displays the contents of that file. Since 
the posting of the standard get file dialog box only occurs once, that task 
could be performed by the fragment's initialization routine. This routine 
would also reserve the memory needed to hold the data from the opened 
'PICT' file. The fragment's main routine would then draw the picture to 
a window. Since the main routine handles the drawing, it would be 
responsible for updating the window that holds the picture. Thus this 
routine would be called by the application whenever the window had to 
respond to an update event. When the application was finished with the 
picture, the import library code could be unloaded. As part of this 
unloading process the import fragment's termination routine would be 
invoked to release the memory that had been allocated for the picture. 

The above example isn't entirely hypothetical. Chapter 12 
has the source code for an example that has an import 
library that defines the three special routine.s as described 
above. 
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IMPORT LIBRARY CODE 

O n a PowerPC, any executable code is considered to be a code frag­
ment. An import library is a code fragment that doesn't stand on its 

own-it relies on either an application fragment or another import 
library fragment to load and execute its code. This chapter's discus­
sions-as well as all of the material in Chapter 5-have familiarized you 
with the theory behind fragments, containers, and import libraries. Now 
its time to see some working code that backs up that theory. 

This section describes the code you'll need to write to create a simple 
import library fragment. Later in this chapter, you'll see how to write the 
code for an application fragment that loads this import library. Finally, this 
chapter will show the Code Warrior project files you'll need to create in order 
to compile and link the example code. The result will be two separate frag­
ment files-an import library and an application that uses the import library. 

While it is very possible for a shared library to import code 
from still a different shared library, all of the discussion in this 
section will assume an application fragment is importing code 
from an import library. That should minimize confusion by mak-
ing it safe for you to assume that discussions of import sym­
bols pertain to the application (it imports code from the 
library) and discussions of export symbols pertain to the 
shared library (it exports code to the application fragment). 

Defining One of the Special Routines 

Earlier in this chapter you read that an import library can define up to 
three special routines that serve as entrance points into the fragment. 
Here you'll see the specific code you'll need to write to create an import 
library that defines an initialization routine. 

An import library special routine can have any valid function name. 
The function return type and argument, however, should follow the form 
shown here: 
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OSErr My_Initialize_Routine( InitBlockPtr init_block_ptr ) 

The initialization routine is called when the import library is loaded. 
When that happens, the application will pass a variable of type 
InitBlockPtr to the routine. The invocation, the filling of the data 
structure pointed to by the I ni tBl ockPt r, and the passing of that point­
er to the initialization routine are all done automatically when the Code 
Fragment Manager loads the library. Depending on the tasks the initial­
ization routine is to perform, it may or may not make use of the import 
fragment container data that the Ini tBl ockPtr points to. Consider this 
very trivial initialization routine: 

OSErr My_Initialize_Routine( InitBlockPtr init_block_ptr ) 
{ 

Drawstring( "\plibrary loaded." ); 

return ( noErr ); 
} 

The above function will get called when the import library of which it is a 
part of gets loaded. Its only task is to draw a string that gives notification 
that the library was loaded. By convention, the initialization routine 
returns an OSErr. In the above example, you can see that I've made the 
bold assumption that the DrawStri ng () call didn't fail-I simply return 
the Apple constant noErr. 

The Apple universal header file FragLoad.h defines the functions 
and data structures (including the In i tB lock struct) you'll be using 
when you write import library code. Any source file that will be compiled 
into an import library needs to include it: 

#include <Fragload.h> 

The initialization function that you've just seen makes several assump­
tions about the application that invokes it: 

• A window is open. 

• The port has been set to that window. 
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Ill The graphics pen has been appropriately positioned. 

These assumptions are too important to make in "real" Macintosh pro­
gramming. But making them here allowed me to demonstrate that an 
initialization routine is not difficult to write. 

A Second Initialization Routine Example 

The previous example demonstrated what's required when writing an ini­
tialization routine-a function that has an InitBl ockPtr as a parameter 
and an OSErr as its return type. Since the previous example was too triv­
ial to be of any practical use, I'll present a more usable initialization rou­
tine example here: 

#include <Fragload.h> 

OSErr My_Initialize_Routine( InitBlockPtr init_block_ptr ) 
{ 

} 

FSSpecPtr the_FSSpec_ptr; 
short res_ref_num; 

the_FSSpec_ptr = init_block_ptr->fraglocator.u.onDisk.fileSpec; 
res_ref_num = FSpOpenResFile( the_FSSpec_ptr. fsCurPerm ); 
UseResFile( res_ref_num ); 

Alert( 128, nil ); 

CloseResFile( res_ref_num ); 

return ( noErr ); 

When called, the above initialization routine will display an alert. 
Normally, the display of an alert is handled simply by calling the Toolbox 
routine A 1 e rt ( ) . The initialization routine requires a little extra code 
because the alert that it displays is found in the resource fork of the 
import library itself-not in the resource fork of the application that 
loads the library. By keeping the alert resources (an 'ALRT' and a 
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'DITL') in resource fork of the import library, the library remains self­
contained. Way back in Figure 11.2 you saw that an import library can 
have its own set of resources. That figure also illustrated how the import 
library fragment container information that is passed to the initialization 
routine can be used to direct the code found in the import libraries data 
fork to the resources found in its resource fork. You now know that this 
fragment container information comes in the form of an InitBlock 
data structure. 

The Ini tBl ock data structure consists of nine fields, one of which is 
another structure-this one of type Fragmentlocator. Deeply embed­
ded in the Fragment Locator structure is an FSSpecPtr named 
fi l eSpec. This pointer to an FSSpec can be used to gain access to the 
resource fork of an import library. 

~ 
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If you must know, the entire path to the FSSpec Pt r is as 
follows. The InitBl ock member Fragmentlocator is itself 
a data structure. Going deeper still, you'll find that the u 
field of the Fragmentlocator is a uni on type that consists 
of three structs. One of those structs is named on Di s k. 
One of the fields of onDi sk is fi l eSpec, which is of type 
FSSpecPtr. Now, if you followed all that, take a break and 
congratulate yourself! If you didn't-and you're still curious 
(or extremely aggravated)-you'll need to look at the com­
plete definitions of all of these structures in a copy of 
Inside Macintosh: PowerPC System Software. 

You can attempt to memorize all of the above In i t Bl o ck structure infor­
mation, or, you can simply make note of the fact that this one line of 
code will always provide you with an FSSpec pointer that can be used to 
access library resources: 

the_FSSpec_ptr = init_block_ptr->fragLocator.u.onDisk.fileSpec; 

The remainder of the initialization routine is pretty straightforward stuff. 
A call to FS pO pen Res Fi l e ( ) is made in order to get a reference number 
to the import library's resource fork. This reference number is then used 
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in a call to UseResFi 1 e() to make the import library resource fork the 
current resource fork. The Toolbox function A 1 e rt ( ) then posts the 
alert. Once dismissed, a call to CloseResFile() will close the import's 
resource fork. 

If you're tempted to save a little typing, you might try to write the ini­
tialization routine as follows: 

OSErr My_lnitialize_Routine( InitBlockPtr init_block_ptr ) 
{ 

Alert( 128, nil ) : 

return ( noErr ); 
} 

What would happen if I tried to take the shortcut of simply calling 
A 1 e rt ( ) without first opening the import library's resource fork? The 
Toolbox will search whatever resource file or files are currently open for 
an 'ALRT' resource with an ID of 128. It may just find one in the applica­
tion's resource fork-but that isn't the one you want. The moral of this 
story? Don't try to save keystrokes. And make use of the I n i t B 1 o ck data 
structure that the system has so gratuitously filled and passed to your rou­
tine. 

Import Library Advantages 

What makes an import library that is as simple as the one presented here 
have the potential to be of practical use? If the alert contains standard 
information that should appear in a whole suite of programs that you 
produce, you'll have a simple means of including that alert in each of 
those programs. Assume that each program in your package of four relat­
ed applications has a menu item that opens an alert that displays infor­
mation about your company-information such as the name, address, 
and telephone number of your company. If the resources and the code 
for this alert are housed in an import library, than a single copy of that 
import library can be used by all programs in the suite. If your company 
ever changes its address or telephone number, the 'DITL' resource in the 
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import library can be updated and the import library can be recompiled. 
As part of an upgrade, this single import library could then be distrib­
uted to everyone who has one or more of the your programs. 

How does the above scenario prove advantageous over the more tra­
ditional method of not using a library file, but instead simply including 
resources in the application's resource fork? In that pre-PowerPC 
approach, if the information in the alert needs updating, the application 
source code will need to be recompiled to create a new version of the 
application. And, if your package consists of several individual programs, 
each one of them will have to be recompiled so that each one contains 
the new information. Not only that, but in order to provide each user 
with the update, you'll have to verify how many different programs in the 
suite of programs each user has. You'll then have to then send each user 
a copy of each application. This could easily involve sending out several 
disks to each user. Using the library method, you'd only have to verify 
that a person has any one of your programs. Then you'd simply send out 
a single library file. 

As the previous example shows, the true advantage of using import 
libraries comes in properly choosing what code should become an 
import library. You should choose code that will be used by more than 
one of your applications, or code that may need unavoidable periodic 
changes. 

LOADING AND EXECUTING IMPORT LIBRARY CODE 

When you consider that an import library can consist of nothing 
more than an initialization routine, you can see that creating an 

import library can be quite simple to do. After writing the code, all you 
need is a compiler that can mark the code as a library fragment rather 
than an application fragment. The Metrowerks CodeWarrior compiler is 
such an environment. Before seeing how Code Warrior performs this 
feat, you'll need to see an example of how an application loads and exe­
cutes an import library. 
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Creating an FSSpec For an Import Library 

To load an import library to memory from disk, you'll make a call to the 
Code Fragment Manager function GetDi skFragment( ). This routine 
requires that the directory path to the import library fragment be in the 
form of a file system specification-an FSSpec. So before covering the 
Get Dis kFragment () function in detail, I'll get the FSSpec creation out 
of the way. A call to FSMakeFSSpec() will take care of that. Assuming I've 
named my import library MylmportLib, the FSSpec code will look simi­
lar to this snippet: 

FSSpec the_FSSpec; 

FSMakeFSSpec( 0, OL, "\pMylmportlib", &the_FSSpec ); 

The first parameter to the Toolbox function FSMakeFSSpec() is the vol­
ume reference number. A value of 0 indicates the file in question resides 
on the default, or startup, drive. 

The second parameter is the parent directory of the file. The parent 
directory contains the file in question. If the first parameter has a value 
of 0, and the file you're concerned with is in the same directory as the 
application that will use it, you can also use a value of 0 for the ID. Since 
this second parameter should be a type 1 ong, you might want to append 
an L to the 0 to force it to occupy the space of a 1 ong. 

The third parameter to FSMakeFSSpec() is the name of the file. This 
parameter can be either a string, as shown above, or a Str255 variable. 

The last parameter is a pointer to an FSSpec variable. 
FSMakeFSSpec() will use the information in the first three parameters to 
create the FSSpec and return it in the fourth parameter. 

Loading a Library 

To load the import library fragment from its disk file to memory, you'll 
make use of a Code Fragment Manager routine called 
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GetDi skFragment( ). Here's how the universal files header FragLoad.h 
declares this routine: 

OSErr GetDiskFragmentC FSSpecPtr 
long 

fileSpec, 
offset, 
length, 
fragName, 
findFlags, 

Parameter 

file.Spec 

offset 

length 

fragName 

findFlags 

connID 

rnainAddr 

err Name 

long 
Str63 
LoadFlags 
Connection ID 
Ptr 
Str255 

*conn ID, 
*mainAddr, 

errName ) ; 

TABLE 11.1 THE PARAMETERS TO THE CODE FRAGMENT 

MANAGER ROUTINE GetDi skFragment( ). 

Description and typical value 

Pointer to the file system specification for the fragment to load. 

Offset, in bytes, from the start of the fragment's data fork to the start of 
the fragment code in the data fork. This will typically be 0. 

Length, in bytes, of the fragment. A value of 0 specifies that the entire 
fragment should be loaded-so typically this will be 0. 

The fragment name. This is an optional name used for debugging. 
Typically this is set to the name of the fragment file. 

Specifies which of three operations to perform on the fragment. 
Typically this will be set to the constant kLoadNewCopy. 

An ID that identifies the connection to the fragment. Will be used when 
the application unloads the fragment at a later time. This will be filled 
in by the function. 

The address of the fragment's main special routine. This will be filled in 
by the function. If the fragment has no main defined, nil will be returned. 

If GetDiskFragment() fails, this will be filled in with the name of the 
fragment that couldn't be loaded. 
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At first glance the parameter list for GetDi skFragment() looks a little 
imposing. The truth of the matter, however, is that things aren't nearly as 
bad as they appear. Once you include a call to GetDi skFragment() in 
your source code, you'll generally be able to copy it and use it "as is" in just 
about any other program you write. Table II.I provides a run down on the 
purpose of each parameter, as well as a typical value for many of them. 

Table II.I shows that two of the eight parameters (offset and 
1 ength) usually have a value of 0. One of the parameters (fi ndFl ags) is 
set to some constant value-usually kloadNewCopy. Two of the parame­
ters get their values from the FSSpec structure that holds information 
about the file system specification for the code fragment file. The 
remaining three parameters are filled in by GetDi skFragment() and 
returned to the calling routine. 

Before calling Get Dis kFragment(), you'll need to declare a few vari­
ables: 

FSSpec 
Connection ID 
Ptr 
OS Err 

the_FSSpec; 
Lib_Connect_ID = 0: 
Lib_Main_Ptr =nil: 
error = noErr: 

The first variable will hold a file system specification-the directory path 
to the import library fragment. The last three of the variables will hold 
values returned by GetDi skFragment( ). Based on Table II.I, here's 
what a typical call to GetDi skFragment() should look like: 

error= GetDiskFragmentC &the_FSSpec, 
o. 
o. 
the_FSSpec.name, 
kloadNewCopy, 
&Lib_Connect_ID, 
(Ptr *)&Lib_Main_Ptr, 
error_name ); 

Assuming I've created an import library named Companylnfo, and it will 
reside in the same folder as the application fragment that uses it, here's 
how I could load it into memory: 
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FSSpec 
Connection ID 
Ptr 
OS Err 

the_FSSpec; 
Lib_Connect_ID = O; 
Lib_Main_Ptr =nil; 
error noErr; 

FSMakeFSSpec( 0, OL, "\pCompanyinfo", &the_FSSpec ); 

error= GetDiskFragment( &the_FSSpec, 
o. 
o. 
the_FSSpec.name, 
kloadNewCopy, 
&Li b_Connect_ID, 
(Ptr *)&Lib_Main_Ptr, 
error_name ); 

When the call to Get Dis kFragment () loads the import library, the 
import library's initialization routine-if it has one defined-will execute. 

Unloading a Library 

After Get Dis kFragment () successfully loads a library, your program will 
have a connection to that fragment in the form of a variable of type 
Connection ID. The primary purpose for this variable is to give you a ref­
erence to the fragment when you want to unload it from memory. To 
unload a fragment, pass a pointer to the Connection ID variable to the 
Code Fragment Manager routine Cl oseConnecti on(): 

CloseConnection( &Lib_Connect_ID ); 

This function will call the fragment's termination routine (if it has one 
defined) and then release the memory allocated to the fragment's code. 

CREATING A LIBRARY WITH CODEWARRIOR 

I f you own the Metrowerks Power PC compiler and you want to develop 
shared libraries, you're in luck. The Metrowerks C/C++ PPC compiler 
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makes turning source code into a library an easy process-as you'll see in 
this section. 

Earlier in this chapter you saw an example of an import library that 
displays an alert. In this section I'll use CodeWarrior to turn that exam­
ple into a functional import library. 

As of this book's printing, the Symantec environment does 
not support the development of shared libraries. If you 
own the Symantec Cross Development Kit, you'll want to 
check with Symantec support-Symantec will soon be 
releasing a new PowerPC compiler that will support 
shared libraries. 

The Import Library Resources 

Import libraries that use resources will want to have those resources self­
contained. To make an import library using CodeWarrior you create a 
resource file, a project file, and a source code file-just as you would for 
an application. Since my import library will be named Companylnfo, I've 
created a resource file named Companylnfo.µ.rsrc. To keep the files I'll 
be creating together, I've also made a new folder named (11) TestAppl 
Lib !-you'll find it on the included disk. 

Though an import library isn't required to include any resources, it 
should minimally include a 'vers' resource. The 'vers' resource provides 
version information about the library. The 'vers' resource has an edit box 
that allows you to add version and copyright information for the applica­
tion. While that's the typical use for this text, I'll instead write a descrip­
tive sentence that will help indicate what this file will be used for. The 
'vers' resource is shown in Figure 11.3. 

After building the library I'll be able to select Get Info from the File 
menu in the finder to see the string that's in the 'vers' resource. Figure 
11.4 shows the string in the Version field of the Get Info window. 
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ALRT DITL 

2.0bl 
6.0.5 
7.0 ... 

vers 

Uersion number: Ll . @=] . @=] 

Release:! Final ,.. , Non-release: @=] 

Country Code:,_l _o_o_-_u_s_R ____ ,..__,I 

Short uersion string: ... J 1_._o ________ __, 

Long uersion string (uisible in 6et Info): 

R shared library with its code in the data fork 
of this file. 

FIGURE 11.3 THE 'VERS' RESOURCE FOR THE COMPANYINFO IMPORT LIBRARY. 

'""Ii . Compon Info Info 

II Company Info 

Kind : Test App 1 document 
Size : 11 K on disk ( 1 ,26 7 bytes used) 

Yhere: Hard Disk 340: CodeWarrior™ 
Gold f :(11) Test 1 Lib f: 

Created : Sat, Aug 20, 1 994, 1 :35 PM 
Modified : Sun, Aug 21 , 1 994, 1 0 :54 PM 
Yersion : A shared library with its code in 

the data fork of this file. 
Comments: 

0Locked D Stationery pad 

FIGURE 11.4 THE GET INFO DIALOG BOX FOR THE COMPANYINFO IMPORT LIBRARY. 
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The import library displays an alert, so I'll need to create an 'ALRT' 
resource and a 'DITL' resource. Figure 11.5 shows what the 'DITL' for 
my example looks like. 

ALRT DITL 

2.0bl 
6.0.5 
7.0 ... 

veors 

Dills from Companylnfo 
Size Name 

128 184 

Software Unlimited, Ltd. 
68030 Pragma Way 
Silicon Ualley, CA. 

Custom software for both the 680HO-based 
Macintosh and the Power Macintosh. 

[ OK ) 

FIGURE 11.5 THE 'Dill' RESOURCE FOR THE COMPANYINFO IMPORT LIBRARY. 

With the resources added, I'll save the file and quit the resource editor. 
Next, I'll need to create a CodeWarrior project to hold the source code 
for the import library. 

The Import Library Project 

An import library starts out as a project-just as an application does. I've 
created a Metrowerks C/C++ PPC project named Companylnfo.µ-you 
can see the project window in Figure 11.6. Depending on the code that 
makes up the import library, you may or may not need some of the three 
libraries that you add to Code Warrior application projects-InterfaceLib, 
MathLib, and MWCRuntime.Lib. In Figure 11.6 you can see that I've 
gone ahead and added all three of these libraries to the project. 
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lnterfacelib 0 ! 0 i [I 0 
Hathlib 0 ! 0 ! [I 

.......... ~~-~~-~-~.!~~.!.:.~.~-~ ......... l.. ............. 9.l... ............ 9.1... ............. .JD .. 

3 file(s) OK OK 

FIGURE 11.6 THE COMPANYINFO PROJECT WINDOW. 

When you create a new project using Code Warrior, the compiler assumes 
that an application will be built from the project. To indicate that this 
project will instead be a shared library, select Preferences from the Edit 
menu. In the preferences dialog box, click on the Project icon to display 
the Project panel. Use the pop-up menu to change the project from an 
application to a shared library. That's shown in Figure 11.7. 

Project type must 
be "shared library" 

Hpply to open project. 

Project Type: 

Shared Library Info:------~ D 
Linker 

ared Library "Y 

' ~~; 
File Name Companylnfo 

.if:· A" .. ,. 
Access Paths , 

(Factory Settings J ( Re1.1ert Panel J ( Cancel J fi OK lJ 

Creator can 
be any four 
characters 

Type can 
be any four 
characters 

FIGURE 11. 7 SETIING A PROJECT'S TYPE TO SHARED LIBRARY 

USING THE CODEWARRIOR PREFERENCES DIALOG BOX. 
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This figure also shows that the file creator and the file type have been 
changed. Every file has a four character creator. I've selected 'TSTl' for 
"test 1." While the choice of creator is arbitrary, you should set this field 
to 'TSTl' if you want your project to match the remaining figures in this 
chapter. For an application, the file type must be set to 'APPL.' For a 
library, the file's type is arbitrary. I've named mine 'dLIB,' hinting that 
the file will be a library held in the data fork of a file. 

Note that the choice of 'dLIB' isn't any kind of Apple or 
Metrowerks naming convention-it was strictly my choice. 
If I was creating an application, I would have to use 'APPL' 
as the file type. If I was creating a text file, I would have to 
use 'TEXT' as the file type. Since there is no pre-existing 
Companylnfo type, I can use whatever characters I want. 

There is one combination of characters that will make your 
import library fall into a specific category of import 
libraries. If you set the project type to 'shlb', your import 
library will get a standard shared library icon. You'll see an 
example of a 'shlb' later in this chapter. 

Before dismissing the preferences dialog box, click on the Linker icon. 
That will display the Linker panel, which is shown in Figure 11.8. This 
panel allows you to specify the three optional entry points into your 
import library. In Figure 11.8 you can see that these three entry points 
default to _initialize, _start, and _terminate. 

Each entry point corresponds to one of the three special routines that 
a fragment can define. Entering the names of an import library's special 
routines lets the linker generate exported symbols for this library. As dis­
cussed earlier in this chapter, a PowerPC linker will generate export sym­
bols for a library fragment. When an application fragment is created, the 
linker will also generate imported symbols in that fragment. The import­
ed symbols it generates will be for the library routines that are called by 
the application. During run time, it will be the job of the Code Fragment 
Manager to see to it that the export symbols of shared library routines are 
paired with import symbols in the application that calls these routines. 
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Apply to open project. 

• Language 

& 
Warnings t 1 

''!Ill I~~ 
:fij~ 

Processor fillli !I I il!ll, 
,,~ 

Link Options:--------~ 
[8] 6enerate SYM File 

[81 Use Full Path Names 

D Generate Link Map 

D Suppress Warning Messages 

1:81 Faster Linking (uses more memory) 

Entry Points:---------
1 nitialization: I-initialize 

::::::::==============~ 
Main: J-start 

Termination: I-terminate 

(Factory Settings J ( Reuert Panel J ( Cancel J ( OK ] 

FIGURE 11.8 THE ENTRY POINTS FOR AN IMPORT LIBRARY ARE 

LISTED IN THE PREFERENCES DIALOG BOX OF CODEWARRIOR. 

The Linker panel requests that the entry points be given by function 
name. So in order to specify the library entry points, I'll need to be famil­
iar with the source code for the import library. Since I've already written 
the code for the Companylnfo library, I know that it defines one of the 
three special routines-an initialization routine named 
My_lnitialize_Routine(). I'll enter that name in the Linker panel, 
and, since my Companylnfo source code doesn't define either a main 
routine or a termination routine, I'll make sure that I blank out the 
other two edit boxes. Figure 11.9 shows the Linker panel after I've listed 
the initialization routine. 

After listing the special routines, the preferences dialog box can be dis­
missed. The only thing left to do to the project is to add a source code file. 

The Import Library Source Code 

An import library project needs a source code file, just as an application 
project does. While still in CodeWarrior, I'll select New from the File 
menu, and then Save from the File menu. When prompted for a file 
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name, I entered the name Companylnfo.c. After dismissing the Save dia­
log box, I selected Add Window from the Project menu. That added the 
new source code file to the project window, which now looks like the one 
shown in Figure 11.10. 
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Hpply to open project. 

I 
D 

PEF 

• Project 

• Access Paths 

link Options:---------~ 
181 Generate SYM File 

181 Use Full Path Names 

D Generate link Map 

D Suppress Warning Messages 

181 Faster linking (uses more memory) 

Entry Points: ~========:::::i 
Initialization: 

r==========;;>J~===: 
Main: 

r===== 
Termination: 

If your import library defines any of the 
three special routines, list them here. 

FIGURE 11.9 SETTING THE NAME OF AN IMPORT LIBRARIES INITIALIZATION 

ROUTINE IN THE CODEWARRIOR PREFERENCES DIALOG BOX. 

Company lnfo.c 01 0 l III -0 
lnter-facelib 0 ! O ! III 
Mathlib 0 ! 0 ! III 

.......... ~~-~~-~-~-~~~.!.:.~.~-~ ......... l... ............ 9.l... ........... g.l... ............. .JD .. 

4 file(s) OK OK 

FIGURE 11.10 THE COMPANYINFO PROJECT WINDOW. 
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Next, I'll type in the library source code-it's listed below. Since I walked 
through the source code for the Companylnfo library earlier in this 
chapter, I'll forego any explanation here. If you have any questions about 
it, flip back to the section titled Import Library Code. 

//+++++++++++++++ include directives +++++++++++++++ 

#include <Fragload.h> 

//1111111 I++++++++ define directives +++++++++++++++ 

1/defi ne ABOUT_COMPANY_ALERT 128 

//1111111 I+++++ initialization routine +++++++++++++ 

OSErr My_Initialize_Routine( InitBlockPtr init_block_ptr 
{ 

FSSpecPtr 
short 

the_FSSpec_ptr; 
res_ref_num; 

the_FSSpec_ptr = init_block_ptr->fraglocator.u.onDisk.fileSpec; 
res_ref_num = FSpOpenResFile( the_FSSpec_ptr , fsCurPerm ); 
UseResFile( res_ref_num ); 

Alert( ABOUT_COMPANY_ALERT, nil ); 

CloseResFile( res_ref_num ); 

return ( noErr ); 
} 

To build the library, select Make from the Project menu-just as you 
would do if you were building an application from a project. Because you 
used the preferences dialog box to set the project type to shared library 
rather than application, the compiler will generate an import library 
rather than an application. After building the Companylnfo import 
library, the folder that holds the project looks like the one pictured in 
Figure 11.11. 
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!fl ( 11) Test 1 Lib t liij 
4items 95.9 MB in disk 58.2 MB available 

;!£ 

D D . ~ D 
Company! nfo .).l Company! nfo.c Company! nfo .).l .rsrc Company ! nfo 

to 
¢1 1¢ vs 

FIGURE 11.11 THE ICON FOR THE COMPANYINFO IMPORT LIBRARY. 

In Figure 11.11 you can see that the Finder gives the import library a 
generic document icon. You and I know, however, that the import library 
consists of much more than what a typical document normally holds. To 
take a look, I opened the Companylnfo library with ResEdit. Note that I 
opened the library itself-not the Company.µ.rsrc resource file that was 
used for the project. Figure 11.12 shows that the resource fork of the 
import library consists of the 'ALRT,' 'DITL,' and 'vers' resources that 
originated in the Company.µ.rsrc resource file. Because the import 
library is a PowerPC file, CodeWarrior added a 'cfrg' resource. 

To get an idea of what the entire library looks like, I selected Get Info 
for Companylnfo from the File menu of ResEdit. The dialog box that 
opened showed that the library's creator was 'TSTl' and its type was 
'dLIB'- as set in the CodeWarrior project. More importantly, the dialog 
box shows that the data fork for the import library isn't empty-there's 
529 bytes in it. Those bytes are the import library code that posts the alert. 

CREATING A TEST APPLICATION WITH CODEWARRIOR 

By definition, an import library is not standalone code. So in this section 
I'll use CodeWarrior to create a simple application fragment that 
includes a call to Get Di skFragment( ). The fragment that 
GetDi skFragment() loads and executes will of course be the 
Companylnfo shared library that was developed in the previous section. 
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Company Info 

[l2I]] :!n:!:: 
~ 

2.0bl 
01 1010 10 6.0.5 :f:!!!!: 

-

= 7.0 ... 

ALRT cfrg DITL vers 

l§Jiii Info forCompanylnfo 

'--
File: I Company Info I D Locked 

Type : I dLIB I Creator: I TSTI I 
D File Locked D Resources Locked File In Use: Yes 
D Printer Driuer MultiFinder Compatible File Protected: No 

Created: I Sat, Aug 20, 1994 I Time: I 1 :35:55 PM I 
Modified: I Sun, Aug 21, 1994 I Time: 110:54:29 PM I 

Siz e: 738 bytes in resource fork 
529 bytes in data fork 

Finder Flags: @7.H Q6.0 .H 

0 Has BNDL D No INITs Label : [ None ... 1 
D Shared ~ lnited D lnuisible 

D Stationery D Alias D Use Custom Icon 

FIGURE 11.12 THE RESOURCE FORK OF THE COMPANYINFO IMPORT 

LIBRARY, AND THE RESEDIT GET INFO DIALOG BOX FOR THAT LIBRARY. 

The Application Resources 

The simple test application, which I'll name TestAppl, has no menus, 
windows, or dialogs- so it requires no resources. However, since System 7 
applications typically have a 'vers' resource that gives information about 
an application, I'll create a resource file that holds a 'vers' resource-it's 
shown in Figure 11.13. 

r:l1 
N 0 T E 

System 7 applications should have a 'SIZE' resource, too. 
Since the Metrowerks compiler adds this resource during 
the build of an application, I won't bother adding one 
myself. Additionally, a PowerPC application should contain 
a 'cfrg' resource. Again, the Metrowerks compiler will add 
that to the application when it gets built. 
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TestApp 1.µ.rsrc 

2.0bl I 6.0.5 
7.0 ... [iii uers ID 1 from TestRpp 1.µ.rsrc 
vers 

Uersion number: EJ.[CJ.@=J 
Release:! Final ""'"I Non-release: Li 
Country Code:I 00 - USR ""'"I 

Short uersion string: 11.0 I 
Long uersion string (uisible in Get Info): 

lTest app. to load and run eHternal code from a J 
shared library. 

FIGURE 11.13 THE 'VERS' RESOURCE FOR THE TESTAPP1 TEST APPLICATION. 

The Application Project 

The TestAppl project contains a single source code file and the three 
libraries that I add to each of my Metrowerks PowerPC projects. For now, 
I've created a new, empty source code file named TestAppl.c and added 
it to the project- I'll describe the source code just ahead a bit. The pro­
ject window is shown in Figure 11.14. 

TestRpp 1.J.l 

File Code Data ~ " 
Test Appl .c 0 ! 0 ! [il {} 
lnterfacelib 0 ! 0 ! [il r'-1 

Hathl ib 0 ! 0 ! [il 

.......... ~~.i:.~.~.~.~~~.!.:.~_i_h. .... L. ........... ~L. ........... g.: .................. Jll. 

4 file(s) 4K OK 

FIGURE 11.14 THE TESTAPP1 PROJECT WINDOW. 
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Next, I selected Preferences from the Edit menu to open the preferences 
dialog box. I clicked on the Project icon to display the Project panel. As 
it did for a shared library, this panel allows me to set the project type and 
set the fragment's creator and type. The project type should of course be 
"Application." The type of any application is 'APPL,' which CodeWarrior 
has defaulted to. While I can give the fragment any four character cre­
ator name I want, I selectively chose to give it the same creator as the 
import library- 'TSTl .' 

The power of an import library is that it can be used by any program 
that knows how to load it. So an import library doesn't have to have a 
Creator type that is the same as the application that will be using it. In 
this example, though, I have given both the library and the test applica­
tion that will load it the same creator type. I've done this for only one 
reason- it will make giving the library its own distinctive icon easier. 
Providing a nongeneric icon for the library won't be covered until 
Chapter 12-but it can't hurt to plan ahead. Figure 11.15 shows the 
Project panel for the TestAppl project. 

Rpply to open project . 

• Processor 

D 
Linker 

D 
PEF 

• 

Project Type: 

r t" I f 

Application 

n r pp 1ca ion n o: 

File Name ITestnppl 

Creator TSTl 
'SIZE' Flags~ 

Type RPPL 

Preferred Heap Size (k) 100 

Minimum Heap Size (k) 100 

Stack Size (k) 64 

(Factory Settings) ( Reuert Panel ) ( Cancel ) n OK J) 

FIGURE 11.15 THE PROJECT PANEL FOR THE TESTAPP1 PROJECT. 
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The Application Source Code 

The TestAppl application has only one purpose-to see if 
Get Dis kFragment () really does load an import library and automatical­
ly execute that library's initialization routine. The TestAppl application, 
when launched, will perform the standard Toolbox initializations, then 
load the Companylnfo library created in the previous section. 

Because the application fragment uses fragment loading code, I'll 
want to include the FragLoad.h universal header file-just as I did for 
the import library: 

#include <Fragload.h> 

Next, I'll list the function prototypes for the three application-defined 
functions. I'll also add a /ldefi ne directive to the top of my code so that 
if I ever decide to rename the Companylnfo import library, I won't have 
to search through the source code to find any references to it. 

void Initialize_Toolbox( void ); 
void Load_Library( FSSpec ); 
void Unload_Library( void ); 

//define CO_I N FO_LI B_STR "\pCompanyinfo" 

The TestAppl program uses two global variables. Li b_Ma i n_Pt r is a 
pointer to the import library's main routine. Since the Companylnfo 
library doesn't define a main routine, this variable won't be of signifi­
cance in this program. I'll still need it, though, as one of the parameters 
to GetDi skFragment( ). The second variable is Li b_Connect_ID. This 
will serve as the application's connection to the imported library. 

Ptr Lib_Main_Ptr nil: 
ConnectionID Lib Connect ID O; 

Next, it's on to some real code. The main ( ) function first calls a routine 
that performs the standard Toolbox initialization. Then, a call to the 
Toolbox function FSMa ke FSSpec ( ) is made. You'll recall that an import 
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library is loaded by way of a call to GetDi skFragment( ), and this func­
tion requires a pointer to an FSSpec. I'll use the call to FSMa ke FSSpec ( ) 
to request that the Toolbox create an FSSpec for the import library file. 
With the FSSpec established, I'll call an application-defined function to 
take care of the actual loading of the import library. Loading the library 
will kick off the library's initialization routine-which means an alert will 
be displayed. When the user dismisses the alert, I'll consider my test pro­
gram finished. I'll call the last application-defined routine, 
Unl oad_L i brary( ), to unload the import library fragment. Here's a 
look at the ma i n ( ) function: 

void main( void ) 
{ 

} 

FSSpec the_FSSpec; 

Initialize_Toolbox(); 
FSMakeFSSpec( 0, OL, CO_INFO_LIB_STR, &the_FSSpec ); 

Load_Library( the_FSSpec ); 

Unload_Library(); 

The Lo ad_ Li bra r y ( ) function is centered around a call to 
GetDi skFragment( ). But before calling this routine, I'll make a call to 
the last of the application-defined routines-Un l o ad_ Li bra r y ( ) . 
Unload_Library() checks to see if there is already an open import 
library. If there is, it gets unloaded. 

The call to Get Dis kFragment () should look familiar. It's eight para­
meters were all discussed in this chapter's Loading and Executing Import 
Library Code section. When the call is complete, the error variable 
should have a value of no Error. If it doesn't, Load_L i bra ry () unloads 
the problemed library and exits. 

You'll want to consider a more graceful way of handling a 
failed library load. After unloading the library, you could 
post an alert that gave the user an informative message 
based on the value of the error variable. 
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void Load_Library( FSSpec the_FSSpec ) 
{ 

OSErr error = noErr; 
Str255 error_name; 

Unload_Library(); 

error = GetDiskFragment( &the_FSSpec, 
o. 

if ( error != noErr ) 
{ 

} 

Unload_Library(); 
ExitToShel l (); 

o. 
the_FSSpec.name, 
kloadNewCopy, 
&Lib_Connect_ID, 
(Ptr *)&Lib_Main_Ptr, 
error_name ); 

The Un 1 o a d_L i bra r y ( ) function first checks to see if there is a valid 
connection to a library. If Li b_Connect_ID has a nonzero value, then 
there is. The Code Fragment Manager routine Cl oseConnect ion () is 
then called to unload the fragment. Before the routine ends, the global 
variable Li b_Connect_ID is set to 0 to show that no library is open. 

void Unload_Library() 
{ 

} 

if < Lib_Connect_ID != 0 ) 
{ 

} 

CloseConnection( &Lib_Connect_ID ); 
Lib_Connect_ID = O; 

Here's an uninterrupted look at the source code for TestAppl. Once you 
grasp how this application works, you're well on your way to understand­
ing PowerPC import libraries. 
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//+++++++++++++++ include directives +++++++++++++++ 

#include <Fragload.h> 

//+++++++I 11111+ function prototypes +++++++++++++++ 

void Initialize_Toolbox( void ); 
void Load_Library( FSSpec ); 
void Unload_Library( void ); 

//++++++++++++++++ define directives +++++++++++++++ 

1/defi ne CO_I N FO_LI B_STR "\pCompanyinfo" 

//11111111111111++ global variables 1111111111111+++ 

Ptr Lib_Main_Ptr = nil: 
ConnectionID Lib_Connect_ID = 0: 

//++++++++++++++++++++++ main ++++++++++++++++++++++ 

void main( void ) 
{ 

FSSpec the_FSSpec; 

Initialize_Toolbox(); 

FSMakeFSSpec( 0, OL, CO_INFO_LIB_STR, &the_FSSpec ); 

Load_Library( the_FSSpec ); 

Unload_Library(); 
} 

//1 I I I I I I I I I I I I initialize the Toolbox I I I I I I I I I I+++ 

void Initialize_Toolbox( void 
{ 

InitGraf( &qd.thePort ); 
InitFonts( >: 
InitWindows(); 
InitMenus(); 
TEinit(); 

307 



Programming the PowerPC 

InitDialogs( OL >: 
FlushEvents( everyEvent, 0 >: 
InitCursor(): 

} 

//11111111111111111 load a library 11111111111111111 

void Load_Library( FSSpec the_FSSpec ) 
{ 

} 

OSErr error = noErr: 
Str255 error_name: 

Unload_Library(): 

error = GetDiskFragment( &the_FSSpec, 
o. 

if ( error != noErr ) 
{ 

} 

Unload_Library(); 
ExitToShell (): 

0, 
the_FSSpec.name, 
kloadNewCopy, 
&Lib_Connect_ID, 
(Ptr *)&Lib_Main_Ptr, 
error_name ): 

//1111111111111111 unload a library 1111111111111111 

void Unload_Library() 
{ 

CloseConnection( &Lib_Connect_ID >: 
} 

Once I've entered all the source code, I'll select Make from the Project 
menu. The result will be a PowerPC application named TestAppl. Figure 
11.16 shows the folder that houses both the TestAppl project and the 
Companylnfo project. 

If you open the TestAppl application (not the TestAppl.µ.rsrc file) 
with ResEdit you'd see that CodeWarrior added the required 'cfrg' 
resource-as well as a 'SIZE' resource-to the 'vers' resource that came 
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from the TestAppl.µ.rsrc file . That's shown in Figure 11.17. Note that 
there are no 'CODE' resources in the application. I'm only looking at 
the resource fork of the application, while the code is in the data fork. 

=iii (11) Test 1 Lib f Iii~ 
8 items 95 .9 MB in disk 58 .2 MB avai l abl e 

¢J 

~ D . ~ ~ 
TestApp 1.J.l TestApp 1.c TestApp 1.u.rsrc TestApp 1 

n D . ~ D 
Companylnfo.u Company! nfo.c Company ! nfo .u .rsrc Company ! nfo 

FIGURE 11.16 THE FOLDER THAT HOLDS BOTH THE TEST 

APPLICATION AND THE IMPORT LIBRARY. 

Iii TestRppl Iii] 
0 I 01 1 101 

{} 
(u) I O I O(t l 

~ 
2.0bl i-=-

0 11 0 I 0 I 0 6.0.5 0(10 1 1 1 10 
0 I 00 OO(u) 

. 
7.0 ... ... 

cfrg SIC::E ver-s 

,Q 

-0 
1¢ Ii 

FIGURE 11.17 THE RESOURCE FORK OF THE TESTAPP1 TEST APPLICATION. 

Executing the Application and the Library 

Running the TestAppl code will cause the Companylnfo library to get 
loaded, and its initialization routine code to execute. The call to the 
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application-defined routine Load_Library() takes care of that. When I 
ran TestAppl I saw the alert that's pictured in Figure 11.18. 

Software Unlimited, Ltd. 
68030 Pragma Way 
Silicon Ualley, CA. 

Custom software for both the 680HO-based 
Macintosh and the Power Macintosh. 

FIGURE 11.18 THE ALERT DISPLAYED BY THE COMPANYINFO IMPORT LIBRARY. 

Clicking the OK button dismisses the alert and ends the program. To see 
the import library code execute, I again ran TestAppl-but this time 
from within the CodeWarrior environment. Holding the option key 
down while selecting Run from the Project menu starts the debugger. 
Instead of just one debugger window open, I want two windows-I want 
to view the source code of both the test application and of the import 
library. So I selected Open from the File menu and opened the 
Companyinfo.xSYM file. 

When a file is compiled using CodeWarrior, the compiler 
saves debugging symbols in a .xSYM file. The file will have 
the source code file name with .xSYM appended to it. 

Next, I set two break po in ts. I set the first at the call to Lo ad_ Li bra r y ( ) 
in main ( ) of the test application. The second was set at the first exe­
cutable line in the initialization routine of the Companyinfo import 
library. These breakpoints are shown in Figure 11.19. 

Selecting Run from the Control menu starts the TestAppl application 
running. It stops at the breakpoint by the call to Load_L i brary( ). The 
arrow in Figure 11.20 indicates this. 
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Testflppl 

Ox 1 34054 ( 68K ) ~ the_fSSpec ! OxOOBEB 1 EO 
Em To NatE ndMovePa rams 
___start 

lni ti al ize_Toolbox( >; 

FSMakeFSSpec ( 0, OL , CO_INF0--1..18....STR, &the.5SSpec >; 

• Load--1.. i brary < the.5SSpec ) ; 

Un I oad--1.. i brary() ; 

lnfo.HSYM 

*Linker-Generated* 

•define ABOUT ...PRODUCTS....ALERT 128 

FIGURE 11.19 5ETIING BREAKPOINTS IN BOTH 

THE TEST APPLICATION AND THE IMPORT LIBRARY. 

Ox 134054 ( 68K) 
E mTo Nat E ndMove Pa rams 
___start 

lni lial ize_Toolbox< >; 

TestRppt 

if" ~ t he_FSS pee 

I 
!OxOOBEB130 ~ 

FSMakeFSSpec< 0 , OL , CO_INF0--1..18....STR, &the.5SSpec >; 

• !• Load--1.. i brary ( the.5SSpec ) ; 

Un I oad--1.. i brary <) ; 

void Initial ize_Toolbox() 

[!)!ill Line: 29 T Source 

FIGURE 11.20 BREAKING JUST BEFORE THE CALL TO L 0 ad_ Li bra r y ( ) • 
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Selecting Run once more from the Control menu resumes execution 
until the next breakpoint is reached. That will occur right away. In the 
application-defined Load _ L i bra ry () routine, the Code Fragment 
Manager function Get Di skFragment() is called. When 
Get Dis kFragment () loads the code for the Companylnfo library, execu­
tion jumps to the initialization routine of that library­
My_Initi al i ze_Routi ne( ) . Since I've set a breakpoint in this routine, 
that's where execution stops. This is shown in Figure 11.21. 

TestRppl Iii 

#define ABOULPROOUCTSJlLERT 128 

#inc I ude <FragLoad . h> 

! OSErr My_lni ti al izeJloutine < lni tBlockPtr ini t...block_ptr ) •i• { 
short res....re f _num ; 

res...reL.num = FSpOpenResF i I e< 
UseResF i I e ( res.J"e f ..J1um ) ; 

in i t...b I ock_ptr-> fragloca tor . u. om 

If •Iii l!Hill Li ne: 7 ] Source 

FIGURE 11.21 BREAKING IN THE IMPORT LIBRARY'S INITIALIZATION ROUTINE. 

From this simple test you can indeed see that the loading of an import 
library is sufficient to trigger the execution of that library's initialization 
routine. You'll never need to explicitly call it yourself. This isn't true of a 
library's main routine, as you'll see in the next chapter. 

LOADING A LIBRARY ON DEMAND 

T he TestAppl application fragment loads the Company Info library at 
application startup. This doesn't have to be, and quite often isn't, 

the case. Your applications can make use of library code only when each 
application requires that code. The most obvious way to implement this 
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conditional loading is through the use of a menu item. In this section I'll 
modify TestA.ppl to include a menu bar and menus to do just that. I'll 
name the resulting application TestA.pp2. 

The Test Application's Resources 

TestA.pp2 will have a menu bar with three menus-their 'MENU' 
resources are shown in Figure 11.22. I'll tie the three 'MENU' resources 
together using a 'MBAR' resource-shown in Figure 11.23. 

Rbout Test ... 
r:.-:1 __ _ 
! 
! 

! .................................................................... .. 

r~a•«iw• ................................... . 
I Company Info ... I 

L ____ , 
128 129 130 

FIGURE 11.22 THE 'MENU' RESOURCES FOR TESTAPP2. 

11 of menus 3 

1) ***** 
Menu res ID I 126 

2) ***** 
Menu res ID I 129 

3) ***** 
Menu res ID I 130 

'I) ***** 

FIGURE 11.23 THE 'MBAR' RESOURCE FOR TESTAPP2. 
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The Apple menu will have the standard About item. I've included an 
'ALRT' and 'DITL' resource to handle that menu item. The 'DITL' is 
shown in Figure 11.24. 

ALRT DITL 

TestApp2.µ.rsrc 

D Ills from TestApp2.µ.r 
Size Name 

128 80 

-Iii~ OITLID = 128Ji;qmJet 

R test application that 
loads import libraries. 

( OK ) 

FIGURE 11.24 THE 'DITL' RESOURCE FOR TESTAPP2. 

The File menu will be used to quit the program, while the Utilities menu 
will be used to give the user the opportunity to load the Companylnfo 
library. Figure 11.25 shows all the resource types in the TestApp2 
resource file. 
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ALRT DITL 

JestRpp2.p..rsrc 

w . . 
MBAR MENU 

2.0bl 
6.0.5 
7.0 ... 

vers 

FIGURE 11.25 THE RESOURCE TYPES FOUND IN TESTAPP2. 
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The Argument for Import Libraries 

For simplicity, TestApp2 has just a single menu item that loads an import 
library. But this idea could easily be extended. Add-on tools, or utilities, 
are becoming a popular feature of many commercial applications. Figure 
11.26 shows the Tools menu of the word processor Microsoft Word. 

Spelling... 38L 
Grammar... 38i!G 
Thesaurus ... 
Hyphenation .. . 
Word Count .. . 

Renumber ... 
Sort 
Calculate 38= 
Repaginate Now 

Preferences ... 
Commands... 38i!~C 

FIGURE 11.26 THE TOOLS MENU FROM THE MICROSOn WORD WORD PROCESSOR, 

If you have Microsoft Word, you'll notice that the installation of that soft­
ware package added a Word Commands folder to your hard drive. Figure 
11.27 shows some of that folder's contents. Note in the figure that some 
of the icons, such as Spelling and Thesaurus, correspond to menu items 
from the Word Tools menu. 

If Microsoft updates its Word Thesaurus, it only has to make the new 
Thesaurus document available to the public. The Word application itself 
need not be redistributed. The new Thesaurus can be sent to registered 
users, or posted to electronic bulletin boards. Software piracy isn't a con­
cern because without owning the Word application, the Thesaurus itself 
is useless. 
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Word Commands liij 
28 items 309 .2 MB in disk 15 MB available 

~ ~ ~ ~ 
Equation Editor Find File Grammar Mail Microsoft Movie Pl M 

~ 
Spelling 

~ ~ ~ 
~ ~~ 

Symbol Thesaurus Picture Voice Annotation 

FIGURE 11.27 THE WORD COMMANDS FOLDER THAT 

IS A PART OF THE MICROSOFT WORD PACKAGE. 

A word processor isn't the only type of application that could be 
enhanced by a utilities-type menu. So TestApp2 serves as a foundation for 
a program that includes a Tools (or Utilities, or Plug-Ins, or Options, 
etc.) menu. Here 's a couple of ideas: 

• A mathematical program might keep different equation-solving 
algorithms as separate libraries. If an inaccurate algorithm is ever 
found, it can easily be replaced. Or, if a faster or more precise 
one if found, it can be substituted for the original one. 

• As the typical Mac's memory and processor speed both increase, 
an existing menu item could be enhanced to take advantage of 
this power. Consider a program that had a Play Movie menu item 
that allows the user to select and play a single QuickTime movie. 
With the assumption that users now have increased memory and 
processor speed, the import library that held the movie-playing 
code could be altered to give the user the option of opening two 
or more movies simultaneously. 
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The Test Application's Code 

TestApp2 differs from TestAppl in just one respect-it has menus and a 
menu bar. So I'll keep the source code walk-through to a minimum, with 
emphasis placed on the differences from TestAppl. I won't skim through 
the code too quickly, however. As mentioned, TestApp2 serves as a good 
shell for any program that will make use of libraries "on demand." 

TestApp2 begins by including FragLoad.h. Next, a function prototype 
appears for each function. Then a host of 4fdefi ne directives are added 
to keep numbers out of the source code listing. Most of the directives are 
menu resource IDs. The preliminaries end with the declaration of three 
global variables. You saw Li b_Ma i n_Pt r and Li b_Connect_ID in 
TestAppl. The third variable is A 11 _Done, used to signal the end of the 
program. 

//+++++++++++++++ include directives ++1111111111111 

#include <Fragload.h> 

//I I I I I I++++++++ function prototypes +++++++++I I I I I I 

void 
void 
void 

void 
void 
void 
void 
void 
void 
void 
FSSpec 

Initialize_Toolbox( void ); 
Load_Library( FSSpec ); 
Unload_Library( void ); 

Set_Up_Menu_Bar( void ); 
Main_Event_Loop( void ); 
Handle_Mouse_Down( EventRecord ); 
Handle_Menu_Choice( long ); 
Handle_Apple_Choice( short ); 
Handle_File_Choice( short ); 
Handle_Utility_Choice( short ); 
Get_File_Spec( Str255 ); 

//++++++++++++++++ define directives +++++++++++++++ 

/fdefi ne CO_I NFO_LI B_STR "\pCompanyinfo" 

/fdefi ne MENU_BAR_I D 128 
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/ldefi ne 
/ldefi ne 
/ldefi ne 
/ldefi ne 
/ldefi ne 
#define 

#define 

APPLE_MENU_ID 
SHOW_ABOUT ITEM 

FILE_MENU_ID 
QUIT_ITEM 

UTILITY _MENU_ID 
CO_INFO_ITEM 

ABOUT _ALERT _ID 

128 
1 

129 
1 

130 
1 

128 

//I I I I I I I I++++++++ global variables +I I I I I I I I I I I I I I I 

Ptr Lib_Main_Ptr =nil: 
ConnectionID Lib_Connect_ID = O: 
Boolean All_Done =false; 

The program's main ( ) routine initializes the Toolbox, sets up the menu 
bar, then calls Mai n_Event_Loop ( ) to loop repeatedly until the program 
ends: 

//++I I I I I l+++++++I I I I I I+ main +++++I I I I I I I I I I I I I I I I I 

void main( void ) 
{ 

Initialize_Toolbox(); 

Set_Up_Menu_Bar(); 

Main_Event_Loop(); 
} 

You've seen Initialize_Toolbox() in the past, so I'll omit its code 
here. Set_Up_Menu_Ba r () uses the standard Menu Manager Toolbox 
calls to set up the menu bar, get a handle to the Apple menu, add the 
Apple items to it, and draw the menu bar at the top of the screen: 

//++++++++++++++++ display menu bar +111111+++++++++ 

void Set_Up_Menu_Bar( void 
{ 

Handle menu_bar_handle: 
MenuHandle apple_menu: 

menu_bar_handle = GetNewMBarC MENU_BAR_ID ); 
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} 

SetMenuBar( menu_bar_handle ); 
DisposHandle( menu_bar_handle ); 

apple_menu = GetMHandle( APPLE_MENU_ID ); 

AddResMenu( apple_menu. 'DRVR' ); 

DrawMenuBar(); 

Main_Event_Loop{) contains no surprises. It relies on 
Wai tNextEvent () to store information about the most recent event. A 
mouse Down event is sent to Handl e_Mouse_Down () for further process­
ing. A keyDown event that includes a press of the command key is 
assumed to be an attempt to access a menu item, and is sent to 
Handle_Menu_Choice{). 

//1111111+++++++++ repeat until done +++++++++++++++ 

void Main_Event_Loop( void 
{ 

Event Record 
char 

the_event; 
the_key; 
menu_choice: long 

while ( All_Done ~ false 
{ 

WaitNextEvent( everyEvent, &the_event, 15L, nil ); 

switch ( the_event.what ) 
{ 

} 

case mouseDown: 
Handle_Mouse_Down( the_event ); 
break: 

case keyDown: 
the_key = ( the_event.message & charCodeMask ); 

if ( ( the_event.modifiers & cmdKey ) != 0 ) 
{ 

menu_choice = MenuKey( the_key ); 
Handle_Menu_Choice( menu_choice ); 

} 
break; 
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} 
} 

TestApp2 is interested in mouse clicks in the menu bar, so that's what 
Hand l e_Mous e_Down () looks for. When that happens, 
Handl e_Menu_Choi ce() is called to determine which menu was selected. 

//+++++++ handle a click of the mouse button +++++++ 

void Handle_Mouse_Down( EventRecord the_event 
{ 

} 

WindowPtr 
short 
long 

the_window; 
the_part; 
menu_choice; 

the_part FindWindow( the_event.where, &the_window ); 

switch ( the_part ) 
{ 

} 

case inMenuBar: 
menu_choice = MenuSelect( the_event.where ); 
Handle_Menu_Choice( menu_choice ); 
break; 

case inSysWindow: 
SystemClick( &the_event, the_window ); 
break; 

Handl e_Menu_Choi ce() is simply a junction point. It determines which 
menu the mouse click occurred in, and then calls another application­
defined routine to actually respond to that menu selection. The Toolbox 
routine Hi Word() extracts the number of the selected menu from the 
menu_choice variable, while its companion routine LoWord() extracts 
the number of the selected item in that menu. 

//+++++++++ handle a click in the menu bar 111111111 

void Handle Menu_Choice ( long menu_choice 
{ 
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} 

if ( menu_choice != O ) 
{ 

} 

the_menu = HiWord( menu_choice ); 
the_menu_item = LoWord( menu_choice ); 

switch ( the_menu ) 
{ 

} 

case APPLE_MENU_ID: 
Handle_Apple_Choice( the_menu_item ); 
break: 

case FILE_MENU_ID: 
Handle_File_Choice( the_menu_item ); 
break: 

case UTILITY_MENU_ID: 
Handle_Utility_Choice( the_menu_item ); 
break: 

HiliteMenu( 0 ); 

Handl e_Appl e_Choi ce() is standard Apple menu handling code. An 
About item menu selection posts the alert that I've included in the 
resource file. Any other menu item selection will be taken care of by the 
operating system via a call to OpenDeskAcc( ). 

//11111111 handle a click in the Apple menu 11111111 

void Handle_Apple_Choice( short the_item 
{ 

Str255 
short 
MenuHandle 

desk_acc_name: 
desk_acc_number: 
apple_menu: 

switch ( the_item ) 
{ 

case SHOW_ABOUT_ITEM: 
Alert( ABOUT_ALERT_ID, nil ); 
break: 

default: 
apple_menu = GetMHandle( APPLE_MENU_ID ); 
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} 
} 

Getltem( apple_menu, the_item, desk_acc_name ); 
desk_acc_number = OpenDeskAcc( desk_acc_name ); 
break: 

Handl e_Fi 1 e_Choi ce() is used to quit the application. Setting the 
Al l_Done flag to true will cause the main event loop to terminate and 
end the program. 

//1 I I I I I I I handle a click in the File menu I I I I I I I I I 

void Handle_File_Choice( short the_item 
{ 

} 

switch ( the_item ) 
{ 

} 

case QUIT_ITEM: 
All_Done =true: 
break: 

Handl e_Util i ty_Choi ce() is used to load the proper import library. 
While TestApp2 only recognizes one library, this could be easily changed 
by adding more case labels-and, of course, more menu items to the 
Utilities 'MENU' resource. In preparation for a future enhancement of 
this type, Handl e_Uti 1 i ty_Choi ce() calls an application-defined func­
tion named Get_Fi 1 e_Spec() to get the FSSpec that Load_L i brary() 
needs. The addition of a new case label would require only that the prop­
er file name be passed to Get_Fi 1 e_Spec ( ) . 

//111111 handle a click in the Utilities menu 111111 

void Handle_Utility_Choice( short the_item 
{ 
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{ 

case CO_INFO_ITEM: 
the_FSSpec = Get_File_Spec( CO_INFO_LIB_STR ); 
Load_Library( the_FSSpec ); 
break: 
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} 
} 

Get_Fi 1 e_Spec() accepts a Str255 variable as its only parameter. It 
uses that string to set up a file standard specification, then returns that 
FSSpec to the calling routine. 

//I 11111++++ return an FSSpec for a file +++++++++++ 

FSSpec Get_File_Spec( Str255 the_lib_name 
{ 

FSSpec the_FSSpec; 
OSErr error; 

error= FSMakeFSSpec( 0, OL, the_lib_name, &the_FSSpec ); 

return ( the_FSSpec ); 
} 

The TestApp2 program concludes with Load_Library() and 
Unl oad_L i bra ry(). Both of these functions are identical to the versions 
developed for the TestAppl program earlier in this chapter. 

//+++++++++++++++++ load a library +++++++++++++++++ 

void Load_Library( FSSpec the_FSSpec ) 
{ 

OSErr error = noErr; 
Str255 error_name; 

Unload_Library(); 

error = GetDiskFragment( &the_FSSpec, 
0, 

if C error != noErr ) 
{ 

Unload_Library(); 
ExitToShell (); 

0. 
the_FSSpec.name, 
kloadNewCopy, 
&Lib_Connect_ID, 
CPtr *)&Lib_Main_Ptr, 
error_name ); 

323 



Programming the PowerPC 

} 

} 

//++++++++++++++++ unload a library ++++++++++++++++ 

void Unload_Library() 
{ 

} 

if ( Lib_Connect_ID != 0 ) 
{ 

} 

CloseConnection( &Lib_Connect ID ); 
Lib_Connect_ID = 0; 

SHARING IMPORT LIBRARIES 

0 ne of the primary advantages to using import libraries is that you 
can write one code fragment that can be used-without modifica­

tion-by two or more application fragments. If you're going to do that, 
you won't want to keep a copy of each import library in a folder with 
each application. Instead, you should consider making the shared library 
a shared library ('shlb'). Then, a single copy of it can be stored in the 
user's Extensions folder where it can be accessed by each application. 

Sharing the Companylnfo 
Library Between Applications 

Before creating a 'shlb,' I'll verify that the Companylnfo library can truly 
be shared among applications. I put a copy of both the TestAppl and 
TestApp2 applications in a new folder-along with a single copy of the 
Companylnfo library. This folder is shown in Figure 11.28. Then I ran 
TestAppl. It opened the alert found in Companylnfo. Next, I launched 
TestApp2. I selected Company Info from the Utilities menu, and the 
alert again opened. Success! 
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!§§. 
( 11) Test Both f •l 

3 items 95.9 MB in disk 58.2 MB avai l able 

.Q 

~ D ~ 
TestApp 1 Company! nfo TestApp2 

-0 
<>l 1¢ l1lii 

FIGURE 11.28 A FOLDER CONTAINING TWO APPLICATIONS THAT 

CAN BOTH USE THE CODE IN THE COMPANYINFO IMPORT LIBRARY. 

Creating a 'shlb' Library 

If you have a Power Mac, and you look in the Extensions folder of your 
System Folder, you might find a couple of documents with icons like the 
one pictured in Figure 11.29. This is the standard icon that the Finder 
gives to a shared library whose type is 'shlb.' 

FIGURE 11.29 AN IMPORT LIBRARY OF TYPE 'SHLB' HAS ITS OWN APPLE-DEFINED ICON. 

You can make any shared library a 'shlb' library by simply setting its type 
to 'shlb,' and then recompiling the library. That's what I'm doing to the 
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Companyinfo library in Figure 11.30. I changed the fragment type from 
'dLIB' to 'shlb' in the Project panel of Code Warrior's preferences dialog 
box. 

Rpply to open project. 

n 
llnker 

n 
PEF 

• Iii 
Access Paths ~ 

Project Type: I Shared Library •I 
Shared Library Info:--------, 

File Name I Company Info 

(Factory Settings J ( Reuert Panel J ( Cancel J ([ OK JJ 

FIGURE 11.30 SETTING A FILE'S TYPE TO 'SHLB.' 

Set type 
to'shlb' 

I made no changes to the source code for the library. Instead, I just 
selected Make from the Project menu to build a new version of the 
Companyinfo library. When complete, the library had a different icon. 
Figure 11.31 shows a folder with a copies of all of the files for the 
TestAppl project and Companylnfo project. Note that the import library 
now has the standard shared library icon. 

If you're going to use 'shlb' libraries, you'll want to change your 
application's call to the Code Fragment Manager routine 
GetDi skFragment( ). Instead, you'll want to use the Code Fragment 
Manager function GetSharedlibrary(). Here's the prototype for that 
function: 

OSErr GetSharedlibrary( Str63 
OSType 
LoadFlags 
Connection ID 
Ptr 
Str255 
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Im (11) Test shlb f ra] 
8 items 95.9 MB in disk 58.2 MB available 

¢J 

D D . ~ ~ 
TestApp 1.u TestApp 1 .c TestApp 1.u.rsrc TestApp 1 

D D . ~ ~ 
Company! nfo.u Company! nfo.c Company! nfo.u .rsrc Company! nfo 

FIGURE 11.31 A FOLDER HOLDING THE NEW TESTAPP1 

PROJECT FILES AND THE NEW COMPANYINFO PROJECT FILES. 

v 
t-=-1 

-01 
1¢ \ii 

The first parameter is a string that holds the shared library's name. 
Though it's defined as a Str63 type, you can pass in a Str255 type string 
if the library name has previously been defined as such. The second para­
meter specifies the instruction set architecture of the shared library. I've 
been compiling with a PowerPC compiler, so this parameter should be 
set to the constant kPowerPCArch. The last four parameters to 
GetSharedlibrary() are the same as the last four parameters to 
GetDiskFragment() . 

To take advantage of my 'shlb' library, I modified Load_ Library( ). 
Rather than pass in a FSSpec, the routine now accepts the library name 
as a string. And in place of the call to GetDi skFragment() is a call to 
GetSharedL i brary( ). Here's the new version of that TestAppl and 
TestApp2 routine: 

void Load_Library( Str255 the_lib 
{ 

OSErr error = noErr; 
Str255 error_name; 

Unload_Library(); 
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} 

error= GetSharedlibrary( the_lib, 
kPowerPCArch, 
kloadNewCopy, 
&Li b_Connect_ID, 

if ( error != noErr ) 
{ 

} 

Unload_Library(); 
ExitToShell (): 

(Ptr *)&Lib_Main_Ptr, 
error_name ); 

To call Load_Library(), simply pass in the library name as a string. 
Don't first create an FSSpec. Here's a typical call to Load_L i bra ry (): 

I/define CO_INFO_LIB_STR 

void main( void ) 
{ 

Initialize_Toolbox(); 

"\pCompanyinfo" 

Load_Library( CO_INFO_LIB_STR ); 

Unload_Library(); 
} 

To test out the 'shlb' library type, you can make the above changes to 
TestAppl and to the Companylnfo library. Or you can look in the (11) 
Test shlb f folder-it holds new versions of the project files an applica­
tion and library. Try running the TestAppl program to verify that the 
new Companylnfo library loads. Then, drag the library to your closed 
System folder. The system views the library as an extension, and asks if 
you want to add it to the Extensions folder in the System Folder. Go 
ahead and add the library. Then restart your Power Mac. Now, thanks to 
the inclusion of the Get Sha red Li bra ry () call in TestAppl, that applica­
tion will be able to find and load the Companylnfo library. 
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CHAPTER SUMMARY 

An import library-also known as a shared library-is a code frag­
ment that relies on some other code fragment to load it. The prima­

ry advantage of turning code into an import library rather than an appli­
cation is that as a shared library the code is accessible by any number of 
other code fragments. This reduces redundancy in writing code, and 
makes the chore of updating code an easier task to perform. 

You'll use your development environment to mark the outcome of a 
project to be a shared library rather than an application. Then, you'll 
include a call to the Code Fragment Manager routine Get Dis kFragment () 

in an application fragment. GetDi skFragment() loads a specified import 
library and executes that library's initialization routine-a special import 
library routine that serves as an entry point into the library. 

An import library that has a type of 'shlb' is a special type of shared 
library. The Finder will give the library a standard shared library icon, 
and the import library code will be accessible by your applications even 
when the library is located in a different folder than the application. 
Typically, 'shlb' libraries are kept in the Extensions folder of your System 
Folder. 
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MORE IMPORT LIBRARIES 

I 
n Chapter 11 you learned the basics of import libraries. Because the 
idea of plug-in tools is fast becoming a very popular Macintosh pro­
gramming concept, this chapter is also devoted to import libraries. 

The Power Macintosh and the new Code Fragment Manager now give 
your applications the ability to include this powerful programming fea­
ture . And, with the CodeWarrior PowerPC compiler, creating import, or 
shared, libraries is remarkably simple. 

In this chapter you'll see how to give your import libraries their own 
distinctive icons. You'll also see how to add sophistication to a library by 
supplying it with three entry points- routines that make the library code 
accessible by an application fragment. Finally, you'll incorporate Apple 
events in your application fragment so that an application and an import 
library can communicate with one another via the Finder. 

331 



Programming the PowerPC 

ADDING ICONS TO APPLICATIONS AND LIBRARIES 

M ost applications that make use of an import library give that library 
a distinctive icon that lets the user know either the library's pur­

pose, or by which program that library will be used. This section looks at 
how the 'BNDL' resource makes this possible . 

Adding an Icon to the Application 

To create all of the icons I'll need, I only need to add a 'BNDL' resource 
to one of my applications. As I add and edit icons from the 'BNDL' edi­
tor, ResEdit will add the necessary resources to the resource file. I'll 
begin by selecting Create New Resource from the Resource menu. In the 
Select New Type dialog box that appears, I'll double-click on the 'BNDL' 
resource. That brings up the BNDL editor, shown in Figure 12.1. 

§!EI§ BNOL ID = 128 from TestRpp l.J.1.r -

Signature: I TSTl 

FIGURE 12.1 THE 'BNDL' RESOURCE FOR TESTAPP1. 

The signature should be the same as the creator of the application. I'm 
going to add an icon to my TestAppl program, so the signature should 
be 'TSTl.' Recall from Chapter 11 that 'TSTl' is the creator I used in the 
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preferences dialog box for the TestAppl project. Figure 12.l shows that 
I've typed the proper signature in the Signature edit box in the editor. 

Next, I choose Create New File Type from the Resource menu, hit the 
tab key, and type in the four character file type. I'm creating an icon for 
an application, so this type is 'APPL'. Then I double-click on any of the 
shaded boxes under the Finder Icons heading-as shown in Figure 12.2. 

::111~ BNDL 10 = 128 from TestRppl.J1.r 

Signature: ITSTl 

Type Finder I cons 

1 APP~ 1 mffililllm 0 

FIGURE 12.2 CREATING ICONS FOR THE TESTAPP1 APPLICATION. 

I'll click on the New button in the dialog box that appears. If I had any 
icons in the resource file already, they'd show up in the dialog box list. 
That dialog box is shown in Figure 12.3. 

After the dialog box is dismissed, the icon editor opens. For the 
TestAppl application, I've created an icon that shows a library document 
being moved into the generic diamond application icon. To create the 
other icons shown in Figure 12.4, I simply dragged the small 'ICN#' 
straight down into the 'icl8' box. Then, I added some shading to the icon 
using the tools from the far left of the icon editor window. I repeated 
those steps to create the 'icl4' icon as well. 

After closing the icon editor the 'BNDL' resource now looked like 
the one pictured in Figure 12.5. 
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§lij 

""' • D 

• 0 

• 0 -

Choose an icon for the type APPL: 

New ) ( fiiit ) (Cancel J ( OK 

FIGURE 12.3 IF A RESOURCE FILE HAS ICONS IN IT, RESEDIT 

ALLOWS YOU TO CHOOSE FROM THEM WHEN CREATING A NEW ICON. 

Icon Farnil ID= 128 from Testnpp 1.Jl.rsrc 

••••••••••••••••• ~ B • • • • • • • ics# • • • • • • • • ••• •• • • •• 
~ • • •• B • • • • • ics8 • • ic18 • • • • [11] • • B • • • • • • ics4 • • ic14 • • • • 
~ • • [i] • • • • • • • • • Mask 

• •••••••••••• Mask 

• • • • • • • 

FIGURE 12.4 EDITING THE APPLICATION ICON IN RESEDIT'S ICON EDITOR. 
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BNDLs from TestRpp 1 • .11.rsrc 

Type Finder Icons 
--------t-r"I ., ... RPPL 

FIGURE 12.5 THE FAMILY OF THREE APPUCATION ICONS. 

Adding an Icon to the Library 

There are two ways to add an icon to an import library. You can add a 
'BNDL' resource to the resource file of the import library, or you can 
add to the 'BNDL' in the application resource file. If you're creating a set 
of libraries that will be used as tools with a single application, you'll want 
to use the second method. If you're using Apple events-as you will be 
later in this chapter-this will have the side benefit of causing a double­
click on an import library to launch the application and run the import 
library code. 

By giving each import library a creator that is the same as the applica­
tion that will use it, you can create a single 'BNDL' resource in the appli­
cation to assign icons to each library. You'll see how that happens in this 
section. 

Applications often have owned documents to which they assign their 
own icon. Figure 12.6 shows the 'BNDL' resource from the Microsoft 

335 



Programming the PowerPC 

Word application. Besides the icon for the application itself, the 'BNDL' 
defines icons for documents that the word processor creates or uses. 

Signature: I MSWD I 
Type Finder I cons 

RPPL ~.,, 

TEHT ~ 
WDBN ~ 
GLOS ~ 

~·fill 

~~~ i .. 
~·fill 

~~~ ~, 

FIGURE 12.6 THE 'BNDL' RESOURCE FOR MICROSOFT WORD. 

To create an icon for the Companylnfo import library, I repeated the 
procedure I used for the application icon. As you read over those steps, 
recall that I gave the Companylnfo library a signature of 'TSTl' and a 
type of 'dLIB': 

1. Open the 'BNDL' resource in the TestAppl resource file. 

2. Select Create New File Type from the Resource menu, hit the tab 
key, and type in the four character file type-' dLIB.' 

3. Double-click on any of the shaded boxes under the Finder Icons 
heading. 

4. Click on the New button in the dialog box that appears. 

5. Create a new family of icons in the icon editor. 

When I completed the above steps, the 'BNDL' resource looked like the 
one shown in Figure 12.7. 
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Signature: Inn 
Type Finder I cons 

APPL ~-···· .Q 
dLIB ~ ••••• :' 

FIGURE 12. 7 THE APPLICATION AND IMPORT 

LIBRARY ICONS FOR THE IEsTAPP1 APPLICATION 

However, the Companylnfo library is created from a project 
and a resource file that are separate from the TestApp1 pro­
j ect and resource file. So how will the Companylnfo 
library-which currently has a generic document icon-take 
on the icon created in the TestApp1.11.rsrc file? 

Because I've set the creator of the library to be the same 
creator as the TestApp1 application (TST1). Thus, the 
Finder views the Companylnfo library as a document owned 
by TestApp1-even though it is a shared library that can be 
used by other applications. 

When your work on the 'BNDL' resource is complete, you'll notice 
that five new resource types have been added to the existing 'vers' and 
'BNDL' types. The resource file is shown in Figure 12.8. 

So far you've only changed the resource file that the project uses­
you haven't changed the TestAppl application. You'll want to launch 
Code Warrior and make a new TestAppl. If you don't see the new icons on 
the application and the library after quitting CodeWarrior, restart your 
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Macintosh. If that doesn't work, rebuild the desktop to force the Finder to 
recognize the new icons. Rebuild the desktop by holding the Command 
and Option keys down while you restart your computer. When the new ' 
icons do show up, they'll look like the ones pictured in Figure 12.9. 

FIGURE 12.8 THE RESOURCES THAT MAKE UP THE TESTAPP1 RESOURCE FILE, 

_Iii (12) Icon Lib f lill 
8 items 95.9 MB in di sk 58.2 MB avai lable 

¢J 

D D . [t • TestApp 1 .J.I TestAppl .C TestApp 1.).1.rsrc TestApp 1 

D D . ~ ~ 
Companyl nfo .J.1 Companyl nfo.c Companyl nfo.J.1.rsrc Companyl nfo 

FIGURE 12.9 THE FOLDER THAT HOLDS BOTH 

THE APPLICATION AND IMPORT LIBRARY PROJECTS. 

~ 

-0 
1¢ Iii 

Now that the Finder recognizes a file with a creator of 'TSTl' and a type 
of 'dLIB,' any file that has this creator and type will get the new icon. If I 
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created two additional libraries, and used the CodeWarrior preferences 
dialog box to set the creator to 'TSTl' and the type to 'dLIB,' I'd have 
the results shown in Figure 12.10. 

~ 
N 0 T E 

Test Folder 
4 items 95.9 MB in disk 58 .2 MB available 

[aJ 
TestApp 1 Company! nfo Product Info Registration Form 

flGURE 12.10 ANY IMPORT LIBRARY THAT IS BUILT WITH A CREATOR 

OF 'TST1' AND A TYPE OF 'DLIB' WILL HAVE THE SAME ICON. 

Of course, I'd have to modify the TestApp1 source code so 
that the application would actually do something with the 
libraries. But even without doing that, the point that the 
libraries all get the same icon still applies. 

A SECOND LIBRARY EXAMPLE 

T he Companylnfo library served as a good introduction to how an 
application makes use of an import library. But its simplicity leaves a 

few questions unanswered. Most importantly, once an import library is 
loaded, how does the application code interact with the library code on a 
continuous basis? This section will answer that question. In doing so, I'll 
develop a library named PICTchooser that performs the very useful act 
of displaying a standard get file dialog box that allows the user to open 
and display any existing 'PICT' file. 
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Opening a PICT File 

Before discussing the next example library, I'll cover the details of open­
ing and displaying a PICT file. This code doesn't pertain directly to 
libraries, so I'll get it out of the way here, then brush over it later when I 
use it in the source code of my picture-displaying import library. 

Rather than displaying a predefined picture, I'll be giving the user 
the opportunity to select the 'PICT' file of his or her choice. To do that 
I'll make a call to the Toolbox routine Sta nda rdGet File ( ) : 

SFTypeL i st 
StandardFileReply 

typelist = {'PICT', 0, 0, 0 }: 
reply; 

StandardGetFile( nil, 1, typelist, &reply ); 

The first three parameters to StandardGetFi le() tell the function 
which types of files to display in the dialog box's list. The dialog box will 
display only the type or types you specify, masking out all other file 
types. 

If you want to specify more than four different file types to display, 
you'll need to pass a pointer to a filter function. Since I'm only display­
ing one file type, nil will suffice for this first parameter. The second 
parameter tells how many types of files to list-a value of I is used here. 
The third parameter gives the types of files to list. This parameter is a 
variable of SFTypeL i st type, which is an array of four file types. Each 
type should be a four character file type surrounded by single quotes. 
Empty array elements should simply be assigned a value of 0. My decla­
ration of the SFTypeL i st variable includes a definition of the one file 
type to be displayed: 

SFTypelist typelist = { 'PICT', 0, 0, 0 }; 

The final parameter to StandardGetFi le() is a pointer to a reply struc­
ture. The Standard Fil eRepl y data structure members will be filled in 
for you by the Toolbox. You'll use the sfFi le member when you open 
the picture file: 
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short pict_ref_num = 0; 

FSpOpenDF( &reply.sfFile, fsRdPerm, &pict_ref_num ); 

The Toolbox routine FSpOpenDF () opens the data fork of the file whose 
FSSpec appears as the first parameter. The data fork of a 'PICT' file 
holds the picture information, so this is exactly what I want to work with. 
The second parameter to FSpOpenDF() is a permission level. The user 
won't be given the opportunity to alter, or write, to the picture. Instead, 
the user will just be allowed to view or read it. So the constant fsRdPerm 
works here. 

After opening the file's data fork, FSpOpenDF() returns a file refer­
ence number to the program. You'll use that reference number to gain 
access to the file. Namely, you'll use it in calls to the Toolbox functions 
GetEOF() and SetFPos( ): 

long file_length; 

GetEOF( pict_ref_num, &file_length ); 
SetFPos( pict_ref_num, fsFromMark, 512 ); 

The Get EO F ( ) function returns the logical end-of-file for the file speci­
fied in the first parameter. The logical end-of-file will yield the actual 
number of bytes of data that the picture occupies-not the physical size 
allocated for the file, which may be a greater value. I'll save this value in 
the long variable file_ length. 

All 'PICT' files have a 512 byte header that holds data unrelated to 
the picture data itself. I'll use a call to Set FPos ( ) to position the file 
mark just past this header information. The file mark tells the File 
Manager where to begin writing or, in my case, reading. 

Now, I'm just about ready to read in the file information. First I'll 
determine the actual number of bytes of data that are devoted to the pic­
ture by subtracting the 512 byte header from the total file length. Then 
I'll use a call to NewHandl e() to allocate some memory to hold the pic­
ture data: 

Size pict_size; 
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Handle temp_handle = nil: 

pict_size = file_length - 512: 

temp_handle = NewHandle( pict_size ); 

Finally, it's time to read in the data from the open 'PICT' file and store it 
in the allocated memory. Since a handle is relocatable, I'll take the pre­
caution oflocking it in place while a call to FSRead () reads in the data: 

Hlock(temp_handle); 
FSRead(pict_ref_num, &pict_size, *temp_handle); 

HUnlock(temp_handle); 

You'll notice that I named the handle that holds the picture data 
temp_handl e. That provides a hint that there's one step left. The 
Toolbox uses a Pi cHandl e when working with a picture-not a generic 
handle. So I'll declare a Pi cHandl e variable and typecast the generic 
handle to that type: 

PicHandle My_Picture: 

My_Picture = ( PicHandle )temp_handle; 

To display the picture I'd open a window and make a call to 
DrawPi ctu re (). I won't do that now, however. Instead, I'll move on to 
the particulars of the new example library. There you'll see both the stan­
dard get file code and the code that draws and updates the picture. 

The Initialization Routine 

Because a library's initialization routine executes just one time, this rou­
tine serves as the perfect place to place the standard get file code devel­
oped in the previous section. I'll assume that an application that uses this 
library includes a menu item named something like Open Picture. In 
response to that item being selected, the application will load the pic­
ture-viewing library. The loading of the library triggers the execution of 
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the library's initialization routine. So to the user, the loading of the 
library results in the dialog box shown in Figure 12.11. 

c::i Macintosh HO 

-0 Eject 

Desktop 

( Cancel ) 

{} t Open J 

FIGURE 12.11 THE RESULT OF RUNNING THE INITIALIZATION 

ROUTINE OF THE PICT CHOOSER IMPORT LIBRARY. 

I've included a single sample 'PICT' file on the disk that accompanies 
this book. You may very well have others on your hard drive. If you do, 
you'll be able to use the pop-up menu in the dialog box to locate them. 

The source code for the library's initialization routine appears below. 
Since the code that makes up the function was developed in the previous 
section, I'll forego the usual walk-through. Instead, I'll just note that even 
though the routine doesn't make use of the Ini tBl ockPtr, it still gets 
passed in as a matter of form. 

//+++++++++++++ initialization routine +++++++++++++ 

OSErr My_Initialize_Routine( InitBlockPtr init_block_ptr 
{ 

SFTypeL i st 
StandardFileReply 
short 
long 
Size 
Handle 

typelist = { 'PICT', 0, 0, 0 }; 
reply; 
pict_ref_num = O; 
file_length; 
pict_size; 
temp_handl e = nil; 

StandardGetFile( nil, 1, typelist, &reply ); 
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} 

FSpOpenDF( &reply.sfFile, fsRdPerm, &pict_ref_num ); 

GetEOF( pict_ref_num, &file_length ); 
SetFPos( pict_ref_num, fsFromMark, 512 ); 

pict_size = file_length - 512; 

temp_handle = NewHandle( pict_size ); 

Hlock( temp_handle ); 
FSRead( pict_ref_num, &pict_size, *temp_handle ); 

HUnlock( temp_handle ); 

My_Picture = ( PicHandle )temp_handle; 

return ( noErr ); 

You'll notice that the variable My_Pi cture isn't declared locally in the 
routine. That's because you'll need to use this variable later on to initially 
draw, and later update, the picture. Instead, the variable is declared glob­
al to the library. I've added it's declaration to the top of the library, just 
after the inclusion of the FragLoad.h universal header file. That makes 
the variable accessible by any routines in the library-but not by any rou­
tines in an application fragment that makes use of the library. 

//++++++111111111 include directives ++1111111111111 

#include <Fragload.h> 

//+++++++++++++++++ global variables +I I I I I l++I I I I I I 

PicHandle My_Pi cture = ni 1; 

344 

Important: Error-checking is an important part of program­
ming. You may have noticed that there's precious little of it 
in the initialization routine. This book deals with PowerPC 
programming-not with files and error handling. So for the 
sake of brevity, error-checking is slight. Typically, you'll 
want to examine the error value that Toolbox functions 
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return to guarantee that they've executed successfully. For 
example, I've written the call to FSpOpenDF() as follows: 

FSpOpenDF( &reply.sfFile, fsRdPerm, &pict_ref_num ); 

You might instead want to write it like this: 

OSErr error; 

error = FSpOpenDF( &reply.sfFile, fsRdPerm, 
&pict_ref_num ); 

if ( error != noErr ) 
{ 

} 

Post_Error_Message( FILE_OPEN ERR); 
ExitToShell (); 

To see if a Toolbox function returns an error code, check 
the universal header files or the Apple Inside Macintosh 
series of books. 

The Termination Routine 

The Companylnfo library had no termination routine, since there was 
nothing to clean up-that's the typical role of this function. The 
PICTchooser library, on the other hand, is the perfect example of a 
library that can use a termination routine. This library has a global vari­
able named My_Pi cture that serves as a handle to the picture data. 
Since this library allocated the memory for the data, it makes sense that 
this library should also be responsible for freeing up this memory when it 
is no longer needed. 

How do I know just when the memory for the picture is no longer 
needed? When the library is unloaded by the application, I'll assume that 
the user is through with the picture. Unloading the library triggers a call 
to the library's termination routine, so I'll just make a call to the Toolbox 
function Ki 11 Picture() at that time. 
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//+++++++++++++++ termination routine +++++t 11111111 

void My_Terminate_Routine( void 
{ 

} 

if ( My_Pi cture != nil ) 
KillPicture( My_Picture ); 

The Main Routine 

The main routine of a library is the one special routine that is explicitly 
called by another fragment. As such, any fragment that makes use of a 
library must be aware of the format of the library's main routine. For the 
PICTchooser example, the main function accepts two parameters. The 
calling fragment will have to be aware of that-as you'll see later in this 
chapter when I develop a simple test application that uses PICTchooser. 

There is no one set format for a library's main routine-its return 
value and parameters will depend on the function's purpose. The pur­
pose of PICTchooser is to open and display a picture. The initialization 
routine handles the opening of the picture. I'll have the main routine 
handle its display. 

True, I could have displayed the picture in the initialization routine. 
But a picture displayed in a window will need updating. So it makes more 
sense to draw the picture from a routine that can be called repeatedly by 
the application fragment. Here's a look at the complete main routine: 

//++++++++++++++++++ main routine ++++++++++++++++++ 

Boolean My_Main_Routine( EventRecord *the_evt, 

{ 
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WindowPtr front_wind 

Boolean evt_handled =false; 

if (the_evt->what == updateEvt) 
{ 

BeginUpdate( front_wind ); 
SetPort( front_wind ); 
DrawPicture( My_Picture, &front_wind->portRect ); 

EndUpdate( front_wind ); 
evt_handled = true; 
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} 
return evt_handled ); 

} 

The main routine accepts an Event Record and a Wi ndowPtr as its two 
parameters, and returns a Boo 1 ea n value. The assumption is that when 
an event occurs, the application fragment will call PICTchooser's main 
routine to see if the event involved the picture. The application will pass 
the main routine a pointer to its event record, as well as a pointer to the 
window that was involved in the event. The main routine will check to see 
if the event was update-related. If it was, it will draw the picture into the 
port of the window whose Wi ndowPtr was passed in front_wi nd. 

If the main routine did in fact redraw the picture, the local variable 
evt_handl ed is set to true. If the main routine didn't handle the event, 
this variable will have its initialized value offal se. In either case, the 
value of this variable serves as the function's return value. When the 
function has completed, the calling application will be informed as to 
whether or not the event has been handled. 

~ 
N 0 T E 

Forcing the picture to fit the window's portRect is just a 
quick and dirty way of displaying it. A better way would be 
to start with the window hidden. Then determine the pic­
ture's size, resize the window to those same dimensions, 
show the window, and finally, display the picture. 

By looking at My _Mai n_Ro u tine ( ) you can see that the main routine 
makes certain assumptions about the calling application. For instance, it 
assumes there is already a window open. Later in this chapter I'll develop 
a test application that demonstrates the interaction between an applica­
tion fragment and the main routine of an import library fragment. 

Using CodeWarrior to Build the Library 

In Chapter 11 you saw how to use CodeWarrior to build a the Companylnfo 
library. For the PICTchooser library the process will be the same. 
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PICTchooser has no required resources. So its resource file will hold 
just the 'vers' resource that is commonly found in an import library. The 
Metrowerks C/C++ PPC project window-shown in Figure 12.12-holds 
the source code file and the three libraries that are added to all 
Code Warrior projects. 

PI CTchooser • .u 
File Code Data II • 

1 PICTchooser .c 0 ! 0 ! [I -0 
Hathlib 0 l 0 l [I i-=-

HYCRuntime .Lib 0 ! O l [I 

.......... ~.~.~~~!~.~.!.~.~.~ ............... L. ............ 9..L ............. 9..L. ................ !D. 

4 file(s) OK OK 

FIGURE 12.12 THE CODEWARRIOR PROJECT WINDOW 

FOR THE PICTCHOOSER IMPORT LIBRARY. 

Before building the library, I'll make a few changes to the project using 
the preferences dialog box. In Figure 12.13 you can see that I've used the 
Project panel of the dialog box to make sure that the project type is set to 
shared library, and the creator and type are set to the desired four char­
acter strings. 
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Remember, the names you choose for the creator and for 
the type of a shared library don't in any way limit which 
applications can make use of the shared library. You're 
choosing names for the purpose of giving the library a par-
ticular icon. If you want the shared library to have a particu­
lar icon associated with it, then you'll set the library's cre­
ator to that of an application that has a 'BNDL' resource 
that includes the type you give the library. For example, the 
TestApp1 has a creator of 'TST1,' and it has a 'BNDL' 
resource that defines the icons for 'APPL' and 'dLIB' type 
fragments. By setting the creator and type of a shared 
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library to 'TST1' and 'dLIB,' respectively, you're telling the 
Finder to look at how the TestApp1 application defines the 
icon of a 'dLIB' fragment. 

Rpply to open project . 

Project Type: Shared Library ..-1 
Shared Library Info:------~ 

File Name I PICTchooser 

Creator I TSTl 

Type I dllB 

[Factory Settings J [ Reuert Panel J [ Cancel J ([ OK ) 

FIGURE 12.13 THE PROJECT PANEL SETIINGS FOR THE PICT CHOOSER IMPORT LIBRARY. 

Next, I used the Linker panel of the preferences dialog box to set the 
library's three entry routines. As shown in Figure 12.14, these three 
names match the names of the three special routines I developed earlier 
in this chapter for the PICTchooser library. 

After dismissing the preferences dialog box, I selected Make from the 
Project menu to build the library. In the next section I'll test the library 
out by loading it from an application fragment. 

MODIFYING THE TESTAPP2 APPLICATION 

The TestApp2 application developed in Chapter 11 is a good vehicle for 
testing import libraries-all it takes is a menu selection to load and exe­
cute one. To test the PICTchooser library I'll again use TestApp2- with a 
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few modifications. First, I'll need to change the resource file by adding a 
'WIND' resource and a second menu item to the project's Utilities 
'MENU' resource. Next, I'll need to change some of the source code to 
allow the application to interact on a continuous basis with the import 
library. 

Apply to open project. 

I I Link Options: 

lliii· 181 Generate SYM File 
w.~n 181 Use Full Path Names i!llit 

D ~ll D Generate Link Map 

D Suppress Warning Messages 
PEF nw: 181 Faster Linking (uses more memory) ·1 · 

D ~Iii 
~I Entry Points: 

Project I I niti111iz11tion: I My_I niti111ize_Routine I 

• I Main: I My_M11in_Routine I 
Termination: I My_Termin11te_Routine I Access Paths . 

(Factory Settings J (Revert Panel J ( Cancel J (( OK , 
FIGURE 12.14 THE LINKER PANEL SETTINGS FOR THE PICTCHOOSER IMPORT LIBRARY. 

Changes to the TestApp2 Resources 

To allow TestApp2 to load either of my two import libraries, I'll add a 
new "Open Picture" menu item to one of the 'MENU' resources. Figure 
12.15 shows how the Utilities 'MENU' resource has changed. 

The PICTchooser library allows the user to select a 'PICT' file to 
open, and then the library displays the picture in a window. The library 
makes the assumption that the calling fragment-in this case TestApp2-
opens a window to draw into. For that reason I've added a 'WIND' 
resource to the TestApp2.µ.rsrc file. Because the import library will 
shrink or expand the picture to fit the size of the window it is drawing to, 
the window's size isn't critical. Figure 12.16 shows the 'WIND' resource 
I've added. 
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'.".Iii MENUs from TestRpp2.µ.rsrc 

a !~ 1-;;:'t 

Ill 

About Test ... l a€Q I Company Info ... J 
Open Picture ... 

I 
•...... 

128 129 130 

FIGURE 12.15 THE 'MENU' RESOURCES FOR 

THE RESOURCE FILE FOR THE MODIFIED TESTAPP2. 

1111: fll11 ldll 1M11urn. Wlndaw 

D 
Top:~ Height:~ 

Left: ~ Width: ~ 

Color: @ Default 
O Custom 

0 Initially uisible 

0 Close boH 

FIGURE 12.16 THE 'WIND' RESOURCE FOR 

THE RESOURCE FILE FOR THE MODIFIED TESTAPP2. 

liii1 
~ 

-0 
~ 

After the above changes, the TestApp2.µ .rsrc file will look like the one 
pictured in Figure 12.17. 
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ALRT MBAR 

~ 
2.0bl CJ 6.0.5 

- 7.0 ... 

MENU vers WIND 

FIGURE 12.17 THE RESOURCES THAT MAKE UP 

THE RESOURCE FILE FOR THE MODIFIED TESTAPP2. 

Recall that I never added a 'BNDL' resource to TestApp2-
only to TestApp1. 

Changes to the TestApp2 Code 

I'll only need to change some of the TestApp2 code, so I won't include 
the entire source code listing for the program here-though it does 
appear on disk in the folder named (12) PICT Lib f. Here I'll just cover 
the important changes. 

After including FragLoad.h, and listing the function prototypes, I 
add the program's ff define directives. All the old TestApp2 ffdef i nes 
are here, and two additions. I've added the name of the new import 
library right after the ffdefi ne for the Companylnfo library: 

//define 
//define 

CO_I N FO_LI B_STR 
GET_PICT_LIB_STR 

"\pCompanylnfo" 
"\pPICTchooser" 

Now that my program has a window, I've added a ffdefi ne directive for 
that window's 'WIND' resource: 
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1/defi ne MAIN_WIND_ID 128 

The PICTchooser library doesn't open a window to hold the picture that 
it opens-it relies on the calling fragment to do that. So my test applica­
tion will declare a Wi ndowPtr variable, then make a call to 
GetNewCWindow() in main(): 

WindowPtr My_Window = nil: 

void main( void ) 
{ 

} 

Initialize_Toolbox(); 
Set_Up_Menu_Bar(): 

My_Window = GetNewCWindow( MAIN_WIND_ID, NULL. 
(WindowPtr)-lL ); 

SetPort( My_Window ): 
HideWindow( My_Window ); 

Main_Event_Loop(); 

The next addition to TestApp2 may be the trickiest. Recall from 
Chapter 11 that the Code Fragment Manager routine 
GetDi skFragment() uses its seventh parameter to return a pointer to 
the main routine of the import library fragment that it loads. Figure 
12.18 highlights this point. 

In past examples I wasn't too concerned about the pointer 
Li b_Ma i n_Pt r-the Company Info library has no main routine. Now, 
because the PICTchooser library does have a main routine, I'll need to put 
a little forethought into things. Specifically, I'll need to add an interface 
to the TestApp2 source code so that it knows the format of the 
PICTchooser main routine. Looking back at the PICTchooser source 
code, I see that I've defined the main routine to look like this: 

Boolean My_Main_Routine( EventRecord *the_evt, 

{ 

} 
II function body 

WindowPtr front_wind 
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Declare a generic pointer 

Ptr Lib_Main_ Ptr = nil; 

error = GetDiskFragrnent( &the_FSSpec, 
0, 
0, 
the_FSSpec.name , 
kLoadNewCopy, 
&Lib_Connect_ID, 
(Ptr *)&Lib_Main_Ptr , 

Toolbox fills in the pointer with the address of the 
main routine of the import library that is being loaded 

FIGURE 12.18 Get Disk Fragment ( ) RETURNS 

A POINTER TO AN IMPORT LIBRARIES MAIN ROUTINE. 

The PICTchooser main routine has two parameters and a Boolean 
return type. If I want to define a pointer to this main routine, I could do 
so as follows: 

t ypedef Boolean (*MainRoutinePtr) ( EventRecord *, WindowPtr ); 

The above definition creates a type named Mai nRouti nePtr that is a 
pointer to a function that returns a Boo 1 ea n, and has a pointer to an 
EventReco r d and a pointer to a window as its two parameters. Now, 
instead of declaring Li b_Ma i n_ Pt r to be a generic Pt r type, I'll declare 
it to be a pointer to the main routine of the PICTchooser library: 

MainRoutinePtr Lib Main Ptr = nil ; 
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My test program allows the user to load the PICTchooser library at any 
time-a selection from the Utilities menu does that. That means that at any 
given time the program may have an import library with a main routine 
loaded. So I'll need to make a few changes to the way the program's main 
event loop handles events. After grabbing hold of an event with a call to 
Wai tNextEvent (), the program should check to see if the event should be 
handled by the import library. Here's how that can be accomplished: 

void Main_Event_Loop( void ) 
{ 

} 

Event Record 
Boolean 
char 
WindowPtr 
long 

the_event; 
event_handled_by_lib; 
the_key; 
the_window; 
menu_choice; 

while ( All_Done ==false 
{ 

} 

WaitNextEvent( everyEvent, &the_event, 15L, nil); 

event_handled_by_lib =false; 

if ( Lib_Main_Ptr != nil ) 
{ 

} 

the_window = FrontWindow(); 
event_handled_by_lib = Lib_Main Ptr( &the_event, 

the_window ); 

if ( event_handled_by_lib ==false 
{ 

II handle as a normal event 
} 

If a library is loaded, Lib Main Pt r will not be n i 1-it will hold the 
address of that library's main routine. If that's the case, the library's main 
routine should be called to be given the opportunity to handle the event. 
The above snippet makes a call to FrontWi ndow() to determine which 
window is at the front. It then passes the Wi ndowPt r returned by 
FrontWi ndow(), along with a pointer to the EventRecord, to the import 
library's main routine. 
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The above version of Mai n_Event_Loop () is written such that if an 
import library is loaded, every pass through the whi 1 e loop will result in 
a call to the import library's main routine. Assuming that the 
PICTchooser library is loaded, its main routine would be called. Here's a 
reminder of what takes place in that routine: 

Boolean My_Main_Routine( EventRecord *the_evt, 

{ 

} 

WindowPtr front_wind 

Boolean evt_handled = false; 

if (the_evt->what == updateEvt) 
{ 

} 

BeginUpdate( front_wind ); 
SetPort( front_wind ); 
DrawPicture( My_Picture, &front_wind->portRect ); 

EndUpdate( front_wind ); 
evt_handled = true; 

return ( evt_handled ); 

The PICTchooser main routine will update the front window by redrawing 
the picture to it. Note that My_Pi cture, which is global to the import 
library, but not declared in the test application, has retained its value. 

When My_Main_Routine() has executed, it will return a Boolean 
value to the calling routine. If the event wasn't handled, a value of fa 1 se 
is returned. If the event was handled, a value of true is sent back. Back 
in the test application, this returned value is examined to determine if 
the event still needs to be handled. If it does, then the application's 
Mai n_Event_Loop() will handle it: 

if ( event_handled_by_lib ==false 
{ 

II handle as a normal event 
} 

Here, in its entirety, is the test application's Mai n_Event_Loop () 
function: 
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void Main_Event_Loop( void ) 
{ 

} 

Event Record 
Boolean 
char 
WindowPtr 
long 

the_event; 
event_handled_by_lib; 
the_key; 
the_window; 
menu_choice; 

while ( All_Done == false 
{ 

WaitNextEvent( everyEvent, &the_event, 15L, nil ) ; 

event_handled_by_lib = false; 

if ( Li b_Mai n_Ptr != nil ) 
{ 

} 

the_window = FrontWindow(); 
event_handled_by_lib = Lib_Main_Ptr( &the_event, 

the_window ); 

if ( event_handled_by_lib == false ) 
{ 

switch (the_event.what) 
{ 

case mouseDown: 
Handle_Mouse_Down( the_event ); 
break; 

case keyDown: 
the_key = (the_event.message & charCodeMask); 
if ( ( the_event.modifiers & cmdKey ) != 0 ) 
{ 

} 
} 

} 

menu_choice = MenuKey( the_key ); 
Handle_Menu_Choice( menu_choice ); 

} 
break; 

case updateEvt: 
the_window = (WindowPtr)the_event.message; 
BeginUpdate( the_window ); 
II update window as needed by the application 
EndUpdate( the_window ); 
break; 
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The only other change to TestApp2 occurs m the 
Handle_Utility_Choice() function. This routine gets called in 
response to a click in the Utilities menu. Since TestApp2 now has two 
menu items, I've added a second case label to the function's switch 
statement. A click on the Open Picture menu item results in the hidden 
window being shown, and the PICTchooser library being loaded. 

void Handle_Utility_Choice( short the_item 
{ 

} 

FSSpec the_FSSpec; 

switch ( the_item ) 
{ 

} 

case CO_INFO_ITEM: 
HideWindow( My_Window ); 
the_FSSpec = Get_File_Spec( CO_INFO_LIB_STR ); 
Load_Library( the_FSSpec ); 
break; 

case OPEN_PICT_ITEM: 
ShowWindow( My_Window ); 
the_FSSpec = Get_File_Spec( GET_PICT_LIB_STR ); 
Load_Library( the_FSSpec ); 
break; 

A Last Word on the Main Routine 

It's important to keep in mind that a library's main routine has no stan­
dard interface. For my library, passing a pointer to the event record and 
a pointer to the front window sufficed. A different library may require 
other information from the calling fragment. For instance, if my main 
routine needed to access the QuickDraw global variables, I'd want to pass 
those along as a parameter. If I wanted to draw a black rectangle in the 
middle of my picture, I could change the My_Mai n_Routi ne() to look 
like this: 

Boolean My_Main_Routine( EventRecord *the_evt, 
WindowPtr front_wind, 
QDGlobals *qd_ptr ) 
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{ 

} 

Boolean 
ODGlobals 
Re ct 

evt_handled = false; 
temp = *qd_ptr; 
the_rect; 

if (the_evt->what == updateEvt) 
{ 

BeginUpdate( front_wind ); 
SetPort( front_wind ); 
DrawPicture( My_Picture, &front_wind->portRect ); 
SetRect( &the_rect, 10, 10, 50, 50 ); 
FillRect( &the_rect, &temp.black ); 

EndUpdate( front_wind ); 
evt_handled = true; 

return ( evt_handled ); 

This new version of the main routine now has three parameters rather 
than two. That means that in the test application the interface to 
My_Mai n_Routi ne() needs to be changed as well: 

typedef Boolean (*MainRoutinePtr) ( EventRecord * 
WindowPtr. 
QDGlobals * ); 

And, any calls to the library's main routine will need to include that third 
parameter: 

if ( Li b_Mai n_Ptr != nil ) 
{ 

} 

the_window = FrontWindow(); 
event_handled_by_lib = Lib_Main_Ptr( &the_event, 

the_window, &qd ); 

If you're writing more than one library, you may want to consider giving 
the main routine of each library the same interface. That way your appli­
cation can use a single line of code to access which ever main routine is 
currently open: 
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event_handled_by_lib = Lib_Main_Ptr( &the_event, the_window. 
&qd ); 

Even if the main routine of one or more libraries doesn't make use of the 
QDGl obal s variable qd, or one of the other parameters, it will still be 
accessible by the application via the above call to Li b_Ma i n_ Pt r . 

Testing the PICTchooser Library 

After making the necessary changes to the TestApp2 resource file and 
source code file, build a new TestApp2 application by selecting Make 
from Code Warrior's Project menu. The (12) PICT Lib f, shown in Figure 
12.19, contains new copies of all of the application and library files. The 
Companylnfo project hasn't changed, so these files are all the same as 
previous versions. 

--13 items 

• TestApp2.u 

D 
Company! nfo .u 

D 
PI CTe hoose r .J.l 

¢1 

( 12) PI CT Lib f 
95 .9 MB in disk 

D . ~ ~ 
TestApp 2.e Test App 2 .u. r s re TestA pp2 

D . ~ ~ 
Company! nfo.e Company I nfo .u. r s re Companyl nfo 

D . ~ ~ 
PI CTe hoose r .e PICTehooser .u.rsre PICTehooser 

FIGURE 12.19 THE FOLDER THAT HOLDS THE 

TEST APPLICATION AND IMPORT LIBRARY PROJECTS. 

Im§ 
58.2 MB avai lable 

.Q 

D 
Sample.PICT 

-0 
J¢ 'iii 

To test the new library, I'll launch TestApp2. Selecting Open Picture 
from the Utilities menu displays an empty window and posts the standard 
get file dialog box. Figure 12.20 shows this. 
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New Window 

la c12) PICT Lib t ..... I = Macintosh HD 

I['} Sample.PICT {} ( 

( 

( 

to1• ~ 

FIGURE 12.20 THE RESULT OF SELECTING OPEN 

PICTURE FROM THE TESTAPP2 UTILITIES MENU. 

Eject l 
Desktop l 

Cancel l 
Open l 

The TestApp2 program, by way of the code in the PICTchooser shared 
library, can open any 'PICT' file. There's one sample 'PICT' included on 
the disk- Figure 12.21 shows how the 'PICT' looks in the TestApp2 appli­
cation. If you have any other 'PICT files on your hard disk you'll be able 
to open them with TestApp2. 

FIGURE 12.21 THE PICTCHOOSER LIBRARY WILL OPEN 

A 'PICT' FILE AND DRAW THE CONTENTS TO A WINDOW. 
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The shared library's main routine is responsible for updating the picture. 
Moving part of the window off screen and then back on screen will gen­
erate an update event and cause the PICTchooser library's main routine 
to redraw the picture. 

APPLE EVENTS 

Apple events are a set of high-level events that allow programs to com­
municate with•one another, and with the Finder. If you haven't used 

Apple events in the past, you'll want to start using them now. That's 
because System 7.x is now the standard Macintosh operating system, and 
Apple defines four "required" Apple events that any program that runs 
under System 7.x should be able to respond to. 

Introduction to Apple Events 

Applications generally use Apple events to either request a service from 
another application, or to provide a service to another application. 
Typically that other application is the Finder. Which ever application ini­
tiates the event is said to be the client application, while the application 
that responds, or provides the requested service, is called the server appli­
cation. 

There are numerous Apple events, but there are only four that all 
System 7 applications are required to watch for: Open Documents, Open 
Application, Print Documents, and Quit Application. Each of these four 
required event types fall into the broader category of core Apple events. 
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Responding to a Quit Application Apple Event 

When you select Restart or Shut Down from the Special menu of the 
Finder, you expect any open applications to quit before your Mac powers 
down. In turn, the Finder will go to each application and terminate it. If, 
in the middle of this process, the Finder goes to an application but 
doesn't terminate it, you know that application doesn't support the Quit 
Application Apple event. The Finder attempts to send that application a 
request to quit, but the application doesn't recognize the Finder's efforts. 

In this section you'll see how easy it is to give your application the 
power to recognize this one Apple event type. There are a few steps that 
all applications must follow if they are to work with Apple events. By giv­
ing your program the ability to respond to the Quit Application Apple 
event, you'll see the steps you'll need to follow to add other Apple event 
types as well. 

To make your application aware of Apple events, add a case label to 
the switch statement in your program's main event loop. Besides check­
ing for the standard event types such as mouseDown, keyDown, and 
updateEvt, you'll want to now watch for events of type 
kHighlevel Event. Should WaitNextEvent() return an event of this 
type, you're application will respond with a call to the Apple Event 
Manager function AEProcessAppl eEvent( ): 

case kHighLevelEvent: 
AEProcessAppleEventC &the_event ); 

Here's a look at the above code in the context of a typical application's 
main event loop: 

void Main_Event_Loop() 
{ 

II local variable declarations 

while C All_Done ~ false ) 
{ 

WaitNextEvent( everyEvent, &the_event, 15L, nil); 
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} 
} 

switch ( the_event.what ) 
{ 

} 

case mouseDown: 
II handle mouse click 
break: 

case updateEvt: 
II handle update event 
break: 

case kHighlevelEvent: 
AEProcessAppleEvent( &the_event ); 

The AEProcessAppl eEvent() routine is a powerful function whose pur­
pose is to identify the type of Apple event that is to be processed, and to 
begin processing that event. It starts the processing of the event by invok­
ing an Appk event handl.er. An Apple event handler is a function that you pr<r 
vide. Each Apple event handler has a clearly defined purpose. It extracts 
data from the Apple event, handles the specific action that the event 
requests, and returns an error result code to indicate whether or not the 
event was successfully handled. How the functionality of the event handler 
routine is implemented is up to you. Here's how I implemented the event 
handler routine for a Quit Application Apple event: 

pascal OSErr AE_Handle_Quit( AEDesclist *apple_evt, 
AEDesclist *reply, 

{ 

} 

All_Done =true: 
return noErr: 

long ref_con 

All my Quit Application event handler has to do to process a Quit 
Application Apple event is set the application's global variable A 11 _Done 
to true. I'll make the assumption that this one line of code doesn't gener­
ate any kind of operating system error and return the global constant 
noErr to AEProcessAppl eEvent(), the function that invoked 
AE_Handle_Quit(). 
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An event handler routine starts with the pascal keyword, and has a 
return type of OSErr. The event handler always has three parameters. 
The first parameter holds the Apple event to handle. Later in this chap­
ter you'll see an example of how an event handler might use this infor­
mation. If your event handler needs to return information to 
AEProcessAppl eEvent( ), it should fill in some of the fields of the sec­
ond parameter. The last parameter is a reference value that your applica­
tion will typically ignore. 

There's one additional step that must be included in order for an 
application to work with Apple events. Each Apple event handler routine 
must be installed near the start of program execution. This is a necessary 
step that relates an Apple event type with the application-defined routine 
that will handle it. In my above example I've defined a routine named 
AE_Handl e_Quit() to handle a Quit Application Apple event. But the 
Apple Event Manager routine AEProcessAppl eEvent() has no way of 
knowing that this is the function that it should invoke in response to a 
Quit Application event. The installation of the event handler gives the 
Apple Event Manager this information. Here's the installer for my ver­
sion of Quit Application: 

AEinstallEventHandler( kCoreEventClass, 
kAEQuitApplication, 
NewAEEventHandlerProcCAE_Handle_Quit), 
o. 
false ) ; 

The first parameter to AEinstal 1 EventHandl er() is the event class of 
the event to be handled. All four of the required Apple events are consid­
ered core events, so the installers for each of these four event handlers 
will have a first parameter kCoreEventCl ass. 

The second parameter is an event ID that specifies which particular 
Apple event is to be handled. For the four required Apple events, those 
IDs are kAEQuitApplication, kAEOpenApplication, 
kAEPrintDocuments,andkAEOpenDocuments. 

The third parameter to AEinstal 1 EventHandl er() is a pointer to 
the application-defined function that will handle this one Apple event. 
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You'll always use the NewAEEventHandl erProc() function here to estab­
lish this pointer. Just provide the name of the event handler that you've 
created in your application. 

The fourth parameter is a reference value that the Apple Event 
Manager will use each time it invokes the event handler function. You 
can safely use a value of 0 for this parameter. 

The final parameter to AEinstal 1 EventHandl er() is a Boolean 
value that specifies in which App!,e event dispatch tabl,e the handler should 
be added. An Apple event dispatch table provides the correlation 
between an Apple event and your application-defined event handler rou­
tine. Typically you'll provide a value offal se here so that the Apple 
Event Manager adds the event handler to your application's own Apple 
event dispatch table, rather than to the system Apple event dispatch table 
that holds handlers that are available to all applications. 

You'll want to install all your event handlers at application initialization 
time. Here I've added my one installer to the Initialize_Toolbox() 
function I include in all my applications: 

void Initialize_Toolbox( void 
{ 

} 

InitGraf( &qd.thePort ); 
InitFonts(): 
InitWindows(); 
InitMenus(); 
TEI nit(): 
InitDialogs( OL ); 
FlushEvents( everyEvent, 0 ); 
InitCursor(); 

AEinstallEventHandler( kCoreEventClass. kAEQuitApplication. 
NewAEEventHandlerProc(AE_Handle_Quit), 
o. false ); 

In the next section you'll see the source code for a complete application 
that handles all four of the required Apple event types. Until then, keep 
this summary of how to add Apple event handling to your application: 
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1. Add a case kHi ghlevel Event label to the switch statement in 
your application's main event loop. Under the label, add a call to 
the Apple Event Manager routine AEProcessAppl eEvent( ). 

2. Install each event handler near the top of your source code by 
calling AEinstall EventHandler() for each Apple event your 
application supports: 

AEinstallEventHandler( kCoreEventClass, kAEQuitApplication, 
NewAEEventHandlerProc(AE_Handle_Quit), 
0, false); 

3. Define an event handler routine for each Apple event your appli­
cation will support. This routine will typically have the same for­
mat as this Quit Application event handler: 

pascal OSErr AE_Handle_Quit ( AEDesclist *apple_evt, 
AEDesclist *reply, 
long ref_con 

ADDING APPLE EVENTS TO AN APPLICATION 

T he preceding section showed the steps you should perform in order 
to get your application to respond to Apple events. Now it's time for 

a specific example. In this section I'll modify the TestApp2 code so that it 
works with Apple events. Since these changes will move my test applica­
tion to a new plateau, I'll also give it a new name. Henceforth, the test 
application now will be known by the very clever name of TestApp3. 
You'll find the entire source code listing for TestApp3 in the folder 
named (12) AppleEvents Lib f. 

Apple events are useful, slick tools that give your applications that 
final professional polish. But how do they pertain to import libraries­
the topic of this chapter? By making your application aware of the Open 
Documents Apple event type, you can allow a user of your application to 
launch that application by dragging an import library icon onto the 
application icon. Not only will that launch the application, it will execute 
the code in that import library. 
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Modifying the Main Event Loop 

Getting your application to recognize Apple events is a three step 
process. The first step is to modify your application's main event loop by 
including a case kHighlevel Event label to the switch statement in 
your application's main event loop. Then, under the label, add a call to 
the Apple Event Manager routine AEProcessAppl eEvent(). Here's the 
complete event loop for the TestApp3 application: 

void Main_Event_Loop( void ) 
{ 
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Event Record 
Boolean 
char 
WindowPtr 
long 

the_event; 
event_handled_by_lib; 
the_key; 
the_window; 
menu_choice; 

while ( All_Done == false 
{ 

WaitNextEvent( everyEvent, &the_event, 15L, nil ) ; 

event_handled_by_lib = false; 

if ( Lib_Main_Ptr != nil ) 
{ 

} 

the_window = FrontWindow(); 
event_handled_by_lib = Lib_Main_Ptr( &the_event, 

the_window ); 

if ( event_handled_by_lib ==false ) 
{ 

switch < the_event.what ) 
{ 

case mouseDown: 
Handle_Mouse_Down( the_event ); 
break; 

case keyDown: 
the_key = (the_event.message & charCodeMask); 
if ( ( the_event.modifiers & cmdKey ) != 0 ) 
{ 

menu_choice = MenuKey( the_key ); 
Handle_Menu_Choice( menu_choice ); 



} 
} 

} 
} 

} 
break; 
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case updateEvt: 
the_window = CWindowPtr)the_event.message; 
BeginUpdate( the_window ); 
EndUpdate( the_window ); 
break; 

I I recognize and respond to Apple events! · 
case kHighlevelEvent: 

AEProcessAppleEvent( &the_event ); 

Installing the Event Handlers 

Each Apple event your application recognizes must have its own event 
handler routine, and those routines must be installed. My TestApp3 pro­
gram will recognize the four required Apple event types, so I'll need to 
add four calls to AEinstal 1 EventHandler( ). Here's the new version of 
Ini ti a 1 i ze_Tool box(), revised to install the four handlers: 

void Initialize_Toolbox( void 
{ 

InitGraf( &qd.thePort ); 
InitFonts(): 
I ni tWi ndows () : 
InitMenus(); 
TEinit(); 
InitDialogs( OL ); 
FlushEvents( everyEvent, 0 ); 
InitCursor(); 

AEinstallEventHandler( kCoreEventClass, kAEOpenApplication. 
NewAEEventHandlerProc 
CAE_Handle_Open_App), 
o. false); 

AEinstallEventHandler( kCoreEventClass. kAEOpenDocuments, 
NewAEEventHandlerProc 
CAE_Handle_Open_Doc), 
o. false); 
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} 

AEinstallEventHandler( kCoreEventClass. kAEPrintDocuments. 
NewAEEventHandlerProc 
(AE_Handle_Print_Ooc), 
0, false); 

AEinstallEventHandler( kCoreEventClass. kAEQuitApplication, 
NewAEEventHandlerProc 
(AE_Handle_Quit), 
0, false ); 

Defining the Event Handlers 

The complexity of an Apple event handler routine varies with the task 
that handler is to perform. You've already seen that the Quit Application 
event handler consists of nothing more than an assignment that toggles 
All_Done to true and a return statement that tells the calling routine 
that everything went all right: 

pascal OSErr AE_Handle_Quit( AEOesclist *apple_evt, 
AEDesclist *reply, 

{ 

} 

All_Oone =true; 
return noErr: 

long ref_con 

TestApp3 recognizes three other Apple events-but it only responds to 
one of them. When the user drags an import library icon onto the 
TestApp3 icon, the Finder-the client-will initiate an Open Document 
Apple event that will be serviced by TestApp3-the server. The next sec­
tion describes in detail just how the Open Document event handler is 
implemented. TestApp3 has made provisions for the other two required 
Apple events-but doesn't really respond to them. Both an Open 
Application event and a Print Document event will result in an event 
handler being invoked. But I've left these two event handlers as nothing 
more than shells that can be filled in at a later time. The constant 
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errAEEventNotHandl ed simply tells the Apple Event Manager that noth­
ing was done in response to either event. 

pascal OSErr AE_Handle_Open_App( AEDesclist *apple_evt. 
AEDesclist *reply, 
long ref_con 

{ 

} 
return errAEEventNotHandled; 

pascal OSErr AE_Handle_Print_Doc( AEDesclist *apple_evt, 
AEDesclist *reply, 
long ref_con 

{ 

} 
return errAEEventNotHandled; 

~ 
N 0 T E 

Is my handling of these two Apple event types a cop out? 
Perhaps. But again, keep in mind that this Isn't a book 
about Apple events. At least now you're all set up to handle 
all four required Apple events. And in just a bit I'll cover the 
one event type that makes the most sense for working with 
import libraries-the Open Document Apple event. For a 
comprehensive look at Apple events, refer to Inside 
Macintosh: lnterappllcation Communication. 

Defining the Open Document Event Handler 

By having my TestApp3 program recognize an Open Document Apple 
event, I provide it with the capability of performing the neat trick of 
launching itself and executing an import library when an import library 
icon is dragged onto the application icon. To get the TestApp3 applica­
tion to do that, I'll need to use a few Apple Event Manager functions in 
the Open Document event handler. 

The AEGetKeyDesc () function is used by an event handler to extract 
information from an Apple event. Here's a typical call: 
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OSErr error; 
AEDesc file_list_desc = { 'NULL'. NULL}; 

error = AEGetKeyDesc( apple_evt, 
keyDirectObject, 
typeAEList, 
&file_list_desc ); 

AEGetKeyDesc () accepts four parameters. The first is an AEDescL i st­

a descriptor list that holds information about the Apple event. You can 
just pass the first parameter of the Open Document event handler for 
this AEGetKeyDesc() parameter: 

pascal OSErr AE_Handle_Open_Doc( AEDescList *apple_evt, 
AEDescList *reply, 
long ref_con ) 

The second parameter is a constant that is an AEKeyword that helps fur­
ther identify information about the event. Use key Di rectObj ect here. 
The third parameter is a DescType. This is a four-character string that 
gives the Apple Event Manager still more information about the event. 
Pass the constant typeAEL i st here. 

In exchange for the information supplied in the first three parame­
ters, AEGetKeyDesc() will fill the last parameter with a descriptor 
record, or AEDesc. You'll use this fi 1 e_l i st_desc variable in a call to 
another Apple Event Manager routine. 

AEGetNthPtr() is used to get information from the AEDesc variable 
that was filled and returned by AEGetKeyDesc( ). Though 
AEGetNthPtr() has a handful of parameters, there is only one that will 
be of interest to you-the sixth parameter. This parameter is a pointer to 
an FSSpec for the file involved in the Open Document Apple event-the 
import library that was dragged onto the application. Here's a call to 
AEGetNthPtrC ): 

FSSpec 
OS Err 
AEKeyword 
DescType 
long 
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error = AEGetNthPtrC &file_list_desc, 
1, 
typeFSS, 
&returned_keyword, 
&returned_type, 
CPtr)&file_spec, 
sizeofC file_spec ), 
&returned_size ): 

The first parameter is the AEDesc variable returned by AEGetKeyDesc( ). 
The second parameter is an index into a list of descriptor records. There's 
only one in the list, so this parameter is set to 1. The third parameter speci­
fies what information I'm attempting to get from fi l e_l i st_desc. Here, I 
want a FSSpec, so I use the constant typeFSS. The fourth and fifth parame­
ters, returned_keyword and returned_type, return information that I 
won't be needing. The sixth parameter is what I'm looking for-a pointer 
to c:in FSSpec for the import library. The seventh and eighth parameters 
deal with the size of the returned data. 

Now that I have an FSSpec for the import library, I can load the 
import library. A call to the application-defined routine 
Load_L i bra ry () handles that. After loading the import library code, I'll 
make a call to AEDi sposeDesc() to dispose of the descriptor record that 
was declared in this routine and filled by AEGetKeyDesc( ). Figure 12.22 
summarizes the process of opening the dragged import library. The fig­
ure points out that AEGetKeyDesc () is called only to fill the AEDesc vari­
able file_list_desc, and AEGetNthPtr() is called only to extract an 
FSSpec from the fi l e_l i st_desc variable. 

Below is the complete source code for an AE_Handl e_Open_Doc() 
routine. Notice that most of the Apple Event Manager function parameters 
are constants or variables that get filled by the function calls-the only 
information you need to supply is found in the passed-in AEDescL i st vari­
able appl e_evt. That means the AE_Handl e_Open_Doc() code will 
work-as is-for any import library-you shouldn't have to change the 
parameters to the two Apple Event Manager function calls in your own 
applications. 
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error= AEGetKeyDesc( apple_evt,, 
keyDirectObject, 
typeAEList, 
&file_list_desc ); 

error = AEGetNthPtr( 
1, 
typeFSS, 
&returned_keyword, 
&returned_type, 
(Ptr}&file~spec, 
sizeof( file_spec ), 
&returned_size ); 

Load_Library( file_spec ); 

FIGURE 12.22 THE TWO APPLE EVENT MANAGER FUNCTION 

CALLS ARE MADE TO GET AN FSSPEC FOR THE IMPORT LIBRARY. 

pascal OSErr AE_Handle_Open_Doc( AEDescList *apple_evt, 
AEDescList *reply, 

{ 
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AEDesc 
FSSpec 
OS Err 
AEKeyword 
DescType 
long 

file_list_desc 
file_spec; 
error; 
returned_keyword; 
returned_type; 
returned_size; 

long ref con 

'NULL', NULL}; 

error AEGetKeyDesc( apple_evt, keyDirectObject, 
typeAEList, &file list_desc ); 



} 

if ( error == noErr ) 
{ 
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error = AEGetNthPtr( &file_list_desc, 

} 

1, 
typeFSS, 
&returned_keyword, 
&returned_type, 
(Ptr)&file_spec, 
sizeof( file_spec ), 
&returned_size ); 

if ( error == noErr ) 
Load_Library( file_spec ); 

AEDisposeDesc( &file_list_desc ); 

return error; 

Testing Apple Events 

With the Apple event code added to the TestApp3 application, it's a sim­
ple matter to test things out. First build a TestApp3 application. You'll 
want to leave the creator as 'TSTI' so that the application will be able to 
communicate with the libraries, which also have a creator of 'TSTI.' 
Then, from the Finder, drag the Companylnfo library icon onto the 
TestApp3 application icon. When you do, the TestApp3 application will 
launch. Not only that, but the Companylnfo import library code will exe­
cute. Click on the Companylnfo alert to dismiss it and end the program. 

What about the PICTchooser library? If you built it with a creator of 
'TSTI ', it too should be capable of launching TestApp3. If you drag the 
PICTchooser library icon onto the TestApp3 icon, the application will 
indeed launch. And, the standard get file dialog box will open. But you'll 
notice that there is no empty window open in the background. That's 
because the window is created in the application's main () routine, and 
then hidden with a call to HideWindow( ). The window doesn't become 
visible until a call to ShowWi ndow() is made when the user selects Open 
Picture from the application's Utilities menu. When the application is 
launched via PICTchooser, the ShowWi ndow() call isn't made. The solu-
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tion? Launching the application through an Apple event will execute the 
application's main ( ) routine. So in TestApp3, comment out the 
Hi deWi ndow() call and add a call to ShowWi ndow( ), as shown here: 

void main( void ) 
{ 

Initialize_Toolbox(): 
Set_Up_Menu_Bar(): 

My_Window = GetNewCWindow( MAIN_WIND_ID, NULL. 
(WindowPtr)-lL >: 

SetPort( My_Window ); 
II HideWindow( My_Window ); 

ShowWindow( My_Window ); 

Main_Event_Loop(): 
} 

Again select Make from the Project menu to create a new version of 
TestApp3. Now, when you drag the PICTchooser icon onto the TestApp3 
icon, everything will work as intended. 

CHAPTER SUMMARY 

I f you're going to create a number of import libraries that will be used 
as plug-in tools for an application, you might consider giving the 

libraries their own icon that visually relates each library to the applica­
tion that will use it. To do this, add a 'BNDL' resource to the resource file 
for the application project. 

An import library can have three special routines. The initialization 
routine is called automatically when the library is loaded, and holds one­
time-only code, such as memory allocation calls. The termination routine 
is invoked automatically when the library is unloaded. If memory was 

allocated in the initialization routine, it call be cleaned up here. The last 
special routine, the main routine, must be invoked explicitly by another 
fragment. Typically an application will make this call from within its own 
main event loop. The library's main routine often handles repetitive 
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tasks such as updating whatever was created during by the library's initial­
ization routine. 

Apple events can be added to any program that is to run under 
System 7. Apple events are especially useful for PowerPC applications 
that make use of import libraries, however. Giving your application the 
ability to handle an Open Document Apple event means that a user can 
drag an import library icon onto an application icon in order to launch 
that application and execute the import library code. You'll use Apple 
Event Manager functions to allow your program to support Apple events. 
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OPTIMIZING POWERPC CODE 

E arlier chapters showed you how to use universal procedure point­
ers and other programming techniques to port 680x0 code to 
PowerPC code. You've also seen how to eliminate PowerPC code 

redundancy by using import libraries. So, is your journey to PowerPC 
coding complete? Perhaps-or perhaps not. While your code may seem 
to run fine on a PowerPC, there's a chance that it could run even quick­
er. This chapter discusses a few of the techniques and tricks that will 
allow your PowerPC code to really shine. 
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IMPROVING THE TIMING OF WAITNEXTEVENT() 

P orting your code to native PowerPC will result in a marked improve­
ment in execution speed. But you should keep in mind that even a 

fully ported application will spend time in the Mixed Mode Manager. 
Why? Not all of the Toolbox has been ported by Apple. If a PowerPC 
application makes a call to a Toolbox routine that hasn't been ported, 
that application must switch modes. 

The execution of a 680x0 Toolbox instruction on a PowerPC doesn't 
involve just a couple of instructions. A mode switch involves the move­
ment of parameters between the stack, the emulated 680x0 registers, and 
the PowerPC registers. The end result? The execution of a single nonport­
ed Toolbox function requires an average of 500 PowerPC instructions! 

If your program makes only occasional calls to 680x0 Toolbox 
instructions, the amount of Mixed Mode time may very well be negligible 
and unnoticeable to your program's users. But if your application makes 
repeated calls to a 680x0 Toolbox trap, your program's performance will 
suffer-perhaps noticeably so. While it will be impossible to determine 
which Toolbox calls have been ported and which haven't (these cate­
gories will change over time), there is one particular Toolbox function 
you can be on the watch for-WaitNextEvent( ). 

Using WaitNextEvent() Outside the Main Event Loop 

Wai tNextEvent (), like all Event Manager routines-hasn't been ported 
to native PowerPC. But there are hundreds of other Toolbox routines 
that haven't been-so why single out this one call? Because many pro­
grams include extra calls to Wai tNextEvent ()-perhaps hundreds or 
thousands of such calls. 

Any Mac program includes a call to Wai tNextEvent() in the pro­
gram's main event loop. But many other programs include an extra call 
to Wai tNextEvent( )-one that is made from within a time-consuming 
function. For instance, if a function has a loop that repeats thousands of 
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times, the programmer will typically insert a call to W a it Next Event ( ) 
within that loop. This extra call typically watches for a keyDown or 
mouseDown event. Should an event of that nature occur during the exe­
cution of the loop, it's assumed that the user wants to cancel the action 
being performed in the loop. Here's an example: 

void Do_Time_Consuming_Stuff( void ) 
{ 

1 ong i ; 
EventRecord evt; 

for ( i = 0; < 10000; i++ ) 
{ 

} 

MoveTo( 20, 20 ); 
FillRect( &The_Rect, &qd.black ); 
FillRect( &The_Rect, &qd.white ); 

if ( WaitNextEvent( keyDownMask, &evt, OL, nil ) ) 
goto escape; 

escape: 
} 

The Do_Time_Consuming_Stuff() routine simply executes a few 
QuickDraw commands-just something to kill a little time for the pur­
pose of my testing out the use of WaitNextEvent(). The function con­
stantly draws a globally defined rectangle, first in black, then in white. 
The result is a flickering rectangle that looks something like the one 
shown in Figure 13.1. 

At each pass through the loop a call to Wai tNextEvent() is made. I've 
used the keyDownMask to instruct WaitNextEvent() to watch only for a 
key stroke. Should the user press a key at any time during the execution of 
the loop, the loop will terminate. While Do_Time_Consumi ng_Stuff() 
doesn't perform the most useful or exciting task, it is representative of how 
WaitNextEvent() is often used outside of the main event loop. If you 
want to run the program yourself, look in the folder titled (13) 
WaitNextEvent f. In that one folder you'll find additional folders that hold 
all four of the short test programs that I'm about to describe. 
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FIGURE 13.1 THE OUTPUT OF THE TEST PROGRAM. 

Verifying the WaitNextEvent() Is Time Consuming 

To see just how time consuming a call to WaitNextEvent() can be, I've 
written a couple of very short test programs. The first doesn't contain any 
calls to the Wai tNextEvent () function. It loops 10,000 times, drawing 
the flickering rectangle at each pass through the loop: 

void Do_Time_Consuming_Stuff( void ) 
{ 

} 

long i : 

for < i = O; < 10000; i++ ) 
{ 

} 

MoveTo( 20, 20 ); 
FillRect( &The_Rect, &qd.black ); 
FillRect( &The_Rect, &qd.white ); 

In order to gauge how long Do_ Ti me_Cons umi ng_Stuff () takes to exe­
cute, I added a few local variables and a couple of calls to LMGetTi c ks ( ) . 

This function returns the number of ticks, or sixtieths of a second incre­
ments, that have passed since the system-the Mac-was booted. Figure 
13.2 shows that when execution stops at the breakpoint at the bottom of 
the function, seconds has a value of about 7.8 seconds. I've taken the lib­
erty of altering the screen dump so that the seconds variable appears in 
boldface-that's the variable I'm most interested in. 
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No WNE Test 

EmToNatEll'.IMl .. 

end-ticks 
i 
seconds 
starLticks 
totaLticks 

__start 
main 
Main...fvenLl ... 

-: 

-: 

void Oo_T ime..Consum i ng...Stuff( voi d ) 
{ 

long i; 
long total_ticks, start_t icks , end_ticks; 
f I oat seconds; 

start-ticks= LMGetT icksO; 

for ( i = 0; i < 10000; i ++ ) 
{ 

Move To< 20, 20 ) ; 
Fi I I Rect( &The...Rect , &qd . b I ack ) ; 
Fi I I Rect< &The...Rect, &qd. white ) ; 

end-ticks = LMGetTicks O; 
total_ticks = end_ticks - start_ticks; 
seconds = totaJ_ticks I 60.0; 

!Illill Line: 1 00 Source 

FIGURE 13.2 TIMING THE EXECUTION OF A FUNCTION THAT 

CONTAINS NO CALLS TO Wait Next Event ( ) • 

Next, I've added a call to WaitNextEvent() inside the loop. Now, the 
user can interrupt the Do_Time_Consuming_Stuff() function-which 
takes about 8 seconds to execute-at any time by just pressing a key. 
Here's the revised function: 

void Do_Time_Consuming_Stu ff( void ) 
{ 

1 ong i ; 
EventRecord evt; 

for ( i = O; < 10000; i++ ) 
{ 

MoveTo( 20, 20 ); 
FillRect( &The_Rect, &qd.black ); 
FillRect( &The_Rect, &qd.white ); 

if ( WaitNextEventC keyDownMask, &evt, OL , nil ) 
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goto escape; 
} 

escape: 
} 

I set up a small CodeWarrior program that included this new version of 
Do_Time_Consuming_Stuff() and added the calls to LMGetTicks(). 

This time, when the function was left to execute uninterrupted, it took 
about 29.8 seconds to execute-that's shown in Figure 13.3. This 
increase in execution time from about 8 seconds to about 30 seconds was 
caused by the numerous calls to Wai tNextEvent (), and by the subse­
quent Mixed Mode instructions that needed to be generated. 

384 

Lots WNE Test 

OxFDFDFA (68 .. ~ 
Ox 1 34054 ( 6 .. . 

enLticks 
~ evt 

! 11 9952 {]>­
: OxOOBEB 1 BC i-=-1 
; 10000 EmToNBIErdMJ .. . i 

seconds 
sta rLticks 
totaLti cks 

___start 
main 

! 29. 7833 
; 118165 

Mai rt..fvenl.l.o .. : 1787 
~ the .. Reci . · ·· ··:ax-oas·s9i'is izy 

void Oo_ T i me_Gonsum i ng...S tu ff < vo i d ) 
{ 

long 
EventRecord 
long 
f I oat 

i ; 
evt ; 
to ta I _ticks, start_t i cks , end_t i cks; 
seconds; 

starLticks = LMGetTicks< >; 

for < i = 0; i < 10000 ; i ++ ) 
{ 

MoveTo< 20 , 20 >; 
Fi I IRect< &The....Rect, &qd . black )­
Fi I IRect( &The....Rect , &qd. white >'. 

if < Wai tNex tEven t< keyDownMask , &evt , OL , n i I 
goto escape; 

escape : 

•!•} 

end_ ticks = LMGetT i cks() ; 
total_ticks = end_ticks - start_ticks; 
seconds = to ta f _ticks / 60 . O; 

[!)IQ) Line: 1 03 Source 

FIGURE 13.3 TIMING THE EXECUTION OF A FUNCTION THAT CONTAINS 

A CALL TO Wait Next Event ( ) IN EACH LOOP ITERATION. 



Chapter 13 Optimizing PowerPC Code 

A First Solution-Fewer Calls to WaitNextEvent(} 

One simple way to speed up a function's execution-while still giving the 
user the power to terminate the function-is to simply reduce the num­
ber of calls to Wai tNextEvent (). There's no need to make this Toolbox 
call at every pass through a loop. Instead, keep a count of the number of 
times through the loop, and call Wai tNextEvent () only every x passes 
through the loop. I chose a value of 10 for x, which means that 
Wai tNextEvent () will be called only every tenth pass through the loop. 
Here's a look at the latest version of Do_ Ti me_Cons umi ng_Stuff ( ) : 

void Do_Time_Consuming_Stuff( void ) 
{ 

long i ; 
evt; Event Record 

short count = O; 

for ( i = 0; i < 10000; i ++ ) 
{ 

} 

count++; 

MoveTo( 20, 20 ); 
FillRect( &The_Rect, &qd.black ); 
FillRect( &The_Rect, &qd.white ); 

if ( count == 10 ) 
{ 

} 

count= O; 
if ( WaitNextEvent( keyDownMask, &evt, OL, nil ) 

goto escape; 

escape: 
} 

This greatly sped up the function execution, while preserving the func­
tion's ability to catch and respond to a key Down event. Figure 13.4 shows 
that function execution time has been reduced from almost 30 seconds 
to just over 10 seconds. 

385 



Programming the PowerPC 

-
' 

Some WNE Test 

i 
seconds 
starLticks 

10000 
10.2667 
136305 

void Oo_T i me...Consum i ng...Stuff( void ) 
{ 

long 
EventRecord 
long 
float 
short 

j· 

e~t· 
tot~ 1 _ti cksJ start_t i cks, end_t i cks; 
seconds; 
count = O; 

star Lt i cks = LMGetT i cks(); 

for < ; = o· ; < 10000; i++ ) 
{ , 

count++; 

Move To< 20, 20 ) ; 
Fi I I Rect < &The...Rect, &qd. b I ock ) ; 
Fi I I Rect< &The...Rect , &qd. white ) ; 

if < count == 10 ) 
{ 

count = o· 
if ( Wai tNextEvent( keyDownMask, &evt, OL, n i I 

go to escape; 

escape: 
end_ ti cks = LMGe tT i cks (); 

•!•) 
toto l_ti cks = end_ticks - storLticks; 
seconds :::= tota l_ticks I 60.0; 

(!)!QI Line: 11 0 Source 

FIGURE 13.4 TIMING THE EXECUTION OF A FUNCTION THAT CONTAINS 

CALLS TO w a i t Next Event ( ) EVERY TENTH LOOP ITERATION. 

A Second Solution-Timing the 
Calls to WaitNextEvent() 

A second solution to reducing Wai t Next Event ( ) mixed mode time is to 
call the function at a specific interval of time. This solution fits more pro­
gramming circumstances than the previous one. For instance, you may 
have a function that doesn't have an unvarying execution time. Some 
loop iterations or some section of the function may take longer to exe­
cute depending on the values of certain passed parameters or global vari­
ables. For such a case you'll want to check to see how much time has 
elapsed since the previous call to Wa itNextEvent () was made. If a suffi-

386 



Chapter 13 Optimizing PowerPC Code 

cient amount of time has passed, call WaitNextEvent() again. Below is 
the final version of Do_ Ti me_Consumi ng_Stuff (): 

/ldefi ne TIME_BETWEEN_WNE 15 

void Do_Time_Consuming_Stuff( void 
{ 

long i : 
EventRecord evt: 
long time_to_call_WNE = O; 

for ( i = 0: i < 10000; i++ ) 
{ 

MoveTo( 20, 20 ); 
FillRect( &The_Rect, &qd.black ); 
FillRect( &The_Rect, &qd.white ); 

if ( LMGetTicks() > time_to_call_WNE 
{ 

if ( WaitNextEvent( keyDownMask, &evt, OL, nil ) 
goto escape; 

time_to_call_WNE = LMGetTicks() + TIME_BETWEEN_WNE; 
} 

} 

escape: 
} 

This version of Do_ Ti me_ Cons umi ng_Stuff () calls Wai tNextEvent () 
only if one quarter of a second has passed since the last call. The con­
stant TIME_BETWEEN_WNE establishes this time-15 sixtieths of a second is 
one quarter of a second. The time_to_cal l_WNE variable starts with a 
value of 0, which will of course be less than whatever value is returned by 
LMGetTi cks (). So the first pass through the loop will always invoke 
Wai tNextEvent ().After Wa itNextEvent () is called, the value of 
time_to_cal l_WNE is changed to the current system tick count plus the 
15 tick count buffer. That means Wai tNextEvent() won't get invoked 
until at least a quarter of a second has elapsed. Figure 13.5 shows that 
using this timed method, Do_Time_Consumi ng_Stuff() takes only 8.5 
seconds to execute-much better than the 30 seconds the function takes 
to execute when Wa itNextEvent () is called at each pass through the 
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loop, and not too much slower than the 7.8 seconds the function takes to 
execute when no Wa itNextEvent () calls are in the loop. 

rl1 
N 0 T E 

388 

But wait! What about all those calls to LMGetTi cks ( )? 

True, there's one at each pass through the loop. But this 
routine is ported to native PowerPC, so there's no mode 
switching involved. And you can see from Figure 13.5 that 
the timing of the loop doesn't suffer from the over 10,000 
calls to LMGetTi cks( ). 

-· Timed WNE Test 

count 
end-ticks 

~ evt 
i 
seconds 

32 
234001 
OxOOBEB1 BC 
10000 
8.5 

#define T I ME....BETWEEN..J.INE 15 

vo id Oo_T i me-Consum i ng.....Stuff ( void ) 
{ 

long 
EventRecord 
long 
f I oat 
long 
short 

i ; 
evt · 
tot~l-licks, stort_ticks, end_ticks ; 
seconds; 
t ime_to...cal l..J.INE = O; 
count = O; 

starLticks = LMGetTicksO; 

for ( i = 0 · i < 10000 ; i ++ ) 
{ , 

MoveTo< 20, 20 ); 
Fi I IRect< &The..Rect , &qd .black ); 
Fi I IRect< &The..Rect , &qd . whi le ); 

if < LMGetTicks<) > time_to....cal l..J.INE ) 
{ 

if < Wai tNex t Event ( keyDownMask, &evt, OL, ni I ) ) 
go lo escape ; 

time_to...cal l..J.INE = LMGetTicksO + TIME....BETWEEN..J.INE; 

count++; 

{!)[ill Line : 114 1 Source 

FIGURE 13.5 TIMING THE EXECUTION OF A FUNCTION THAT 

CONTAINS TIMED CALLS TO Wai tNext Event ( ) • 



Chapter 13 Optimizing PowerPC Code 

MISCELLANEOUS PERFORMANCE ENHANCEMENTS 

L imiting calls to WaitNextEvent() is the simplest single step you can 
take to improve the performance of your PowerPC application. 

There are, however, a few other tips you'll want to consider. 

Align Data Structures 

As described in Chapter 10, make sure that your compiler is set to 
PowerPC structure alignment whenever possible. The Power Mac can 
access struct members from a struct that has been appropriately 
padded much more quickly than it can access members of a struct that 
was specifically aligned for a 680x0-based Macintosh. 

You'll only need to use //pragma options align= mac68K when you 
know your application will be transferring data between a 680x0-base 
Macintosh, or if it will be running on a network with both Power Macs 
and 680x0-based Macs. 

Move Floating-Point Parameters 
to the End of the List 

One subtle but sometimes noticeable change you can make to your code 
is to move all floating-point parameters to the end of the parameter list 
for application-defined functions. If you have a routine with the follow­
ing parameters: 

void My_Function( double d_l, double d_2, double d_3, 
double_4, int i_l, int i_2, int, i_3 

Change the ordering of the parameters to this: 

void My_Function( int i_l, int i_2, int, i_3, 
double d_l, double d_2, double d_3, 
double_4 ) 
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The reasoning behind this switch? You'll reduce memory accesses. The 
PowerPC contains eight general-purpose registers that are reserved for 
the first eight function parameter words. These eight registers will always 
be used first-no matter what type of parameters are first encountered. 
Once these eight words are filled, the PowerPC will use either the stack 
or some of its 13 floating-point registers to hold the remaining parame­
ters. If the parameters aren't floating-point values, they'll be written to 
the stack-and that means memory access. If the parameters are floating­
points, they'll stay in the PowerPC's floating-point registers. 

In my first example, repeated below, the eight words of the general 
purpose registers will quickly be filled by the double parameters-each 
double occupies 8 bytes, or two PowerPC words. That means that the last 
three parameters, the integers, will all be written to the stack. 

void My_Function( double d_l, double d_2, double d_3, 
double_4, int i_l, int i_2, int, i_3 

Now consider what happens when the ordering of the parameters is 
changed-as in the version of My_Function() that's shown below. 
Here, the first three parameters-the integers-would go into three of 
the PowerPC's general purpose registers. Next, the four double para­
meters would go into four of the 13 PowerPC floating-point registers. A 
simple rearranging of the parameters results in the elimination of 
memory access. 

void My_Function( int i_l, int i_2, int, i_3, 
double d_l, double d_2, double d_3, 
double_4 ) 

CHAPTER SUMMARY 

Using the techniques provided in the previous chapters of this book will 
allow you to port any existing 680x0 application to native PowerPC code. 
There are a few easily overlooked tips you'll want to follow, however, to 
push the most performance out of your Power Mac. 
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The single most important change you can make to your source code 
is to limit the number of calls that are made to WaitNextEvent( ). The 
Event Manager hasn't been ported to native PowerPC code, so you'll want 
to institute some sort of timing code to limit extra calls to this routine. 

You can look over the parameter list of each of your program's appli­
cation-defined functions to verify that floating-point parameters (fl oat, 
doub 1 e, and 1 ong doub 1 e), all appear at the end of the lists. That makes 
it easier for the PowerPC to work with function calls. Finally, make sure 
that your PowerPC-only applications don't have struct alignment set to 
680x0 alignment. The PowerPC can access struct members much more 
quickly if those members fall on boundaries set for the Power PC. 
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Apple Events 
AE.besc data type, 372 
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AEGetKeyDesc(), 371-372 
AEGetNthPtr(), 372-373 
AEinstallEventHandler(), 

365-367, 369 

AEProcessAppleEvent(), 363-
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367-375 
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370 
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stant, 365 
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365 
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(CCR), 14, 16-17, 21 
defined,2 
evolution of, 14 
instruction execution, 14-17 
instruction timing, 17-19 
limiting factors of, 16-17 
status register, 14 

client application, 362 
CloseConnection(), 291, 306 
CloseResFile (), 286 
Code Fragment Manager (CFM) 

defined,74 
loading fragments, 75-78 

code fragments 
containers for, 275-277 
creation of, 27 4 
defined,65,73 
symbols in, 75, 79-80 

code resource fragment, 74 
CODE resources, 172, 173-175, 

200-201, 309 
coherency, 39 
Companylnfo, 292-300 
compatibility issues, 9-11 
compilers 

PowerPC, 87-88 
see also Symantec CDK 

compiler 
see also Metrowerks 

Index 

Code Warrior compiler 
complex instruction-set comput­

er, see CISC technology 
condition code register (CCR), 

14, 16-17, 21 
condition register (CR), 21 
conditional compilation direc­

tives, 145, 238-248 
containers, code fragment, 275-

277 
Con trolAction UPP, 148-149 
core events, 362 
cross-mode calls, 58-61 

D 

data alignment 
680x0, 256-258 
compatibility, 261-263 
lasting effects of, 265 
manual, 267-271 
padding, 256-260 
PowerPC, 258-260 
problems with, 260-261 
structures/variables,265 
testing, 263-266 

data fork erasing, 202-206 
data section, 76-77 
debugging, 264 
DFerase utility, 204-206 
dispatch table, 366 
DisposRoutineDescriptor(), 143 
DOS/Mac compatibility, 8-9 
double data format, 211, 212-213 
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double-double data format, 211-
213 

double_t data type, 216-217 
DrawText(), 47 
dynamically linked libraries, see 

import libraries 

E 

Emulator software 
cross-mode calls, 58-61 
defined, 49-50, 225 
mode switches, 50-55, 58 

engineers, 8 
EraseRgn (), 4 7 
error -192 ID, 169-170, 194 
error checking, 344-345 
Ethernet, 7 
event handlers, 364-367, 370-375 
EventRecord data type, 347 
example programs 

.. 
CDKdemoPPC, 111-131 
Companylnfo, 292-300 
fat binary stripping, 200-208 
fat binary, 176-193 
graceful exit, 193-199 
MWdemoPPC, 90-104 
PICTchooser, 339-349 
TestAppl, 301-312 
TestApp2, 313-324, 349-358 
TestApp3, 367-375 
UPPdemol, 152-156 
UPPdemo2, 157-164 

exiting gracefully, 193-199 
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expression evaluation, 218-223 
Extended Common Object File 

Format, 277 
extended data type, 211, 216-217 
extension fragment, 74 

F 

fat binary applications 
creating with Code Warrior, 

176-184 
creating with Symantec, 184-

193 
defined, 145,167,170 
forks of, 173-176 
stripping to PowerPC-only, 

167, 200-209 
filter functions, 134-136, 140-143, 

146-148, 154-156 
float.h header file, 228 
floating-point registers (FPR), 39 
Floating-Point Unit (FPU), 37-39 
forks, resource and data, 171-176 
fp.h header file, 213, 216-217 
FragLoad.h header file, 283, 304 
fragments, see code fragments 
FS:M:akeFSSpec(), 288,305 
FSpOpenDF(), 341 
FSpOpenResFile (), 285 
FSRead(), 342 
FSSpec data type, 285, 288, 304-

305, 373 
function 

calls, 33-36 
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declarations, 233-236 
prototypes, 236-237 
return types, 233-236 

general purpose registers 
(GPR), 38 

Gestalt(), 57 
gestaltProcessorType selector, 57 
GetDiskFragment(), 289-291, 305-

306, 312 
GetEOF(), 341 
GetFontlnfo(), 47 
GetNewCWindow(), 353 
GetSharedLibrary(), 326-328 
global variables, 76-77, 82 
glue code, 60-61 
GrayRgn, 251-253 

H 

Hide Window(), 375 
HiWord(), 320 

I 

icons, import libraries, 332-339, 
348-349 

import libraries 
advantages of, 69-73, 286-287, 

315-316 
CloseConnection (), 306 
connections, 278-279 
creating, 291-300 

Index 

Creator, 295 
data fork size, 300 
defined,65,68,277 
entry points, 279, 296 
export symbols, 278 
GetDiskFragment(), 289-291, 

305-306, 312 
GetSharedLibrary(), 326-328 
icons for, 332-339, 348-349 
import symbols, 278 
InitBlockPtr data type, 283, 

343 
initialization routine, 279-280, 

297-298, 342-345 
loading via menus, 312-313 
loading, 288-291 
main routine, 279, 281, 346-

347, 353-358, 359-360 
plug-in tools, 315-316 
qd globals and, 358-360 
resource access, 280, 284-286 
shlb type, 296, 324-328 
special routines, 279 
symbols, 278 
termination routine, 279, 281, 

345-346 
testing, 300-312 
Type,295 
unloading, 291 
uses for, 316 

InitBlockPtr data type, 283, 343 
initialization routine, 279-280, 

297-298, 342-345 
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Insignia Solutions, 8 
installing event handlers, 369-370 
instruction set architecture, 58, 

139 
INT_MAX constant, 229 
integer exception register (XER), 

38 
Integer Unit (IU), 37-38 
InterfaceLlb, 93 

K 

kAEOpenApplication constant, 
365 

kAEOpenDocuments constant, 
365 

kAEPrintDocuments constant, 
365 

kAEQuitApplication constant, 
365 

kCoreEventClass constant, 365 
k.HighLevelEvent constant, 363 
KillPicture (), 345 

L 

latency, 25 
libraries, 213-214 
limits.h header file, 228, 231 
Line(), 47 
linked libraries 

creating, 68 
defined,68 
MacTraps, 68 
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LMGetGrayRgn(), 252 
LMGetTicks(), 387-388 
LoMem.h header file, 253 
low-memory system globals, 249-

253 
LowMem.h header file, 252 
Lo Word(), 320 

M 

Mac/DOS compatibility, 8-9 
Mac/Windows compatibility, 8-9 
mac68k pragma, 261-263, 389 
MacHeadersPPC, 96-97, 177, 248 
Macintosh Programmer's 

Workshop (MPW), 230 
MacTraps, 68 
main routine, 279, 281, 346-347, 

353-358, 359-360 
MathLib, 93, 213 
MAX.INT constant, 229, 230-232 
memory address bit size, 249 
Memory control panel, 249 
Memory Management Unit 

(MMU), 56 
Memory Manager, 4 7 
Metrowerks CodeWarrior compiler 

adding files to, 92-96 
( application builing, 103-104 

cfrg resource, 99, 308-309 
defined, 87, 88-89 
example program, 90-104 
fat application building, 176-

184 



fat binaries and, 104 
import libraries, 292-300, 34 7-

349 
InterfaceLib, 93 
libraries and, 96-98 
MacHeadersPPC, 96-97, 177, 

248 
MathLib, 93 

MWCRuntime.Lib, 93 
preferences, 96-98 
prefix file, 96-97 
project creation, 90-92 
resource files and, 98-100 
SIZE resource, 99, 308-309 

x:S\:M file, 310 
minimum evaluation format, 219-

223 
Mixed Mode Manager 

cross-mode calls, 58-61 
defined, 49-50, 58, 133 
mode switches, 50-55, 58 

ModalDialog(), 134-136, 140, 142, 

152-156 
ModalFilterUPP, 141 
mode switch, 52 
Motorola microprocessors, 56 
multimedia authors, 8 
multiply-add array, 39 
MWCRuntime.Lib, 93 
MWdemoPPC, 90-104 

N 

nanokernel system software, 50 

Index 

native software, defined, 47 
NewAEEventHandlerProc(), 366 
NewControlActionProc(), 148-

149 
NewHandle(), 341-342 
NewModalFilterProc(), 141 
nil, in place of UPP, 149 
NoteAlert(), 136 
numeric environments 

defined,209 
see also SANE 
see also PowerPC Numerics 

0 

OpenDeskAcc(), 321 
optimizing PowerPC code 

data structure alignment, 256-
271, 389 

LMGetTicks(), 387-388 
parameter ordering, 389-390 
ported traps, 380 
WaitNextEvent(), 380-388 

p 

partitions, memory, 249 
PEF file format, 277 
PicHandle data type, 342 
PICT files, opening, 339-342 
PICTchooser, 339-349 
pictures, displaying, 339-342 
pipelining, 25 
plug-in tools, see import libraries 
ported system software, 46-4 7 
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porting code 
32-bit clean, 248-249 
ANSI C compliance, 230-237 
assembly language, 229 
comp data type, 218 
conditional compilation, 238-

248 
declarations, function, 233-

236 
extended data type, 216-217 
int data type, 230-232 
long data type, 232 
low-memory system global 

variables, 249-253 
prototypes, function 236-237 
qd global variable, 239-241 
QuickDraw globals, 239-241 

return types, function, 233-
236 

short data type, 232 
single source code file, 237-

238 
thePort global variable, 239-

241 

universal header files, 226 
see also universal procedure 

pointers 
Power Macintosh 

compatibility issues, 9-11 
developer support, 10-11 
multimedia versions, 6 
naming of, 5 
original release, 5-9 
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sales of, 1 

System software version, 9, 49 
powerc macro, 242-248 
POWERPC macro, 241-248 
PowerPC Numerics 

680x0 and, 210 
comp data type, 218 
defined,209 
double data format, 211, 212-

213 
double-double data format, 

211-213 
double_t data type, 216-217 
expression evaluation, 218-

223 
extended data type, 211, 216-

217 

fp.h header file, 213, 216-217 
libraries, 213-214 
MathLib, 213 
minimum evaluation format, 

219-223 
PowerPC and, 210 
scalb(), 217 

single data format, 211, 212-
213 

pragma options, 261-263, 389 
Preferred Executable Format, 277 
prefetching, 31 
prefix files, 96 
printf(), 263 
procedure pointers 

defined,62, 136 



errors compiling, 144 

ModalDialog(), 134-136, 142 

UPPs and, 136-140 

Process Manager, 173-174 

ProcPtrs, see procedure pointers 
program segmentation, 67, 

76-77 

prototypes, function 236-237 
publishers, 8 

Q 

qd global variable, 124, 188, 239-
241, 358-360 

QuickDraw, 4 7 

R 

reduced instruction-set computer, 

see RISC technology 

reset pragma, 261-263, 389 
resource not found error, 169-

170, 194 

return types, function, 233-236 
RISC instructions 

Branch Processing Unit and, 

32-36 
building, 3-4, 22 

dependencies, 22 
execution, 21-24 
fetching, 30-36 
latency, 25 

pipelining, 25 
prefetching, 31 

queue, 31, 32-36 

rearrangement, 22 

scheduling, 22-24 

stalls, 24 

throughput, 25 

timing, 25-27 

Index 

RISC Software Developers Kit 
(SDK), 229 

RISC technology 

basic operation of, 3 
benefits of, 4 

condition register (CR), 21 

defined,3 

evolution of, 20-21 
latency, 25 

pipelining, 25 
stalls, 24 

throughput, 25 

see also RISC instructions 
routine descriptors 

creating, 141, 149 
defined, 59, 62-63 

described, 139 
NewModalFilterProc(), 141 

runtime environment 
defined,66 

overhaul of, 66-6 7 

s 
SANE 

comp data type, 218 
defined, 209 
expression evaluation, 218 
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extended data type, 211, 216-
217 

libraries, 213 
PowerPC and, 210 
SANE.h header file, 213, 216-

217 
SANE.lib, 213 
scalb(), 217 
see also PowerPC Numerics 

scalb(), 217 
Segment Manager, 172 
segmentation, 67, 76-77 
SetDitem(), 150-152 
SetFPos(), 341 
SFfypeList data type, 340 
shared libraries, see import 

libraries 
Shared Library Manager, 78 
ShowWindow(), 375 
SHRT_MAX constant, 231-232 
SIZE resource, 99, 119-120, 173, 

308-309 

snooping logic, 39-40 
SoftWindows emulation software, 

8 
special purpose register (SPR), 39 
special routines, 279 
stalls, 24 
Standard Apple Numerics 

Environment, see SANE 
StandardFileReplay data type, 340 
StandardGetFile(), 136, 340 
status register, 14 

402 

stereo input/ output, 7 
StopAlert(), 136 

superscaling, 36-39 
Symantec CDK compiler 

adding files, 115-117 
AppleScript and, 105, 106-109 
application building, 121, 

126-131 
build errors, 129-130 
cfrg resource, 119, 121 
defined, 87, 105 

example program, 111-131 

fat application building, 184-
193 

int, size of, 230-231 
memory partitions, 119-120 
project creation, 112 
project folder, 109-112 
qd global variable, 124, 188 
resource files and, 112-115 
SIZE resource, 119-120 
ToolServer, 105 
translators, 244-247 

symbols, 278 
SysEqu.h header file, 252 
System 7.1.2, 9, 49 
system global variables, 249-253 
system heap, 249 
system partition, 249 
system software 

porting of, 46-49 
PowerPC version, 9, 49 
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Table of Contents (TOG) 
defined, 79-80 

pointers and, 81-84 
TVectors and, 79-80 

termination routine, 279, 281, 
345-346 

TestAppl, 301-312 
TestApp2, 313-324, 349-358 
TestApp3, 367-375 
thePort global variable, 239-241 
throughput, 25 
ToolServer, 105 
TrackControl(), 136, 147-149 
transition vectors 

defined, 78-79 
pointers and, 78-79, 83-84, 

136 
Table of Contents and, 79 

translators, 244-24 7 
TVectors, see transition vectors 

u 
universal header files, 226 
universal procedure pointers 

(UPP) 
conditional use of, 145-146 
Con trolAction UPP, 148-149 
defined, 138-139 
disposing, 143 
DisposRoutineDescriptor (), 

143 

Index 

errors compiling, 144, 150 
local/ global usage, 254-255 
ModalDialog(), 140, 152-156 
ModalFilterUPP, 141 
NewControlActionProc(), 

148-149 

NewModalFilterProc(), 141 
nil, in place of UPP, 149 
SetDitem(), 150-152 
user items and, 150-152, 157-

164 
UserltemUPP, 150-152, 163 

U niversalProcPtr, see universal 

procedure pointers 
UnloadSeg(), 76-77 
UPPdemol, 152-156 
UPPdemo2, 157-164 
user items, 150-152, 157-164 
UseResFile(), 285 
UserltemUPP, 150-152, 163 
USEROUTINEDESCRIPTORS 

macro, 238-239 

v 
Values.h header file, 228, 231 
variables, missing, 264 
vers resource, 292-293 
Virtual Memory Manager, 49 

w 
WaitNextEvent(), 380-388 
Windows/Mac compatibility, 8-9 
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x 
XCOFF file format,· 277 
xSYM file, 310 
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ABOUT THIS DISK 

The one 1.4 M disk contains a single folder named PowerPC 
Programming f. Within this folder are three more folders. The first con­
tains a simple utility program that you'll use in Chapter 8. The other two 
folders holds source code files and project files for each of the examples 
presented in the this text. One folder holds Metrowerks CodeWarrior 
projects, the other holds Symantec Cross-Development Kit (CDK) pro­
jects. If you have either of these compilers, this disk provides you with 
everything you need to get started. 

This disk is a Macintosh l.4M high-density disk. All newer model 
Macintosh computers come with the SuperDrive-a 1.4 M high-density 
floppy drive. If you have an older Macintosh with an 800 K double-densi­
ty floppy drive, you won't be able to use this disk. You can, however, if you 
find a friend or coworker who has a SuperDrive. That person can copy 
the folders to two 800 K disks for you. The files on this l .4M disk are not 
compressed or archived-just copy them to your hard drive and use 
them "as is." 
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